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Preface

Audience
This guide is written for administrators who are responsible for setting up and
maintaining the Action Request System (AR System). The administrator is the
architect of the support request and problem resolution process.

As an administrator, you will need to be familiar with the AR System User Tool
and Notification Tool. This manual assumes that you understand the
information contained in the Action Request System User’s Guide.

This manual also assumes that you are familiar with the UNIX and
OpenWindowsUNIX and Motif environments for mouse and menu-driven
applications on UNIX workstations. A modest understanding of how to
administer distributed applications is also helpful.

Overview of This Document
Chapter 1, “Using the Administrator Tool,” provides an introduction to the
Administrator Tool window and menus and tells how to start the tool. It also
describes how to obtain information about the AR System UNIX and Windows
NT servers and licenses and how to build and use change history for AR
System structures.

Chapter 2, “Setting Up the AR System,” gives an overview of concepts an AR
administrator will need to understand in order to design and build an efficient
application of the AR System.
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Chapter 3, “Setting Up Groups and Users,” describes how to set up client
users and establish client environments on user’s machines. This chapter
includes a discussion of access control.

Chapter 4, “Defining Schemas,” describes how to create and maintain the
schemas that define the information fields in your database.

Chapter 5, “Defining Menus,” describes how to create and maintain character
menus and how to attach the menus you create to any character field on any
schema.

Chapter 6, “Defining Filters,” describes how to create and maintain the filters
that define your workflow process on the server and other conditional
processing.

Chapter 7, “Defining Escalations,” describes how to create and maintain the
escalations that control the timing aspects of your workflow process and other
conditional processing.

Chapter 8, “Defining Active Links,” describes how to create and maintain the
active links that take specific actions on the client machine when a user
performs a particular task or operation.

Chapter 9, “Defining Administrator Commands,” describes how to create and
maintain extensions for the User Tool that allow users running the tool on
UNIX workstations to invoke UNIX commands on the server.

Chapter 10, “Importing and Exporting Definitions,” describes how to transfer
schema, filter, active link, escalation, menu, and administrator command
definitions.

Chapter 11, “Using the Import Tool,” describes how to start and use the AR
System Import Tool to import data into your database.

Chapter 12, “Electronic Mail Support,” describes how to configure the mail
handler so that ARs can be submitted using email, and explains the
conventions used for mail templates.

Chapter 13, “The Multi-Process Server Option,” describes how to use and
administer the multi-process feature of the AR System.

Chapter 14, “Full Text Search,” describes how to use and administer the full
text search (FTS) feature of the AR System.
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Chapter 15, “AR System Server Utilities,” describes how to use the arcache
and arreload utilities with the Windows NT server.

Appendix A, “Changing Colors and Fonts,” describes how to change the
colors and fonts used by the Administrator Tool.

Appendix B, “AR System Files,” describes the various files needed by and
created by the AR System.

Appendix C, “Core and Reserved Schema Fields,” describes the fields all
schemas must contain as well as the fields that are reserved for special uses.

Appendix D, “Operators, Wildcards, and Keywords,” lists the operators,
keywords, and wildcards that you use to build qualifications in filters,
escalations, and active links.

Appendix E, “Command Line Options,” tells you how to use the command
line options to start the Administrator and Import tools.

Appendix F, “Design Worksheets,” provides worksheets that you can
reproduce for designing your workflow, schemas, active links, filters, and
escalations.

Appendix G, “Procedures,” provides a list of procedures.

The “Glossary”  lists and describes terms that you need to be familiar with as
you use the AR System.

AR System Documents
The Action Request System Installation Guide is a guide to installing the AR
System software for all operating environments. There are separate Installation
Guides for UNIX and Windows NT environments.

The Action Request System Getting Started Guide and Sample
Schemas provides an online demonstration showing the use of the AR System
in a sample help desk environment and describes how you can use the sample
schemas provided with the AR System.

The Action Request System User’s Guide is a how-to description of the
operations performed by all users of the AR System. There are separate User’s
Guides for environments supporting the Motif, Macintosh, and Windows
graphical user interfaces (GUIs) and for ASCII terminals.
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The Action Request System Administrator’s Guide (this document) describes
how the AR System Administrator can use the Administrator Tool to set up the
AR System and define its local operations. This manual is also a reference of
advanced AR System concepts. There are separate Administrator's Guides for
the UNIX and Windows environments.

The Action Request System Programmer’s Guide is a reference guide for
programming with the application programming interfaces (APIs) that come
with the AR System.

The Action Request System Troubleshooting and Error Messages Guide
provides information to help you identify and solve problems with the AR
System.

The Action Request System Distributed Server Option Administrator’s Guide
provides information about operating the AR System in a distributed, multi-
server environment.

The Action Request System Help Desk Template Guide describes the Helpdesk
application that runs in conjunction with the AR System to help you manage
your internal help desk organization. The template takes full advantage of the
rich feature set of the AR System and implements workflow and reporting
mechanisms to simplify the task of working in or managing a help desk.

The ARWeb Administrator’s Guide provides details about installing, using,
and customizing the ARWeb application, so that you can provide access to
your company’s AR System applications through the World-Wide Web.

The Action Request System Help Desk Template Guide describes the Help
Desk application that runs in conjunction with the AR System to help you
manage your internal help desk organization.

The Action Request System Accessories binder provides a place to keep
documentation for utilities and peripheral add-ons to the AR System. As
shipped, the Accessories binder includes the documentation for the Network
Management Platforms Integration Accessory.

Conventions Used in this Manual
bold font

Indicates that a word is a new or important term.
Example: filters.
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Initial Caps
Button and menu names and items have the first letter capitalized.
Example: File.

computer font
Indicates computer output, including UNIX prompts, an explicit directory, or a
file name.
Example: prompt% .

bold computer font
Indicates data to be entered by the user.
Example: aruser & .

< italic  font in angle brackets>
Indicates a variable directory, file name, or string that you are to  replace with
an appropriate directory, file name, or string.
Example: <ar_config_dir>.

italics
Indicates a reference to another manual or to a different section within the
current manual.
Example: see “AR System Documents” on page xxviii.
Italic type is also used for emphasis.
Example: All users will be affected.

Using the Mouse Buttons with Motif
Mouse buttons are referred to by SELECT (left),ADJUST (middle), and MENU
(right).

Use the SELECT button to select items from the menu banner at the top of the
window, set the location of the text cursor, and move fields. You can also use
the SELECT button to open and select from menus as well as open text edit
icons and diary icons.

Use the PASTE button to paste selected text.
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Use the MENU button to pop up a menu that lets you open a text edit window
and to select items from a pull-right menu for a field.

Mouse Button Activities

Select means to click once with the SELECT mouse button.

Drag means to click once with the SELECT mouse button and hold it down
while moving an object.

Double-click means to click the SELECT mouse button twice in quick
succession.

Pull-right means to select a sub-menu item by holding down the MENU button
while moving the mouse to the right to display and select a sub-menu item.
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Using the Administrator Tool 1

The Action Request (AR) System Administrator Tool is the tool you, as the AR
System administrator, will use to set up the AR System for use by support staff
and end users. You will use the tool to create and modify schemas, character
menus, filters, escalations, active links, and administrator commands.

This chapter describes the basic operations of the Administrator Tool. It
includes instructions for running the tool and provides a brief introduction to
the tool’s basic menus. It also describes how to display information about the
AR System server and licenses and how to build and use change history
information for the structures you create and modify using the Administrator
Tool.

Before attempting to use the Administrator Tool, you must have a general
familiarity with the Action Request System’s features and functions. If you are
not yet familiar with the AR System, review the Action Request System User’s
Guide before continuing with this guide.

The following topics are covered in this chapter:

• Overview of Administrator Tool functions.

• Starting and exiting the Administrator Tool.

• Using the Administrator Tool main window.

• Displaying and modifying server and preference information.

• Displaying license and version information.
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• Building and using a history of changes made to schemas, menus, filters,
escalations, active links, and administrator commands.

Administrator Tool Functions
You use the Administrator Tool primarily to create and maintain the AR
System schemas, menus, filters, escalations, active links, and administrator
commands. You also use the tool to import and export definitions and
electronic mail (email) templates and to view and manage information about
the server. You can use the Administrator Tool to administer all UNIX and
Windows NT server processes running in the AR System.

The functions of the AR System Administrator Tool are described below.

Creating and Modifying Schemas

The information fields in your AR System databases are described in
schemas. Each schema represents a database in a database on the AR server.
The AR System comes with several sample schemas and you can build as
many additional schemas as you need.

When you define a schema, you set up the fields on the schema and determine
what kind of information users will enter in each field. You may also create
field fill-in aids (menus) and help text.

All schemas have a set of core fields (discussed in Appendix C) and as many
additional fields as needed. For information on designing schemas, see
Chapter 2. For details on creating and modifying schemas and defining schema
fields, see Chapter 4.

Creating and Modifying Menus

You can define character menus that you can then attach to any character field
on any schema. You can create menus that are simple lists of items, menus that
are stored as system files, or menus that are built dynamically based on queries
to AR System schemas. For details on creating menus and using them on a
schema, see Chapter 5.
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Creating and Modifying Filters

Filters define the workflow process and other conditional processing steps for
your application of the AR System. Filters test for specified conditions on each
server transaction and, if the conditions are met, they take one or more actions.
These conditions and actions are called filter conditions and filter actions. For
example, you might define a filter so that when an AR changes state (filter
condition) the AR System notifies a specific end user (filter action).

Keep in mind when creating a filter for any purpose that filters execute on the
AR System server.

For information on designing filters, see Chapter 2. For details on creating and
modifying filters, see Chapter 6.

Creating and Modifying Escalations

Escalations test for entries matching specified conditions on a defined interval.
If the conditions are met, one or more actions are taken. These conditions and
actions are called escalation conditions and escalation actions. For example,
you might create an escalation that executes when a ticket more than eight
hours old has not yet been closed by support personnel.

Keep in mind when creating an escalation for any purpose that escalations
execute on the AR System server.

For information on designing escalations, see Chapter 2. For details on creating
and modifying escalations, see Chapter 7.

Creating and Modifying Active Links

Active links define operations that are executed on the client machine when
the user performs a specific action. These conditions and actions are called
active link conditions and active link actions. For example, you might create
an active link that searches the database for information about the customer
when the user presses Return in the Customer Name field.

Keep in mind when creating an active link that active links execute on the
client system when triggered.

For information on designing active links, see Chapter 2. For details on
creating and modifying active links, see Chapter 8.
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Creating and Modifying Administrator Commands

Administrator commands (extensions) are special menu extensions for the
User Tool that let users invoke specific UNIX processes on the server.
Administrator commands are available to users who are running the client
tools on a UNIX platform and who have the appropriate access permissions.
For details on creating and modifying administrator commands, see Chapter 9.

Importing and Exporting Definitions

A definition is the structure in which the data in the AR System is organized
and manipulated (for example, for fields or active links). You can use the
Administrator Tool to export definitions on an AR server. The definitions are
exported to files. The tool also supports the import of definitions into the AR
server from files exported from AR servers. In this way, it is possible to share
definitions among organizations and to migrate an AR System setup to a new
server. For a full discussion of importing and exporting definitions, see
Chapter 10.

Creating Export Mail Templates

You can use electronic mail to submit action requests or to notify users. As the
administrator, you are responsible for generating a template for users to fill in
and use to submit their ARs. For details on generating mail templates using the
export operation, see Chapter 10. For information on setting up and using the
electronic mail handler, see Chapter 12.

Starting and Stopping the AR System Server Manually
The installation script automatically starts the AR System server for you.
Under normal conditions, you will not need to stop the AR server. If the server
seems to be unresponsive, you should determine whether or not someone is
performing an operation that may take a long time, such as deleting a field
from a schema, before you take any action that results in terminating the
server. If at any time you feel it is necessary to stop the AR System server, you
can use the kill  command.You can stop and start the AR System server
manually at any time.
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Note – If the software is automatically started from a system startup file, you
should not need to manually start the server when the system reboots.

To stop and start the AR System server manually:
1. Log in as root and get the process ID number of the arservtcd process:

For SunOS systems, type the following:

For other systems, type the following:

Kill the server by typing the following UNIX command at the UNIX prompt:

Warning – Do not use the kill -9  command to stop the AR server. Doing so
may leave your database in an inconsistent and unrecoverable state.

2. Start the server by typing the following UNIX command at the UNIX
prompt:

The AR System server environment starts.

If the AR System software was installed by a non-root user (as described in
the Action Request System Installation Guide), then to start the server you
must use the same login and password as the user that performed the
installation. For example, you would enter su maris , where maris  is the
login name.

# ps -ax | grep arservtcd

# ps -ef | grep arservtcd

# kill <process_number_ arservtcd>

# <ar_install_dir> /bin/arservtcd &
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Starting the Administrator Tool
Only users registered as AR administrators or subadministrators will be able to
use the Administrator Tool. See Chapter 3 for information on how to add
administrators and subadministrators to the AR System.

To start the Administrator Tool:
1. Type the following at the UNIX prompt:

where <ar_install_dir> is the directory containing the executables for the
Administrator Tool.

2. If this is the first time you have started an AR System tool, you will see a
warning message telling you that there is no user specified in your config
file. Open the Login window (select Login from the File menu) and log in
as Demo. The AR System is case sensitive. This means you must use Demo,
not demo or DEMO. You do not need to enter a password the first time you
log in to the AR System.

Note – Do not let the Demo user become a security hole in the AR System. Add
a password for this user as soon as possible. See Chapter 3 for information on
adding a password.

The Administrator Tool Main window is displayed, as shown in Figure 1-1.

%<ar_install_dir> /bin/aradmin &
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Figure 1-1 Admin Tool Main Window

After starting the Administrator Tool, refer to the appropriate chapter for
information about specific tasks.

Command Line Options

A number of command line options are available that allow you to control the
state that the Administrator Tool comes up in initially. You simply include the
option in the command that you use to start the tool. For example, to start the
Administrator Tool with the active link list displayed, you use the -a  command
line option, as follows:

%<ar_install_dir> /bin/aradmin -a &
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The following command line options are available:

Using the Administrator Tool Main Window
The Administrator Tool main window shown in Figure 1-1 on page 7 is the
window from which you access all utility menus within the tool. Depending on
the category you select from the Category menu, the window lists the available
schemas, menus, filters, escalations, active links, or administrator commands.

This section provides a short description of the File, Category, Edit, and Help
menus.

The File Menu

The File menu is shown in Figure 1-2.

Table 1-1 Administrator Tool Command Line Options

Option Action

-a Start the Administrator Tool with the Active Links category
displayed in the list.

-e Start the Administrator Tool with the Admin Commands (admin
extensions) category displayed in the list.

-f Start the Administrator Tool with the Filters category displayed in
the list.

-m Start the Administrator Tool with the Menus category displayed in
the list.

-s Start the Administrator Tool with the Schemas category displayed
in the list.

-t Start the Administrator Tool with the Escalations category
displayed in the list.

-x Start the Administrator Tool and connect only to the specified
server or servers. This option overrides the list of servers specified
in the /etc/ar  file. You can specify this option multiple times to
connect with multiple servers.
For example, to start the Administrator Tool and connect only to
the servers named metaphysix and narnia, you would enter:
<ar_install_dir>/bin/aradmin -x metaphysix -x narnia&
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Figure 1-2 Admin Tool — File Menu

The File menu provides the following options:

Login Allows you to log in to the AR System. You must (1) belong to the
Administrator or Subadministrator group and (2) have a fixed
license.

Server Shows servers listed in the /etc/ar  file (or specified using the -x
command option) so you can select the server you wish to
administer.

Server
Information

Displays information about the currently selected server. If you are
a full administrator, it also allows you to set server options. See
“Setting Server Information and Option Settings” on page 13.

License
Information

Displays information about licenses that are available or in use on
the currently selected server. If you are a full administrator, it also
allows you to release a floating license if it becomes necessary to do
so. See “License Information” on page 25.

Distributed
Mappings

If you are licensed for the Distributed Server Option (DSO),
displays the Distributed Mappings menu, which lets you select the
Add Distributed Fields, Server Settings, and Distributed Pending
windows.
For more information, refer to the Action Request System Distributed
Server Option Administrator’s Guide for OSF/Motif manual.

Import Allows you to import definitions that have been exported from the
AR System. See “Importing and Exporting Definitions” on page 241.

Export Exports selected definitions and generates mail templates. See
“Importing and Exporting Definitions” on page 241.
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The Category Menu

The Category menu, shown in Figure 1-3 on page 10, lets you select what you
want to work with: schemas, menus, filters, escalations, active links, or
administrator commands. The first time you start the Administrator Tool, the
Schemas category is selected and the window shows a list of schemas.
Thereafter when you start, the tool opens and displays the category you last
selected.

Note – You can use one of the options described in “Command Line Options”
on page 7 to cause the Administrator Tool to open with a specific category
displayed.

Figure 1-3 Admin Tool — Category Menu

The following categories are available through the Category menu:

Preferences Allows you to define user-specific preferences when operating the
Administrator Tool. See “Preferences” on page 28.

Exit Exits the Administrator Tool.

Schemas Lists schemas on the server.
Menus Lists menus on the server.
Filters Lists filters on the server.
Escalations Lists escalations on the server.
Active Links Lists active links on the server.
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The Edit Menu

The Edit menu, shown in Figure 1-4, provides a choice of actions you can
perform on a selected item (you can select only one item at a time).

Figure 1-4 Admin Tool — Edit Menu

The Edit menu provides the following choices:

The Help Menu

The Help menu, shown in Figure 1-5, displays the version number of the AR
System software and the host name the Administrator Tool client is running
on.

Admin
Commands

Lists administrator commands (administrator extensions) on the
server.

Distributed
Mappings

Lists distributed mappings on the server. For more information,
refer to the Action Request System Distributed Server Option
Administrator’s Guide for OSF/Motif manual.

Open Opens a window containing the item for viewing or editing.
Create a New Creates and opens a new item.
Copy Makes a copy of the item, naming it Copy of <xxx>, where <xxx> is

the name of the item copied. Does not open the new item.
Delete Deletes the item from the system. This is a permanent action and

cannot be undone.
Group Access Sets schema, active link, and admin command permissions globally

for a specific group defined on a server.
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Figure 1-5 Admin Tool — Help Menu

Selecting a Server to Administer
You only need to run one Administrator Tool to administer all the servers
running at your location. To select a server, select the Server sub-menu from
the File menu of the Administrator Tool main window. The sub-menu appears,
as shown in Figure 1-6.

To select a server:
1. Select the Server sub-menu from the File menu, as shown in Figure 1-6.

Figure 1-6 Admin Tool — Server Menu

2. Select a server to administer.
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Depending on your level of permissions, the Administrator Tool then displays
the items from the server that you chose. For example, if you selected the
server narnia, only the schemas for that server that you have permission to
administer appear on the list.

Setting Server Information and Option Settings
To display information about the currently selected server or to set server
options, select the Server Information item under the File menu of the
Administrator Tool main window (or type Ctrl+R ). The Server Information
window appears, as shown in Figure 1-7 on page 14.

The functions of the Server Information window are server specific. The
information and settings on the Server Information window are global to the
selected server and affect how the AR System works on that server.

Note – The Server Information window does not display the information for
administering the full text search and multi-process server options if the server
is not licensed for these options.
These options are not available with the current release of the Windows NT
server.

A number of the fields on the Server Information window contain display-only
information that cannot be modified. Other fields in the window allow you to
set options that control how the server will act. If you do not set an option for
a field, the default value is in effect. You must be an Administrator to make
changes in this window.

Note – You may be asked to provide information from the Server
Information screen when you place a call to Customer Support.

Platform Information

When the Server Information window (Figure 1-7 on page 14) first appears, it
displays information about the platform on which the selected server is
running.
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To display platform information about the currently selected server:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Platform from the Category list,
as shown in Figure 1-7.

Figure 1-7 Server Information — Platform

The following display-only fields are available:

Timeouts Information

Select the Timeouts category (Figure 1-8 on page 15) to specify timeouts for the
currently selected server.

Server Version Information field displaying the version number of the
AR System software on the server.

Server
Directory

Information field displaying the directory where the AR
server data files reside on the server system.

Hardware Information field displaying the hardware platform on
which the server is running.

Operating
System

Information field displaying the operating system
software version running on the server system.
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To set timeouts:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Timeouts from the Category list,
as shown in Figure 1-8.

Figure 1-8 Server Information — Timeouts

3. Enter values for the following timeout settings as required:

Process Timeout (seconds) A filter or escalation can perform a Set Fields action that
runs a process and waits for a return. To prevent blocking
the server if a process does not return, the server waits a
specified interval and then returns even if the process has
not completed.
Enter a value from 1 to 20 to set a timeout in seconds. The
timeout defaults to 5 seconds. (Specifying long intervals
can cause an increase in response time for users.)
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4. Select the Apply button to save the option settings.

License Information

Select the License category (Figure 1-9 on page 17) to display information
about the type and number of AR System licenses. You also set the Submitter
Mode in this window.

To display license information and set the Submitter Mode:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Licenses from the Category list,
as shown in Figure 1-9.

Floating License Timeout
(hours)

This field allows you to set a time limit on how long a
floating write license reserved for a user will remain
reserved if the user is not accessing the AR System.
When using floating write licenses, a user will reserve a
token while connected to the server. If the user does not
perform any AR System operation for this period of time,
the license is automatically freed. You specify the number
of hours of inactivity before automatic release of the
license.
Enter a value in hours to set a time limit. The timeout
defaults to two (2) hours (a two hour limit avoids
undesired timeouts over lunch). The minimum value you
can set is one (1) hour.

Full Text Timeout (hours) This field allows you to set a time limit on how long a
floating full text search license reserved for a user will
remain reserved if the user is not accessing the AR
System.
When using full text search licenses, a user will reserve a
token while connected to the server. If the user does not
perform any AR System operation for this period of time,
the license is automatically freed. You specify the number
of hours of inactivity before automatic release of the
license.
Enter a value to set a time limit, in hours. The timeout
defaults to two (2) hours (a two hour limit avoids
undesired timeouts over lunch). The minimum value you
can set is one (1) hour.
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Figure 1-9 Server Information — Licenses

3. The following display-only fields and options appear:

Server License Type Information field displaying the server’s license type.
Fixed Write Licenses Information field displaying the total number of fixed write

licenses that exist on the server.
Floating Write Licenses Information field displaying the total number of floating

write licenses that exist on the server.
Fixed Full Text Licenses Information field displaying the total number of fixed full

text search licenses that exist on the server.
Floating Full Text
Licenses

Information field displaying the total number of floating full
text search licenses that exist on the server.

Max Schemas Allowed
On Server

Information field displaying the number of schemas you are
licensed to create on the server. If the field reads Unlimited ,
you can create all the schemas you want.

Remedy Server ID Information field displaying the unique Remedy identifier
code attached to the machine licensed to run the AR System.
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4. Select the Apply button to save the option settings.

Configuration Information

Select the Configuration category (“Server Information — Configuration” on
page 19) to set various administrative options.

To set the configuration:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Configuration from the Category
list, as shown in Figure 1-10.

Submitter Mode This field lets you specify whether or not anyone can change
the name in the Submitter field of an AR ticket. Submitter
mode determines if a submitter must have a license to write
to a ticket.
* If you select Locked, the submitter field is “locked” at
submit time. Its value cannot be changed by any user.
Licensing is relaxed so that submitters do not need a write
license to update fields that they have change access to. This
allows users to update information on ARs that have their
names in the Submitter field without requiring a write
license.
* If you select Changeable (the default setting), modifications
to ARs is restricted to users with write licenses. Licensing is
strictly enforced so that all users (even submitters) require a
write license to make any updates.
The default is Changeable.
Note: Changes to the Submitter Mode settings do not take
effect until after the server is stopped and restarted. When the
server restarts, the system alerts you with a confirmation
message that you have made changes to the Submitter Mode.
For more information on the role of submitters, licenses, and
access control, see “Understanding Access Control” on
page 69 and especially “Special Submitter Access” on
page 71.
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Figure 1-10 Server Information — Configuration

3. Select from the following options or enter settings as required:

Allow Guest Users This field lets you specify whether or not the AR System will
allow access by users who are not registered users of the
system. If allowed, guest users have the following capabilities
in the AR System:
View any structures that are visible to the Public group.
Submit new entries, if open submissions are allowed.
View fields on schemas where fields allow Public view
capability.
View fields on schemas where they are the Submitter or
Assignee, if the Submitter or Assignee have View permission.
Guest users will not have permissions to update existing ARs,
unless the Submitter mode is set to Locked. Then, if guest users
submit an AR and the Submitter group has change permissions,
they can modify any fields in the ARs they submit.
Set this option to Yes to allow guest users on this server. Set to
No to disallow guest users. The default is Yes.
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Cross Ref
Blank
Password
(UNIX
servers
only)

You can set this option to tie the password for a user to the
password for the UNIX user of the same name. When a user
logs on with this option set, the AR System checks the AR
System database for the user specified. If a password is found
for the user, that password is used. If the password is blank, the
AR System validates the password against the password in the
/etc/passwd  file.
Note: The /etc/passwd  file used is the file on the machine
running the AR System server.
The default setting (Cross Ref Blank Password option is not
selected) specifies that all passwords for the AR System are
stored within the AR System; a blank password means that the
user has no password.
This setting is not displayed for Windows NT servers.

Use
Password
File
(UNIX
servers
only)

You can set this option to use the /etc/passwd  file for user
validation. When a user logs on with this option set, the AR
System first attempts to validate the user against users
registered with the AR System. If a match is found, that user
definition and permissions specified in the matching User
record are used.
If no match is found, the AR System checks the
/etc/passwd  file or NIS password map for a match. If a match
is found, the user is considered a valid user (not a guest) of the
system. The UNIX group specification from the file is retrieved
and the user is considered to be a member of the AR System
group whose Group ID matches the UNIX group.
Note: The /etc/passwd  file used is the file on the machine
running the AR System server.
Set to Yes to cause the server to reference the
/etc/passwd  file if the user is not registered with the AR
System. Set to No to disallow checking of
/etc/passwd  and require registration with the AR System.
The default is Yes.
This setting is not displayed for Windows NT servers.

Allow
Unqualified Queries

This option lets you specify whether or not the server will
accept unqualified queries. Unqualified queries are requests for
the system to return entries with no qualifications set on the
data; all database entries are returned by an unqualified query.
The main reason to consider restricting the use of unqualified
queries is to prevent the performance penalty of retrieving and
returning large blocks of data due to accidental, unqualified
queries to the database.
Set to Yes to allow a query with no qualifications on the data.
Set to No to disallow such a query. The default is Yes.
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4. Select the Apply button to save the option settings.

Log Files Information

Select the Log Files category (Figure 1-11 on page 22) to set one or more of the
debugging modes for the system. In debug trace mode, the AR System creates
a log file containing information about system activity.

By default, each log file is located in the directory identified in the Log File
field (by default, <ar_install_dir>/db ). To change the location or name of
one of the log files, enter a name and path in the appropriate Log File field
below.

You can activate logging at any time; logging will start immediately. Each log
file is flushed and restarted when you restart the AR server process or when
you reactivate logging after it has been deactivated. The previous log file is
written to <logname>.bak

You should be aware that log files consume increasing amounts of disk space
as messages accumulate. You may want to monitor your disk resources
carefully while logging is active.

Max Entries Returned
By GetList

This option lets you limit how many database entries are
returned after a query. For example, setting the maximum
entries to 50 would return a maximum of 50 entries, even if
there were more entries that satisfied the qualification. The AR
System warns users that the query matched more entries than
the administrator allows to be retrieved.

User Email
Notifies From
(UNIX
servers
only)

This option lets you specify the From user for email
notifications.
By default, when the AR System sends email notifications they
are delivered from the user
ARSystem . You can specify an alternate user for the source of
these notifications.
If the UNIX user running the arserverd  process is not a
trusted email user, the source of the email messages will be the
UNIX user themselves. The mail system will only allow trusted
users to change the source of the email message. See your
UNIX System documentation for more information on email
and trusted users if you have questions.
Enter a name to set the From address of email notifications. The
default is ARSystem .
This setting is not displayed for Windows NT servers.
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These fields allow you to enter a location and name other than the default
location and name for each of the log files created in debug mode. Note that
logging will not occur unless you also check the appropriate debug trace mode
checkbox.

Note – If you are running a multi-process server, each server will write to its
own log file. These log files also include the RPC number of the server, as in
the following: arsql.log.390620 .

See the Action Request System Troubleshooting and Error Messages Guide for more
information on the debug modes.

To set log files:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Log Files from the Category list,
as shown in Figure 1-11.

Figure 1-11 Server Information — Log Files

3. Select from the following options to enable the desired debug modes (you
can select all log files, some log files, or no log files). Note that the log file
name fields are disabled until you select the Debug Trace Mode. After you
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have enabled a trace mode, you can specify a different log file for the
trace, if you desire, or leave the field unchanged to accept the default file
name.

4. Select the Apply button to save the option settings.

Database Information

Select the Database category (Figure 1-12) to display information about type,
home directory, name, and version of the database you are using. You can also
use this window to define the database password.

To display and update information about the database:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Database from the Category list,
as shown in Figure 1-12.

SQL Log File Logs SQL commands sent to the database. Information is
logged for each SQL command issued, including a timestamp
and the user name of the user performing the operation. By
default, the log file is called arsql.log .

Filter Log File Logs information about filter activity for each operation.
Information includes the filters that executed and whether or
not filter execution was successful. By default, the log file is
called arfilter.log .

User Log File Logs information about connection activity for each user.
Information includes the time that each user logs on, whether
or not they are able to obtain a license, and when each floating
license is released. This allows you to keep an audit trail of
user activity. By default, the log file is called aruser.log .

Escalation Log File Logs information about escalation activity. Information
includes that escalations were checked and whether or not the
escalation qualification found any matches and escalation
actions taken. By default, the log file is called arescl.log .

API Log File Logs information about all API calls made by all clients. By
default, the log file is called arapi.log .
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Figure 1-12 Server Information — Database

3. The following display-only fields and settings appear:

4. Select the Apply button to save the option settings.

Database Type Information field displaying the type of database that the server is
using.

Database Home For UNIX only, information field displaying the directory path of
the database that the server is using.

Database Name Information field displaying the name of the database created for
the AR System within the SQL database.

Database
Version

Information field displaying the version of the SQL database that
the server is using.

Database
Password

For SYBASE, ORACLE, or SQL Server databases, this field allows
you to define the password used by the AR System for access to the
database. Note that the existing password is not displayed.
Enter a value in this field to change the password.
Note: The default user/table password created by the AR System
for the database is AR#Admin#. If you changed the password and
do not remember it or have changed it outside the AR System and
need to reflect the change within the AR System, go into the
database as the database administrator and change it back to the
default. If the encrypted password is in the ar.conf configuration
file, delete it from there.
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Multiple Process Option

If you are licensed for the multiple-process server option, see “Configuring
Multiple Process Servers” on page 295 for further information on configuring
the Multiple Processes category in the Server Information window. This
chapter also describes how to administer multi-process servers in the AR
System.

If you do not own a multi-server license, you cannot access the Server
Information — Multiple Processes category.

Full Text Search Option

If you are licensed for the full text search (FTS) option, see “Configuring FTS in
the AR System” on page 317 for further information on configuring the Full
Text Search category in the Server Information window. This chapter also
describes how to administer FTS in the AR System.

If you are not licensed for full text search, you cannot access the Server
Information — Full Text Search category.

License Information

To display information about licenses:
• Select the License Information item under the File menu of the

Administrator Tool main window (or type Ctrl+U ). This causes an
information window to appear, as shown in Figure 1-13.
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Figure 1-13 License Information Window — Current Licenses

The License Information window shows you information about the users on
the currently selected server. You can get a list of registered users on the server
or a list of the users who are currently connected to the system. You can select
whether to see the registered or current users and for each, whether to see all
the users or just the users in one of the six license categories: Read, Fixed,
Floating, FTS Fixed, FTS Floating, or FTS None. Use the Category menu to
choose the list and category of license within that list to be displayed. The type
of information currently selected is shown at the bottom of the screen. For
example, Figure 1-13 on page 26 shows the total number of all current licenses
on the server.

Registered Licenses

When you display information about registered users, you see information
about all users of the selected category that are known to the system, as shown
in Figure 1-14. You will see the name of the user, the type of license the user is
assigned, if the user has an FTS license, the default notify mechanism for the
user, and the email address for the user. By viewing this list, you can discover
who is using floating licenses and who has write license access versus read-
only access.
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Figure 1-14 License Information Window — Registered Licenses

The AR System obtains the information displayed about each user from the
entries in the User schema. (You can update the information for each user
through that schema.) See Chapter 3 for more information on the User schema.

Current Licenses

When you display information about current licenses in use (as shown in
Figure 1-13), you see information about the name of the user, the type of
license the user is assigned, if the user has an FTS license, the connect time for
the user during the current session, and the time the user last accessed the
server during this session. The list shows only those users who are currently
connected to the AR System.

If you are an Administrator, you can also use the License Information window
to force the release of a floating license that has not yet timed out.

When using floating licenses, a timeout interval determines the point at which
a user’s floating license will automatically be released if the user has
performed no action against the server within that interval. However, it is
sometimes necessary to free a user license that has not yet timed out. (For
example, if a Windows client fails and the user cannot get back onto the
system, it may be necessary to release the license held by the PC user before
the failure.)
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To force the release of a floating license:
1. Select the license that you want released from the active list of licenses in

the License Information window.

2. Select the Release User button at the bottom of the License Information
window.

If the user has a Fixed or Read license, the only action is to remove the user
from the list of current users; there is no effect on the user’s connection to the
server. They are not occupying a token on the server that prevents access by
others; the next time they access the server, the license information for that
server will reappear. If the user has a Floating license, however, the license
token held by that user is freed. This means that another user could grab the
token and start working. If the original user returns, they may not be able to
get back into the system if there are no tokens available.

Preferences
Select Preferences under the File menu of the Administrator Tool main window
(or type Ctrl+P ) to display the Admin Preferences window, as shown in
Figure 1-15 on page 29. You use this window to set warnings, default
permissions for schemas, active links, and fields, and other Administrator Tool
preferences.

Setting default permissions for schemas, active links, and fields lets you easily
define access control, especially when you are adding new objects to the AR
System. New items use the default permissions you specified.

In contrast to the Server Information window which you use to specify the
operations of each AR System server administered by this Administrator Tool,
the Preferences window lets you specify how the Administrator Tool itself will
operate.

Warning Settings

When the Admin Preferences window (Figure 1-15) first appears, it displays
warning settings. These settings determine the types of warning dialog boxes
that appear during Administrator Tool processing.



Using the Administrator Tool 29

1

To set warnings:
1. Select Preferences from the File menu. The Admin Preferences window

appears.

2. In the Admin Preferences window, select Warnings from the Category list,
as shown in Figure 1-15.

Figure 1-15 Admin Preferences — Warnings

3. Select from the following options:

4. Select the Apply button to save the option settings.

Delete-
Confirmation
Warnings

Select Yes to display a confirmation dialog box each time you
delete a schema, menu, filter, escalation, active link, or admin
command.
The default is Yes.

Duplicate-Field-Name
Warnings

Select Yes to display a confirmation dialog box when you
create a schema field with a duplicate name. The default is
Yes.

Admin-Only-
Permissions Warnings

Select Yes to display a confirmation dialog box that notifies
you when a field or active link is accessible only to a user
with Administrator access. The default is Yes.

Admin Tool Exit
Confirmation

Select Yes to display a confirmation dialog box when you exit
the Administrator Tool.
The default is Yes.



30 Action Request System Administrator’s Guide for OSF/Motif—January 1996

1

Setting Default Schema Permissions

Select Default Schema Permissions in the Admin Preferences window
(Figure 1-16 on page 30) to specify the values to be used as the default settings
of new schemas. Schema permissions determine which groups have access to a
schema.

Setting up default permissions allows you to establish initial permissions for
new schemas. This is especially useful if you have a large number of groups.

Remember that you do not set the schema permissions themselves in the
Admin Preferences window. This window only creates the default schema
permissions for each group but does not set them. You can set the default
schema permissions by selecting the Set to Defaults button on the Schema
Permissions window. See “Defining Schema Permissions for the User Tool” on
page 128 for information on setting schema permissions.

To set default schema permissions:
1. Select Preferences from the File menu. The Admin Preferences window

appears.

2. In the Admin Preferences window, select Default Schema Permissions
from the Category list, as shown in Figure 1-16.

Figure 1-16 Admin Preferences — Default Schema Permissions



Using the Administrator Tool 31

1

3. For each group, choose a default setting of Yes or No. Yes lets the group
have access to a schema while No denies access to a schema.

4. Select the Apply button to save the option settings.

Setting Default Active Link Permissions

Select Default Active Link Permissions in the Admin Preferences window
(Figure 1-17 on page 32) to specify the values to be used as the default settings
of new active links. Active link permissions determine which groups have
access to an active link. Groups without access to an active link cannot fire it.

Setting up default permissions allows you to establish initial permissions for
new active links. This is especially useful if you have a large number of groups.

Remember that you do not set the active link permissions themselves in the
Admin Preferences window. This window only creates the default active link
permissions but does not set them. You can set the default active link
permissions by selecting the Set to Defaults button on the Active Links
window. See “Specifying Active Link Conditions” on page 202 for information
on setting active link permissions.

To set default active link permissions:
1. Select Preferences from the File menu. The Admin Preferences window

appears.

2. In the Admin Preferences window, select Active Link Permissions from
the Category list, as shown in Figure 1-17.
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Figure 1-17 Admin Preferences — Default Active Link Permissions

3. For each group, choose a default setting of Yes or No. Yes lets members of
the group have access to the active link while No restricts members of the
group from firing it.

4. Select the Apply button to save the option settings.

Setting Default Field Permissions

Select Default Field Permissions in the Admin Preferences window to specify
the values to be used as default settings for fields. Field permissions determine
which groups have view and change access to fields.

Setting up default permissions allows you to establish initial permissions for
new fields. This is especially useful if you have a large number of groups you
generally grant access to.

Remember that you do not set the field permissions themselves in the Admin
Preferences window. This window only creates the default permissions but
does not set them. You can set the default permissions by selecting the Set to
Defaults button on the Field Properties window. See “Field Properties” on
page 97 for information on setting field permissions.
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To set default field permissions:
1. Select Preferences from the File menu. The Admin Preferences window

appears.

2. In the Admin Preferences window, select Default Field Permissions from
the Category list, as shown in Figure 1-18.

Figure 1-18 Admin Preferences — Default Field Permissions

3. For each group, choose View or Change or neither option. View lets users
read but not change the field value while Change lets you both view and
change the value.

4. Select the Apply button to save the option settings.

Setting Miscellaneous Options

Select Miscellaneous in the Admin Preferences window (Figure 1-19) to set
various administrative functions such as allowing expandable menus on
schema screens and prompting users for logins.

1. Select Preferences from the File menu. The Admin Preferences window
appears.
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2. In the Admin Preferences window, select Miscellaneous from the
Category list, as shown in Figure 1-19.

Figure 1-19 Admin Preferences — Miscellaneous

3. Select from the following options:

Expand Menus On Set Fields
Screens

Selecting Yes lets you view all items in the menus in the
Set Fields windows for active links, filters, and
escalations. However, selecting Yes might slow down
your system performance.
Selecting No keeps you from being able to view the
menus in the Set Fields window.

Always Prompt For Login Selecting Yes means each time you run the User, Admin,
and Notification Tools, you are prompted to supply your
user name and password. The system does not save your
user name and password in your config file.
Selecting No means that you will not be prompted to
supply your user name and password each time you run
the User, Admin, and Notification Tools. The system
saves your user name and password in your config file.
No is the default value.
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4. Select the Apply button to save the options.

Displaying Version Information

To display version information about the Administrator Tool:
• Select the On Version item under the Help menu of the Administrator Tool

main window (or type Ctrl+V ). This causes an information window to
appear, as shown in Figure 1-20. You should be prepared to provide this
information whenever you call Customer Support.

Figure 1-20 Admin Tool Version Information

Menu-To-List
Conversion Threshold

Enter the number of entries to use as a threshold to
determine how menus in the modify menus, filters,
escalation, and active link windows are displayed in the
Administrator Tool. If the menu contains fewer entries
than the number specified for this option, it is displayed
as a pull-down menu. Otherwise, it is displayed as a
listbox. Setting this option to 0 forces menus to display
as listboxes.
This threshold setting does not affect how menus are
displayed in the Modify Schema window.

Default
Import/Export Directory

Shows default directory where import and export
definitions are stored when you import or export
definitions. See Chapter 10. Enter another directory path
if desired.
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Exiting the Administrator Tool

To exit the Administrator Tool:
• To exit the Administrator Tool, select the Exit item under the File menu (or

type Alt+F4 ). You can also exit the tool by selecting the Close item from the
Window menu.

Note – On some Sun workstations, the accelerator key combination that allows
you to exit from the Administrator Tool is Meta+F4 , rather than Alt+F4  as
shown on the menu.

Building and Using Change History
For each structure that you build using the Administrator Tool (schemas,
fields, menus, filters, escalations, active links, and admin commands), the AR
System automatically records information about the owner, the user who last
modified the structure, and the date of the modification. You can display this
information at any time by selecting the Change History button at the bottom
of the window in which you build each structure. This button opens a Change
History dialog box so that you can view and modify history information.

The Change History dialog box for a schema is shown in Figure 1-21.
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Figure 1-21 Change History Dialog Box

You can use the Change History dialog box as a diary of changes made to each
structure. The dialog box works in a manner similar to diary fields in the User
Tool. Each time you modify a schema, field, menu, filter, escalation, active link,
or admin command, you can update the change history to maintain a record of
changes made over time.

To update the change history:
1. On the item window (schema, field, menu, filter, escalation, active link, or

administrator command) you have created or modified, select the Change
History button to open the Change History dialog box (Figure 1-21).

2. If you want to change the ownership of the item for which you are
viewing change history, in the Owner field enter the name of the user who
is to own (have responsibility for) that structure from this point on.

Note – Any user with Administrator or Subadministrator permissions can
modify an item regardless of who the specified owner is for the item.
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3. Enter information about the item or about the change you have just made
in the lower portion of the dialog box. (You will not be able to type in the
upper portion of the dialog box to modify an entry once it has been
made.)

4. Select Apply in the Change History dialog box. Dismiss the dialog box
then select Apply in the window you are using to modify the structure to
update the change diary. The next time you display the Change History
dialog box, your entry will appear in the upper portion of the screen
along with the time you made the entry and your user name.

Setting Help
The help text you supply for schemas, fields, and active links is included in the
context-sensitive help in the User Tool. The help text you supply for menus,
filters, and escalations is available to the administrators and subadministrators
who have access to these objects.

Context-Sensitive Help for End-Users

The context-sensitive help that you create for schemas, fields, and active links
will be read by end-users of the User Tool and should be written accordingly.
The Help Text window for fields and active links contains a simple description
of the feature, to which you then can add additional comments.

• For schemas, the AR System generates a listing of all the fields that are
indexed for FTS and active links that activate on submit, modify, and
display (the active link names, execute conditions, and any administrator-
defined help text are included as well).

• For fields, the AR System generates a listing of field attributes and active
links that activate on return or menu-choice.

• For active links that activate on a button, the AR System generates a listing
of the active link name and execute conditions.

Any user running version 1.2 (or later) of the AR System User Tool can display
this help text by selecting the On Context item under the Help menu or by
pressing the Help key (or F1 if no Help key) with the cursor on the field. If the
user selects On Context from the menu, the pointer changes to a question
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mark; the user can then position the question mark over the field for which
they want to view help text and click the mouse button. Accordingly, you
should write the help text with your users in mind.

Note – If you are creating context-sensitive help that will be viewed on a
Windows client, limit the text to 28,000 characters; on a Macintosh client, limit
the text to 32,000 characters.

To view help for schemas, fields, active links, and admin commands, do the
following:

• For active links that activate on a button, use context-sensitive help on the
button.

• For help on fields or for active links that activate on a menu choice or a
return, use context-sensitive help on the field.

• For help on schemas, use context-sensitive help on the schema window.

• For help on admin commands, select the Run Admin Command option and
select the command you want help for.

Help for Administrators

The help that you create for menus, filters, and escalations will be read by AR
administrators and subadministrators who use the Administrator Tool. This
help is available for viewing and editing only by AR administrators and
subadministrators who have permission to access the structures.
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Setting Up the AR System 2

The AR System is most appropriate where there are frequent events, the events
move through states, and the action requests (ARs) are entered and worked on
by a group of people. However, you can design schemas for almost any
database application. You can create as many schemas as you require. How
you use the AR System depends on many factors that are specific to your
business needs.

This chapter provides some guidelines for setting up your application of the
AR System. It covers the following topics:

• General factors to consider and questions to ask as you design your
application.

• Schema and field design considerations.

• Menu design considerations.

• Filter design considerations.

• Escalation design considerations.

• Active link design considerations.

• Using macros and custom user or administrator commands (extensions) as
automation aids.

Note – The discussion and examples in this chapter are specific to the use of
the AR System as a trouble tracking and reporting application. While this is a
good example of one of the uses of the AR System, it is by no means the only
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possible application. You will be able to apply the basic information presented
here about AR System design considerations regardless of how you are using
the AR System.

To help set up the AR System, Appendix F  provides worksheets you can
reproduce to track your workflow and design schemas, active links, filters, and
so on.

General Design Questions
The process of designing your application of the AR System involves several
steps:

1. Design a schema or schemas to contain and display needed information.

2. Define a process flow that determines actions that will occur based on
specific AR System events.

3. Define users and groups of users who have access to some or all of the
information in your schemas.

When designing a new support application for the AR System, it is best to
begin by evaluating how support requests and problems are currently
resolved. The answers to a series of simple questions will help you evaluate
your current problem-solving process and determine the best way to take
advantage of the AR System’s capabilities.

• The answers to the following questions will help you design schemas for
your database.

What stages does each problem pass through from discovery through
resolution?

What information needs to be collected and communicated during each of
these stages?

What is the source of each piece of information? Is there some information
that is available from more than one source?

Is there information that needs to be made available in more than one place?

What information is most likely to be valuable in summary form or
included in a report?
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• The answers to the following questions will help you design the filters,
escalations, and active links that will define the workflow process.

What is your current workflow process? Create a simple process flowchart
or other representation that describes how your current problem-solving
process works. An example of a process flowchart is shown in Figure 2-1 on
page 44.

What events occur that result in the need for specific actions? What,
specifically, keys these actions?

• The answers to the following questions will help you define groups of users
and determine the appropriate level of access for each group.

What distinct functional groups are involved in your problem-solving
process (for example, support staff, help desk, and end users)?

Who in your organization needs to belong to each of these groups? Consider
who needs to know what and at what stage in the problem-solving process.
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Figure 2-1 Workflow Process Flowchart Example

Designing Schemas
Once you understand the information requirements of your organization, you
can start designing your database schema.

End User Dispatcher Staff Management

Discover
problem and
report it to
dispatcher.

Check for new problems
and determine priority.
Check staff to see who is
available and assign
problem. Send list of new
problems to
management daily.

Check for new
assignments. Begin
problem
resolution.

List of new
problems.

Track open problems. If
problem is still open after
1 day and priority is high,
begin escalation. If still
open after 2 days and
priority is medium, begin
escalation. Report to
management on
escalated problems.

Work with staff and
escalation team to
assure all problems are
resolved. Notify users as
individual problems are
resolved.
Provide status and
summary information to
management.

Check history
reports to see if
similar problems
have been reported
and resolved. Fol-
low procedures for
problem identifica-
tion and resolution.

Close resolved
problems and
report to dispatcher.

Escalated
problems.

Summary
Information.

Monitor open
problems and
respond to
escalations.
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A schema defines how information is stored in your database. When you open
an AR System schema, you see a screen that contains a set of fields. The fields
are where various pieces of information are entered and displayed.

When you design your schema, you should first decide whether you want to
start from scratch to design a new schema or start with an existing schema that
is similar to the schema you want to create. Starting with an existing schema, if
an appropriate one exists, can often save you time since you may not have to
create every field.

The sections that follow describe the processes involved when you create a
new schema from scratch or modify an existing schema to fit a new purpose.

Working with New Schemas

Create a new schema if there is no existing schema that you can easily modify
and adapt to your needs. You will find detailed instructions for creating a
schema in Chapter 4.

Core Fields

When you create a schema from scratch, the schema automatically contains a
set of core fields. These are fields that all AR System databases are likely to
need. Core fields help provide consistency when merging and sharing
databases and when exchanging macros. You cannot delete core fields, though
you can modify their appearance by altering labels, adding or changing menus,
altering the display type, altering their location, or hiding them from view. You
can also customize some aspects of specific core fields. For detailed
information on each of the core fields, see Appendix C.

It is likely that some of the information you identified as needed when you
analyzed your current process will be accounted for by the core fields.

A newly created schema is shown in Figure 2-2 on page 46. Notice that the
field labels appear in different styles. The styles have special meaning, as
described below:
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Italic text Field is system maintained; information is automatically updated by the AR
System.

Bold text Field is required; submitter must enter information in this field.

Plain text Field is optional; submitter can submit a request without entering
information in this field.

Figure 2-2 New Schema with Core Fields

Schema Layout

Once you have opened the new schema and decided what fields you need in
addition to the core fields, you can begin to define the additional fields and
design the schema so that it fits your needs. It is a good idea to sketch out the
layout you want for the screen before you actually begin adding fields. That
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way you will have an idea of where you want to insert fields and in what
order. Remember when deciding where to place fields that will have character
menus, text editors, or diary editors associated with them that you will need to
allow space for the icons that will appear next to the fields. (In some cases, a
field may have both a menu icon and a text editor icon next to it.)

As you design your layout, take into account that users in different roles will
need to manipulate different fields and that different users will have different
access privileges to the fields.

You might want to lay your schema out so that it is convenient for use by the
various types of users you have identified. For example, you can group fields
that will be most significant to end users at the top of the schema and group
fields that will be used only by dispatchers at the bottom. You can also arrange
your layout so that fields that are of interest to only a few people will not show
on the opening view of the schema.

You should also consider the platform on which your users will be running the
User Tool. You can provide users with multiple views of the same schema,
based upon the platform they are operating from, whether Motif, Windows, or
Macintosh. If the schema you are designing will be used exclusively on
personal computers, you can take advantage of that fact and lay the schema
out in the way that looks best on that platform. If, on the other hand, your
users are on a variety of platforms, you may want to create several different
views, one for each environment.

Users with Administrator or Subadministrator access to a schema can
customize the view on the User Tool, then export the view back to the server as
an alternate admin view. For information on exporting customized views, see
Chapter 4, Customizing The Environment in the Action Request System User’s
Guide.

Note – Users at ASCII terminals will not be able to customize their own views.

Working from Existing Schemas

If there is an existing schema that you can easily modify and adapt to your
needs, you can use it as a basis for your new schema.
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Note – The User and Group schemas contain several reserved fields that make
these schemas special. You should never copy these schemas as you may
introduce unintended access control functionality into your environment. For
more information on the User and Group schemas, see Chapter 3.

Modifying Fields

To adapt an existing schema to new needs, simply verify that the fields that
currently exist are defined appropriately. If not, you can modify the field
definitions according to the instructions in Chapter 4. Add any additional
fields that are required on the new schema, rearrange the fields on the schema,
or change a field’s display properties to meet your new needs. Follow the
guidelines for schema layout presented above.

Sample Schema and Database

You may want to look at the sample schemas that came with your AR System
software to see if one of them can serve as a starting point for your schema
design process. Use them to help you become familiar with the AR System or
as starter schemas in your organization. See the Action Request System Getting
Started Guide and Sample Schemas manual for descriptions of the available
sample schemas.

Default Schema Views

When you define a schema layout, from either a new or existing schema, you
are defining a default (administrator) view. This is the view of the schema that
users will see unless they customize their view.

Multiple Schema Views

You can create multiple views of a schema. It is easy to use the Modify Schema
window to open a schema, copy it, then create a different “view” of the schema
by rearranging or even hiding fields, based on which platform you are
operating from or what role the user plays. You will find detailed instructions
for modifying an existing schema and creating multiple schema views in
“Multiple Schema Views” on page 118.



Setting Up the AR System 49

2

Schema Attribute Settings

For each schema, you can define attribute settings that control the behavior of
that schema. You can set database indexing on selected fields, specify which of
the schema’s fields will appear in the list in the Query List window, and set
overall access permissions that determine which users will be able to view or
modify the schema. For information on how to set attributes for a schema, see
Chapter 4.

Defining Fields

Once you have decided on the information that your schema will contain and
designed the layout of the schema, you can begin defining the individual
fields. It is the fields that determine the internal structure of the AR System
application database.

Before adding a new field to a schema, you should consider carefully the
purpose of the field and whether adding the field is the best way to handle
your information requirements. The addition of new fields should be
motivated by the planned use of the field for querying and reporting during
the process that this schema is designed to manage. You may find it impractical
to eliminate a field once users have come to rely on it.

Occasionally, you may want to include information that is also kept in another
database. If the information is stable and unlikely to change frequently, then
keeping it in two places may be manageable. However, if the information is
changing at a rate that would require frequent updating just to keep it
consistent with another database, the information is not a good candidate for
adding to this schema. See the discussion of active links later in this chapter for
ways you can cross-reference data in other places.

Field Definition and Display Properties

As you define each field on a schema, you describe field attributes that include
its definition properties (such as the field’s data type and attributes of the
information it will contain), access control (such as group permissions and
create mode), and global settings (such as whether or not it is a required field).
You also can set a field’s display properties that might apply only to a
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particular schema view (such as a field visible in one schema view but hidden
in another view). Chapter 4, includes step-by-step instructions for defining
fields and describes each of the field properties in detail.

Core Field Design Considerations
The following core fields have special characteristics that need to be considered
when defining a new schema.

Short-Description Field

Fields that categorize problem and request types are essential to the efficient
use of the AR System. A new schema includes a Short-Description field for this
purpose. Unless you modify Query List fields when you define a schema’s
attributes, the contents of the Short-Description field are displayed by the
Query List operation.

It is a good idea to define a character menu for the Short-Description field that
will help users define the possible problem and request types. This makes AR
submission easier and it creates a problem type “vocabulary” that the entire
organization can use. A uniform vocabulary makes queries and reporting
much more efficient.

If other short descriptive fields are necessary, you can add other fields with
similar fill-in aids.

As you decide how many descriptive choices to set up in your menu, you
should balance the need for query efficiency against the need for completeness
of description.

Status Field

In your process, each event represented by an AR moves from the status (or
state) of newly submitted to some resolved state. Along the way, an AR moves
through different states as it is being worked on. The meaning of each
individual state helps define the workflow process. The core schema includes a
Status field that permits you to define any number of states. The AR System
keeps additional information with the Status field as ARs move through their
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states. This information is called status history and includes the name of the
person who puts the AR into a particular state and the time the change
occurred.

You should take some care in defining states. The Status field represents the
problem resolution process more than any other field in the schema. The states
must capture the important steps in the process. Often the best case process is
represented by four or five states, while the worst case process is defined by
many more. The right number of states may be somewhere in between, with
several states being defined, but not used during the resolution of a typical AR.

Note – As with all selection fields, it is difficult to modify the Status field
choices once users have begun to use the schema. For example, if the current
choices are New, Assigned, and Closed, and you add a choice labeled Fixed
before the Closed selection, existing database entries with a status of Closed
will now have a status of Fixed instead. This is because the data for a selection
field is stored in the database as an integer that relates to the order of the
choices, as in the following examples:
New = 0
Assigned = 1
Closed = 2
Fixed = 3

To avoid confusion, do not add selection choices to an active schema other than
as the last choice of the selection field.

Designing Menus
You can design menus that you can then attach to any character field on any
schema. You can attach each menu to as many character fields in as many
different schemas as you would like. Each menu has a name that you specify
and a set of options that you define using the Administrator Tool. There are
three different styles of menus you can define:

Character You define the menu by entering a series of labels and values into the fields of
the Menu window.

File You specify a file that contains a formatted character menu.

Query You specify a query that lets you pull values from another schema.
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Menus are defined and stored independently of schemas. This allows you to
define a single menu and use it anywhere on any schema. For example, you
might create a menu that includes the names of all members of your support
group. You could then attach that menu to as many schemas as you desire. If
any change should occur in the members of the group, you would only need to
update a single menu in order to change the menu selections on all schemas
that list group members.

See Chapter 5, for information on creating each style of menu and attaching
menus to the fields of a schema.

Designing Filters
Your workflow process is defined partly by your schema (especially the Status
field), but mostly by the filters, escalations, and active links you create. This
section describes how filters work and presents issues to consider in designing
them.

Filters define what actions the server will take when an AR transaction meets
certain conditions. For example, you can define a filter that automatically
notifies the end user that his problem has been solved (action) when the Status
field of the AR is changed to “Fixed” (condition).

Filter Conditions

You can design filters that act on the query, modify, submit, delete, or merge
operation or any combination of those operations. You can also include a
qualification in the condition to further refine the filter conditions.
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Filter Actions

There are five kinds of actions you can define for a filter, as shown in
Table 2-1. A single filter can invoke up to 25 multiple actions.

Filter processes run on the server, as opposed to active links, which run on the
client machine (see “Designing Active Links” on page 60). Filters are defined
and modified from within the Administrator Tool without programming, by
using convenient forms and other aids. You can use filters to guide ARs
through each stage of the resolution process.

Filters run on the server with the same permissions as the administrator. You
can use filters to restrict how users can submit or modify an AR. You can also
use them to check for conditions in ARs that are submitted by a network
management system for a device that it is monitoring; the filter can then
automatically call a program to control that device. Filters can act upon
virtually any condition that arises in manipulating an AR.

Note – You should always remain aware while designing filters that filters run
on the server with Administrator privileges. This can have an impact on
system security as well as on server performance.

Table 2-1 Filter Actions

Action Description

Notify Sends text to a specified user or group.

Message Sends an interactive error, warning, or note to the
user who initiated the transaction.

Log to File Records an entry in an audit trail log file.

Set Fields Sets field values in the current AR to static or key-
word values or to values retrieved from another
data source. The data source may be a field in the
same schema or another schema on the same server,
the results of an independent system process or the
results of a mathematical calculation or a function.

Run Process Runs a specified program.
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Be conservative in designing your first filters. A user base may be initially
excited about the prospect of being notified of each step in your process, only
to become irritated by receiving too many notifications. The following are
examples of useful filters.

Filter example #1, notify the assignee of an AR:
For every AR where the Status field is modified to the “Assigned” state, use
the Notification Tool to notify the user whose name is in the Assigned-to
field. Include some fixed text and the variable information text from the
Entry ID and the Short Description fields.

Filter example #2, assign a particular problem to a specific support person:
For every newly submitted AR operation that has the word “print”
anywhere in the description field, set the Assigned-to field to Sally, update
the diary field to indicate that the AR has been assigned to Sally, and set the
Status to “Assigned.”

When you create filters, you assign them an execution order so that multiple
filters can act on a single server transaction. For the two example filters above,
the filter assigning a problem (example #2) should be executed before the filter
that notifies the assignee (example #1).

You can export filters from one site and import them to another site so
organizations can share the definition of the workflow process.

Sending Notifications From Filters

You can greatly improve the efficiency of your workflow process by assuring
that the support staff is proactively notified of new things to do and that end
users are immediately told that their problem is fixed. Immediate notification
can greatly reduce the length of time required by the process life cycle. The
Notification Tool of the AR System gives immediate notification to the user —
it acts as a “desktop beeper.” It is a low-overhead tool that is dormant unless
the user is notified through some filter or escalation action. The tool can notify
the user by beeping, displaying a pop-up dialog box, flashing its icon, or any
combination of the above.

The Notification Tool also holds a memory of past notifications and allows the
user to immediately open any AR for which a notification has occurred.
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Alternatives to the Notification Tool are also available. A more passive
notification option of electronic mail (email) is available. Notifications are sent
to a specific name or a name contained in another field. You can also route the
notification to a spooling file to be read by a program for integration with
paging beepers and other notification alternatives.

Designing Escalations
Escalations function much like filters except that they occur at a specific time
or on a time interval instead of on a transaction to the database. Like filters,
escalations define what actions the server will take when an AR transaction
meets certain conditions. For example, you can define an escalation that
automatically sets the Assigned-Priority field to High (action) if a problem has
not been solved within 24 hours (condition).

Escalation Strategy

There are some basic steps to help you decide when escalations should take
place, as described in the following example of users submitting problems to a
support staff responsible for resolving problems.

1. Decide on the rules.

Think about the conditions under which you want to escalate an entry.
Consider all the different possibilities and decide exactly what conditions
determine when escalation is appropriate.

You may determine that an entry that is not closed after 5 days should be
escalated. You might also determine that a specific type of problem should be
escalated after only three days.

Typical categories of escalation include the following:

• New problems not handled quickly enough. For example, you might decide
that new problems with a critical priority should be assigned within 8 hours
and those with a serious priority assigned within 24.

• Assigned problems not closed soon enough. For example, you might decide
that assigned problems, if critical, must be handled within 5 days of being
submitted; if serious, within 14; and if medium, within 60.

2. Decide on escalation actions.
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Once you have defined the escalation criteria, you can determine the action
you want to take when each of these criteria is encountered. For example, you
may want to notify another person that you are escalating an entry.

For new problems that are not handled quickly enough, you might want to
assign ARs to Francie Frontline with a notification to her. For assigned
problems not closed soon enough, you might want to notify the escalation
manager, Marie Manager. You also might want to send a warning when an
escalation is about to occur.

3. Add escalation field(s)/state(s).

You may need to add one or more new fields or states to your schema to note
the escalation cases. You may want to introduce new escalation states to the
Status field in a schema or add a field to hold which escalation case was last
applied. (Usually this is a selection field, though it could be any type.)

To have a record of an escalation, you might create two new fields: Assign-
Escalate-State and Fix-Escalate-State. Both are Selection type fields and are
optional. The selection values are None and Escalated for the Assign-Escalate-
State field and None, Pre-Escalated, and Escalated for the Fix-Escalate-State
field. The Pre-Escalate state is needed to issue the warning before escalation.

4. Decide how often to check escalations.

You can define an escalation so that the AR System checks conditions for
activating the escalations at a specific time or at specified time intervals. You
can also include a qualification in the condition to further refine the escalation
conditions.

When you set a specific time for execution (for example, first of month or every
Monday), the server checks the escalation at the time defined. If the
qualification is true, the escalation triggers the action. Otherwise, the server
waits for the next scheduled time.

In contrast, when you set an execution interval (for example, every hour), the
server checks the escalation at the interval. Figure 2-3 illustrates how escalation
intervals work:
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Figure 2-3 Escalation Intervals

Escalation intervals are immediately checked when the escalation is created or
enabled or when the interval is modified. Then the server waits for the defined
interval and checks if the qualification is true.

• If the qualification is true, the escalation triggers the actions in order. The
server then waits for the next interval.

• If the qualification is false, the escalation triggers no actions and the server
waits for the next interval.

Escalations execute on the server machine. Each escalation is attached to a
single schema on the server. How often you want the server to check an
escalation is a question only you the AR administrator can answer. If you make
frequent AR server checks (for example, 50 escalations that query the database
every 2 minutes), you can seriously impact the performance of the AR system.
Balance the load on the AR System against how often you actually need to
check the escalation.

5. Use the Escalations window to create the escalation, specifying the
following:

• Conditions, including setting the time of escalations and transaction
qualifications.

• Actions, including notifying users, setting fields, and so on.

(Note:  Escalation is checked immediately when created, enabled, or modified.)

Hour Hour Hour Hour

Escalation
Checked

Escalation
Checked

Escalation
Checked

Escalation
Checked

Qualification True,
Triggers Action

Qualification False,
No Action

Qualification False,
No Action

Qualification False,
No Action
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Figure 2-4 illustrates how escalations are executed in the AR System.

Figure 2-4 Escalations in the AR System

Escalation Conditions

You can define an escalation so that the AR System checks conditions for
activating the escalations at a specific time or at specified time intervals. You
can also include a qualification in the condition to further refine the escalation
conditions.

Escalation Actions

There are four kinds of actions you can define for an escalation, as shown in
Table 2-2. A single escalation can invoke up to 25 multiple actions.

Table 2-2 Escalation Actions

Action Description

Notify Sends text to a specified user or group.

Log to File Records an entry in an audit trail log file.
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Escalation processes run on the server. Escalations are defined and modified
from within the Administrator Tool without programming, by using
convenient forms and other aids. You can use escalations to guide ARs through
each stage of the resolution process.

Note – Be aware while designing escalations that escalations run on the server
with Administrator privileges. This can have an impact on system security as
well as on server performance.

Be conservative in designing your first escalations. It may seem like a good
idea at the time to notify your user base of all the exceptions to normal process
flow, but creating too many escalations might cause them to be less effective or
even annoying.

The following are examples of useful escalations.

Escalation example #1, track open problems:
For every AR where the Priority field is set to “High” and the problem is
still open after 24 hours, send a notification to the user whose name is in the
Assigned-to field. Include some fixed text and the variable information text
from the Entry ID and the Short Description fields.

Escalation example #2, assign escalated problems to management:
For every AR where the Priority field is set to “High” and the problem is
still open after 48 hours, set the Assigned-to field to Management, update
the diary field to indicate that the AR has been reported to Management,
and set the Status to “Escalated.”

Set Fields Sets field values in matching ARs to static or key-
word values or to values retrieved from another
data source. The data source may be a field in the
same schema or another schema on the same server,
the results of an independent system process or the
results of a mathematical calculation or a function.

Run Process Runs a specified program.

Table 2-2 Escalation Actions

Action Description
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Unlike filters, there is no execution order field you can use when creating
escalations. Instead, use the Time calendar in the Escalation window to set an
execution order. First create an escalation and set a specific time for the server
to check the escalation (for example, 2:00 AM). Then create another escalation
and set a later time for the server to check the escalation (for example, 2:05
AM).

You can export escalations from one site and import them to another site so
organizations can share the definition of the workflow process.

Sending Notifications From Escalations

Sending notifications from escalations works like sending notifications from
filters. For more information, refer to “Sending Notifications From Filters” on
page 54.

Designing Active Links
In addition to filters and escalations, which are executed on the server, you can
define active links, which are executed on the client machine based on actions
taken by the user. You can assign an execution order to active links so that
more than one active link can execute based on a single user action. You can
also specify conditions that must be met before an active link will execute.

Active link actions are performed on the data in the current user window. For
example, you can define an active link that causes information to be retrieved
from another AR, from the same schema, or from a different schema, and
inserted in the AR the user is working on when the user presses Return in a
particular field.

Active links are associated with a single schema and execute under explicit
user control. Access control is supported for active links so that you can control
which users will be able to execute a specific active link.

Note – When designing active links that launch other processes or tasks, you
should take care if users in your environment are running on different
platforms (UNIX, Windows, Macintosh, and so on). Not all OS commands are
available on all platforms.
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Active Link Conditions

As with filters and escalations, it is possible to define qualifications that must
be met before an active link operation will occur. For example, you could
define an active link that checks which hardware platform the tool is running
on and uses that information to determine whether or not to execute.

By combining conditional execution with the ability to tie more than one active
link to a single execution option, you can design an active link that will execute
a different operation based on conditions at the time the active link operation
occurs. For example, you can design an active link that checks the name in the
Submitter field and attaches a different menu to the Short Description field
depending on the results. This would let you provide one set of descriptive
options to Sally Smith and a different set to John Jones.

Execution Options

When you define an active link, you specify the user activity that will cause the
active link to execute. You can choose from seven execution options, as shown
in Table 2-3  below.

Table 2-3 Active Link Execution Options

Option Description

Button Places a button that the user can select on the schema.
You can attach more than one active link to a button.

Return Executes the active link when the user presses Return in
a specified field or selects a radio button (if the field is a
selection-type field).

Submit Executes the active link when a user submits a new AR.

Modify Executes the active link whenever a user modifies an
existing AR for the schema. (Note that the active link does
not execute if the operation is a Modify All operation.)
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The Button, Return, and Menu Choice options are especially useful when you
are designing an active link that displays additional information or retrieves
information from other sources and inserts it in the current AR. For example,
suppose you are designing a schema for a help desk and you want the help
desk person to be able to verify a user’s configuration before continuing with a
call. You can design a button-activated active link that takes the value entered
in the User Name field of the current AR and uses it as a parameter in a macro
that displays configuration information for the given user. By simply pressing
a button, a help desk person can get information from another schema without
leaving the current AR.

The Submit, Modify, Display, and Set Default options are useful when you are
designing an active link whose purpose is to insure complete and consistent
data definition. For example, whenever a new AR is submitted, you may want
an active link to retrieve the hostname of the client and copy it into a field on
the schema. This would guarantee that every submitted AR includes the
hostname.

Display Executes the active link when a user retrieves an AR for
display.

Menu Choice Executes the active link when the user selects a choice
from a character menu.

Set Default Executes the active link when the user selects the Set to
Default option or when the AR System loads defaults prior
to a new query or submit.

Table 2-3 Active Link Execution Options

Option Description
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Actions

There are six kinds of actions you can define for an active link, as shown in
Table 2-4 below. A single active link can invoke up to 25 multiple actions.

Using Filters Versus Active Links
Both filters and active links help you define your workflow process by
allowing you to define actions that will occur based on specific events.
Whether a filter or an active link would be better to accomplish a specific
purpose is a decision you will have to make on a case-by-case basis. There may
be times when either mechanism would suit your purpose. More often,
however, the specifics of the work you are trying to accomplish will determine
whether you use a filter or an active link.

When you are making determinations about how to manage your workflow
process, it is important to be aware of both the differences and the similarities
of filters and active links.

Table 2-4 Active Link Actions

Action Description

Run Macro Executes an AR System macro.

Set Fields Sets field values in the current AR to static or keyword
values or to values retrieved from another data source.
The data source may be a field in the same or another
schema, the results of an independent system process, a
DDE operation, or the results of a mathematical calcu-
lation or a function.

Run Process Executes an independent system process on the client
system.

Message Sends an interactive error, warning, or note to the user
who initiated the transaction.

Change Field Changes the characteristics of a field. You can attach a
new menu to the field, move the focus to the field, or
change access permissions of the field based on condi-
tions and qualifications specified in the active link.

DDE Executes a DDE operation. (PC clients only)
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Table 2-5 summarizes the features of filters and active links.

Table 2-5 Filters versus Active Links  (1 of 2)

Filter Active Link

Where Action
Executed

On the server. On the client.

Access control Runs with Administrator
permissions.

Runs with permissions of
current user.

Acts on data In the current transaction. In the current window.

Conditions Query, Modify, Submit,
Delete, Merge.

Button, Return, Submit,
Modify, Display, Menu
Choice, Set Default.

Qualifications Checks values in the cur-
rent transaction, the data-
base, or both the current
transaction and the data-
base.

Checks values in the cur-
rent screen only.

Possible actions:

Log to File Creates audit trail of
transactions that meet
conditions.

Not applicable.

Notify Provides active event noti-
fication.

Not applicable.

Message Displays error message,
note, or warning to user.

Displays error message,
note, or warning to user.

Run Process Launches an independent
system process. Runs
under arserver process
permissions on the server.
Same for users on all cli-
ents.

Launches an independent
system process. Runs
under the user’s permis-
sions on the client. Client
architecture dependent.

Run Macro * On UNIX, can launch a User
Tool to run a macro.
* On Windows NT, can
launch runmacro.exe to run
a macro.
Runs with Administrator
permissions.

Runs a macro.
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Automation Aids
The User Tool of the AR System is very simple to use for query, modification,
and reporting. Your users will become skilled at these operations in a few
hours of use. To automate commonly used operations and further simplify
your process, the AR System offers two more capabilities: macros and custom
commands.

Set Fields Loads data into fields on
current AR. May be static
values, keywords, data
from field on same or
other schema on the same
server, or results of a func-
tion, an independent pro-
cess, or a mathematical
calculation.
When you are assigning a
value from another field
and multiple matches to a
qualification are found, a
filter takes only the first
AR that matches a qualifi-
cation.

Loads data into fields on
current screen. May be
static values, keywords,
data from other fields on
same or other schema, or
results of a function, an
independent process, or a
mathematical calculation.
When you are assigning a
value from another field
and multiple matches to a
qualification are found,
an active link produces a
selection list so that the
user can select which AR
to use.

Change Field Not applicable. Adjusts the characteristics
of a field. Use to dynami-
cally change character
menus, move focus to a
field, or change access to a
field.

DDE Not applicable. Executes a DDE operation
on a Windows client.

Table 2-5 Filters versus Active Links  (2 of 2)

Filter Active Link
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Macros

Macros allow users to capture commonly run queries and operations on ARs
by a simple record and playback sequence. Any user can create a set of macros;
moreover, you, as the AR administrator, can organize a library of useful
macros. You can keep these organized by different roles, such as support staff
or end user. Users can invoke macros from within the User Tool, from the
command line, or from other tools. Macros can also use variables, so that parts
of the query are specified at the time the macro executes. Macros can be shared
with other AR System users, even those on different hardware platforms and
operating environments. To share macros locally, users can set the ARPATH
environment variable to define a search path for macros.

The following are examples of a few useful macros:

• Show the ARs assigned to a user, with the user name being a variable.

• Create a periodic report of unresolved, critical ARs, with the begin and end
dates being variables.

• Create a statistics report of the average time to fix problems.

• Open a partially filled in Submit window for a schema.

For information on recording and using macros as well as on the ARPATH
variable, see the Action Request System User’s Guide.

Custom Commands

Custom commands (extensions) can be created by you as the administrator or
by users, if they are running the User Tool on a UNIX client. Custom
commands are simply a facility for invoking other programs from within the
User Tool. Examples of useful custom commands include the following:

• Start a shell or text editor with the file of all hosts on the network.

• Start a spreadsheet loading a statistics file.

• Start a network management system, such as SunNet Manager, HP
OpenView, or IBM NetView/6000.

Note – Because of the differences in the operating systems, it is not possible
to run custom commands on the Windows or Macintosh clients.
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Administrator commands are custom commands that you create using the
Administrator Tool. Administrator commands are available to users with the
appropriate permissions through the Actions menu of the Query window and
execute on the server. See Chapter 9, for information on creating or modifying
custom administrator commands.

User commands are custom commands that users create and run through the
Actions menu of the User Tool’s Query window. See the Action Request
System User’s Guide for information on creating and modifying user
commands.

Custom commands can be executed from within a macro. For example, you
can create a macro that generates a statistical report and starts a spreadsheet
that loads the report.
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Once you have identified the users of your AR System application and
determined the type of information each user will need to access, you can set
up your users and establish their access to the system. You can also define
groups to which various users will belong. It is group membership that
ultimately determines which operations individual users can perform and
which schemas, fields, active links, and admin commands they can access.

This chapter includes the following:

• A discussion of access control and how it works.

• Instructions on how to create access control groups.

• Instructions on how to add users to the AR System.

• Instructions on how to set up and use Subadministrator access.

Understanding Access Control
The AR System access control mechanism lets you define groups of users and
determine which of the groups have access to each schema and to each field
within a schema. You define these groups of users, called access control
groups, by submitting an entry to the Group schema through the User Tool.
Then, when you define individual schema fields using the Administrator Tool,
you specify the access each group will have to information in your database.
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An access control group may reflect a functional area, such as “Tech Support,”
or a general category, such as “Browsers.” Each user may be a member of
several of these groups. In order for the user to be allowed to view or modify a
field, at least one of the groups the user belongs to must have the appropriate
View or Change access to the field. View access means the user is able to see
the contents of the field. Change access means the user is able to modify the
contents of the field. Even if users have view permissions to access a schema,
they cannot see the field if they do not have view or change access to the field
as well.

Groups are assigned their own View and Change permissions as well. The
group access setting determines the maximum rights for the group, but not the
specific rights the group will have for a field. It is the field definition that
ultimately determines a particular group’s access to a specific field. For
example, the “Tech Support” group may have Change access rights in general,
but for the “Problem Description” field this group may be defined as having
only View access.

The submitter and assignee of an AR are given special consideration in the
access control mechanism. The submitter is the person who submits the AR
(whose name is entered in the Submitter field). The assignee is the person who
is assigned responsibility for resolving the AR (whose name is entered in the
Assigned-to field). In the field definition, you can specify that the submitter or
assignee of an AR have access to the field regardless of the access rights of the
individual users who submit or are assigned the ARs.

Note – Except as described in “Special Submitter Access” on page 71, the
submitter and assignee must have valid AR System write licenses to be able to
take advantage of the Change access privileges given to the special groups.

The diagram shown in Figure 3-1 on page 71 illustrates how access control is
defined and operates. In this example, the field definition for a specific field
gives the “Help Desk” group Change access to the field, and the “Browser”
and “HD Staff” groups View access. This means that John can change the field,
but Alice and Rick can only view its contents. Notice that John is a member of
both the Browser and Help Desk groups. Notice also that even though Alice
belongs to a group that has Change access rights, the field definition limits her
to View access for this field.



Setting Up Groups and Users 71

3

Figure 3-1 Access Control Operation

Special Submitter Access

If you select Locked for the Submitter Mode in the Server Information window,
the Submitter field is “locked” (that is, it cannot be changed) once a ticket is
submitted. Submitters without write licenses are allowed to write to or update
AR tickets for which they are the submitter if the special Submitter group or a
group they are a member of has been allowed Change access. This is one of the
two instances where a user without a write license can update existing entries
(see “Allowing Users to Modify Their Password” on page 83 for the other
instance).
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If you select Changeable for the Submitter Mode in the Server Information
window, the Submitter field is not “locked” once a ticket is submitted. After a
ticket is submitted, anyone with a valid write license and write permission to
the field can change the name in the Submitter field. In Changeable mode, a
user must have a fixed or floating license to change any record, including
entries for which they are the submitter.

To set the submitter mode, see “License Information” on page 25.

Access Control Groups
Groups are used primarily to define user access to the various features of the
AR System, including schemas, fields within a schema, active links, and
administrator commands. They are also used to define groups of users to
receive notifications. A group can have Change, View, or no access. A user can
be a member of more than one group.

Six special groups are provided by the AR System — Public, Administrator,
Customize, Submitter, Assignee, and Subadministrator. (The Group ID
numbers 0 through 5 are reserved for these groups.) You may want to set up
additional groups to reflect various functional groups, such as a “Help Desk”
or “Tech Support” group.

Of the special groups, the Administrator, Subadministrator, and Customize
groups are explicit groups to which you can assign users. The Public group is
a group to which every user belongs automatically. The Submitter and
Assignee groups are implicit groups. Users belong to these implicit groups
based on specific conditions; you do not assign users to these groups.

Details about each of the groups are as follows:

Administrator The Administrator group defines users who have full
and unlimited access to the AR System. Users who
belong to this group can create schemas, menus, filters,
escalations, and active links, or delete entries. They
also can add or delete users and other groups.
Users assigned to this group automatically have
change access permission to all fields (the ability to
change field contents). Users will belong to this group
only if you explicitly assign them to it.
Each member of the Administrator group must have a
fixed license or the group assignment is ignored.
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Subadministrator The Subadministrator group provides a layer of limited
administrative access to the AR System, allowing dif-
ferent functional administrative groups in a single AR
System server.
A user has subadministration access to a schema if (1)
the user belongs to the Subadministrator group and (2)
the user belongs to a group that is enabled for subad-
ministrator access to the schema.
Each member of the Subadministrator group must
have a fixed license or the group assignment is ignored.
For more information on subadministration in the AR
System, see “Subadministrator Permissions” on
page 84.

Customize The Customize group grants users the right to custom-
ize their schema layout and create user commands in
the User Tool. Users will belong to this group only if
you explicitly assign them to it.

Public Every user is a member of the Public group. You can
use this group to define general View or Change access
to fields or schemas. For any field or schema where the
Public group is allowed View access, any user can view
the contents of the field for any entry regardless of
what groups they are a member of and what permis-
sions are granted to those groups.
Note that this includes users who are connected to the
system as “guest” users (users who are not registered
users of the AR System), if guest users are allowed on
your server.
For any field where the Public group is allowed Change
access, any user with a fixed or floating license can
update the entry regardless of the groups they belong
to and the permissions granted to those groups. See
“Configuration Information” on page 18 for information
on allowing guest users.
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When you create a new group, the group name is added to the list of groups
that appears when you use the Administrator Tool to define group access to
schemas, individual fields, active links, and administrator commands.

Row Level Access Control

The row level access feature of the AR System extends the access control
capabilities of the system to allow per-entry control on the basis of group
membership. Access to individual ARs, or “rows,” and to the individual fields
within those ARs can be controlled by the group membership of the current
user.

Prior to row level access control, administrators were only able to define group
access for entire schemas, for individual fields on all ARs in a schema and for
individual entries of a specific person. With the addition of row level access
control, administrators may now control access to individual fields on
individual ARs on a group basis.

Implementation

To support row level access control, the AR System has been modified as
follows:

• The Assignee Group group (ID 7) has been defined.

• Field number 112 has been defined as a reserved field.

Submitter
and
Assignee

The Submitter and Assignee groups are implicit
groups. Users automatically belong to the Submitter
group for ARs where their name is in the Submitter
field, and to the Assignee group for ARs that have been
assigned to them. If a field has change access defined
for the Submitter or Assignee group, licensed users can
change the contents of that field when they are the
submitter or assignee of an AR even if they do not
belong to any of the other groups that have change
access for that field.
For information on how Submitter Mode affects the
Submitter group, see “Special Submitter Access” on
page 71.
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To initiate row level access control in a schema, add field 112 as a character
field with a length of 30. Enter field 112 into a group name. If an AR contains a
group in field 112, and the current user belongs to that group, the user is
granted the additional access defined for group name Assignee Group .

Once a schema contains field 112, you can set permissions for group name
Assignee Group in the group permissions settings for each field on the
schema. Users that gain access to the schema as members of group name
Assignee Group are able to access each field to which that group has been
granted access.

If group name Assignee Group has not been granted access to any fields in
the schema, users will not be able to access the schema’s contents based on
their membership in the group in field 112. However, users may still access the
schema through any other method available to them.

To establish row level access to a schema and fields:
1. Add a field to the schema with field ID 112.

You may choose to hide this field. You may also choose to grant no access to
any control group to see or change this field.

2. Add workflow that inserts a group name into field 112 according to the
business rules at your site.

For example, if you determine that group name Assignee Group  should be set
when the AR is created, you can create a filter that fires on submit and sets
field 112 to a group name based on the contents of the current AR.

3. Change the access control of the fields in the schema to either grant or
deny access to users accordingly.

Adding Groups

You add groups by running the User Tool and submitting new entries in a
database provided by a special AR System schema, called the Group schema,
shown in Figure 3-2 on page 76. You can add as many new groups as you
want.

When you create a new group, the group name is added to the list of groups
that appears when you use the Administrator Tool to define group access to
schemas, individual fields, and active links.
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Figure 3-2 Submit Windows — Group Schema

The key fields in the Group schema are:

Group name The Group name is the alias name by which the access con-
trol group is known. This is the name you use in the User
schema in its Group list field. It is also the name that
appears in the Group Permissions list in the Field Proper-
ties window when you are defining schema fields, on the
Schema Permissions window when you are defining
schema attributes, and in the permissions lists for active
links.

Group ID Each access control group has an integer ID that is the real
identity of the group. For groups that you create, the ID
should be greater than 12. If you use the same ID with mul-
tiple group names, you must keep the Group type the same
for each (you are really creating aliases for the same group
in this case).
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Note – When field access permissions are granted during field creation or
modification, the permissions granted for the group can be no greater than the
type specified for the group in the Group schema. For example, if the group
has a View type, you cannot assign Change permissions on a field for the
group. However, if the group has Change permission, it can be limited to View
permission only on the field.
If a group does not have access permission to a schema’s Entry ID field (core
field 1) or if a group does not have schema permissions, members of that group
will not be able to access any information from that schema, regardless of the
permission settings for other fields on the schema.

To create a group:
1. Start the User Tool by typing the following at the UNIX prompt:

2. If this is the first time you have used the User Tool, the Login window
appears. Enter your user name and password, then select the Apply
button.

If there are no other Administrator users yet, you must log in as Demo.

Group type The Group type field holds the maximum permission type
intended for the group. The alternatives are None (no
access), View (view field contents), and Change (modify
field contents).
You can use the type None to disable all access allowed for
the group without deleting the group itself. The group
remains as a placeholder (and can be restored in the
future), but all permissions for the group are lost. You
might create a group with the type None if you want to
define a group that will be used only for notifications.

Long Group
Name

The Long Group Name lets you enter additional information
about the group. It should be descriptive of the group since
this is the name that will appear by default in the Query List
window in the User Tool.

<ar_install_dir>/bin/aruser &
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Note – For more information on the Demo user, see “Starting the
Administrator Tool” on page 6.

3. Select Open Schema from the File menu (or type Ctrl+O ), then select the
Group schema from the list in the Open Schema dialog box. Double-click
on the name or select the Apply button to load the schema.

4. Once the Group schema is loaded in the Query window, select Open
Submit from the File menu (or type Ctrl+S ). The Group schema appears
in the Submit window (as shown in Figure 3-2).

5. Enter information in the appropriate fields.

Create a new group by specifying a group name, ID and type. There are
additional fields in the Group schema for describing the meaning and
attributes of the group more thoroughly. (If there are additional attributes not
represented on the Group schema that are important to your organization and
you would like to specify these attributes in the group definition, you can use
the Administrator Tool to add fields to the Group schema.)

Note – Privileges for a user are determined by the permissions assigned to the
user’s Group ID. If you later change the Group ID for a group, the users
belonging to the original Group ID will still be attached to the old ID. If there
is no group with the old ID, these users are no longer attached to any group.

6. When you have finished entering information, select the Apply button.

When you receive a confirmation that your entry was successful, the new
group has been added to the system.

After you have created a new group, you can assign users to the group by
using the User schema (also from within the User Tool). Adding users to a
group gives them the access rights of that group. (For more information, see
“Adding Users” on page 80.)

Modifying Groups

Follow these steps to modify a group from the AR System.
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To modify a group:
1. Open the Group schema in the User Tool.

2. Select Query List from the Query menu (or type Ctrl+L ) to retrieve a list
of currently defined groups.

3. Select one or more groups that you want to modify from the list.

4. Click the Modify button (or choose Modify Individual from the Query
menu).

5. Modify information in the appropriate fields.

6. When you have finished entering information, select the Apply button to
modify the record.

Deleting Groups

Follow these steps to delete a group from the AR System.

To delete a group:
1. Select Open Schema from the File menu (or type Ctrl+O ) then select the

Group schema from the list in the Open Schema dialog box. Double click
on the name or select the Apply button to load the schema.

2. Select Query List from the Query menu (or type Ctrl+L ) to retrieve a list
of currently defined groups.

3. Select the group that you want to delete from the list.

4. Select Delete from the Query menu in the Query List window.

5. A confirmation box will appear to verify that you want to delete the group
entry. Click the Apply button to confirm. Click the Dismiss button to
cancel the delete operation.

AR System Users
When adding users to the system, you’ll need to keep in mind the limitations
of your user licenses. The basic AR System product includes one server license,
which allows unlimited users with submit and query access, and three fixed
write user licenses — that is, three users with the ability to change ARs after
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they are submitted. A user with change access may belong to the
Administrator or Subadministrator group or one or more groups with Change
permission.

Note – If you want more than three users with change access, you must
purchase the appropriate license from Remedy Corporation or an authorized
reseller. Check with your sales representative for information on the types of
licenses that are available.

Adding Users

You add users to groups by running the User Tool and submitting entries in a
database provided by another special AR System schema, called the User
schema, shown in Figure 3-3.

Figure 3-3 Submit Window — User Schema

The key fields in the User schema are:

License Type The type of write license the user has: Read (includes sub-
mit and query permission), Fixed, or Floating. The default
is Read.
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Whether or not users have permission to access an AR System database,
specific fields or active links in a database, or specific administrator commands
is determined in part by the permissions given in the Group list field of the
User database entry. (Even when users do not belong to an explicit group with
appropriate access, they may be able to access fields by being the submitter or
assignee for a particular entry.)

It is possible to add more than one user with the same login name as long as
you specify a different password for each entry. It is the combination of user
name and password that makes a user entry unique to the AR System.

Login name The identifying name that the user will enter into the
User Name field when starting the AR System. The login
name for the AR System is distinct from any other login
name the user may have elsewhere; however, it is conve-
nient to use the same name to avoid confusion and extra
maintenance.

Password The identifying password that the user will enter when
starting the AR System. It is a good idea to select a pass-
word that is different from ones used for other purposes.
You can set options on a UNIX server to tie the password
to the user’s UNIX password or to use the /etc/passwd  file
for user validation. See “Configuration Information” on
page 18 for more information.

Email Address The email address that will be used to notify the user
when email is the notification method.

Group list Specifies the access control groups to which the user
belongs. If this field is left empty, the user will have only
basic submitter, assignee, or public permissions. When
entering groups in the Group list, you can specify the
groups either by name or ID.

Full Name Holds the full name of a user. By default, this name
appears along with the entry ID in the Query List window
when users perform a Query List operation.

Default Notify
Mechanism

The way in which the user will be notified of actions affect-
ing them if no notify mechanism is specified or the default
mechanism is specified at the time the action is taken.

Full Text
License

The type of full text search license the user has: None,
Fixed, or Floating. The default is None. For more informa-
tion, see Chapter 14.
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The default view of the User schema contains fields in addition to the key
fields listed above that allow you to collect information about the user you are
adding to your system. As with all other schemas, you can change the field
labels and add new fields to suit your needs.

To add users to the system:
1. Run the User Tool on any machine on which you installed the software by

typing the following at the prompt:

2. If this is the first time you have used the User Tool, the Login window
appears. Enter your user name and password, then select the Apply
button.

If there are no other users yet, you must log in as Demo.

Note – For more information on the Demo user, see “Starting the
Administrator Tool” on page 6.

3. Select Open Schema from the File menu (or type Ctrl+O ) then select the
User schema from the list in the Open Schema dialog box. Double-click
on the name or select the Apply button to load the schema.

4. Once the User schema is loaded in the Query window, select Open
Submit from the File menu (or type Ctrl+S ). The User schema appears in
the Submit window (as shown in Figure 3-3 on page 80).

5. Enter information in the appropriate fields.

Always set passwords, especially for the AR administrator. It is recommended
that you make Password a required field. For security reasons, the password
you enter is not echoed in the Password field.

In the Group list field, enter a list of the groups to which the user is to belong,
separated by spaces. The list can include one or more of the special groups
(Administrator, Subadministrator, or Customize) and/or any access control

<ar_install_dir>/bin/aruser &
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group defined in the Group schema. In the example in Figure 3-3 on page 80,
Susan Subadministrator will be a member of the Sales Staff and
Subadministrator groups.

• If the Administrator group is in the Group list, the user will be able to
modify all fields, delete entries, and run the Administrator Tool to manage
the structures in the system.

• If the Customize group is in the Group list, the user will be able to use all
features of the customize facility of the User Tool.

• If the Subadministrator group is in the Group list, the user will be able to
perform a subset of the Administrator functions as described in
“Subadministrator Permissions” on page 84. For example, users will be able
to modify all fields and delete entries and to manage structures in the
system to which the Administrator has allowed Subadministrator access to
other groups which the user is a member of.

When first getting started, do not worry about specifying all the additional
access control groups you may need. You can add groups to the Group list for
a user’s entry at any time and give those groups access to fields by modifying
field definitions within schemas.

6. When you have finished entering information, select the Apply button.

When you receive a confirmation that your entry was successful, the user has
been added to the system. If adding a new user will cause you to exceeded
your license agreement, an error message appears.

Note – You may need to delete the AR System demonstration users before you
can add a user. For more information, see the Action Request System Getting
Started Guide and Sample Schemas manual.

Allowing Users to Modify Their Password

If you desire, you can define your user entries so that users will have the
ability to modify their own password. You can take advantage of the Assignee
(or Submitter) group to accomplish this without allowing users to access any
passwords other than their own.
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To allow users to change their passwords:
1. On the User schema entry for the user, make the user the Assignee by

entering the same name in the Login name field and in the Assigned-to
field. (Alternatively, you could make the user the submitter by entering
the same name in the Submitter field as in the Login name field.)

2. Make sure that the Assignee (or Submitter) group has change permission
to the Password field.

Note – In addition to the Password field, you can grant change permission to
the Default Notify Mechanism and Email Address fields.

Deleting Users

Follow these steps to delete a user from the AR System.

To delete a user:
1. Select Open Schema from the File menu (or type Ctrl+O ) then select the

User schema from the list in the Open Schema dialog box. Double click
on the name or select the Apply button to load the schema.

2. Select Query List from the Query menu to retrieve a list of currently
defined users.

3. Select the user that you want to delete from the list.

4. Select Delete from the Query menu in the Query List window.

5. A confirmation box will appear to verify that you want to delete the user
entry. Click the Apply button to confirm. Click the Dismiss button to
cancel the delete operation.

Subadministrator Permissions
Granting subadministrator permissions to a user is a powerful feature of the
AR System. Users can be granted subadministrator permissions to a subset of
available schemas, as shown in Figure 3-4. Inside a schema, subadministrators
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have the same privileges and permissions that an administrator has, including
creating objects, viewing server settings, setting local preferences, and so on.
Use subadministrator access wisely.

Figure 3-4 Users Subadministering Schemas

Only users who (1) belong to the Subadministrator group and (2) belong to a
group with subadministrator access to a schema can be a subadministrator and
perform the following functions:

• Administer any schema that your group has subadministrator access to.

• Create and administer filters, active links, and escalations connected to
schemas that your group has administrative access to.

• Create and administer menus.

• Create new schemas.

• View server information settings.

• Set local Administrator Tool preferences.
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However, members of the Subadministrator group cannot:

• Change server information settings.

• Create or modify administrator commands (extensions).

• Release users currently accessing the AR System.

• View users of the AR System.

Allowing multiple subadministrators poses interesting administrative
challenges. For example, if you allow 2 different groups (say, Engineering and
Marketing) subadministrator permissions to a schema, Engineering with their
permissions theoretically could use the Administrator Tool to revoke the
permissions of the Marketing group! However, the AR Administrator could
ultimately restore schema permissions back to the Marketing group. Just be
aware of potential problems.

To create a user having subadministrator capabilities:
1. In the User Tool, select Open Schema from the File menu (or type Ctrl+O )

then select the User schema from the list in the Open Schema dialog box.
Double-click on the name or select the Apply button to load the schema.

2. Once the User schema is loaded in the Query window, select Open
Submit from the File menu (or type Ctrl+S ). The User schema appears in
the Submit window (as shown in Figure 3-3 on page 80).

3. Enter information in the appropriate fields.

a. Always set passwords, especially for an AR subadministrator. It is
recommended that you make Password a required field. For security
reasons, the password you enter is not echoed in the Password field.

a. In the License Type field, assign the subadministrator a Fixed write
license.

a. In the Group list field, use the pull-right menu to enter the groups to
which the user is to belong. The list must include the
Subadministrator group. Remember that giving users membership in
the Subadministrator reserved group only gives them the potential to be
a subadministrator. For users to be subadministrators, they must belong
both to the Subadministrator group and also to a group with
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subadministrator permissions to a schema. In the example in Figure 3-3
on page 80, Sarah Subadministrator will be a member of the Sales Staff
and Subadministrator groups.

4. When you have finished entering information, select the Apply button.

When you receive a confirmation that your entry was successful, the user has
been added to the system as a subadministrator.

Use the Subadmin Permissions dialog box (see Figure 4-11 on page 130) in the
Modify Schema window to give subadministrator permissions to a schema to a
specific group or groups. For example, Sarah Subadministrator will not have
subadministrator permissions to a schema unless you explicitly give them to
her group. To define subadmin permissions, see “Defining Subadmin Access
For Schemas” on page 130.
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Defining Schemas 4

This chapter describes how to create and modify schemas. You should be
familiar with the information in “Designing Schemas” on page 44 before you
perform the operations described in this chapter.

The following topics are covered in this chapter:

• Creating or modifying schemas.

• Creating or modifying schema fields.

• Setting field properties.

• Rearranging field layout.

• Schema views.

• Creating or modifying active links from a Schema window.

• Setting schema attributes.
• Defining indexes.
• Defining query list fields.
• Defining schema permissions.
• Defining group access to schema fields.

• Setting help for a schema.

• Building and using schema change history.
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Using the Modify Schema Window
When you open a schema, it is displayed in the Modify Schema window.
Figure 4-1 shows a new schema containing only core fields.

Figure 4-1 Modify Schema Window

You use the Modify Schema window to perform the following tasks:

• Specify a schema name.

• Create new fields.

• Set definition and display properties of fields, such as default value, data
type, access control and permissions, field label, field length, and
presentation.

• Create button-activated active links.

• Re-arrange the field layout.

• Define and select multiple schema views.
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• Create help text for the schema and for the fields on the schema.

• Define schema attributes such as indexing, fields returned in a query,
permissions for the schema, and subadministrator definitions for the
schema.

This chapter describes the steps to follow to perform the tasks above. It also
provides details about the field properties you define. Chapter 2, provides
information about planning for these tasks.

Opening Schemas
Follow these steps to open a new or existing schema.

To open a schema:
1. Select Schemas from the Category menu in the Administrator Tool

window (or type Ctrl+S ).

The currently available schemas are listed.

2. To create a new schema, select Create a New from the Edit menu (or type
Ctrl+N ).

A new schema is created and assigned the name Schema<nn>, where <nn> is an
integer.

3. To modify a schema, select Open from the Edit menu, or type Ctrl+O , or
double-click the schema in the window to open the schema. (If you just
created a new schema, it is already opened.)

The schema appears in the Modify Schema window (Figure 4-1 on page 90).

Naming Schemas
For a newly created schema, the value in the Schema Name field will be
Schemann, where nn is an integer. For a copy of an existing schema, the value
in the Schema Name field will be Copy of <xxx>, where <xxx> is the name of
the schema you copied. In either case, replace the value in the Schema Name
field with the name that you want to use for this schema. Schema names must
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be unique on each AR server. There is no enforced convention for specifying
schema names, but it is helpful to make the name descriptive and indicative of
the schema’s function. Names may be up to 30 characters, including blanks.

Note – Users must log onto the server again or restart the User Tool to see a
new schema name or a modification to a schema.

Deleting Schemas
Deleting permanently removes a schema and all associated ARs. Any filters or
active links tied to this schema will also be deleted. Follow these steps to delete
an AR System schema:

To delete a schema:
1. Select Schemas from the Category menu (or type Ctrl+S ).

The currently available schemas are listed.

2. Select the schema to be deleted.

3. Select Delete from the Edit menu.

A confirmation message appears.

4. Select Proceed with delete to delete the schema. Or select Cancel Delete to
cancel the delete operation.

Note – The delete operation is permanent and cannot be undone. Make sure
you no longer need a schema before deleting it.

Creating or Modifying Fields
You can create new fields or modify existing fields at any time. You do not
need exclusive access to the system; other users can continue using the schema.
All changes take effect as soon as they are applied to the database. (Current
users will need to reopen the schema in order to see the changes.)
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There are a number of performance considerations that you should keep in
mind when you are adding a field to an existing database, increasing the size
of an existing field, setting the index for full text search, or deleting a field.
These operations require a varying amount of time, depending on a number of
factors including the size of the database, the amount of data currently stored
in the database, and the number of indexes that are defined for the fields on
the schema. Additionally, such modifications may require a great deal of disk
space in both the log and data segments for a full copy of the schema and its
data to be possible.

During these operations, users may not be able to access the AR System server.
Clients may receive RPC timeout messages; however, the operation the client is
performing at the time of the message will continue.

To create a new field:
1. Open the schema.

2. Select New Field from the Modify Schema window’s Edit menu (or type
Ctrl+F ).

The new field appears at the top of the Modify Schema window and the Field
Properties window appears.

3. Specify the field’s properties by filling in or modifying the values in the
Field Properties window. (See “Field Properties” on page 97 for
information on the values you enter in the Field Properties window.)

4. In Group Permissions, select the Set To Defaults button to use the
predefined settings from the Admin Preferences — Default Field
Permissions window (see “Setting Default Schema Permissions” on
page 30). If needed, however, you then can override individual default
settings.

5. Select the Set Help button in the Field Properties window to open a Field
Help Text window that lets you enter informational text about the field.
(Users will see this text when they select Help On Context for the field.)
Apply the changes and Dismiss the Field Help Text window when you are
finished.
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6. Select Change History if you want to enter a note describing the field you
are creating. The Change History lets you keep a log of modifications
made to a field over time. (See “Building and Using Change History” on
page 36 for more information.) Apply the changes and Dismiss the
Change History window when you are finished.

7. When you have entered the appropriate values in the Field Properties
window, select the Apply button, then select Dismiss to dismiss the Field
Properties window.

8. When you have finished setting up the new field, position it where you
want it on the schema using the mouse to drag it into position. (You can
specify more exact coordinates for the field using the Field Properties
window.) See “Rearranging Field Layout” on page 117 for more
information.

9. Select the Apply button in the Modify Schema window to add the field to
the schema.

To modify a field:
1. Open the schema (see “Opening Schemas” on page 91).

2. Select the field and open the Field Properties window by selecting
Properties from the Modify Schema window’s Edit menu, double-clicking
on the field, or typing Ctrl+R .

3. Make the appropriate modifications to the field’s properties by filling in
or modifying the values in the Field Properties window. (Note that you
will not be able to modify the field’s data type.) For information on the
values that you can enter in the Field Properties window, see “Field
Properties” on page 97.

4. Select the Set Help button to open a Field Help Text window that lets you
modify the informational text about the field. (Users will see this
information when they select Help On Context for the field in the User
Tool.) Apply the changes and Dismiss the Field Help Text window.

5. Select the Change History button if you want to enter a note describing
the modifications you are making to the field. The Change History lets
you keep a log of modifications made to a field over time. (See “Building
and Using Change History” on page 36  for more information.) Apply the
changes and Dismiss the Change History window when you are finished.
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6. When you have modified the appropriate values in the Field Properties
window, select the Apply button, then select Dismiss to dismiss the Field
Properties window. You do not have to close the Field Properties window
but can select another field to modify. The Field Properties window
displays the properties of any field you select from the Modify Schema
window. But any changes to the field properties are not saved until you
select Apply in the Field Properties window.

7. Select the Apply button on the Modify Schema window to apply the
changes to the database.

To delete a field:
1. Select the field to be deleted. You cannot delete the core fields.

2. Select Delete from the Modify Schema window’s Edit menu.

If you change your mind, you can restore the field at this point by selecting the
field and choosing Un-Delete from the Edit menu.

3. Select the Apply button on the Modify Schema window to perform the
delete in the database. When the field is successfully deleted, it will be
removed from the view on the screen and from the database. You will not
be able to select Un-Delete at this point.

Note – Deleting a field deletes all the data associated with that field and frees
this space in the database. The operation is expensive in the sense that it may
take several minutes to complete. Your database may be unavailable for this
time so your users will be impacted while the delete is occurring (they will not
be able to access the server and may get time out messages). Accordingly, you
may want to perform deletes off-hours so that users will not be impacted.

To make a field non-operational:
If you don’t want to use a field but also don’t want to delete it, you can make
it non-operational by completing the following steps.

1. Open the schema (see “Opening Schemas” on page 91).

2. Select the field and open the Field Properties window by selecting
Properties from the Modify Schema window’s Edit menu, double-clicking
on the field, or typing Ctrl+R . Change the following options:
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• In the Default field, delete any existing default information.

• For Entry, select Optional.

• For the Visible/Hidden choice, select Hidden.

• In the Group Permissions box, make sure all selection choices are deselected
(so that no group has access to the field).

3. Select the Apply button and dismiss the window.

4. Select Apply on the Modify Schema window to apply the changes to the
database.

The field will no longer appear on any user’s view of the schema. The field will
not be hidden to current users of the schema until they re-open the schema or
log in again.

To create a new field that is a copy of an existing field:
1. Open the schema and select the field you want to copy. (The field must

have the same data type as the field you want to create since you cannot
change the data type of an existing field.)

2. Select Copy from the Modify Schema window’s Edit menu (or type
Ctrl+C ).

The new field appears at the top of the schema, named Copy of <xxx>, where
<xxx> is the name of the field you copied. The Field Properties window
appears.

All settings for this field are the same as the original field.

3. Change any values as desired. Enter a new name in the Label field to
change the field’s name.

4. Select the Set Help button to open a Field Help Text window that lets you
modify the informational text about the field. Apply the changes and
Dismiss the window when you are finished.

5. Select the Change History button if you want to enter a note describing
the field you are creating. The Change History lets you keep a log of
modifications made to a field over time. (See “Building and Using Change
History” on page 36 for more information.) Apply the changes and
Dismiss the Change History window when you are finished.
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6. After you have made all your changes to the field definition, select the
Apply button to save the changes then dismiss the Field Properties
window.

7. Position the field where you want it on the schema using the mouse to
drag it into position. (You can specify more exact coordinates for the field
using the Field Properties window.) See “Rearranging Field Layout” on
page 117 for more information.

8. Select the Apply button on the Modify Schema window to add the new
field to the schema.

Field Properties
When you create a new field (using either New Field or Copy from the Edit
menu of the Modify Schema window), a Field Properties window appears, as
shown in Figure 4-2 on page 98. You can also display this window for an
existing (selected) field by selecting Properties from the Edit menu, by typing
Ctrl+R , or by double-clicking the field.
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Figure 4-2 Field Properties Window

The AR System lets you have multiple views of the same schema, including
whether a field hidden in one schema view is displayed in a different schema
view. Some field properties affect schema views while other field properties do
not. Use the Field Properties window to change a field’s definition and display
properties:

• Definition properties of a field apply to all schema views. For example, you
can decide whether a field should be indexed for full text searches, what
group permissions it should have, and so on.

Definition
Properties

Display
Properties
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• Display properties of a field apply only to a particular schema view. For
example, in one schema view a field might be visible while in another
schema view, the field might be hidden or located somewhere else on the
schema.

To create and modify fields in a schema view, see “Multiple Schema Views” on
page 118.

The following information summarizes each of the definition and display
settings in the Field Properties window and provides guidelines for filling in
the values in each field.
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Field Definition Properties

The following field settings apply to all schema views.

Table 4-1   Field Definition Properties  (1 of 9)

Field
ID

Every field in a schema has an integer field ID that is
unique on that schema. If you leave the field ID blank or set
it to zero when you are defining a field, the AR System will
assign a number from the unrestricted number set. Restric-
tions on field ID numbers are as follows:
* Numbers 1 – 99 are reserved for core fields. You cannot
assign an ID in this range unless you are creating a field
that is compatible with one of the core fields obsoleted as of
the 1.2 release of the AR System. See Appendix C, for infor-
mation on these fields.
* Numbers 100 – 536870911 are reserved for fields regis-
tered to Remedy Corporation. If you use an ID in this range,
the field definition should match the definition registered
with Remedy Corporation. You will receive a warning that
the ID is in this range and must acknowledge it before you
can use the ID.
* Numbers 536870912 – 2147483647 are user defined.
There are no restrictions on assigning numbers in this
range.
The field ID is used internally to identify the field through-
out the AR System. The field ID remains constant even if
the field label changes. You cannot modify the field ID after
it is applied to the database.
If you are creating multiple schemas and you are defining
fields that serve the same purpose on more than one
schema, it is a good idea to assign identical IDs to the iden-
tical fields in the different schemas. This allows you to have
a consistent meaning for the ID across the schemas.



Defining Schemas 101

4

Default By entering an appropriate value in this field, you can
assign an
administrator default to any field on the schema. This value
will be assigned to the field any time the user submits a
ticket unless the user enters a different value or has
assigned a user default to the same field.
You are limited to 255 characters. Also, the number of char-
acters you enter into the Default field cannot exceed the
number allowed in the Length field.
You also can enter the field value that you want to appear
when users load default preferences into the Query or Sub-
mit windows in their User Tool.
Note: Users can override any defaults you may have
defined when you set up the schema.

Entry The Entry option allows you to specify whether the field will
be required or optional. Making a field required forces the
user to fill in that field when they submit a new AR. If a
field is optional, each user is free to enter information in
the field or not, as suits their needs.
A required field appears with a bold label to signify its
importance to the user. The core schema has three required
fields: Submitter, Short Description, and Status. You should
only make a field required if it must be filled in for every
AR.
Note:You can also use filters and active links to require
users to enter information in a field under specified circum-
stances. See the sample schemas for examples. For more
information about filters, see “Designing Filters” on page 52
and Chapter 6. For more information about active links, see
“Designing Active Links” on page 60 and Chapter 8.

Table 4-1   Field Definition Properties  (2 of 9)
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Create Mode This choice allows you to select the create mode for the field.
The create mode works in conjunction with the Group Per-
missions settings to determine access control (security set-
tings) for the field at the time an AR is submitted.
Select a create mode of Open to allow anyone to assign a
value to the field at submission time, regardless of whether
or not the submitter belongs to a group that has change per-
mission for the field.
Select a create mode of Protected to restrict data entry to
users who belong to one or more groups with explicit change
permission for the field.
Note:  If the submit mode is set to Protected, only users
with write access to the field can set a value for that field.
Since write access requires a write license, this means that
only users with a fixed or floating write license will be able
to set a value for the field. Setting the submit mode to Open
will allow anyone to submit a value for the field, regardless
of whether they have a write license.

Table 4-1   Field Definition Properties  (3 of 9)
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Data Type The data type field property lets you specify the kind of
information that will be contained by the field. There are six
possible data types:

* Character

* Date Time

* Diary

* Integer

* Real

* Selection
Table 4-2 on page 109 summarizes the meanings and use of
the field data types.
As you select a data type, other field property choices will be
grayed out or activated according to the data type you
select. This is because certain properties are relevant only
to specific data types. Because the choices are grayed or
activated automatically, you do not need to worry about
whether or not a field property setting is meaningful for the
data type you select.
Note:You can only set the data type property for a new field;
once you have applied your choice in the Field Properties
window, you will not be able to modify the data type.

Table 4-1   Field Definition Properties  (4 of 9)
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Length For character fields, enter the maximum length of the infor-
mation the field can contain. You will get the most efficient
use of database storage if you set the maximum length of a
character field to be less than or equal to 255 characters.
When the field length is less than or equal to 255 charac-
ters, the allocated storage is equal to the length of field con-
tents. If you set the maximum length to larger than 255
characters, storage is allocated in blocks that average 1-2K
characters (depending on the database). A full block is allo-
cated for the first character. When that block is filled with
the field contents, another full block is allocated. Leaving
the Length field blank specifies an unlimited length field. If
the field length is 70 characters or more, the user will be
able to open a Text Editor window by selecting the text edit
icon to the right of the field with the SELECT mouse button.
Remember that, for some databases, you cannot do searches
on fields over 255 characters. If you have questions about
the capabilities of your particular database, refer to your
database reference guides.
Note:When deciding on the length to specify for a field, you
should keep in mind that the maximum amount of data that
will be displayed is 100,000 characters on a UNIX platform
and 32,000 characters on a PC or a Macintosh.

Selection
Values

For selection-type fields, you can set the selection values of
the field. For more information, see “Creating Selection
Field Values” on page 114.

Table 4-1   Field Definition Properties  (5 of 9)
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Pattern For character fields, you can specify a pattern for the field
contents. Specifying a pattern restricts what the user can
enter as the contents of a field.
There are two types of character patterns that you can spec-
ify. The first type is a pattern similar to that used in the
LIKE operator. This type of pattern allows you to enter any
character pattern you wish to match. The pattern can
include any of the wildcard characters that are allowed in
the LIKE comparison operation (see “Table of Operators” on
page 366).
The second type of pattern is a keyword that specifies a
style for the field. You can specify only one keyword for a
pattern and the pattern keyword cannot be combined with a
pattern of characters and wildcards:
$ALPHA$ Value must be alphabetic characters

(and blank space).
$ALNUM$ Value must be alphabetic characters and digits

(and blank space).
$DIGIT$ Value must be digits.
$LOWER$ Value may be any alphabetic character or digit

(and blankspace) except uppercase letters.
$MENU$ Value must match an item defined on the

character menufor the field.
$PRINT$ Value must be printable characters.
$UPPER$ Value may be any alphabetic character or digit

(and blank space) except lowercase letters.

Menu For character fields, you can enter the name of a menu to be
used as a fill-in aid for the field. See Chapter 5 for informa-
tion on creating and defining a menu.
You can enter the menu name directly or you can use the
mouse button to select the menu symbol and open a list of
defined menus. You can then select a menu from the list.

Table 4-1   Field Definition Properties  (6 of 9)
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Menu Drop For character fields, this choice allows you to specify how
text will be added to the field when a user selects an item
from a character menu. If you choose Append, the menu
text will be added to any text already in the field. If you
choose Overwrite, the menu text will replace any text
already in the field.

Table 4-1   Field Definition Properties  (7 of 9)
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QBE Match For character fields, you can specify how a match will be
determined when a user performs a query-by-example
(QBE). You can select any of the following values:
Anywhere A query will find a match if the value occurs

anywhere in the field. For example, if the user
enters Bob in the Submitter field, the query will
return all ARs submitted by Bobby Jones, Bob
Smith, and Jill Bobbington.

Leading A query will find a match only if the value
occurs at the beginning of the field entry. For
example, if the user enters Bob in the Submitter
field, the query will return all ARs submitted by
Bob Smith and Bobby Jones, but not those sub-
mitted by Jill Bobbington.

Equal A query will find a match only if the value
entered in the query matches the value in the
field exactly. For example, to find ARs submit-
ted by Bob Smith, the user must enter Bob

Smith , with exact spelling and capitalization, in
the Submitter field.

Searches on fields where the QBE match type is Leading or
Equal will be faster than searches on fields where the
match type is Anywhere, especially if the field is indexed.
Note: Relational operators and wildcards will work during a
query-by-example regardless of the QBE Match setting.
This means that users will be able to specify an exact match
in a field with a QBE Match setting of “Anywhere” by using
the equal sign (=) relational operator.
Users will also be able to use the percent sign (%) wildcard
at the beginning of the search string (%abcd) to override a
QBE Match setting of “Leading” or “Equal.” However, using
the % wildcard at the end of a string (abcd%) does not over-
ride the “Leading” or “Equal” setting.
Overriding the Leading or Equal QBE Match settings will
also override the performance benefits of using those set-
tings.

Table 4-1   Field Definition Properties  (8 of 9)
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Mini-
mum/Maxi-
mum

For real and integer fields, you can define a minimum and
maximum limit specifying a range of values by entering
numbers in the Minimum and
Maximum fields. During data submission and modification,
the user will be limited to entering values that fall within
the range you specify.

Precision For real fields, you can set a limit on the number of decimal
places that are displayed in the user’s view. The number
that is displayed is rounded off. (The data stored in the
database is unchanged.)
For flat-file databases, the maximum precision that can be
represented is 10.

Index For
FTS

If you are licensed for full text search, you can define
whether to index the field for full text search (if you are
using the FTS option). For more
information, see “Defining a Field for FTS in the Field Prop-
erties Window” on page 326.

Table 4-1   Field Definition Properties  (9 of 9)
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Data Types

Table 4-2 describes the various data types of fields you can create.

Table 4-2 Data Types  (1 of 3)

Data Type Summary

Character Character fields accept strings of ASCII text. Character
fields are useful when there is significant variation in the
field contents or length of the content, for example, descrip-
tive text, names of people, addresses, and keywords.
Optionally, you can associate a character menu with a char-
acter field. A special menu icon appears to the right of any
field with a character menu. The character menu provides
users with a fill-in aid that can help standardize the text
contents. Character menus give all users a common vocabu-
lary for description and can therefore help improve the accu-
racy of queries made by the support staff. Note that, unless
you specify a pattern match in the Pattern field (see below),
users are free to enter their own text in a character field
even when character menus are defined for the field. See
Chapter 5 for information on designing and creating a pull-
right character menu.
For character fields 70 characters and longer, users can also
open a text editing window for viewing and editing the field’s
contents. This allows you to conserve space on the users’
view of the schema because the display length can be
smaller than the length attribute. A special menu icon will
appear to the right of any field for which it is possible to
open a text editing window.
For users with full text search licenses, you can also create a
search index for long character fields. See “Defining a Field
for FTS in the Field Properties Window” on page 326.
On UNIX platforms, a character field can hold up to 100,000
characters. On PCs and Macintosh computers, a character
field can hold up to 32,000 characters.
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Date/Time Date and time fields are useful for information that is lim-
ited to calendar dates and time. The format is in local (lan-
guage) time formats, such as 12/21/95 13:14:21 and
December 21, 1995 1:14:21 PM. Date and time fields can
play a significant role in providing metrics for your AR Sys-
tem implementation. You can perform queries and statistical
evaluations on Date Time fields and use the results in a
number of ways. For example, you can design a macro that
generates a statistics report of the average time required to
fix problems.
Several date and time fields are part of the core set of fields.
A date and time is also maintained with every state repre-
sented by the Status field (one of the core fields). This record
is called the Status History.

Real Real type fields accept and contain floating point numbers.
This type of field permits you to store more quantitative
information in an AR. You can limit the range for a particu-
lar field by entering values in the Minimum and
Maximum fields. You can also set a limit on the number of
decimal places that are displayed in the user’s view by
specifying a value in the Precision field. Values displayed
with a precision setting are rounded off. (Note that the preci-
sion setting affects only the number that is displayed in the
user’s view; the actual value stored in the database is not
changed.)

Integer Integer type fields accept integer values between
 -2147483648 and 2147483647. You can limit the range for a
particular field by entering values in the Minimum and
Maximum fields. Like real type fields, integer fields permit
you to enter and store more quantitative information.
You can use integer and real type fields to process statistical
information. For example, you might use them in conjunc-
tion with a time field to calculate the cost of resolving certain
types of problems.

Table 4-2 Data Types  (2 of 3)
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Diary Diary type fields are a special data type designed to capture
a history of the resolution of an AR. Diary fields are designed
so that each time an action is taken on an AR an entry to the
diary field will be appended to previous entries. A text editor
allows flexible entry of each new diary addition. A special
icon will appear to the right of each diary field to allow users
to open the diary text editor.
Every diary entry is stamped by time and user name. Once
entered, entries cannot be modified.
You can add one or more diary fields as needed. You might,
for example, designate one diary as the public diary and
design another diary that will be seen only by support staff.
For users with full text search licenses, you can also create a
search index for diary fields. See “Defining a Field for FTS in
the Field Properties Window” on page 326.
* On UNIX platforms, a diary field can hold up to 100,000
characters.
* On PCs, a diary field can hold up to 64,000 characters.
* On Macintosh computers, a diary field can hold up to
32,000 characters.

Selection Selection type fields offer a flexible method for providing a
small number of choices. The user’s view shows the selec-
tions menu choices. The user cannot enter choices that are
not included in the definition of the field. (This is one distinc-
tion between Selection fields and Character fields with
menus.) You should use selections only in cases where you do
not expect the options available to users to change over time.
Altering the choices in a selection field often alters views
and may require modifications to the existing database. If it
is necessary to add new choices to a selection, add them to
the end of the list to avoid having to modify the database.
To specify the selection values for the field, select the Selec-
tion Values button and see “Creating Selection Field Values”
on page 114.

Table 4-2 Data Types  (3 of 3)
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Field Display Properties

You can define the following field settings for different schema views.

Table 4-3   Field Display Properties  (1 of 3)

Label In the Label field, enter a name for the field that will
appear in the currently selected view of the schema.
Labels may be up to 30 characters long, including blanks,
and should describe the meaning and purpose of the field.
(However, do not include trailing blanks as part of the
label.) Users can personalize labels later using the User
Tool.
If you leave this field blank, the field will appear on the
screen with no label.
You may use single quotes in field labels; however, when
performing queries, users will need to enter two single
quotes when specifying the label. This is because field
labels that contain special characters must be enclosed in
single quotes in queries and a single quote in the label
would otherwise be interpreted as the end of the field
label.
It is possible to use the same label for more than one field
on a schema. However, if duplicate field labels exist on a
schema, the AR System will issue a warning message any
time you apply changes to that schema (unless you set the
Admin Preferences for this warning to No).

Label
Position

This choice lets you specify whether a field label will
appear above the field or to the left of it on the schema.
Select Top to cause the label to appear above the field.
Select Left to cause the field to appear to the left of the
field.

Display
Length

For text or numeric fields, you enter a display length to
determine how much room a field will occupy on the
screen. Display length often differs from the setting of the
maximum length allowed for data entered in the field. If a
user enters more characters than can be displayed, the
text will scroll off the end of the field, provided that the
internal field length is greater than the display length.
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Number of
Rows

For radio buttons, the number of rows determines the
number of horizontal rows used for the selection choices. A
setting of 1 produces a single horizontal row. A setting of 2
or more will divide the choices evenly into 2 or more hori-
zontal rows.
For text or numeric fields, the number of rows determines
the number of rows of text that are displayed.

Field Type This choice allows you to set a field type, which determines
how information will be presented. For character, date and
time, diary, and real fields, the only choice is Text.
For selection fields, you can choose .  provide a visible set
of choices from which to choose.
For Integer type fields, you can choose Text or Numeric
Text. Numeric Text provides increment and decrement
arrows (▲▼).

Location The Location fields let you determine where the field is
positioned on the schema. After dragging the field to a gen-
eral location using the mouse, you can use the location
fields to specify a more exact location on the screen using X
and Y coordinates. If you have a series of fields on the
same line, these fields must have the same Y coordinate in
order for tabbing between fields to work as you would
expect. (Tabbing works from top-to-bottom, left-to-right.)

Visible/
Hidden

This choice allows you to specify whether the field will be
visible or hidden. Making a field hidden means the field
will not appear in the user’s view. (Users with Customize
permissions can make a hidden field visible.) A hidden
field remains in the database and may be used by filters,
active links, or programs that might access the field. You
can also set administrator defaults for hidden fields.

Table 4-3   Field Display Properties  (2 of 3)
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Creating Selection Field Values
Follow these steps to create (or modify) the values available in a selection type
field. You create selection field values in the Selection Values window shown in

Group
Permissions

The Group Permissions settings allow you to control who
can view and change individual fields of a schema. You can
prevent some groups from accessing the field while allow-
ing full update permissions to other groups.
A group permission of View means users who are members
of the group are able to read the contents of the field. A
group permission of Change means users who are mem-
bers of the group may read and write the contents of the
field. If neither permission is selected for a group, mem-
bers of the group will not be able to view or change the
field. (Keep in mind that users must be assigned a valid
fixed or floating license in order to be able to change a
field.)
The groups listed in the Group Permissions area are the
groups defined for the server. Select the appropriate View
and Change levels for each group listed to determine the
type of access that each group will have to this field.
Note: Users who do not belong to a group that has permis-
sion to view a schema’s Entry ID field (core field 1) will not
be able to access any information from that schema,
regardless of how permissions are set on other fields.
Selecting View gives a group View permissions for schema
fields while selecting Change gives a group View and
Change permissions.
You can use the Set to Defaults button to set the permis-
sions to those defined in the Admin Preferences window
(see “Setting Default Schema Permissions” on page 30).
You can also set permissions for the entire schema using
the Permissions schema property setting. See “Defining
Schema Permissions for the User Tool” on page 128 for
more information.
For more information on groups, permissions, and access
control, see Chapter 3.

Table 4-3   Field Display Properties  (3 of 3)
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Figure 4-3. You access the Selection Values window through the Field
Properties window.

Figure 4-3 Selection Values Window

Note – You should take great care when modifying selection value choices for
an existing database. If you change the order of existing selection field items,
the meaning of data previously entered in the database will be changed. For
example, in a Status field, if the current choices are New, Assigned , and Closed ,
and you add a choice labeled Fixed  before the Closed  selection, existing
database entries with a status of Closed  will now have a status of Fixed

instead. This is because the data for a selection field is stored in the database as
an integer that relates to the order of the choices.
To avoid confusion, do not add selection choices to an active schema other
than as the last choice of the selection field.

To create selection values:
1. Select the field.

2. Select Properties from the Edit menu, type Ctrl+R , or double-click the
field to open the Field Properties window.

3. In the Field Properties window, select the Selection Values button, which
is activated only for selection type fields. The Selection Values window
appears (Figure 4-3).
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4. To add a new value, type the information in the Choice field, then use the
Insert or Append buttons to add the value to the Choices list.

The list box in the Selection Values window shows existing selection values.
The order of values in the list box is the order in which they will appear in the
selection field. You use the Choice field to specify a new value or edit an
existing one. The Insert and Append buttons let you specify where a new value
is inserted in the list box. Insert will add an item before the currently selected
choice, while Append will add the item after the currently selected choice.

5. To delete a value, select the value in the Choices list, then select the
Delete button.

(See the note above before adding or deleting choices in the middle of a
selection field on an existing schema.)

6. To modify a value, select the value in the Choices list, edit the
information in the Choice field, then use the Modify button.

7. Select the Apply button to save your changes.

Setting Help for a Field
Selecting the Set Help button in the Field Properties window brings up a Field
Help Text editing window. You can supply help text for the selected field here.
In most cases, this is simply a description of the field and its uses. For more
information on setting help, see “Setting Help” on page 38.

Building and Using Field Change History
The AR System automatically records information about the owner of a field,
the user who last modified the field, and the date of the modification. You can
display this information at any time by selecting the Change History button at
the bottom of the Field Properties window to open the Change History dialog
box. For more information on viewing and modifying change history
information, see “Building and Using Change History” on page 36.
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Rearranging Field Layout
You can change the physical layout of a schema by dragging fields to
reposition them, as shown in Figure 4-4. Dragging a field past the bottom (or
top) of the visible window moves the field onto the next (or previous) schema
page.

Note – You can reposition a field more precisely by specifying X and Y
coordinates in the Field Properties window.

Figure 4-4 Rearranging Fields on a Schema

To move a field:
1. Open the schema to display it (if it is not already displayed).

Select the field
and drag it to a
new location.



118 Action Request System Administrator’s Guide for OSF/Motif—January 1996

4

2. Select the field.

3. Drag the field to its new position.

4. You can continue modifying the schema by moving other fields, adding
new fields, or setting the field definition or field layout. For more
information, see the appropriate sections in this chapter.

5. When you are ready to save your changes, select the Apply button.

Multiple Schema Views
As an administrator, you can provide users with multiple views of the same
schema. For example, you might create a schema with one look for Motif users
and another for Windows users.

Note – Administrators or subadministrators also can customize a view on the
User Tool, then export the view back to the server. The next time you open the
schema in the Administrator Tool, the customized view you created in the User
Tool now appears as one of the views you can select and modify in the
Administrator Tool.

The Administrator Tool lets you create as many schema views as you need for
different users. Use the View menu to select a view, copy it, then create a
different “view” of the schema by rearranging or even hiding fields.
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Figure 4-5 Modify Schema Window — Multiple Views

To define a schema view:
1. Open the Modify Schema window.

2. To create a new view, select New from the Views menu (or type Ctrl+N ).
Your first new view will be called Copy of  <xxx> in the View Name field
where <xxx> is the name of the original view.

To create a copy of a view, select the view you want to copy and then select
Copy from the Views menu. The copied item will be called Copy of <xxx> in
the View Name field where <xxx> is the name of the original view.

To open an existing view for modification, choose the Select sub-menu from
the Views menu and choose one of the views.

Multiple
Schema Views
Available
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The view appears in the Modify Schema window. Create new fields or re-
arrange fields as needed.

3. Rename the new view as appropriate, for example, Windows Schema View .
You cannot create multiple views with the same name.

4. Drag fields to different positions, if needed.

5. To change the display properties of a field for this particular view, select
the field by double-clicking on it. The Field Properties window appears.

6. Change the display properties for a field in each schema view as needed
(see Figure 4-6). For example, you can hide the field, modify its label or
display length, change label positions, and so on. For more information
on the display properties of a field, see “Field Display Properties” on
page 112.

Figure 4-6 Field Display Properties

Note – For a particular schema view, you can only change the field’s display
properties. If you make changes to any other field properties, as in a field’s
attributes or database properties, these changes apply to all schema views. For
example, changing a field’s QBE match setting applies to all schema views.

7. When you are ready to save your changes, select the Apply button in the
Modify Schema window to save your definitions.

To select and modify a schema view:
1. Open the schema view to display it (if it is not already displayed).
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2. From the Views menu, as shown in Figure 4-5 on page 119, choose a view
from the Select sub-menu. Customized views created and exported from
the User Tool also appear in the Select sub-menu. The name of the view
you selected appears in the View Name window.

3. Make any needed changes.

4. When you are ready to save your changes, select the Apply button in the
Modify Schema window to save your definitions.

To delete a schema view:
1. Open the schema view to display it (if it is not already displayed).

2. From the Views menu, as shown in Figure 4-5 on page 119, choose the
view that you want to delete from the Select sub-menu.

3. Select the Delete button to delete the view.

A warning message appears, listing the name of the view you want to delete.

4. Press the Proceed with delete button if you are sure you want to delete the
view.

The view is removed from the Modify Schema window.

5. When you have made all of the modifications you want to the Modify
Schema window, select Apply to save the modified schema then select
Dismiss.

Creating or Modifying Active Links from the Modify Schema Window
For active links that are activated by a button, you can create, modify, or delete
the active link directly from the Modify Schema window. This makes
positioning the button and creating new active links for your schema much
easier.

• To open the Active Link window, select New Active Link from the Edit
menu of the Modify Schema window (or type Ctrl+A ). See Chapter 8 for
information on defining the active link.

• To modify an active link button, double-click the active link button and
Modify Active Link window appears.
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Defining Group Access For Schemas
The Administrator Tool lets you do bulk assignments of group permissions for
all schemas within a server. Rather than going through each schema
individually to assign permissions for a group, the Group Access dialog box
lets you assign them all at once.

The Group Access — Schemas window is particularly useful when you have
added a new access control group since the schemas were created and you
want to set its access rights across a number of schemas. You can use this
window to assign the new group access for each schema instead of having to
open each schema and modify the conditions for each schema.

Note – The Administrator Tool offers several different ways to set
permissions. For example, when creating a schema, you might give access to
the Public group. However, if you decide that you want to deny the Public
group access to schemas, you then can use the Group Access window to set the
group permissions for all schemas at the same time.

To define group access for schemas:
1. Select Schemas under the Category menu of the Administrator Tool main

window.

2. From the Edit menu, select Group Access (or type Ctrl+G ). This causes the
Group Access window to appear, as shown in Figure 4-7 on page 123. You
use this window to set schema permissions globally for each group
defined for a server.
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Figure 4-7 Group Access — Schemas Window

3. Click the Group icon. The Groups dialog box appears.

4. Select a group from the dialog box, then click Apply (or double-click the
entry). The Group Access window then lists all current permission
settings for that group for all items in the current category.

5. For each item, set the schema permissions for the specified group.
Selecting Yes gives the group permissions to access the schema.

6. Select the Apply button to save the option settings.

Setting Schema Attributes
For each schema, you can define attributes (properties) that determine
characteristics of how that schema will look and act during operations
performed using the User Tool. You can define the following schema attributes:

Indexing Allows you to define up to 16 indexes on the fields of the
schemas you create. By setting an index on a field that users
search on frequently, you can greatly increase the speed of
access to items in the search.

Query List Fields Allows you to specify which of the schema’s fields will appear
in a query list for the schema.
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Instructions for defining each of the schema attributes are provided in the
following sections.

Defining Indexes

The Indexes schema property setting lets you define up to 16 indexes. Indexing
can greatly decrease the time required for a database search.

Note – You can only index a relational database. Flat file databases do not
support indexing.

You can specify up to 16 indexes and up to 16 fields for each index that you
define. The sum of all field lengths in an index must be less than 255 bytes.

Good candidates for fields to index include fields that you search on
frequently. The Entry ID field is already indexed, so there is no need to build a
separate index for that field.

If you define an index for a character field, make sure the QBE Match type set
for the field is Leading or Equal. An index on a field with an Anywhere match
type will not save any search time. (For more information, see “QBE Match” on
page 107.)

You should also avoid creating a large number of indexes on a schema, as this
can be counterproductive.

Note – You should be aware that for schemas with indexes defined, more time
is required when you make modifications to the schema (such as adding new
fields). The greater the number of indexes defined for the schema the more
time and disk space is required. Additionally, submit and modify operations in
the User Tool take longer on schemas with many indexes.

Schema
Permissions

Allows you to specify which of the access control groups
defined on the server are able to see the schema. By denying
permission to a group, you can assure that no member of
that group will be able to access the schema, unless they
belong to another group with permissions.

Subadmin
Permissions

Allows you to specify which groups have Subadministration
privileges over the schema.

Field Group Access Allows you to set permissions on all fields for a given group.
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To define indexes for a schema:
1. Create or open the schema for which you want to define an index.

2. Select Indexing from the Attributes menu (or type Ctrl+I ). The Indexing
dialog box will appear, as shown in Figure 4-8.

Figure 4-8 Index Fields Dialog Box

3. Define the first index for the schema by entering the names of from one to
16 of the schema’s fields in the data entry fields in the dialog box. These
are the fields that will be included in the index. Enter the fields in the
order that you want them indexed. You can use the character menu to
select from a list of the existing schema fields.

4. Specify whether or not the index is a unique index by selecting the Yes or
No radio button. Unique means that the system will enforce a rule
requiring all values (existing and new) in the field or combination of
fields to be unique. For example, you would not define a unique index on
a field that contains first names, since more than one person might have
the same name. You might, however, define a unique index on a phone
number field, since each phone number may be unique.

5. When you have entered the names of the fields for the first index, select
Create to create the index.
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6. To create a second index for the schema, select the New button. A new set
of data entry fields will appear. Enter the names of the fields to use for
this index, select the Yes or No Unique indicator, if appropriate, and select
the Create button to create the second index. Repeat this step as many
times as needed to create the indexes you want.

7. Use the Previous and Next buttons to move from one defined index to
another, as you desire.

8. Once you have created all the indexes that you need for the schema, select
the Apply button in the Indexing dialog box then select Dismiss.

9. Select Apply in the Modify Schema window to save your definition. If
you are creating indexes on a schema for which a lot of data already
exists, this step may take a significant amount of time and disk space.
Therefore, you may want to limit doing any defining of indexes during
your normal production hours.

Defining Query List Fields

The Query List Fields schema attribute setting allows you to customize which
fields appear when a user performs a query list operation in the User Tool. By
default, the user sees the contents of the Entry ID field and the Short
Description field. By specifying this property, you can modify the query list to
contain the contents of any fields on the schema. (The contents of the Entry ID
field is always returned.)

When you define the list of fields, you specify each field, the width to use for
that field, and the string to use as a separator between that field and the next
field in the list. The total string that you define can be no longer than 128
characters.

Note – Modifying the contents of the query list will also affect the contents of
the Selection List window (pick list) in the User Tool. The Selection List
window appears when an active link that performs a set field operation based
on a query returns more than one result. See the Action Request System User’s
Guide for more information on the Selection List window.

To define fields returned in a query list:
1. Create or open the schema for which you want to define query list format.
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2. Select Query List Fields from the Attributes menu (or type Ctrl+Q ). The
Query List Fields dialog box appears, as shown in Figure 4-9.

Figure 4-9 Query List Fields Dialog Box

3. In the first Field Name field, enter the name of the first field that you want
to appear in the list after the Entry ID field. You can type the name
directly or use the list icon to select from a list of schema fields. Select as
many fields as needed, but the total width of all fields cannot exceed 128
characters.

If you have purchased the full text search option from Remedy Corporation,
you can also select WEIGHT to display the weighted value of retrieved ARs
when you do a query list in the User Tool. For further information, see
“Accruing and Weighting Results in an FTS” on page 305.

4. In the Separator field next to the field name you just entered, type a
character or string to be used as the separator between that field and the
next one in the list. The string may contain spaces as well as any of the
following special characters:
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In the Width field next to the field name you just entered, type a number
to determine the width of the data that appears in the
query list. If you set a width of 20, only the first 20 characters of the field
value will appear in the list, regardless of the length of the actual entry. If
you do not set a width, the width will be set to the full width of the field.

5. Enter the names of additional fields that you want to appear in the query
list, along with their separator characters and widths, in the remaining
data entry fields. You can display up to 128 characters in the query list; the
number of fields that you can display will vary depending on the width
that you specify for each field.

6. Select Apply to save your query list definition, then select Dismiss.

7. Select Apply in the Modify Schema window to save your definition.

Defining Schema Permissions for the User Tool

The Schema Permissions dialog box allows you to determine whether users
belonging to each access control group can see a schema in the User Tool or
not. If the user cannot see the schema in the User Tool, they cannot see any
field or any data from that schema, regardless of other permission settings on
the schema. For example, if Public access is denied for a schema, users who do
not belong to any group that does have access to the schema will not be able to
see it even if the schema contains fields with Public read access. If a user is not
in a group that has permission to see the schema, the schema will not appear in
that user’s Schema list.

If no permissions are set for a schema, only the administrator and any
associated subadministrator will be able to see the schema.

Special Character: You Enter:
Backspace \b

Return \n

Tab \t

Backslash \\

ASCII Character \< nnn>  (this number is decimal, not octal)
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To define schema permissions:
1. Create or open the schema for which you want to define permissions.

2. Select Schema Permissions from the Attributes menu (or type Ctrl+P ).
The Schema Permissions dialog box appears, containing a list of the
access control groups defined on the server, as shown in Figure 4-10.

Figure 4-10 Schema Permissions Dialog Box

3. For each listed group, select the Yes radio button to allow access to the
schema, or the No radio button to disallow access.

4. To use default permissions, select the Set To Defaults button.

Note – For information on default schema permissions, see “Setting Default
Schema Permissions” on page 30.

5. Select the Apply button to save your permissions, then select Dismiss.

6. Select Apply in the Modify Schema window to save your definition.

To allow all users to see a schema:
• Select Yes for the Public group.
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Defining Subadmin Access For Schemas

The Subadmin Permissions dialog box allows you to determine which groups
have subadministrator privileges over the schema. Remember that inside a
schema, subadministrators have the same privileges and permissions that an
administrator has. For further information on subadministration, see “Access
Control Groups” on page 72 and “Subadministrator Permissions” on page 84.

To define sub admin permissions:
1. Create a new schema or open a schema to display the Modify Schema

window (see Figure 4-1 on page 90).

2. From the Modify Schema window, select Subadmin Permissions from the
Attributes menu (or type Ctrl+S ). The Subadmin Permissions dialog box
appears, containing a list of the access control groups defined on the
server, as shown in Figure 4-11.

Figure 4-11 Subadmin Permissions Dialog Box

3. For each listed group, select the Yes button to grant subadministrator
access to the schema, or the No button to disallow access.

4. Select the Apply button to save your permissions, then select Dismiss.

5. Select Apply in the Modify Schema window to save your definition.
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Defining Group Access For Schema Fields

The Group Access — Schema Fields window (Figure 4-12 on page 132) allows
you to determine View or Change access to field data. Group access for schema
fields lets you do bulk assignments of permissions for a specific group for all
fields within a schema. For example, rather than going through each field
individually to assign permissions for a group, the Group Access window lets
you assign them all at once. You then can modify access for specific fields
individually, if required. (Keep in mind that users must be assigned a valid
fixed or floating license in order to be able to change a field’s content.)

Group access is particularly useful when you have added a new access control
group since the fields were created and you want to set its access rights across
a number of fields. You can quickly assign the new group access for each field
on one window instead of having to use the Field Properties window for each
field.

For more information on groups, permissions, and access control, see
Chapter 3.

Note – The Administrator Tool offers two different ways to set permissions for
fields. The first lets you set permissions as you create each field. For example,
when creating the field, you might give change access to a particular group in
the Field Properties window. The second lets you assign permissions to one or
more fields for a given group. For example, if you decide that you want to
grant a particular group view access to the field, you can use the Group Access
window to set permissions for all fields at the same time. For more information
on setting individual field permissions, see “Group Permissions” on page 114.

To define group access for schema fields:
1. From the Administrator Tool, select Schemas from the Category menu (or

type Ctrl+S ). The Schema List appears in the Administrator Tool.

2. From the Schema List in the Administrator Tool, open a schema by
double-clicking on it (or select a schema, then type Ctrl+O ). The Modify
Schema window appears.
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3. From the Attributes menu, select Field Group Access (or type Ctrl+G ).
This causes the Group Access — Schema Fields window to appear, as
shown in Figure 4-12. You use this window to set schema permissions
globally for each group defined for a server.

Figure 4-12 Group Access — Schema Fields Window

4. Use the Group icon to select a group. The Groups dialog box appears.

5. Choose a group, then select Apply (or double-click the group).

Depending on the group you choose, different buttons appear in the Group
Access — Schema Fields window. Groups with a group type of View only
allow you to select View permissions for schema fields. However, groups with
a group type of Change allow you to select View and Change permissions.

6. Set the permissions for each field. Selecting View allows users to view the
field data in the schema. Selecting Change allows users to view and
change the field data in the schema.

7. Select the Apply button to save the permission settings before selecting
another Group to work on.

8. After you make all your changes, select the Apply button in the Modify
Schema window. The changes you made are now applied to the schema.

Group Icon
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Setting Help for Schemas
Selecting the Set Help button in the Schema window brings up a Schema Help
Text editing window. You can supply help text for the selected schema here. In
most cases, this help text is simply a description of the schema and what it is
used for. For more information on setting help, see “Setting Help” on page 38.

Building and Using Schema Change History
The AR System automatically records information about the owner of a
schema, the user who last modified the schema, and the date of the
modification. You can display this information at any time by selecting the
Change History button at the bottom of the schema window to open the
Change History dialog box. For more information on viewing and modifying
change history information, see “Building and Using Change History” on
page 36.
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Defining Menus 5

This chapter describes how to create and modify pull-right menus. Once you
create a menu, you can attach the menu to any field on any schema on the
server. You can use the same menu for as many different fields as you desire.

You should be familiar with the information in Chapter 4 before you attempt to
design and create a menu.

The following topics are covered in this chapter:

• Creating a menu.

• Defining a menu list.

• Defining a menu that queries.

• Defining a menu that uses a file.

Creating Menus
You can create a menu (pull-right or list box) and attach it to any character data
field. A menu with two levels is shown in Figure 5-1.
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Figure 5-1 Character Menu

It is possible to define up to 15 menu levels, though you will probably want to
limit most menus to five levels or less. You define menus using a Create (or
Modify) Menu window that appears when you select Menu from the Category
menu and then select the Open or Create a New option from the Edit menu.

Note – The maximum number of items that can be displayed in a menu is 1600
for Motif clients, 1729 for Windows and Macintosh
clients.

There are three styles of menus that you can define:

Character You use the fields in the menu editing window to define the
menu as a series of label and value entries.
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To create a menu:
1. In the Admin Tool window, select Menus from the Category menu (or

type Ctrl+M ) to see a list of menus currently defined on the server.

2. To create a new menu, select Create a New from the Edit menu (or type
Ctrl+N ).

To open an existing menu for modification, select the menu and select Open
from the Edit menu (or simply double-click the menu or type Ctrl+O ).

To create and open a copy of a menu, select the menu you want to copy and
then select Copy from the Edit menu (or type Ctrl+C ). A new item will appear
in the list box as the selected item. The new item will be called Copy of <xxx>
where <xxx> is the name of the original menu. Select Open from the Edit menu
(or simply double-click the copy) to open.

The Create (or Modify) Menu dialog box appears, similar to that shown in
Figure 5-2 on page 138.

Query You specify a query, with any conditions, on another AR System
schema. You specify which field of matching entries to use as
the label and which to use as the value. When a user accesses
the menu, the AR System performs the query and places all
items retrieved on the menu. This method allows you to create
a dynamic menu that updates based on current conditions. In
addition, because permissions are checked at the time of the
query, only those users who have permission to view the source
fields and schema will be able to see the menu.

File You specify a file, located on either the client or the server, that
contains a formatted character menu. You can update this file
at any time; the changes will take effect the next time the menu
is referenced.



138 Action Request System Administrator’s Guide for OSF/Motif—January 1996

5

Figure 5-2 Create Menu — Character Window

3. If the correct name is not already assigned to the menu, edit the name in
the Menu Name field.

4. Select a value from the Refresh field for the menu by choosing one of the
following options:

Note – Refresh codes affect only a menu’s contents, not its definition and work
somewhat differently based upon the style of menu. The definitions of all
menus are updated every time you re-connect to a schema. But the refresh

On
Connect

Menu is retrieved when the user first opens it after selecting
the schema. It will not be updated until the user selects the
schema again.

On
Open

Menu is retrieved each time the user opens the menu. (Note
that frequent menu retrieval can have an impact on perfor-
mance. You should select this option only if it is critical that
the menu be absolutely up-to-date.)

On
15 Minute
Interval

Menu is retrieved every 15 minutes. This choice provides a
balance between the need to be current and the expense of
constant menu retrieval.
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codes which affect a menu’s contents work somewhat differently for character
menus than for file and query menus.
Refresh codes are disabled for character menus. The only way a character
menu is updated is when you re-connect to a schema.
If you select Open or 15 Minute Interval, the contents of file and query menus
are dynamically updated. However, if you select Connect, their contents are
updated only when you re-connect to a schema, just like character menus.

5. Select a menu type for the menu by choosing the Character, Query, or File
option. The remaining fields in the dialog box will change according to
the menu type you select.

Note – You cannot change the menu type of an existing menu. If you are
creating a menu by copying and modifying an existing menu, the menu you
select to copy must have the same menu type as the menu you want to create.

6. Fill in the rest of the fields in the dialog box as appropriate for the menu
type you have selected by following the applicable set of instructions
found later in this chapter:

• To define a character menu, see “Defining Character Menus” on page 139.

• To define a menu that queries another schema, see “Defining Query Menus”
on page 141.

• To define a file menu, see “Defining File Menus” on page 142.

7. When you have finished defining the menu, select the Set Help button to
enter help text for the menu. Select Apply to create the help text then
dismiss the Menu Help Text window.

8. When you are ready to save the menu, select the Apply button.

Defining Character Menus

To define a character menu:
1. Create or open the menu, then edit the menu name according to the

previous instructions.

2. Select a Menu Type of Character. This Menu Type choice will cause the
window to appear similar to that shown in Figure 5-2 on page 138.
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3. Select the level for which you want to add or modify menu choices by
selecting the radio button next to the level’s label. To add or modify menu
choices at the highest level, select Level 0. Select each successive menu
level to modify the choices at that level.

Menu choices added at levels below the top level (level 0) will be sub-items of
the selected item at the next highest menu level. For example, if you are adding
items at level 3, the items you add appear as sub-items for level 2.

4. Enter a label (the text that will show up in the menu). Enter a maximum of
30 characters.

5. If the text that you want to appear when the user selects this menu item
differs from the label text, enter the text you want to appear in the Value
field. Enter a maximum of 255 characters. (This text only appears in the
text field when a user selects the item. Nothing is put into the field if the
user only pulls the menu open to an intermediate item.)

If you do not enter different text, the label text will be displayed when the user
selects the item.

6. From the Add New Entries selection menu, select an option to determine
whether the entry you are defining is added to the top of the current list
of selections, the bottom of the list, or before or after the item that is
currently selected.

7. Select Add to add the item to the list. Select Modify to replace the
currently selected item with the new label and text.

8. Repeat steps 3 through 7 for the items at that menu level.

Note – You can put up to 99 items at each menu level.

9. To create a sub-menu item:

• Select the parent label in the current scrolling list (initially the list under
Level 0).

• Select the sub-menu level by selecting the level button above the scrolling
list for the sub-menu.

This indicates that the new label and text will belong at that level. If more
levels must be accessed than fit on the Character Menus window, use the
horizontal scroll bar.



Defining Menus 141

5

10. When you have finished creating menu items, select Apply to save the
menu definition.

Defining Query Menus

To define a menu that uses a query:
1. Select a Menu Type of Query. This Menu type will cause the window to

appear similar to the window shown in Figure 5-3 on page 141.

2. Create or open the menu, edit the menu name, and select a refresh code
according to the previous instructions.

Figure 5-3 Create Menu - Query Window

3. In the Server Name field, select the name of the server where the schema
that you are querying resides.

4. In the Schema Name field, select a schema.

5. In the Label field, select the name of a field on the schema you are
querying. The contents of this field will be used as a label for the menu
you are creating.
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6. In the Value field, select the name of a field on the schema you are
querying. The contents of this field will be used as the value for the menu
you are creating.

7. Select No or Yes to indicate whether or not you want the menu values
sorted by their label.

8. In the Qualification field, build a qualification that will determine which
items from the schema you are querying will be included in the menu list.
It is a good idea to make the qualification as specific as possible to avoid
building a list with an unmanageable number of items.

You can refer to current screen values by using $<field id>$. For example:

'Problem Summary' = $8$

Note – If you refer to a field on the current screen in the qualification, do not
use the pattern $MENU$ for any field that the menu is attached to. The server
cannot resolve the field references so the value will always be rejected.

9. Select Apply to save the menu definition.

For example, you could build a menu that brings up the names of everyone
with an open request to the help desk. To do so, you would select the server
and schema that contain the information, in this case perhaps AR-Help Desk
Tickets. You would then select the Submitter field as both the Label and Value.
Finally, you would build a qualification that would search for tickets with a
Status of Open.

Once you have created the menu, you can attach it to any character field on
any schema. You might use the menu created in this example as an aid to
performing queries on a particular caller’s open tickets on the AR-Help Desk
Calls schema.

Defining File Menus

To define a menu that uses a file:
1. Select a Menu Type of File. This Menu Type will cause the window to

appear similar to the window shown in Figure 5-4 on page 143.
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2. Create or open the menu, edit the menu name, and select a refresh code
according to the previous instructions.

Figure 5-4 Create Menu - File Window

3. In the File Name field, enter the name of the file that contains the menu
definition. See the next section, “Menu File Format, for how to structure
this file.

4. Indicate where the file is located by selecting a File Location of Server, if
the file is on the server system, or Client, if the file is on the system where
the Client is running.

5. Select Apply to save the menu definition.

Menu File Format

A menu file is a file that contains a formatted menu structure. Each line in the
file contains a definition of a menu entry in the format:

label\text
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To create sub-menu items under a specific item, use tabs to indicate a child
menu. (You can omit the text specification for any label that has sub-items.)

Note – You must use the tab key, not spaces, to indicate sub-menu items.

The following example shows a formatted menu file with three main items,
two of which have sub-items:

You can use a # sign in the first column to comment out lines in the menu file.

Setting Help for Menus
Selecting the Set Help button in the Create Menu window brings up a Menu
Help Text window. You can supply help text for the selected menu here. In
most cases, this help text is simply a description of the menu and what it is
used for. It is available for viewing and editing by AR administrators. For more
information on setting help, see “Setting Help” on page 38.

Building and Using Menu Change History
The AR System automatically records information about the owner of a menu,
the user who last modified the menu, and the date of the modification. You can
display this information at any time by selecting the Change History button at
the bottom of the menu window to open the Change History dialog box. For
more information on viewing and modifying change history information, see
“Building and Using Change History” on page 36.

OpenWindows\
2.0\OpenWindows 2.0
3.0\Openwindows 3.0

Motif\Motif 1.1
MS Windows\

3.0\Windows 3.0
3.1\Windows 3.1
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This chapter describes how to use the Administrator Tool to create and modify
filters. Once defined, filters test every server transaction to see if certain
conditions are met and respond to the conditions by taking specific actions. For
example, you might define a filter that notifies support staff members when
they are assigned responsibility for a new AR.

For a detailed discussion about filter design, refer to “Designing Filters” on
page 52.

The following topics are covered in this chapter:

• The Filter window.

• Opening a filter.

• Specifying filter conditions.

• Building filter qualifications.

• Specifying filter actions.

• Types of filter actions.

• Setting help for a filter.
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Using the Filter Window
You create and modify filters from within the Filter window, as shown in
Figure 6-1 on page 146. The Conditions section of the Filter window (top
section) is where you specify the conditions that will cause the filter to execute.
For example, the condition may be that the user submits an AR.

The Actions section (bottom section) is where you specify actions the filter will
take when specified conditions are met. For example, a filter condition may be
to look for “hardware” in the Problem Type field. The filter action may be to
automatically delegate the AR to the hardware support person.

Filters execute on the server machine. Each filter is attached to a single schema
on the server.

Figure 6-1 Filter Window
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Opening Filters
Follow these steps to open an existing filter or to create and open a new filter.

To open a filter:
1. In the Admin Tool window, select Filters from the Category menu (or type

Ctrl+F ) to see a list of filters available on the server.

2. To create a new filter, select Create a New from the Edit menu (or type
Ctrl+N ).

To open an existing filter for modification, select the filter and select Open from
the Edit menu (or simply double-click the filter or type Ctrl+O ).

To create and open a copy of a filter, select the filter you want to copy and then
select Copy from the Edit menu (or type Ctrl+C ). A new item will appear in
the list box as the selected item. The new item will be called Copy of <xxx>
where <xxx> is the name of the original filter. Select Open from the Edit menu
(or simply double-click the copy or type Ctrl+O ) to open.

The Filter window appears (Figure 6-1 on page 146). For new filters, the
window is blank. For existing filters or copies of existing filters, the current
values are shown.

3. Specify or change filter conditions according to the steps described in the
following section, “Specifying Filter Conditions”.

4. Specify or change filter actions according to the steps described in
“Specifying Filter Actions” on page 157.

Specifying Filter Conditions
This section describes how you use the top half of the Filter window to specify
filter conditions, as shown in Figure 6-2 on page 148. The filter conditions
define the criteria that a transaction must meet before the corresponding filter
actions take place. You specify conditions including:

• Name of the filter.

• The schema that the filter is to be applied to.

• The operations that will invoke the filter.
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• Whether the filter is enabled or not.

• The order in which the filter will execute in relation to other filters.

• The specific qualifications that limit the transactions on which the filter will
execute, as described in the following section, “Building Qualifications” on
page 150.

Figure 6-2 Specifying Filter Conditions

To specify or change filter conditions:
1. Open the filter you want to work with (see the previous section).

2. If the correct name is not already assigned to the filter, specify the filter
name in the Filter Name field.

Filter names may be up to 30 characters, including blanks, and must be unique.
There is no enforced convention for filter names, but it is helpful if the name is
descriptive and indicative of the filter’s function.

3. Enter the name of the schema the filter will act on in the Schema Name
field. You can select the list to choose from a list of schemas on the server.

A filter will not do anything until it is applied to a schema.

4. In the Execute On field, specify which operations will activate the filter by
selecting one or more of the options, as follows:

Query Filter will act when an AR is retrieved. You cannot use the
Query option to perform the Set Fields action.

Modify Filter will act when an AR is modified.
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You can select any combination of operations. If you select multiple options,
the filter will act when any one of the operations takes place.

5. In the Enable field, specify whether you want to activate the filter.
Selecting Yes activates the filter; selecting No turns it off. The default is
Yes.

6. Specify the filter execution order.

More than one filter may be designed to execute based on the same set of
conditions with the output from one filter affecting another. The Execution
Order field lets you specify the processing order for each filter. Valid values for
Execution Order are numbers between 0 and 1000 inclusive. Filters with lower
numbers are processed first. After each filter is processed, the AR System
reevaluates the conditions to verify that the conditions have not changed as a
result of the filter action, then executes the filter with the next lowest number.
You can assign the same number to multiple filters; however, there is no
guarantee about the processing order for filters that have the same number.

7. You can further refine your filter selection criteria by entering a
qualification statement in the Qualification field. You can specify whether
the qualification is to check conditions for the current transaction only, in
the database only, or both in the current transaction and the database. You
can enter the text directly, by typing it in, or building the qualification
using the query bar palette and Fields menu, as described in the next
section, “Building Qualifications.”

8. When you have finished specifying filter conditions and qualifications, go
on to specify the filter actions (see “Specifying Filter Actions” on
page 157).

Submit Filter will act when an AR is submitted.
Delete Filter will act when an AR is deleted.
Merge Filter will act when an AR is merged into the database from a

different database. (You can merge entries using the AR
Import Tool, as described in Chapter 11. You cannot merge
entries through the User Tool.)
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Building Qualifications
You can further refine the conditions that will activate a filter (or an active link
or an escalation) by specifying qualification criteria. Qualifications help to
narrow down the entries that will cause a filter, an active link, or escalation to
execute. You can type qualification criteria directly in the Qualification field or
you can build the qualification using the available palette and Fields menu,
shown in Figure 6-3.

You can define qualification criteria using any of the following techniques:

• Type information directly into the qualification field.

• Select a field or keyword from the Fields menu or dialog box to add a field.

• Select an operator from the palette to add an operator.

Figure 6-3 Building a Filter Qualification

You must follow a set of formatting conventions when you construct the
qualifications criteria. The formatting conventions are described below.

You will also use a set of operators and wildcard symbols that have specific
meaning to the AR System. You can concatenate a qualification string using
keywords, operators, and wildcards, as in the following query:

'Login Name' LIKE ("%" + $Submitter$ + "%")

The operators and wildcard symbols are described in Appendix D.

Add
operators
by selecting
from the
palette.

Select field
names from
the Fields
menu.
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Formatting Conventions

Use the following formatting conventions to construct qualification criteria in
the Qualification field:

Note – If the label includes a single quote, specify two single quotes when
entering the label. For example, if the field name is 'Doug's Tickets' , enter it
as 'Doug''s Tickets' . (This is done automatically when you select the field
from the Fields menu.)

Fields Enclose field labels in single quotations. Single quotations are
automatically added when you select fields from the menu button
list. Example: 'Short Description'

If two fields have the same label, the menu displays their field ID.
You can also reference fields by using their internal field ID. If
you use the ID, you must enclose it in single quotations.
For filters, you can specify whether the qualification is to check
field values in the transaction only, in the database only, or in
both the transaction and the database by using a prefix when you
enter the field name. To check the value for the transaction only,
enter the field name as 'TR.< field>'. To check the value in the
database only, enter the field name as 'DB. <field>' . To check the
value for the transaction first and then check the database if a
new value is not found in the transaction, enter the field name
with no prefix. For more information, see “Checking Transaction
vs. Database Values” on page 152.
Example (to check transaction only): 'TR.Submitter'

Example (to check database only): 'DB.Submitter'

The TR and DB prefixes are not used for active link or escalation
qualifications.
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Note – It is only possible to use a Status History reference in a filter
qualification if you are checking values in the database; Status History is not
meaningful if you are checking the value of the current transaction. See
“Checking Transaction vs. Database Values” on page 152 for more information
on checking field values in the database or in the transaction.
You cannot use Status History references in active link qualifications.

Checking Transaction vs. Database Values

In filter qualifications only, the qualification can access values in the database
for the current record as well as in the current transaction. This makes it
possible for you to perform state-transition checking using a filter qualification.
For example, you could define a filter that would watch for transactions where

Values Non-numeric values (including time, field, and keyword values)
must be enclosed in double quotations.
Example: ''07/01/92''

When entering time values, note that any integer (unquoted) will
be interpreted as a number of seconds. To specify a number of
minutes or hours, use a relative time value within quotes.
Example (to specify 10 hours): ''10:00''

Keyword values do not require surrounding quotes. (See “Table of
Keywords” on page 369 for available keywords.)
Example: 'Submitter' = $USER$

To query for ARs that have no value in a field, you can use the
keyword $NULL$.
Example (to query for ARs that have no value in the Assigned-to
field): 'Assigned-to' = $NULL$

Status His-
tory

Status History references must have the following information and
format:
* The name or ID of the Status History field (followed by a period).
* The name or index of the status value you want to match (followed by a
period).
* The keyword USER (for the user last changing to that status) or TIME
(for the time last changed to that status).
Example: 'Status-History.Fixed.TIME' < ''07/01/92''

This syntax is used automatically when you select the Status His-
tory reference from the Fields menu.
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the status is being changed to “Closed.” You can then check the database to
verify that the current status of the AR is “Fixed,” and reject the operation if
the status is anything other than “Fixed.”

There are three ways to specify a field reference in the filter qualification:

Filter Qualification Examples

The examples below show the steps you would follow to create three different
filter qualifications. The first example builds a qualification that will cause the
filter to act on current transactions with a status of either “Fixed” or “Closed.”
The second example builds a qualification that will cause the filter to act on
entries that required more than 10 hours to resolve.The third example builds a
qualification that causes the filter to test that a value has changed in a field.

Example 1:

The procedure below will build a qualification that causes the filter to act both
on transactions with a “Fixed” status and transactions with a “Closed” status.

1. In the Qualification field, select the Fields menu, then select the
Status  field. The name of the field appears enclosed in single quotes:

Transaction
Only

Check the value of the field in the current transaction only. If
the value is not changed in the transaction, it is considered to
be $NULL$. If the operation is a query or a delete, it is consid-
ered to be $NULL$. To specify a check of the transaction only,
use the format 'TR.< field>'  when you enter the field name in
the Run If or Set Field If fields.

Database Only Check the value of the field in the database only. No check is
made of the value in the current transaction. If the operation
is a create operation (submit), it is considered to be $NULL$.
To specify a check of the database only, use the format
'DB. <field>'  when you enter the field name in the Run If or
Set Field If fields.

Transaction or
Database

Check the value of the field in the current transaction and
use that value if changed. If not changed in the current
transaction, check the value of the field in the database. To
specify a check of both the transaction and the database, use
the format ' field'  when you enter the field name in the Run If
field.
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'Status'

2. To cause the filter to act on the current transaction only, move the cursor to
the beginning of the field name (after the single quote) and enter the
characters TR.  before the field name.

'TR.Status'

3. With the cursor positioned at the end of the qualification, select the =

(equal sign) operator from the palette. The operator is added to the
Qualification field, as follows:

'TR.Status' =

4. Type the field value Fixed  in the Qualification field, enclosed in double
quotes. The Qualification field now contains:

'TR.Status' = ''Fixed''

5. Select the OR operator from the palette. The OR operator is added to the
Qualification field:

'TR.Status' = ''Fixed'' OR

6. Select the Fields button and select the Status field again, then add the TR.

prefix as before. Move the cursor to the end of the field and select the
equal sign (=) operator. The Qualification field contains:

'TR.Status' = ''Fixed'' OR 'TR.Status' =

7. Complete your qualification by typing the field value Closed . Enclose it in
double quotes. The Qualification field now contains:

'TR.Status' = ''Fixed'' OR 'TR.Status' = ''Closed''

Example 2:

The procedure below will build a qualification that causes the filter to act on an
entry in the database where the difference between the current time and the
time the action request was entered in the AR System greater than 10 hours.
This example uses a status history reference as one of its values.

1. Select the Fields menu, then select TIMESTAMP from the KEYWORDS list. The
TIMESTAMP keyword will appear in the Qualification field, enclosed in
dollar signs:

$TIMESTAMP$
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2. Select the - (minus sign) operator from the palette in the filter
Qualification field. The operator is added to the Qualification field:

$TIMESTAMP$ -

3. Begin building the status history reference by entering a single quote
followed by the name of the status history field and a period, as follows:

$TIMESTAMP$ - 'Status-History.

4. Enter New to indicate the status value you want to match, followed by a
second period, as follows:

$TIMESTAMP$ - 'Status-History.New.

5. Enter the keyword TIME to indicate the time that the AR was entered.
Complete the value by entering a single quote. Your Qualification field
should contain the following:

$TIMESTAMP$ - 'Status-History.New.TIME'

This will cause the filter to calculate the difference between the time the AR
was entered with a “New” status and the current time.

Note – When you use a status history reference in the qualification, the AR
System assumes you are checking the value in the database, since status
history has no meaning in the current transaction. You do not need to preface
the field reference with “DB”.

You could also have entered the status history value by selecting it from the
Fields menu.

6. Continue building your filter qualification by selecting the > (greater
than) operator from the palette:

$TIMESTAMP$ - 'Status-History.New.TIME' >

7. Finally, enter a value of ten hours, enclosed in double quotes (see
“Formatting Conventions” on page 151 earlier in this chapter for
information on entering time values). Your qualification should now look
like the following:

$TIMESTAMP$ - 'Status-History.New.TIME' > ''10:00''
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This will cause the filter to determine if the result of the calculation of the
difference between the current time and the time of the entry’s creation is
greater than ten hours.

Example 3:

The procedure below will build a qualification that causes the filter to test that
a value has changed in a field.

1. In the Qualification field, select the Fields menu, then select the
field. The name of the field appears in the Qualification field enclosed in
single quotes:

'<field>'

2. To cause the filter to check the value of the field on the current transaction
only, move the cursor to the beginning of the field name (after the single
quote) and enter the characters TR.  before the field name.

'TR.<field>'

3. With the cursor positioned at the end of the qualification, click the != (not
equal sign) operator from the palette. The operator is added to the
Qualification field, as follows:

'TR.<field>' !=

4. In the Qualification field, choose the field again. The Qualification field
now contains

'TR.<field>' != '<field>'

5. To check the value of the field in the database only, move the cursor to the
beginning of the field name (after the single quote) and enter the
characters DB.  before the field name. The Qualification field now contains:

'TR.<field>' != 'DB.<field>'

6. Click the AND operator from the palette. The AND operator is added to the
Qualification field, as follows:

'TR.<field>' != 'DB.<field>' AND

7. Choose the field again, then add the TR.  prefix as before. Move the cursor
to the end of the field and click the equal sign (=) operator. The
Qualification field now contains:
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'TR.<field>' != ''DB.<field>' AND 'TR.<field>' =

8. Complete your qualification by choosing NULL from the KEYWORDS list. The
Qualification field now contains:

'TR.<field>' != ''DB.<field>' AND 'TR.<field>' = $NULL$

Specifying Filter Actions
You can specify up to 25 filter actions to be performed when an AR transaction
meets the conditions specified by the filter conditions. For example, actions
might include notifying a support staff person, setting the contents of certain
fields, or running a predefined process. If you specify multiple actions, you can
use the Shift buttons in the Filter Actions section of the Filter window to set the
order in which the actions will occur.

Here are the basic steps involved in creating, modifying or deleting a filter
action. The following sections provide a detailed description of the attributes
you must specify for each type of filter action.

Note – Use this section to obtain information on how to set actions for
escalations as well, since the Escalation Actions window looks and functions
like the Filter Actions window. See “Types of Escalation Actions” on page 197.

To create a filter action:
1. Open the filter you want to work with if it is not already open.

2. Make sure that the filter conditions and qualifications are specified
correctly, according to the instructions provided earlier in this chapter.

3. If this is a newly created (blank) filter, go to Step 5

4. If this is an existing filter and you want to create an additional action,
select the New Action button in the Filter window. The window changes
to allow you to specify a new action.

5. Select the action you want: Notify, Message, Log to File, Set Fields, or Run
Process.

The window displays the attribute choices for the action you have selected.
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6. Set the attributes as appropriate. Refer to the following sections for
information about setting attributes for a specific action.

7. When you have finished setting the attributes, select the Create/Modify
button to add the new action.

8. To create an additional action for the same filter, select the New Action
button.

9. Set attributes as appropriate for the additional action, then select the
Create button to add the action.

10. When you have defined all the actions you want for the filter, select Apply
to create the filter, then select Dismiss.

To modify a filter action:
1. Open the filter you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to modify.

3. Change the various attributes as appropriate. Refer to the following
sections for detailed information about setting attributes for a specific
action.

4. When you have finished making changes, select the Modify button.

5. When you have made all of the modifications you want to the filter’s
actions, select Apply to save the modified filter then select Dismiss.

To delete a filter action:
1. Open the filter you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to delete.

3. Select the Delete button to remove the action.

4. When you have made all of the modifications you want to the filter’s
actions, select Apply to save the modified filter then select Dismiss.
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Ordering Filter Actions

The order in which the actions defined for a filter will execute is indicated in
the Filter Actions section. If only one action is defined, it is labeled as 1 of 1. If
the action is one of 2 or more actions, it is labeled appropriately. If there are
three actions defined, for example, each is labeled as 1 of 3, 2 of 3, or 3 of 3, as
appropriate. When you move from one action to another using the Next and
Previous buttons, you will see the order indicator numbers change.

You can change the order in which the actions execute by using the Shift arrow
buttons located next to the order indicator. The shift buttons are left and right
arrows that let you adjust the order of the filter actions.

To change the order of filter actions:
1. Open the filter you want to work with if it is not already open.

2. Use the Next and Previous buttons to locate the action that you want to
move forward or backward in the execution order.

3. Use the left and right arrow Shift buttons to change the order in which
the actions will execute.

4. Continue to move between actions and adjust their order using the Shift
arrow buttons until the actions are in the desired order.

5. Select Apply to save the filter with the new action order then select
Dismiss.

Types of Filter Actions

Note – Use this section to obtain information on how to set actions for
escalations as well, since the Escalation Actions window looks and functions
like the Filter Actions window. See “Types of Escalation Actions” on page 197.

There are five types of filter actions you can specify:

• Notify issues a notification message to the designated user.

• Message returns a message and displays it for the user who activated the
filter. (Escalations do not support message actions.)

• Log to File writes an audit trail message to a specified file.
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• Set Fields assigns values to specific fields in the current AR.

• Run Process executes an operating system command or a program on the
server.

Each of the types is explained in the following sections.

The Notify Filter Action

When you choose the Notify filter action, all requests meeting the filter
conditions will use a mechanism you specify (such as email, the Notification
Tool, or the user’s default notify mechanism) to send text to one or more users
that you specify. For example, you could create a filter that would notify
support staff that they have been assigned a new AR.

To define the Notify filter action:
1. Select Notify in the Filter Actions section of the Filter window. The Filter

Actions section will change to present the fields required to define the
notify filter action, as shown in Figure 6-4.

Figure 6-4 Notify Filter Action

2. In the Notify Text field, enter a string, up to 255 characters in length,
which will be the text of the notification message.
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You can specify any of the keywords defined by the system (see “Table of
Keywords” on page 369) or you can substitute the value of any field of the AR
generating the notification by enclosing the field name or ID in dollar signs ($)
in the text. The keyword or field will be expanded when the notification is
sent.

You can select the menu next to the Notify Text field to open a list of all the
fields in the current schema as well as a list of keywords. You can simply select
one of these fields or keywords to have it included in the text.

The email notify text can contain returns. To place returns in your notifier text
you must open a text edit window for the Notify Text field. You can select the
text edit icon to open a text edit window for easier data entry, if desired.

3. In the User Name field, enter the name of the user to notify.

Note – You can enter the name of a group instead of the name of a single user.
This allows you to send notifications to all members of a group simultaneously.
Do not put the group name in dollar signs ($) or in quotes.

You can enter a field name or ID within dollar signs ($) to indicate that the
name of the user (or group) to notify is in a field on the AR. For example, to
send a message to the user who submitted the problem, you would enter
$Submitter$ .

You can select the menu next to the User Name field to display all the available
fields for the selected schema. The field you select will replace any value
currently in the field.

If the notification will be sent by email, you can enter the email address of the
person to be notified.

4. The Notify Priority field is reserved for future use by Remedy
Corporation.



162 Action Request System Administrator’s Guide for OSF/Motif—January 1996

6

5. Select a mechanism for delivery of the notification message. The available
mechanisms are:

Notifier Users will be notified with the specified text using the
Notification Tool. User can be any user logged into the
Notification Tool.
For more information on the Notification Tool, refer to
Chapter 8, Using the Notification Tool in the Action
Request System User’s Guide.

E-Mail The supplied text will be sent to the address specified in
the User Name field using electronic mail. The AR Sys-
tem will first try to resolve the contents of the User Name
field by checking for a User entry. If the user is found, the
email address is retrieved from the user record. If the
user cannot be found, the AR System checks for a Group
definition. If the name corresponds to a group name, the
message is sent to all members of the group specified.
Finally, if no User or Group definition is found, the con-
tents of the User Name field are used as a literal address
and the message is sent to the address specified via SMTP
mail on UNIX servers or Microsoft Mail on Windows NT
servers. This address could be an email address repre-
senting users that are not AR System users, an alias for a
group, or an email address representing a program.

User Default The filter will check the User record of the user to be noti-
fied and use the default notification method specified in
the User record. If no default notify mechanism is speci-
fied on the User record, the filter will attempt to notify
the user through the Notification Tool. If this attempt is
not successful, no notification will be delivered.

Cross
Reference

To use this notification mechanism, you identify another
field on the schema that will contain the notification
mechanism to use. The field selected must be a selection
or integer type. When you choose Cross Reference as the
notification mechanism, the Reference Field is activated.
(See the description of “Other” below for an explanation of
how the value of the field is interpreted.)
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6. The Reference Field is activated if you select Cross Reference. Select the
menu next to Reference Field to choose which field you want to use for
the cross reference. The menu lists the selection and integer type fields
available on the current schema.

Note – If you cross reference the value of a selection field, remember that the
first value stored in the database in a selection type field is 0 (zero), not one. As
a result, selecting the first value in a selection field will not alert users by the
notifier (because 0 means do not notify). In a selection field, 1 (for the notifier)
is actually the second value, 2 (for email) is the third value, and so on.

7. The Subject Line is activated if you select E-mail, User Default, Cross
Reference, or Other. In the Subject Line field, you can enter text of up to
255 characters which will appear on the subject line of your email
notification. You also can add any of the keywords defined by the system
(see “Table of Keywords” on page 369) or the value of any field of the AR
by entering the field name enclosed in dollar signs ($). The keyword or
field will be expanded when the notification is sent.

Select the menu next to the Notify Text field to display all the fields in the
current schema as well as a list of keywords. You can simply select one of these
fields to have it included in the text. In addition, the Text Edit Window choice
on the menu allows you to open a text edit window for easier data entry, if
desired.

8. The Fields list is activated if you select E-mail, Cross Reference, User
Default, or Other. Select fields from the list to specify a set of fields to be
delivered with the Notification (in addition to the Notify text).

Other Allows you to specify the index for the mechanism to use.
A value of 1 means notifier, a value of 2 means email, and
a value of 3 means user default. Any value from 4 to 98
will send the notification to a file named
<ar_install_dir>/db/notify <nn>.arn , where <nn> is
the number you selected. You can read the notifications
from this file or write a daemon (like a mail daemon) to
watch the file and take appropriate action. For example,
you could create a paging beeper daemon in this way.
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When you use email as a notification method, you can send the contents of
selected fields, as long as the user being notified has the appropriate
permissions for those fields.

You can choose from the following delivery options for notification:

No fields can be delivered using the Notification Tool so this list is grayed
when the Notifier choice is selected.

If the Notify mechanism is User Default and the User record specifies that the
Notification Tool is the default notify mechanism, any fields selected will be
ignored when the notification is delivered.

Note – The permissions of the target user are enforced when sending fields.
Only fields that the user has permission to view are delivered from the list of
fields specified. If no user match is found when sending email and the message
is directed to an email address specified in the User Name field, only publicly
viewable fields are delivered.

9. When you have finished specifying the Notify filter action, select the
Create/Modify button.

10. If you want to create an additional action for this filter, select the New
Action button. If you have finished defining conditions and actions for
this filter, select the Apply button then select Dismiss.

The Message Filter Action

When you choose the Message filter action, an interactive error, warning, or
note will be displayed by any application that initiates a transaction that meets
the filter conditions.

None No fields are included with the notification.

List Selected fields from the list box are included with the notifi-
cation.

Changed Only fields which have changed in the current transaction
are included with the notification.

All All fields of the entry are included with the notification.
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Note –  Escalations do not support message actions.

To define the Message filter action:
1. Select Message in the Filter Actions section of the Filter window. The

Filter Actions section will change to present the fields required to define
the message filter action, as shown in Figure 6-5.

Figure 6-5 Message Filter Action

2. In the Message Text field, enter a string, up to 255 characters in length,
which will be the text of the message. The text may include field
substitution parameters or system keywords.

You can select the menu next to the Message Text field to display a menu
containing a list of all the fields in the current schema as well as a list of
keywords. You can simply select one of these fields or keywords to have it
included in the text. In addition, you can select the text edit icon to open a text
edit window for easier data entry, if desired.
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3. Select a message type for the message. The message type will be
displayed with the message. The available message types are:

4. Specify a message number in the Number field. The message number will
be displayed with the message. The number you specify must be greater
than or equal to 10000. (Numbers under 10000 are reserved for AR System
messages.)

5. When you have finished specifying the message filter action, select the
Create/Modify button.

6. If you want to create an additional action for this filter, select the New
Action button. If you have finished defining conditions and actions for
this filter, select the Apply button then select Dismiss.

The Log to File Filter Action

When you choose the Log to File filter action, all operations meeting the filter
conditions will be appended to an ASCII file on the AR server. Each log entry
includes a date and time stamp, the name of the user whose action triggered
the filter, the name of the schema, the entry’s ID number, and the fields
included in the transaction. This creates an audit trail of transactions meeting
the filter condition.

Note – If for any reason or at any time there is a failure writing to the log file,
a warning message is written to the arerror.log  file and the AR System will
log the filter or escalation activity to the
<ar_install_dir>/db/ar.log  file instead. This warning message appears
only once, not at every instance of logging failure.
The ar.log  file is used only when there is a failure to write to the log file you
specify. The AR System continues to try to log filter or escalation activity to the

Note Returns a note and continues the operation.The message
type is displayed as ARNOTE.

Warning Returns a warning and continues the operation. The mes-
sage type is displayed as ARWARN.

Error Returns an error and terminates the operation. The message
type is displayed as ARERR.
For example, you can use an error type message to require
users to enter a value into a field before submitting an AR
even if the field is not normally a required field.
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log file you specify in this action, but if it is unsuccessful, will write to the
ar.log  file.
The next time the system successfully writes to your log file, a message is also
written to the arerror.log  file.

To define the Log to File filter action:
1. Select Log to File in the Filter Actions section of the Filter window. The

Filter Actions section will change to allow you to define the log to file
action, as shown in Figure 6-6 on page 167.

Figure 6-6 Log to File Filter Action

2. Specify the full directory pathname of the file to log to in the File Name
field. If needed, you can select the text edit icon to open a text edit
window for easier data entry.

3. When you have finished specifying the log to file filter action, select the
Create/Modify button.

4. If you want to create an additional action for this filter, select the New
Action button. If you have finished defining conditions and actions for
this filter, select the Apply button then select Dismiss.
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The Set Fields Filter Action

When you choose the Set Fields filter action, the resulting filter will load
specific values into selected fields for each transaction that meets the filter
conditions. This allows you to automate field updates in entries. For example,
you can define a filter that will automatically set the State field to “Assigned”
every time the Assigned-to entry gets set to a support staff name.

Note – A Set Fields action will be ignored for filters that are based on a Query
operation. This is because the system does not allow updates during a read
operation.

The value you assign to a field can be a simple static value, a keyword, a field
from another schema, the result of a function, or the results of an executing
process or arithmetic operation. These options are described in detail in the
following sections.

Note – You can also assign values to hidden fields. Hidden fields are shown
with dimmed labels in the Set Fields window.

If you assign a value to a diary field, the value is appended to any user text
already in the field.

To define the Set Fields filter action:
1. Select Set Fields in the Filter Actions section of the Filter window. A Set

Fields button appears in the window. Select the Set Fields button to open
the Set Filter Fields window, as shown in Figure 6-7.



Defining Filters 169

6

Figure 6-7 Set Filter Fields Window

2. In the From Schema field, use the menu to enter
CURRENT TRANSACTION if the value is to come from another field on the
same AR or is to be only static values or keywords. You also can use the
menu to enter the name of a schema on the server to specify from where
the AR System is to retrieve the value for the field.

Note – If you enter a schema different than the CURRENT TRANSACTION but you
use a static value or a keyword or you do not actually set a field from the
remote schema, the schema reverts to the
CURRENT TRANSACTION.

3. Enter the values in the schema fields that you want to be automatically set
when the filter executes. You can use the commands available through the
Edit menu of the Set Filter Fields window, as described below in “Using
the Set Fields Edit Menu” on page 170. You can use the MENU button in a
field to pull up a selection list of available fields, functions, and keywords
or to open a text edit window.

Note – Since filters and escalations execute with administrator permissions,
field values set through a filter are updated regardless of whether or not the
user has update permissions for the field.
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You can set field values to any of the following:

• A static value. Enclose text values that include special characters, such as
parentheses, single quotes, or arithmetic operators, in double quotes.

• A keyword value (see “Assigning Keyword Values” on page 171).

• A value from another field in the same schema or another schema on the
server (see “Assigning Values from Other Fields” on page 171)

• The value resulting from a specified process (see “Assigning Values from
Process Results” on page 173).

• The value resulting from an arithmetic operation (see “Assigning Values
Using Arithmetic Operations” on page 174).

• The value resulting from a function (see “Using Function Results in Set
Fields” on page 175).

• A combination of the above. You might want to combine a static text entry
with a keyword, for example, 'Entry entered by' + $USER$ .

4. If the data or value you want is on a different AR, create a qualification to
locate the specific AR.

5. When you have finished entering the values to set, select the Apply
button on the Set Fields window to save the field values you want to load.

6. If you want to create an additional action for this filter, select the New
Action button. If you have finished defining conditions and actions for
this filter, select the Apply button then select Dismiss.

Using the Set Fields Edit Menu

The Edit menu in the Set Filter Fields window contains the following
commands to help you set values:

Clear Clears all values in the window.
Reset Resets the field values in the window to those

defined when the settings in this window were
last applied.
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Assigning Keyword Values

You can use any of the keywords listed in “Table of Keywords” on page 369 to
set a field value. The data type of the keyword value must match the field data
type. Use the MENU mouse button in any field to see and select from a list of
available keywords.

Assigning Values from Other Fields

You can set a field to a value drawn from another field on the current
transaction or an AR from the same or another schema (on the same server).
Each action can draw data only from a single AR. However, you can use data
from multiple ARs by creating additional actions.

When you assign a value from an existing AR, you must specify the schema
that you want and define the qualification criteria that will locate the specific
AR within that schema. If only one AR matches the qualification when the
filter executes, the requested values are pulled from the AR and loaded as
values on the current window. If no ARs match the qualification, the field is set
to a null value. If multiple entries match, the values are drawn from the first
AR that meets the qualifications. (This differs from active links, which provide
a selection list in the case of multiple matches.)

Note – There will be no notification to the user that multiple matches were
found in a set fields filter action.

To assign a value from another field in the current transaction:
1. In the Set Filter Fields window, make sure the From Schema field is set to

CURRENT TRANSACTION.

Toggle Field Display Toggles (switches) the display type of the
selected field between the type chosen for the
field and a text display type. For example, you
can toggle the display of a radio button field to a
text display if you want to enter a field name to
retrieve the value from another schema.
If you toggle from a menu to a text field, you can
enter the numeric value of a field as well as a
label value (for example, FIXED).
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2. If the field you are loading a value for is a radio button, selection menu,
or numeric text field with arrows, use the Toggle Field Display command
on the Edit menu to switch the field to a text line.

3. Place the mouse cursor in the field where you want the value loaded and
use the MENU mouse button to pop up a menu of available fields.

4. From the menu, select the field from which the value will be drawn when
the filter executes.

To assign a value from a different AR:
The following steps apply to both filters and escalations.

1. Use the MENU mouse button to open the From Schema field menu. Then
select the schema from which you want to retrieve the data. Note that you
can only access schemas that are on the same server.

2. If the field you are loading a value for is a boxradio button, selection
menu, or numeric text field with arrows, use the Toggle Field Display
command on the Edit menu to switch the field to a text line.

3. Place the mouse cursor in the field where you want the value loaded and
use the MENU mouse button to pop up a menu of available fields. The fields
that appear in the listing are from the schema shown in the From Schema
field.

4. From the menu, select the field from which the value will be drawn when
the filter executes.

5. Use the Qualification field at the bottom of the Set Filter Fields window to
define the qualification criteria that will locate the specific AR from which
the data will be drawn.

Use the Fields menu to reference fields in the schema you are drawing data
from. These fields will be delimited with single quotes.

Use the MENU button in the Qualification field to reference the value of a field in
the current transaction. These fields will be delimited with dollar signs ($).

For example, if you want to find the AR where the Entry Id field of the From
Schema contains the same ID as the Related-to field in the current transaction,
the qualification would look like this:

'Entry Id' = $Related-to$
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For a more detailed description of constructing qualification statements, see
“Building Qualifications” on page 150.

6. When you have finished specifying the qualification, select the Apply
button in the Set Filter Fields window then select Dismiss.

Assigning Values from Process Results

You can set a field to the value resulting from running a specified process. For
example, you may want to load information about the current system or
information retrieved from another data source (such as an existing database
holding contact information). To do so, you can define and run a process
whose stdout  output will be used as the value for a field.

The syntax for loading the return of a process is as follows:

$PROCESS$ <process-to-run>

Note – Security Alert:The process will run with the same privileges as the AR
server. If the server is running with root privileges, the process will run with
root privileges.

Note – ■ Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the
explicit path to commands, for example,
/home/jim/bin/ <command>. In the Windows NT
environment, you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).
■ On the Windows NT server, you can only run a process that
runs in a console (like a .bat script or runmacro.exe ) or that
creates its own window. If the process does create a window,
the window appears on the server system where the
AR System is running.
■ In the UNIX environment, the process will run under
a Bourne shell.
■ Use quotes around substituted fields when the values
may contain blanks or other special characters, for
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example, $PROCESS$ /bin/cmd  "$<field>$"
■Substituted field values containing carriage return or
other special characters may have unexpected results.

The keyword $PROCESS$ indicates that all following text is a command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can enter up to 255 bytes for your command
definition. The command can be up to 4096 bytes once the substitution
parameters are expanded. You can select substitution parameters (as well as
the $PROCESS$ string) from a pop-up menu on each field on the window.

When the filter is performed, the specified command line will be executed on
the server. All data returned to stdout  will be read by the User Tool and
processed according to the return of the process. If the process returns 0, the
returned data is used as the value for the field. The data is expected in ASCII
format and is converted as needed to match the data type of the target value. If
the process returns a value other than 0, it is assumed there was an error and
the process failed. In this case, the data returned in stdout  is treated as the text
of an error message and is returned to the user. All other server activity is
blocked until the process completes or exceeds the process interval.

If the process does not complete within a defined interval, the server continues
processing and ignores the process response. The process interval is configured
using the Server Information window. See Chapter 1 for information on using
the Server Information window.

Assigning Values Using Arithmetic Operations

You can use arithmetic operations to load a computed value. You can combine
an arithmetic operation with a static value, a keyword, a value from the current
screen or an existing AR, or a value from a process. The same arithmetic
operations allowed for specifying qualifications are allowed to build a
computed value (see “Table of Operators” on page 366). The operation must
meet all the rules for arithmetic operations and produce a result whose type is
compatible with the target field.
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Note – If you include a process result in a mathematical operation, the process
definition must not be contained within parentheses and it must be the last
item in the operation since all data after the keyword $PROCESS$ is considered
to be part of the command line.

Here are some examples of valid arithmetic operations:

$TIMESTAMP$ - $CREATE-DATE$

$FIRST NAME$ + '' '' + $LAST NAME$

''hostname ='' + $PROCESS$ hostname

Using Function Results in Set Fields

The AR System supports a set of functions that you can use in the set fields
action. The functions allow you to manipulate data so that you can control
various aspects of values you are loading into fields. For example, you can use
the UPPER function to convert the value loaded in a field to all uppercase.

To assign a value using a function in the set field operation:
1. Use the MENU mouse button in the field. Display the FUNCTION submenu

to see a list of the available functions.

2. Select the function you want to use. It will appear in the field with a set of
parentheses to its right.

3. Within the parenthesis, enter any arguments that are appropriate for the
function you have selected. (With the exception of $PROCESS$, you can
include keywords, field values, and arithmetic operations).

Note – If the value of any of the arguments of a function is NULL, the result of
the function is NULL (the field is blank). To avoid this result, use a
qualification that tests that the transaction includes a value for all arguments.
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Information about each of the functions supported by the AR System is
provided in Table 6-1.

Table 6-1 Functions in Set Fields Actions  (1 of 6)

Function Return Argument(s) Description

DATE char (timestamp) Returns the date portion of
the timestamp.

DAY long (timestamp) Returns the day of the times-
tamp (1 to 31).

HOUR long (timestamp) Returns the hour of the times-
tamp (0 to 23).

LEFT char (char,long) Returns the left most bytes of
the first parameter (char) up
to the number of bytes indi-
cated by the second parame-
ter (long).
For example, to set the value
of a field to the first ten char-
acters of the Submitter name,
you would enter:
LEFT($Submitter$,10)

LENGTH long (char) Returns the number of char-
acters in the string (char).

LOWER char (char) Returns all characters in the
string (char) as lowercase
characters (downshifts all
characters).
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LPAD char (char,long,char) Returns the value that results
from padding the first param-
eter (char) to the left with the
value of the third parameter
(char) so that the resulting
value is the length of the sec-
ond parameter (long).
For example, if you want the
results of a set field operation
to be a 15 character value pre-
fixed with the word LEAD,
followed by zeros, and ending
in the contents of the integer
field “Call #” you would

enter:

LPAD($Call #$,15, \
"LEAD00000000000")

If the Call # field contains the
number 947, the result of the
set field operation will be
LEAD00000000947 . If the Call
# field contains the number
122334556, the result of the
set field operation will be
LEAD00122334556 .

LTRIM char (char) Returns the value of (char)
after deleting any blank
spaces to the left.

Table 6-1 Functions in Set Fields Actions  (2 of 6)

Function Return Argument(s) Description
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MAX any
(matches
input)

(any,any[,any]...) Returns the maximum value
of the set specified. The
datatype of all values must
match in order for the result
to be meaningful.
For example, to check the cur-
rent time and the escalation
time and return only the
greater (latest) value of the
two, you would enter:
MAX ($Escalate Date$, \
$TIMESTAMP$)

MIN any
(matches
input)

(any,any[,any]...) Returns the minimum value
of the set specified. The
datatype of all values must
match in order for the result
to be meaningful.
For example, to check the cur-
rent time and the escalation
time and return only the
lower (earliest) value of the
two, you would enter:
MIN ($Escalate Date$, \
$TIMESTAMP$)

MINUTE long (timestamp) Returns the minute of the
timestamp (0 to 59).

MONTH long (timestamp) Returns the month of the
timestamp (1 to 12).

Table 6-1 Functions in Set Fields Actions  (3 of 6)

Function Return Argument(s) Description
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REPLACE char (char,char,char) Returns the value that results
from replacing any occur-
rences of the second parame-
ter (char) found in the first
parameter (char) with the
contents of the third parame-
ter.
For example, to replace the
name Bob with the name Rob-
ert if Bob is found in the Sub-
mitter field, you would enter:
REPLACE($Submitter$, \
"Bob","Robert")

RIGHT char (char,long) Returns the right most bytes
of the first parameter (char)
up to the number of bytes
indicated by the second
parameter (long).
For example, to set the value
of a field to the last four char-
acters of an account code, you
would enter:
RIGHT($Account#$,4)

ROUND long (real) Returns the rounded value of
a real number. For example,
5.1 to 5.4 are rounded to 5, 5.5
to 5.9 are rounded to 6.

RPAD char (char,long,char) Returns the value that results
from padding the first param-
eter (char) on the right with
the value of the third parame-
ter (char) so that the resulting
value is the length of the sec-
ond parameter (long).

RTRIM char (char) Returns the value of (char)
after deleting any blank
spaces to the right.

Table 6-1 Functions in Set Fields Actions  (4 of 6)

Function Return Argument(s) Description
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SECOND long (timestamp) Returns the second of the
timestamp (0 to 59).

STRSTR int (char,char) Returns an integer indicating
the position of string 2 if it is
found in string 1. If string 2 is
not found, returns a -1.

SUBSTR char (char,long,[,long]) Returns the substring of char-
acters in the first parameter
(char) starting at the position
indicated by the second
parameter (long) and continu-
ing to the position indicated
by the third parameter (long).
The string is 0 indexed (num-
bering of characters begins at
0). If the third parameter is
not included, returns charac-
ters to the end of the string.
For example, to set the value
of a field to six characters of
the Location field, skipping a
three character prefix, you
would enter:
SUBSTR($Location$, 3, 9)

TIME char (timestamp) Returns the time portion of
the timestamp.

TRUNC long (real) Returns the truncated value
of a real number. For exam-
ple, 5.1 through 5.9 are trun-
cated to 5.

UPPER char (char) Returns all characters in the
string (char) as uppercase
characters (upshifts all char-
acters).

Table 6-1 Functions in Set Fields Actions  (5 of 6)

Function Return Argument(s) Description
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The Run Process Filter Action

Choosing the Run Process filter action allows you to execute a command to run
a process. When an AR transaction meets the filter conditions, the system will
execute the command specified in the Command Line field. For example, you
could specify a program in the Command Line field that will automatically fix
a problem described in the AR fields. The command line also accepts
parameters.

Note – Security Alert: The process executed with the Run Process command
will be executed with the same permissions as the AR server. You should
consider this carefully when defining filter actions as it may have security
implications for your system.

To define the Run Process filter action:
1. Select Run Process in the Filter Actions section of the Filter window. The

Filter Actions section will change to present the fields required to define
the run process filter action, as shown in Figure 6-8.

WEEKDAY long (timestamp) Returns the weekday of the
timestamp (1 to 7, 1=Sunday,
7=Saturday).

YEAR long (timestamp) Returns the year portion of
the timestamp.

Table 6-1 Functions in Set Fields Actions  (6 of 6)

Function Return Argument(s) Description



182 Action Request System Administrator’s Guide for OSF/Motif—January 1996

6

Figure 6-8 Run Process Filter Action

2. In the Command Line field, enter the command that will execute when
filter conditions are met.

You can specify any of the keywords defined by the system (see “Table of
Keywords” on page 369) or you can substitute the value of any field of the AR
generating the notification by enclosing the field name or ID in dollar signs ($)
in the text. The keyword or field will be expanded when the process is run. If
the expanded value contains spaces, remember to enclose the value within
quotes so that the operating system will interpret it as a single value. If in
doubt, use quotes. They will not interfere and they may prevent a problem.

You can enter up to 255 bytes for your command definition. The command can
be up to 4096 bytes once the substitution parameters are expanded.

You can select the menu next to the Command Line field to display the
available keywords and fields in the current schema. You then simply select
one of these fields to have it appended to the command. In addition, you can
select the text edit icon to open a text edit window for easier data entry, if
desired.

Note – ■ Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the
explicit path to commands, for example,

Field contents
can be passed
as parameters.
Enclose field
name with
$ symbols.
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/home/jim/bin/ <command>. In the Windows NT
environment, you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).
■ On the Windows NT server, you can only run a process that
runs in a console (like a .bat script or runmacro.exe ) or that
creates its own window. If the process does create a window,
the window appears on the server system where the
AR System is running.
■ In the UNIX environment, the process will run under
a Bourne shell.
■ For UNIX, use quotes around substituted fields when the
values may contain blanks or other special characters, for
example, /bin/cmd  "$<field>$"
■Substituted field values containing carriage return or
other special characters may have unexpected results.

3. When you have finished specifying the command for the filter action,
select the Create/Modify button.

4. If you want to create an additional action for this filter, select the New
Action button. If you have finished defining conditions and actions for
this filter, select the Apply button, then select Dismiss.

Using the runmacro.exe Utility from the Command Line

For the Windows NT server, you can execute a Run Process filter action using
runmacro from the Command Line field. The runmacro.exe  utility, located in
your <ar_install_dir>\bin  directory, takes arguments from the command
line to run macros, as in the following example:

c:\remedy\bin\runmacro   -h \\obelix\home    -e "TestMacro"
-p "Submitter"=$USER$   -x $SERVER$

Note – When creating macros, you can record a login with the proper
permissions if you are performing actions that require those permissions, for
example, an administrator deleting ARs. If your macro does not record a login,
you must use the -h option to specify the directory that contains the ar.ini

file.
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Command Line Options

You can enter the following runmacro options in any order on the command
line:

Setting Help for Filters
Selecting the Set Help button in the Filter window brings up a Help Text
editing window. You can supply help text for the filter here. In most cases, this
help text is simply a description of the filter, and is available for viewing and

-h Use the -h option to specify a path to the <ar_config_dir> direc-
tory<ar_config_dir>\arcmds  if you are using an ar.ini file that contains
the user and password information for the user running the macro. If
you do not specify the -d option, runmacro  also looks in this directory
for the <ar_config_dir> \arcmds directory that contains the macro to
be run.
You can create separate home directories for each user that you want
to run a macro. To run a user’s macros, copy the user’s home directory
from the machine where they run the User Tool to the Windows NT
server and specify it with the -h option, or use the -h option to point
to the user’s home directory on the machine where they run the User
Tool.
Warning: The ar.ini  file contains the user and password information
of the last person logged into the machine. If two people are sharing a
PC, make sure that you access the correct ar.ini  file.

-d If your macro is not in the <ar_config_dir >\arcmds  directory or if
you do not have a <ar_config_dir > directory, use the -d option to
specify the directory that does contain the macros.

-e Specify the macro to be run.
-p Specify a value for a parameter. There may be more than one -p

option in a command line. If the macro specified (using the -e  option)
has a parameter, a value can be supplied by naming that parameter
and assigning a value. If either the parameter name or value includes
a space or other special character that is interpreted by the command
line, the parameter must be enclosed in quotes to stop the interpreta-
tion of the special characters.

-x Specify the name of a server to connect to. The -x option may be
included more than once to connect to multiple servers.
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editing only by AR System administrators and subadministrators who have the
filter open. For more information on setting help, see “Setting Help” on
page 38.

Building and Using Filter Change History
The AR System automatically records information about the owner of a filter,
the user who last modified the filter, and the date of the modification. You can
display this information at any time by selecting the Change History button at
the bottom of the Filter window to open the Change History dialog box. For
more information on viewing and modifying change history information, see
“Building and Using Change History” on page 36.

Tracing Filter Activity
You can activate the filter debug trace mode on the server to create a log file of
filter activity. This server option logs information about filter activity for each
operation, including the filters that executed and whether or not filter
execution was successful. By default, the log file is called arfilter.log . See
“Log Files Information” on page 21 for more information on creating a filter
log file.
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Defining Escalations 7

This chapter describes how to use the Administrator Tool to create and modify
time-based escalations within the AR System. An escalation is a general
purpose capability that allows a condition to be checked on a regular basis
and, if met, performs one or more actions.

For example, you might define an escalation that sets the Assigned-Priority to
Urgent if the trouble ticket is not closed within 24 hours. Or you may choose to
escalate tickets to a Critical priority when they have not been addressed in one
hour.

For a detailed discussion about escalation design, see “Designing Escalations”
on page 55.

This chapter covers the following topics:

• The Escalation window.

• Opening an escalation.

• Specifying escalation conditions.

• Specifying escalation actions.

• Types of escalation actions.

• Setting help for an escalation.
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Using the Escalations Window
You create and modify escalations within the Escalation window, as shown in
Figure 7-1. The Conditions section of the Escalation window (top section) is
where you specify the conditions that will cause the escalation to be checked
by the AR server.

The Actions section (bottom section) is where you specify actions the escalation
will take when the execution intervals are checked by the server and specified
qualifications are met. For example, an escalation qualification might look for
“New” in the Status field. The escalation action then might automatically
delegate the AR to the hardware support person.

Figure 7-1 Escalation Window
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Opening Escalations
Follow these steps to open an existing escalation or to create and open a new
escalation.

To open an escalation:
1. In the Admin Tool window, select Escalations from the Category menu (or

type Ctrl+X ) to see a list of escalations on the server.

2. To create a new escalation, select Create a New from the Edit menu (or
type Ctrl+N ).

To open an existing escalation for modification, select the escalation and select
Open from the Edit menu (or type Ctrl+O  or simply double-click the
escalation).

To create and open a copy of an escalation, select the escalation you want to
copy and then select Copy from the Edit menu (or type Ctrl+C ). The new item
will appear in the list box as the selected item. The new item will be called
Copy of  <xxx> where <xxx> is the name of the original escalation. Select Open
from the Edit menu (or type Ctrl+O  or simply double-click the copy) to open.

The Escalation window appears (Figure 7-1 on page 188). For new escalations,
the fields are blank. For existing escalations or copies of existing escalations,
the current values are shown.

3. Specify or change escalation conditions according to the steps described
in the following section, “Specifying Escalation Conditions.”

4. Specify or change escalation actions according to the steps described in
“Specifying Escalation Actions” on page 195.

Specifying Escalation Conditions
This section describes how you use the top half of the Escalation window to
specify escalation conditions, as shown in Figure 7-2 on page 190. The
escalation conditions define the criteria that a transaction must meet before the
corresponding escalation actions take place. You specify conditions including:

• The name of the escalation.

• The schema associated with the escalation.
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• The execution time settings that trigger the escalation, defined either at an
interval or at a certain time.

• Whether the escalation is enabled or not.

• Specific qualifications that limit the entries on which the escalation will
execute, as described in “Building Qualifications” on page 150.

Figure 7-2 Specifying Escalation Conditions

To specify or change escalation conditions:
1. Open the escalation you want to work with (see the previous section).

2. If the correct name is not already assigned to the escalation, specify the
escalation name in the Escalation Name field.

Escalation names must be unique. There is no enforced convention for
specifying escalation names, but it is helpful to make the name descriptive and
indicative of the escalation’s function. Names may be up to 30 characters,
including blanks.

3. Enter the name of the schema the escalation will apply to in the Schema
Name field. You can select the list icon to choose from a list of schemas on
the server.

An escalation is associated with a single schema.
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4. In the Execution field, specify the time setting for the AR server to check
the escalation.

• Select Interval to cause an escalation to be checked at a regular interval (for
example, every 30 minutes, every 6 hours, every 7 days, or any combination
of days, hours, and minutes). The interval begins when you create, modify,
or enable the escalation.

For more on setting execution intervals, see the following section, To set an
execution interval.

• Select Time to cause an escalation to be checked at a specified time (for
example, every day at 4:00 PM or 1600 hours). Unlike the Interval setting,
the execution time is not checked immediately; the server waits until the
time that you set. Selecting Time allows you to check escalations at irregular
intervals, for example, every 24 hours or the 15th and 31st of every month
or weekdays at 4:00 PM.

For more on setting execution times, see “To set an execution time:” on
page 192.

5. In the Enable Escalation field, specify whether you want to activate the
escalation. Selecting Yes activates the escalation; selecting No turns it off.

6. You can further refine your escalation selection criteria by entering a
qualification statement in the Query field. You can enter the text directly,
by typing it in, or building the qualification using the query bar palette
and Fields menu, as described in “Building Qualifications” on page 150.

7. When you have finished specifying escalation conditions, go on to specify
the escalation actions (see “Specifying Escalation Actions” on page 195).

To set an execution interval:
You can set the AR server to check the escalation at regular intervals. The
server checks the interval immediately and then at its set interval (for example,
every 4 hours).

1. After you have specified the Escalation Name and Schema name, select
Interval in the Execution field.
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2. In the Days/Hours/Mins fields, select the execution interval. The server
checks the escalation at each interval you set (beginning when you set the
interval). For example, if you set the interval to 1 hour, the server checks
the escalation immediately, then every hour. Make the execution interval
as large or small as you need.

3. When you have finished specifying escalation conditions, go on to specify
the escalation actions (see “Specifying Escalation Actions” on page 195).

To set an execution time:
Depending on your escalation, you can cause the AR server to check the
escalation at different times and even at irregular intervals. For example, you
can use the Days of Week and Hours of Day categories to execute escalations
Monday through Friday at 8:15 (AM) and 16:15 hours (4:15 PM). Or you can
use the Days of Month and Hours of Day categories to create escalations that
execute on the 15th and 31st of every month at 8:00 AM.

1. After you have specified the Escalation Name and Schema name, select
Time. The Calendar button is activated.

2. Click Calendar. The Escalation Time Specification window appears, as
shown in Figure 7-3 on page 193. You can choose days of the month, days
of the week, hours and minutes of the day, or any combination.
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Figure 7-3 Escalation Time Specification Window

3. If you want the server to check the escalation on a specific day or days of
the month, select the days in the Day of Month field. Selecting All sets the
entire month. If you do not select any minutes, the server checks the
escalation at the default setting of 0 minutes and 0 seconds for the day of
the month selected.

4. If you want the server to check the escalation on a specific day or days of
the week, select the days in the Day of Week field. Selecting All sets the
entire week. If you do not select any minutes, the server checks the
escalation at the default setting of 0 minutes and 0 seconds for the day of
the week selected.
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You can combine Day of Month with Day of Week. If you select the 15th and
31st days of month and Monday and Friday, the server checks the escalations
on the 15th and 31st as well as all Mondays and Fridays during the month. If a
Friday occurs on a 15th or 31st, the server checks the escalation only once.

Warning – In the AR System, selecting the 31st day of month creates an
escalation on the last day of the month for all months, including February.

5. In the Hour of Day field, select the hours of the day that you need.

You must set the Hour of Day field to create an escalation but it must also be
combined with either Day of Month or Day of Week. You cannot set Hour of
Day by itself. For example, you can combine the following:

• Day of Month with Hour of Day.

• Day of Week with Hour of Day.

• Day of Month and Day of Week with Hour of Day.

If you do not set an Hour of Day or if you set only the Hour of Day field, the
AR System returns an error message when you select Apply on the Escalation
window.

6. In the Minute field, enter the minutes past the hour. The Minute Field is
particularly useful for staggering escalations so that they balance the load
on the server. For example, you can order escalations so that the server
checks some escalations on the hour, others at 15 minutes past the hour,
still others at 30 minutes past the hour, and so on.

This window uses a 24-hour clock. For example, to trigger an escalation at
10:30 PM, select 22 from the Hour of Day field and enter 30 in the Minute field.

7. Select Apply.

8. Select Dismiss to close the Escalation Time Specifications window. When
you have finished specifying escalation conditions, go on to specify the
escalation actions (see “Specifying Escalation Actions” on page 195).
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Specifying Escalation Actions
You can specify up to 25 actions to be performed when an entry meets the
conditions specified by the escalation conditions. For example, actions might
include loading a value into a field on the AR and notifying the escalation
manager about the escalation. If you specify multiple actions, you can use the
Shift buttons in the Actions section of the Escalation window to set the order in
which the actions will occur.

Here are the basic steps involved in creating, modifying or deleting an
escalation action.

To create an escalation action:
1. Open the escalation you want to work with if it is not already open.

2. Make sure that the escalation conditions and qualifications are specified
correctly, according to the instructions provided earlier in this chapter.

3. If this is a newly created (blank) escalation, go to Step 5

4. If this is an existing escalation and you want to create a new action, select
the New Action button in the Escalation window. The window changes to
allow you to specify a new action.

5. Select the action you want: Notify, Log to File, Set Fields, or Run Process.

The window displays the attribute choices for the action you have selected.

6. Set the attributes as appropriate.

7. When you have finished setting the attributes, select the Create button to
add the new action.

8. To create an additional action for the same escalation, select the New
Action button.

9. When you have defined all the actions you want for the escalation, select
Apply to create the escalation, then select Dismiss.

As a test, if you set an execution interval, the AR System immediately checks
the escalation after you create or enable it.
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To modify an escalation action:
1. Open the escalation you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to modify.

3. Change the various attributes as appropriate.

4. When you have finished making changes, select the Create/Modify
button.

5. When you have made all of the modifications you want to the escalation’s
actions, select Apply to save the modified escalation then select Dismiss.

To delete an escalation action:
1. Open the escalation you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to delete.

3. Select the Delete button to remove the action.

4. When you have made all of the modifications you want to the escalation’s
actions, select Apply to save the modified escalation then select Dismiss.

Ordering Escalation Actions

The order in which the actions defined for an escalation will execute is
indicated in the Escalation Actions section. If only one action is defined, it is
labeled as 1 of 1. If the action is one of 2 or more actions, it is labeled
appropriately. If there are three actions defined, for example, each is labeled as
1 of 3, 2 of 3, or 3 of 3, as appropriate. When you move from one action to
another using the Next and Previous buttons, the order indicator numbers will
change.

You can change the order in which the actions execute by using the Shift
buttons located next to the order indicator. The shift buttons are left and right
arrows that let you adjust the order of the escalation actions.

To change the order of escalation actions:
1. Open the escalation you want to work with if it is not already open.
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2. Use the Next and Previous buttons to locate the action that you want to
move forward or backward in the execution order.

3. To move the action earlier or later in the execution order, select the right
or left Shift arrow button.

4. Continue to move between actions and adjust their order using the Shift
arrow buttons until the actions are in the desired order.

5. Select Apply to save the escalation with the new action order then select
Dismiss.

Types of Escalation Actions
There are four types of escalation actions you can specify. With one exception,
the Escalation Actions window looks and functions like the Filter Actions
window as described in “Types of Filter Actions” on page 159. (Escalations,
unlike filters, do not support message actions)

• Notify provides active user notification of an event. To use the Notify
Escalation Action, see the discussion under “The Notify Filter Action” on
page 160.

• Log to File writes an audit trail message to a specified file. To use the Log
to File Escalation Action, see the discussion under “The Log to File Filter
Action” on page 166.

• Set Fields assigns values to specific fields in the current AR. To use the Set
Fields Escalation Action, see the discussion under “The Set Fields Filter
Action” on page 168.

• Run Process executes an operating system command or a program on the
server. To use the Run Process Escalation Action, see the discussion under
“The Run Process Filter Action” on page 181.

Setting Help for Escalations
Selecting the Set Help button in the Escalations window brings up a Help Text
editing window. You can supply help text for the selected escalation here. In
most cases, this help text is simply a description of the escalation, and is
available for viewing and editing only by AR System administrators and
subadministrators. For more information on setting help, see “Setting Help” on
page 38.
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Building and Using Escalation Change History
The AR System automatically records information about the owner of an
escalation, the user who last modified it, and the date of the modification. You
can display this information at any time by selecting the Change History
button at the bottom of the Escalation window to open the Change History
dialog box. For more information on viewing and modifying change history
information, see “Building and Using Change History” on page 36.

Tracing Escalation Activity
You can activate the escalation debug trace mode on the server to create a log
file of escalation activity. This server option logs information about escalation
activity for each operation, including the escalations that executed and
whether or not escalation execution was successful. By default, the log file is
called arescl.log . See “Log Files Information” on page 21 for more
information on creating an escalation log file.
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Defining Active Links 8

This chapter describes how to use the Administrator Tool to create and modify
active links. An active link is a specific operation that is defined by the AR
administrator to be performed when an action is taken by the user.

For example, you might define an active link that runs a macro to display all
problems reported for the current machine whenever a user presses return on
the “Machine Name” field.

For a detailed discussion about active link design, see “Designing Active
Links” on page 60.

This chapter covers the following topics:

• The Active Link window.

• Opening an active link.

• Specifying active link conditions.

• Specifying active link actions.

• Types of active link actions.

• Setting help for an active link.
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Using the Active Link Window
You create and modify active links using the Active Link window, as shown in
Figure 8-1. For most active links you define, you open the Active Link window
using the Administrator Tool menus. For active links that execute on a button,
you can also open the Active Link window from the Modify Schema window.

The Conditions section of the Active Link window (top section) is where you
specify what the user will do to cause the active link to execute. For example,
the condition may be that the user presses Return in a specified field or selects
a button on the user’s view of the screen.

The Actions section of the window (bottom section) is where you specify the
actions the active link will take when specified conditions are met. For
example, an action may be to run a specified macro.

Active links execute on the client machine. Each active link is attached to a
single schema on the server.

Figure 8-1 Active Link Window
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Opening Active Links
Follow these steps to open an existing active link or to create and open a new
active link.

To open an active link:
1. In the Admin Tool window, select Active Links from the Category menu

(or type Ctrl+A ) to see a list of active links on the server.

2. To create a new active link, select Create a New from the Edit menu (or
type Ctrl+N ).

To open an existing active link for modification, select the active link and select
Open from the Edit menu (or type Ctrl+O  or simply double-click the active
link).

To create and open a copy of an active link, select the active link you want to
copy and then select Copy from the Edit menu (or type Ctrl+C ). The new item
will appear in the list box as the selected item. The new item will be called
Copy of <xxx> where <xxx> is the name of the original active link. Select Open
from the Edit menu (or type Ctrl+O  or simply double-click the copy) to open.

The Active Link window appears (Figure 8-1 on page 200). For new active
links, the window is blank. For existing active links or copies of existing active
links, the current values are shown.

3. Specify or change active link conditions according to the steps described
in “Specifying Active Link Conditions” on page 202.

4. Specify or change active link actions according to the steps described in
“Specifying Active Link Actions” on page 206.

To open an active link from the Modify Schema window:
• To create a new active link that executes on a button, select New Active Link

from the Edit menu or type Ctrl+A .

• To Open an existing active link, select the active link button then select
Properties from the Edit menu or type Ctrl+R . You can also open the Active
Link window by double-clicking on the active link button.

Opening the active link from the Modify Schema window can make
positioning button-activated active links on the schema much easier.
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Specifying Active Link Conditions
This section describes how you use the top half of the Active Link window to
specify active link conditions, as shown in Figure 8-2. The active link
conditions define the criteria that a transaction must meet before the
corresponding active link actions take place. You specify conditions including:

• The name of the active link.

• The schema that will contain the active link.

• The access control groups that are allowed to execute the active link.

• The order in which the active link will execute in relation to other active
links.

• Whether the active link is enabled or not.

• How users will activate the active link (for example, by clicking a button or
by pressing Return).

• Specific qualifications that limit the transactions on which the active link
will execute, as described in “Building Qualifications” on page 150.

Figure 8-2 Specifying Active Link Conditions

To specify or change active link conditions:
1. Open the active link you want to work with (see the previous section).
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2. If the correct name is not already assigned to the active link, specify the
active link name in the Active Link Name field.

Active Link names must be unique. There is no enforced convention for
specifying active link names, but it is helpful to make the name descriptive and
indicative of the active link’s function. Names may be up to 30 characters,
including blanks.

3. Enter the name of the schema the active link will apply to in the Schema
Name field. You can select the menu icon to choose from a list of schemas
on the server.

An active link is associated with a single schema.

4. Indicate which access control groups will be able to use the active link.
Use the scroll bar to see all of the applicable access control groups. To set
the default permissions, select the Set To Defaults button. If needed, you
then can override the default settings for this particular active link.

Select Yes for each group you want to have access and No for each group you
do not want to have access. By default, access for all groups is set to No so that
only the Administrator or Subadministrator group has access to the active link.
Select Yes on the Public group to make the active link available to everyone.

Note – If a user has access to an active link, it executes for that user whenever
the conditions for the link are met. If a user does not have access, it does not
execute and the user’s view of the schema does not show an active link button,
if one is defined.

5. Specify the active link execution order.

There may be more than one active link designed to execute based on the same
set of conditions. The output from one active link might affect another active
link. The Execution Order field allows you to specify the processing order for
the particular active link. Valid values for Execution Order are numbers
between 0 and 1000 inclusive. Active links with lower numbers are processed
first. You can assign the same number to multiple active links; however, there
is no guarantee about the processing order for active links that have the same
number.

6. In the Enable field, specify whether you want to activate the active link.
Selecting Yes activates the active link; selecting No turns it off.
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7. In the Execute On field, specify when the active link will be performed by
selecting one or more of the options, as described in Table 8-1:

Table 8-1 Active Link Conditions

Button Places a button on the schema that executes the active link
when a user with the appropriate access selects the button.
If you choose this option, the Button Label, X and Y, Visible,
and Hidden fields are activated to allow you to define the
button’s physical characteristics.
You can associate multiple active links with the same but-
ton simply by using the same button label for both. The AR
System will place the buttons on top of one another so that
to the user there appears to be a single button. A good use
of this capability is to define active links that execute condi-
tionally based on current conditions, such as the platform
on which the tool is running. For example, you could define
an active link to execute only if the tool is running on a PC.
You could then associate another active link with the same
button, this time defining the active link so that it executes
only if the tool is running on a UNIX machine. Users on
either platform can then perform the same action to exe-
cute the appropriate active link for their platform.
To determine where the buttons are located on the view
that the user sees, you can do the following:
* Set the buttons on top of each other at the location that
you want them to appear. For example, you can set the
same X and Y coordinates for each active link. This ensures
the location of the button as it appears to the user in the
User Tool. However, this also makes it harder to administer
the various active links from the Modify Schema window in
the Administrator Tool.
* Place the button with the lowest execution order where
you want the button to appear to the user. The button with
the lowest execution order is the button that will be visible
to the viewer in the User Tool.
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You can select any combination of the options. If you select multiple options,
the active link will act when any one of the selected operations takes place.

Return Causes the active link to execute when a user with the
appropriate access presses Return in a specific field (or
selects a radio button if the field is a selection type field). If
you choose this option, Field is activated to allow you to
specify the field that will cause the active link to execute.
Note: In multi-line text fields, where Return inserts a line
feed in the text, the user must press Shift-Return (or press
the Enter key on the keypad) to activate the active link.

Submit Causes the active link to execute whenever a user with
appropriate access submits a new entry for the schema via
the User Tool. The active link will be performed before the
entry is submitted.

Modify Causes the active link to execute whenever a user with
appropriate access modifies an existing entry for the
schema via the User Tool Modify Individual operation. (The
active link will not execute during a Modify All operation.
However, any other conditions will execute.) The active link
will be performed before the entry is modified.

Display Causes the active link to execute whenever a user with
appropriate access retrieves and displays an entry for the
schema via the User Tool.

Menu
Choice

Causes the active link to execute whenever a user selects a
choice from a menu. If you choose this option, Field is acti-
vated to allow you to specify the field for which a menu
choice will cause the active link to execute.
You can combine this condition setting with a qualification
on the contents of the field to build an active link that exe-
cutes only if the user chooses a specific menu selection.

Set Default Causes the active link to execute whenever the user selects
the Set to Default command or the User Tool loads defaults
prior to a new query or submit.

Table 8-1 Active Link Conditions



206 Action Request System Administrator’s Guide for OSF/Motif—January 1996

8

8. You can further refine your active link selection criteria by entering a
qualification statement in the Qualification field. You can enter the text
directly, by typing it in, or build the qualification using the query bar
palette and Fields menu, as described in the section titled “Building
Qualifications” on page 150.

9. When you have finished specifying active link conditions, go on to
specify the active link actions.

Specifying Active Link Actions
You can specify up to 25 actions to be performed when an AR transaction
meets the conditions specified by the active link conditions. For example,
actions might include loading the hostname of the client, checking other
problems reported for a machine, or running a pre-defined process. If you
specify multiple actions, you can use the Shift buttons in the Actions section of
the Active Link window to set the order in which the actions will occur.

The following sections provide a detailed description of the attributes you
must specify for each type of active link action as well as the steps involved in
creating, modifying or deleting an active link action.

To create an active link action:
1. Open the active link you want to work with if it is not already open.

2. Make sure that the active link conditions and qualifications are specified
correctly, according to the instructions provided earlier in this chapter.

3. If this is a newly created (blank) active link, go to Step 5

4. If this is an existing active link and you want to create a new action, select
the New Action button in the Active Link window. The window changes
to allow you to specify a new action.

5. Select the action you want: Run Macro, Set Fields, Run Process, Message,
Change Field, or DDE.

The window displays the attribute choices for the action you have selected.

6. Set the attributes as appropriate. Refer to the sections that follow for
information about setting attributes for a specific action.
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7. When you have finished setting the attributes, select the Create button to
add the new action.

8. To create an additional action for the same active link, select the New
Action button.

9. Set attributes as appropriate for the additional action, then select the
Create button to add the action.

10. When you have defined all the actions you want for the active link, select
Apply to create the active link, then select Dismiss.

To modify an active link action:
1. Open the active link you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to modify.

3. Change the various attributes as appropriate. Refer to the following
sections for detailed information about setting attributes for a specific
action.

4. When you have finished making changes, select the Modify button.

5. When you have made all of the modifications you want to the active link’s
actions, select Apply to save the modified active link then select Dismiss.

To delete an active link action:
1. Open the active link you want to work with if it is not already open.

2. Use the Previous or Next button to page through action definitions to
display the one you want to delete.

3. Select the Delete button to remove the action.

4. When you have made all of the modifications you want to the active link’s
actions, select Apply to save the modified active link then select Dismiss.
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Ordering Active Link Actions

The order in which the actions defined for an active link will execute is
indicated in the Active Link Actions section. If only one action is defined, it is
labeled as 1 of 1. If the action is one of 2 or more actions, it is labeled
appropriately. If there are three actions defined, for example, each is labeled as
1 of 3, 2 of 3, or 3 of 3, as appropriate. When you move from one action to
another using the Next and Previous buttons, the order indicator numbers will
change.

You can change the order in which the actions execute by using the Shift
buttons located next to the order indicator. The shift buttons are left and right
arrows that let you adjust the order of the active link actions.

To change the order of active link actions:
1. Open the active link you want to work with if it is not already open.

2. Use the Next and Previous buttons to locate the action that you want to
move forward or backward in the execution order.

3. To move the action earlier or later in the execution order, select the right
or left Shift arrow button.

4. Continue to move between actions and adjust their order using the Shift
arrow buttons until the actions are in the desired order.

5. Select Apply to save the active link with the new action order then select
Dismiss.

Types of Active Link Actions
There are six types of active link actions you can specify:

• Run Macro causes a macro to run in the background.

• Set Fields assigns values to specific fields in the current AR.

• Run Process executes a command line on the client.

• Message returns a message and displays it for the user who activated the
active link.

• Change Field dynamically adjusts certain characteristics of a specified field.
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• DDE allows the definition of a DDE operation for Windows clients.

Each of these types is explained in the following sections.

The Run Macro Active Link Action

The Run Macro action lets you specify a macro to run whenever the active link
is executed. The macro may perform any operation or series of operations
(including performing an operation on another schema). If the macro contains
parameters, you can specify values for those parameters — including a value
from a field in the current AR.

For example, you might designate the value entered in the “Customer Name”
field of the current AR for use as the parameter value in a macro that queries
the database for information about the specified “Customer.”

Note – To use a macro in an active link, you must first create the macro using
the User Tool. For information about creating a macro, see Chapter 6, Using
Macros, in the Action Request System User’s Guide.

The macro you specify is copied into the active link and recorded with the
active link. Changes you make to this macro after the active link is created will
not affect the operation of the active link. If you want the changes made to the
macro to apply to the active link, you must modify the active link and specify
the macro again.

To define the Run Macro active link action:
1. Select Run Macro in the Active Link Actions section of the Active Link

window. The Active Link Actions section will change to present the fields
required to define the Run Macro action, as shown in Figure 8-3 on
page 210.
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Figure 8-3 Run Macro Active Link Action

2. Select the list icon for the Macro Name field and select the macro you
want to be performed when the active link is activated.

3. If the macro contains parameters, a list of parameters appears. You can
enter any of the following as parameter values:

• A static value.

• A keyword.

• A reference to any field in the current schema.

A field reference must be enclosed within dollar symbols. (You cannot use
dollar symbols within the prompt.) For example, if you want the contents of
the Customer Name field to be used for a particular parameter in the macro,
enter $Customer Name$ . You can enter a field reference by selecting the
Macro Name field with the MENU mouse button to open a menu containing
all the fields for the schema. When you select a field from this list, the field
is automatically entered with the correct syntax.

Note – If you specify a field as a parameter, the macro uses the value that it
finds in the field on the window from which the active link was executed.

4. Select the Create button to add this action to the active link.
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5. If you want to create an additional action for the active link, select the
New Action button. If you have finished defining conditions and actions
for this active link, select the Apply button, then select Dismiss.

Hints for Creating Macros for Active Links

When you are creating a macro to be used in an active link, there are several
important things remember:

• Create the macro before you create the active link.

The macro must exist before you open the Active Link window. If you forgot to
create the macro in advance, you must close and reopen the Active Link
window in order for it to recognize the new macro.

• If you modify the macro and want the modification to apply to the macro
when it is executed by the active link, you must modify the active link and
specify the macro again. This is because the macro is actually copied into
and recorded as part of the active link definition.

• While recording the macro, size and position any windows as you want
them to appear when the macro executes.

Take advantage of the fact that the macro remembers the size and position of
any window that it displays. For example, you may want to resize a window to
appear in the upper right corner of the user’s screen so that it will not interfere
with other windows the user has open. (Remember that size and position of
windows will vary according to the platform on which the client is running.)

The Set Fields Active Link Action

When you choose the Set Fields active link action, the resulting active link will
load specific values into selected fields for each transaction that meets the
active link conditions. This allows you to automate field updates for an entry.
As in filters, the value you assign to a field can be a simple static value, a
keyword, a field from another schema, the result of a function, or the results of
an executing process or arithmetic operation. For active links, you can also
assign a value from a DDE request operation performed on a Windows client.
The set field options are described in detail in the following sections.
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Note – You can also assign values to hidden fields. Hidden fields are shown
with dimmed labels in the Set Active Link Fields window. A value assigned to
a hidden field will not appear on the screen; however, the value will be used in
any operation (including Submit and Modify operations) that includes hidden
values.

If you assign a value to a diary field, the value is appended to any user text
already in the field.

To define the Set Fields active link action:
1. Select Set Fields in the Active Link Actions section of the Active Link

window. A Set Fields button appears in the window. Select the Set Fields
button to cause a Set Active Link Fields window with a schema view to
appear, as shown in Figure 8-4.

Figure 8-4 Set Fields Active Link Action

2. In the From Schema field, use the pull-right menu to select the name of
the schema from which the AR System is to retrieve the value for the
field. You also can use the menu to enter CURRENT SCREEN if the value is to
come from another field on the same entry.

Selecting a schema in the From Schema field works in connection with
constructing qualification statements to locate ARs that contain specific data.
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3. Enter the values in the schema fields that you want to be automatically set
when the active link executes. You can use the commands available
through the Edit menu of the Set Active Link Fields window, as described
below in “Using the Set Fields Edit Menu” on page 214. You can use the
MENU button in a field to display a selection list of available fields,
functions, and keywords.

Note – Since active links execute with the permissions of the user, field values
set through an active link are updated only if the user has update permissions
for the field.

You can set the field values to any of the following:

• A static value. Enclose text values that include special characters (such as
parentheses, single quotes, or arithmetic operators) in double quotes.

• A keyword value (see “Assigning Keyword Values” on page 214).

• A value from another field in the same schema or another schema (see
“Assigning Values from Other Fields” on page 214).

• The value resulting from a specified process (see “Assigning Values from
Process Results” on page 216).

• The value resulting from a DDE request operation on a Windows client (see
“Assigning Values from a DDE Request” on page 218).

• The value resulting from an arithmetic operation (see “Assigning Values
Using Arithmetic Operations” on page 219).

• The value resulting from a function (see “Assigning Values Using Function
Results” on page 219).

• A combination of the above. You might want to combine a static text entry
with a keyword, for example, 'Entry entered by' + $USER$ .

4. If the data or value you want is on a different AR, create a qualification to
locate the specific AR.

5. Select the Apply button on the schema view to save the field values you
want to load, then dismiss the Set Active Link Fields window.

6. If you want to create an additional action for this active link, select the
New Action button. If you have finished defining conditions and actions
for this active link, select the Apply button then select Dismiss.
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Using the Set Fields Edit Menu

The Edit menu in the Set Active Link Fields window contains the following
commands to help you set values:

Assigning Keyword Values

You can use any of the keywords listed in Table D-3 on page 369  to set a field
value. The data type of the keyword value must match the field data type. Use
the MENU button in any field to see and select from a list of the available
keywords.

Assigning Values from Other Fields

You can set a field to a value drawn from another field on the current screen or
an AR from the same or another schema (on the same or a different server).
Each action can draw data only from a single AR. However, you can use data
from multiple ARs by creating additional actions.

When you assign a value from an existing AR, you must specify the schema
that you want and define the qualification criteria that will locate the specific
AR within that schema. If only one AR matches the qualification when the
active link executes, the requested values are pulled from the AR and loaded as
values on the current window. If no ARs match the qualification, an error
message is displayed and no action is taken. If multiple entries match, a

Clear Clears all values in the window.
Reset Resets the field values in the window to those

defined when the settings in this window were
last applied.

Toggle Field Display Toggles (switches) the display type of the
selected field between the type chosen for the
field and a text display type. For example, you
can toggle the display of a radio button field to a
text display if you want to enter a field name to
retrieve the value from another schema.
If you toggle from a menu to a text field, you can
enter the numeric value of a field as well as a
label value (for example, FIXED).
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selection list will appear so that the user can select the entry to use. (This
differs from filters and escalations which take the first AR that meets
qualifications if multiple matches are found.)

To assign a value from another field on the current screen:
1. In the Active Link Set Fields window, make sure the From Schema field is

set to CURRENT SCREEN.

2. If the field you are loading a value for is a radio button, use the Toggle
Field Display command on the Edit menu to switch the field to a text line.

3. Place the mouse cursor in the field where you want the value loaded and
use the MENU mouse button to pop up a menu of available fields.

4. From the menu, select the field from which the value will be drawn when
the active link executes.

To assign a value from a different AR:
1. Use the MENU mouse button to open the From Schema field menu then

select the schema from which you want to retrieve the data.

2. If the field you are loading a value for is a radio button, selection menu,
or numeric text field, use the Toggle Field Display command on the Edit
menu to switch the field to a text line.

3. Place the mouse cursor in the field where you want the value loaded and
use the MENU mouse button to pop up a menu of available fields. The fields
that appear in the listing are from the schema shown in the From Schema
field.

4. From the menu, select the field from which the value will be drawn when
the active link executes.

5. Use the Qualification bar at the bottom of the Set Active Link Fields
window to define the qualification criteria that will locate the specific AR
from which the data will be drawn.

Use the Fields menu to reference fields in the schema you are drawing data
from (shown in the From Schema field in the Set Active Link Fields window).
These fields will be delimited with single quotes.
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Use the MENU button in the Qualification field to reference the value of a field
on the current screen. These fields will be delimited with dollar signs ($).

For example, if you want to find the AR where the Entry Id field of the From
Schema contains the same ID as the Related-to field on the current screen, the
qualification would look like this:

'Entry Id' = $Related-to$

You can also search for a field using wildcards. The following example would
locate an AR where the contents of the Name field are LIKE the contents of the
User Name field on the current screen:

'User Name' LIKE "%" + $Name$ + "%"

Use the same general techniques to construct an active link qualification
statement as you use to construct a filter qualification. For a detailed
description, see “Building Qualifications” on page 150.

6. When you have finished specifying the qualification, select the Apply
button in the Set Active Link Fields window then select Dismiss.

Assigning Values from Process Results

You can set a field to the value resulting from running a specified process on a
UNIX client. For example, you may want to load information about the current
system or information retrieved from another data source (such as an existing
database holding contact information). To do so, you can define and run a
process whose stdout  output will be used as the value for a field.

The syntax for loading the return of a process is as follows:

$PROCESS$ <process-to-run>

Note – ■ Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the
explicit path to commands, for example,
/home/jim/bin/ <command>. In the Windows NT
environment, you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).
■ In the UNIX environment, the process will run under
a Bourne shell.
■ Use quotes around substituted fields when the values
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may contain blanks or other special characters, for
example, $PROCESS$ /bin/cmd  "$<field>$"
■Substituted field values containing carriage return or
other special characters may have unexpected results.

The keyword $PROCESS$ indicates that all following text is a command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can enter up to 255 bytes for your command
definition. The command can be up to 4096 bytes once the substitution
parameters are expanded. You can select substitution parameters (as well as
the $PROCESS$ string) from a menu on each field on the window.

When the active link is performed, the specified command line will be
executed and the User Tool will wait for the process to complete. All data
returned to stdout  will be read by the User Tool and processed according to
the return of the process. If the process returns 0, the returned data is used as
the value for the field. The data is expected in ASCII format and is converted
as needed to match the data type of the target value. If the process returns a
value other than 0, it is assumed there was an error and the process failed. In
this case, the data returned in stdout  is treated as the text of an error message
and is displayed to the user in an error dialog box.

When you design an active link that loads field values from process results, it
is important to be aware of the hardware platforms and operating systems
your clients may be using. The process you are specifying may not be available
on all platforms and operating systems. If your users run the client tools on
more than one type of platform or operating system, you can build a
qualification for the active link using the $HARDWARE$ and $OS$ keywords to
verify that the client is running on an appropriate platform and operating
system at the time the active link executes. See “Building Qualifications” on
page 150 for more information.

Note – If you include a process result in a mathematical operation, the process
definition must not be contained within parentheses and it must be the last
item in the operation since all data after the keyword $PROCESS$ is considered
to be part of the command line.
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Assigning Values from a DDE Request

You can set a field to the value resulting from a dynamic data exchange (DDE)
request operation executed on a Windows client. DDE is a part of MS Windows
and is a form of interprocess communication that uses shared memory to
exchange data between applications.

The syntax for loading the result of a DDE request operation is as follows:

$DDE$ <servicename>;< topic>;< pathtoprogram>[;<item> ]

The DDE parameters hold the following information:

<servicename>The unique ID of the DDE application.

<topic>The topic name that identifies a logical data context.

<pathtoprogram>The location on the PC where the DDE service is found.

<item>(Optional) A string identifying a unit of data.

For example, you might enter the following:

$DDE$excel;sheet1;c:\excel\excel.exe;R1C1

This operation returns the contents of cell R1C1 of Sheet 1 in Excel to the
current field.

Refer to the MS Windows documentation for more information on DDE. To
integrate the AR System with other Windows applications, refer to Appendix
C, DDE Functionality in the AR System in the Action Request System User’s Guide
for Windows. To integrate with another application, refer to that application’s
documentation as well.

The keyword $DDE$ indicates that all following text is a DDE command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can select substitution parameters (as well as the
$DDE$ string) from a menu on each field on the window.

When the active link is performed on a Windows client, the specified DDE
request is executed and the User Tool waits for the operation to complete.
Whatever data the DDE request returns is then entered into the field.

If the active link is performed on a non-Windows client, an empty string is
returned (the field will contain no value).
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Note – If you include a process result in a mathematical operation, the process
definition must not be contained within parentheses and it must be the last
item in the operation since all data after the keyword $DDE$ is considered to be
part of the DDE definition.

Assigning Values Using Arithmetic Operations

You can use arithmetic operations to load a computed value. You can combine
an arithmetic operation with a static value, a keyword, a value from the current
screen or an existing AR, or a value from a process. The same arithmetic
operations allowed for specifying qualifications are allowed to build a
computed value (see “Table of Operators” on page 366). The operation must
meet all the rules for arithmetic operations and produce a result whose type is
compatible with the target field. If you include a process or DDE result in the
operation, the process definition must not be contained within parentheses and
it must be the last item in the operation since all data after the keyword
$PROCESS$ is considered to be part of the command line.

Here are some examples of valid arithmetic operations:

$TIMESTAMP$ - $CREATE-DATE$

$FIRST NAME$ +'' '' + $LAST NAME$

''hostname ='' + $PROCESS$ hostname

Assigning Values Using Function Results

The AR System supports a set of functions that you can use in the set fields
action. The functions allow you to manipulate data so that you can control
various aspects of values you are loading into fields. For example, you can use
the UPPER function to convert the value loaded in a field to all uppercase.

To use a function in the set field operation:
1. Use the MENU mouse button in the field. Select FUNCTION from the menu

that appears and pull right to see a list of the available functions.

2. Select the function you want to use. It will appear in the field with a set of
parentheses to the right.
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3. Enter any arguments that are appropriate for the function you have
selected within the parenthesis.

Information about each of the functions supported by the AR System is
provided in Table 6-1 on page 176.

The Run Process Active Link Action

Choosing the Run Process active link action allows you to execute a command
line to run a process. When the active link is executed, the system will execute
the command specified in the Command Line field. For example, you could
specify a program in the Command Line field that will launch a related
process, such as a program to display a graphical representation of a machine.

The command line also accepts references to values on the current screen if you
specify the field name enclosed in dollar signs ($). You can specify the field
name by selecting the icon to open a menu containing all the fields for the
schema. When you select a field from this list, the field is automatically entered
with the correct syntax.

Note – The Run Process action simply executes an independent
process — it does not return a value to the User Tool. This is not the same as
inserting the results of a process into a field using the Set Fields action (see
“Assigning Values from Process Results” on page 216).

When you design an active link that runs a process, it is important to be aware
of the hardware platforms and operating systems your clients may be using.
The process you are specifying may not be available on all platforms and
operating systems. If your users run the client tools on more than one type of
platform or operating system, you can build a qualification for the active link
using the $HARDWARE$ and $OS$ keywords to verify that the client is running on
an appropriate platform and operating system at the time the active link
executes. See “Building Qualifications” on page 150 for more information.

To define the Run Process active link action:
1. Select Run Process in the Active Link Actions section of the Active Link

window. The Active Link Actions section will change to present the fields
required to define the run process active link action, as shown in
Figure 8-5.
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Figure 8-5 Run Process Active Link Action

2. In the Command Line field, enter the command that will execute when
active link conditions are met.

You can specify any of the keywords defined by the system (see “Table of
Keywords” on page 369) or you can substitute the value of any field of the AR
generating the notification by enclosing the field name or ID in dollar signs ($)
in the text. The keyword or field will be expanded when the process is run. If
the expanded value contains spaces, remember to enclose the value within
quotes so that the AR System will interpret it as a single value. If in doubt, use
quotes. They will not interfere and they may prevent a problem.

You can select the icon next to the Command Line field to open a menu
containing the available keywords and fields in the current schema. You then
simply select one of these fields to have it appended to the command. In
addition, you can select the text edit icon to open a text edit window for easier
data entry, if desired.

Note – ■ Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the
explicit path to commands, for example,
/home/jim/bin/ <command>. In the Windows environment,
you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).
■ In the UNIX environment, the process will run under
a Bourne shell.

Field contents
can be passed
as parameters.
 Enclose field
name with
$ symbols.
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■ Use quotes around substituted fields when the values
may contain blanks or other special characters, for
example, /bin/cmd  "$<field>$"
■ If clients are running on different platforms that do not all
support the same process commands, use $HARDWARE$

or $OS$ keywords in the qualification to target the AR to run
only on the appropriate platform.
■ Substituted field values containing carriage return or
other special characters may have unexpected results.

3. When you have finished specifying the command for the active link
action, select the Create button.

4. If you want to create an additional action for this active link, select the
New Action button. If you have finished defining conditions and actions
for this active link, select the Apply button, then select Dismiss.

The Message Active Link Action

When you choose the Message active link action, an interactive error, warning,
or note will be displayed by any application that initiates a transaction that
meets the active link conditions. This is especially useful when combined with
qualifications so that you can check some conditions on the action request and
issue errors or warnings to the user if there is an unexpected condition.

To define the Message active link action:
1. Select Message in the Active Link Actions section of the Active Link

window. The Active Link Actions section will change to present the fields
required to define the message active link action, as shown in Figure 8-6
on page 223.
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Figure 8-6 Message Active Link Action

2. In the Message Text field, enter a string, up to 255 characters in length,
which will be the text of the notification message. The text may include
field substitution parameters or system keywords.

You can select the icon next to the Message Text field to display a menu
containing a list of all the fields in the current schema as well as a list of
keywords. You can simply select one of these fields or keywords to have it
added to the text. In addition, you can select the text edit icon to explode the
line into a text edit window for easier data entry, if desired.

3. Select a message type for the notification message. The message type will
be displayed with the notification message. The available message types
are:

4. Specify a message number in the Number field. The message number will
be displayed with the notification message. The number you specify must
be greater than or equal to 10000. (Numbers under 10000 are reserved for
AR System messages.)

Note Returns a note and continues the operation.The message
type is displayed as ARNOTE.

Warning Returns a warning and continues the operation. The mes-
sage type is displayed as ARWARN.

Error Returns an error and terminates the operation. The mes-
sage type is displayed as ARERR.
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5. When you have finished specifying the message active link action, select
the Create button.

6. If you want to create an additional action for this active link, select the
New Action button. If you have finished defining conditions and actions,
select the Apply button then select Dismiss.

The Change Field Active Link Action

The Change Field active link action allows you to dynamically adjust selected
characteristics of fields in the current window. Based on conditions when the
active link executes, you can specify and attach a different character menu to a
field that already has a character menu, move the focus point within the
window to the field, or change the accessibility of the field.

To define the Change Field active link action:
1. Select Change Field in the Active Link Actions section of the Active Link

window. The Active Link Actions section will change to present the fields
required to define the change field action, as shown in Figure 8-7.

Figure 8-7 Change Field Active Link Action

2. In Field, enter the name of the field in the current schema whose
characteristics you want to set. You can type directly into the field or select
the list icon next to the field to open a list containing the schema fields.

3. Specify the changes that you want to make:
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• To select a new character menu and attach it to the field, enter the name of
the menu in the Menu field. You can type the menu name directly into the
field or select the icon to display the available menus. (The field must
already have a character menu assigned in order for you to be able to
change to a different character menu.)

• To move the focus to the field, select the Set To Field radio button. To leave
the focus as it is, select the Unchanged radio button.

• To change the current access settings for the field, select the appropriate
Access radio button. You can choose from the following:

4. When you have finished specifying the change field active link action,
select the Create button.

5. If you want to create an additional action for this active link, select the
New Action button. If you have finished defining conditions and actions,
select the Apply button then select Dismiss.

The DDE Active Link Action

Choosing the DDE active link action allows you to perform a dynamic data
exchange (DDE) operation on a Windows client. DDE is a part of MS Windows
and is a form of interprocess communication that uses shared memory to
exchange data between applications.

DDE always takes place between a client application and a server application
on the same PC. The client initiates the exchange by establishing a
conversation with the server so that it can request data or services from the
server. The server responds by providing the data or services to the client. A
server can have many clients at the same time and a client can request data
from multiple servers. Additionally, an application can be both a client and a
server.

Unchanged Leave the access setting as it is.
Read Only Set the field access to read only. The user will be able to

read the contents of the field but will not be able to enter
data.

Read/Write Set the field access to read/write. The user will be able to
read the contents of the field and enter data as required.

Disabled Set the field access to disabled. The user will be able to
read the field value but not able to write to the field and
the field label will be grayed.
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DDE uses a three-level hierarchy to uniquely identify a unit of data to be
exchanged during a DDE conversation: service (application) name, topic name,
and item name.

A service name is a string that a server application responds to when a client
attempts to establish a conversation with the server.

A topic name is a string that identifies a logical data context.

An item name is a string that identifies a unit of data that a server can pass to
a client during the transaction.

For two examples of using an active link action with DDE, see “Active Link
DDE/Execute Action” on page 229 and “Active Link DDE/Poke Action” on
page 230.

Refer to the Microsoft Windows documentation for more information on DDE.
To integrate the AR System with other Windows applications, refer to
Appendix C, DDE Functionality in the AR System in the Action Request System
User’s Guide for Windows.

Note – If you are designing an active link for a schema that is used by clients
on platforms other than a PC, it is a good idea to verify that the current
platform is a PC as a condition of activating the DDE action. To do this, include
a qualification that uses the $HARDWARE$ keyword to check the current
platform. See “Building Qualifications” on page 150 for more information.

To define the DDE active link action:
1. Select DDE in the Active Link Actions section of the Active Link window.

The Active Link Actions section will change to present the fields required
to define the DDE active link action, as shown in Figure 8-8 on page 227.
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Figure 8-8 DDE Active Link Action

2. Select an Action for the DDE operation. The available actions are:

3. In the Service Name field, enter the unique ID of the DDE application.

4. In the Topic field, enter the DDE topic.

5. In the Item field, enter the DDE item, if applicable. (Item is ignored if the
DDE Action type is Execute.) You can select the list icon next to the Item
field to pop up a menu containing a list of all the fields in the current
schema as well as a list of keywords.

6. In the Path field, enter the path indicating the location of the service on
the PC. You can select the list icon next to the Path field to pop up a menu
containing a list of all the fields in the current schema as well as a list of
keywords.

7. In the Command field, enter the command you want to execute. (You must
enter a value in this field.) You can select the list icon next to the
Command field to pop up a menu containing a list of all the fields in the
current schema as well as a list of keywords.

• If the action is Execute, the command is sent to the remote application.

Execute Client request for server to execute the command specified in
the Command field.

Poke Client alters data in the server application data on the con-
tents of the Command field.
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• If the action is Poke, the command is the data being set in the remote
application.

8. When you have finished specifying the DDE active link action, select the
Create button.

9. If you want to create an additional action for this active link select the
New Action button. If you have finished defining conditions and actions,
select the Apply button then select Dismiss.

Note – All data sent to the server is assumed to be in cf_text  format.

See “Assigning Values from a DDE Request” on page 218 for information on
how to load the result of a DDE request operation into a field using an active
link that performs a Set Field operation.

Time-out Settings for DDE Transactions

All AR System DDE transactions are synchronous. If you need to set longer
times for DDE transactions, you can create a [DDE] section in your ar.ini  file
and enter your own time-out settings:

[DDE]
AppResponseTimeout=<30>

TransactionTimeout=<20>

AppResponseTimeout  is the active link time-out setting to load the application
into memory after starting it. The default setting is 30 seconds.

TransactionTimeout  is the active link time-out setting if the DDE server does
not respond back with the requested DDE action. The default setting is 20
seconds.
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Active Link DDE/Execute Action

You use the DDE/Execute action to execute specific commands or functions on
another Windows application. The DDE Execute action requires the following
components in the DDE Active Link Action window:

For example, you could create an active link button that launches a Windows
application. Instead of the administrator hardcoding a specific DDE application
in a specific directory into the Path field in the DDE Active Link Action
window, Figure 8-8 on page 227 illustrates an active link that uses $Path$  to
reference the Path  field in the Run DDE schema.

As a result, users of the schema are free to enter their own application and path
name, in this case, a spreadsheet application that starts with a blank page
whenever they enter a path name and then click the Run DDE button, as
shown in Figure 8-9.

Figure 8-9 Creating and Using an Active Link Button for DDE Actions

Service Name Application DDE name.
Topic Additional DDE definition, for example, a file name or a

category of command (like the system  command in
Excel).

Path Location of application executables. Make sure that you
point the path to the DDE application in the Service
Name field.

Command Command or function being sent to the Windows appli-
cation.

User can enter
their own path,
then trigger the
application via
an active link
button
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Active Link DDE/Poke Action

You use the DDE/Poke action to send data to another Windows application.
The DDE Poke action requires all five components in the DDE Active Link
Action window:

Figure 8-10 illustrates creating an active link that sends the value of the
$Submitter$  field into cell R1C1 (row one and column one) of Sheet1 in a
Windows application (like a spreadsheet). Users enter their own application
and path name in the $Path$  field in the User Tool, as in Figure 8-9 on
page 229.

Figure 8-10 DDE/Poke Action

Service Name Application DDE name.
Topic Additional DDE definition, for example, a file name or

a category of command (like the system  command in
Excel).

Item Multiple items which identify the details in a topic, for
example, the cell location in a spreadsheet.

Path Location of application executables. Make sure that
you point the path to the DDE application in the Ser-
vice Name field.

Command Data being sent, which can either be a literal value or
a data field value.
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Defining Group Access For Active Links
The Administrator Tool lets you do bulk assignments of group permissions for
all active links within a server. Rather than going through each active link
individually to assign permissions for a group, the Group Access window lets
you assign them all at once.

The Group Access window is particularly useful when you have added a new
access control group since the active links were created and you want to set its
access rights across a number of active links. You can use one window to
assign the new group access for each active link instead of having to open each
active link and modify the conditions for each active link.

Note – The Administrator Tool offers several different ways to set
permissions. For example, when creating an active link, you might give access
to the Public group. However, if you decide that you want to deny the Public
group access to active links, you then can use the Group Access window to set
the group permissions for all active links at the same time.

To define group access for active links:
1. Select Active Links under the Category menu of the Admin Tool main

window.

2. From the Edit menu, select Group Access (or type Ctrl+G ). This causes the
Group Access window to appear, as shown in Figure 8-11 on page 232. You
use this window to set active link permissions globally for each group
defined for a server.



232 Action Request System Administrator’s Guide for OSF/Motif—January 1996

8

Figure 8-11 Group Access — Active Link Window

3. Click the Group list icon. The Groups dialog box appears.

4. Select a group from the dialog box, then click Apply (or double-click the
entry). The Group Access window then lists all current permission
settings for that group for all items in the current category.

5. For each item, set the active link permissions for the specified group.
Selecting Yes gives the group permissions to access the active link.

6. Select the Apply button to save the permission settings.

Setting Help for Active Links
Selecting the Set Help button in the Active Link window brings up a Help Text
editing window. You can supply help text for the active link here. In most
cases, this help text is simply a description of the active link, what it does, and
how it is used. User Tool users will be able to view this help text in the same
way that they can view help text that is available for fields. See “Setting Help”
on page 38 for information on how users can access help information.
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Building and Using Active Link Change History
The AR System automatically records information about the owner of an active
link, the user who last modified it, and the date of the modification. You can
display this information at any time by selecting the Change History button at
the bottom of the Active Link window to open the Change History dialog box.
For more information on viewing and modifying change history information,
see “Building and Using Change History” on page 36.
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Defining Administrator Commands 9

This chapter describes how to use the Administrator Tool to create special
menu extensions for the User Tool that let users invoke specific commands
running on the server. Administrator commands are available to all users who
belong to a group that has permission to access the command and are running
the User Tool on a UNIX workstation. (User commands, which are defined by
individual users from within the User Tool, appear only on that user’s local
system.)

Note – Admin commands execute with the same permissions as arserverd .
The root user (or whoever starts arserverd ) is the owner of the admin
commands.

The following topics are covered in this chapter:

• The Admin Command window.

• Opening an administrator command.

• Creating or modifying an administrator command.

• Deleting an administrator command.

• Setting help for an administrator command.
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Using the Admin Command Window
Administrator commands are displayed in the Admin Command window.
Figure 9-1 shows the Admin Command window containing a currently
existing administrator command.

Figure 9-1 Admin Command Window

You use the Admin Command window to create, modify, and delete
administrator commands.

Note – Admin commands only work on UNIX clients.

Opening Administrator Commands
Follow these steps to open a new or existing administrator command.

To open an administrator command:
1. In the Admin Tool window, select Admin Commands from the Category

menu  to see a list of administrator commands available on the server.
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2. To create a new administrator command, select Create a New from the
Edit menu.
To open an existing administrator command for modification, select the
administrator command and select Open from the Edit menu (or type
Ctrl+O  or simply double-click the administrator command).

To create and open a copy of an administrator command, select the
administrator command you want to copy and then select Copy from the
Edit menu (or type Ctrl+C ). A new item will appear in the list box as the
selected item. The new item will be called Copy of <xxx> where <xxx> is the
name of the original administrator command. Select Open from the Edit
menu (or type Ctrl+O  or simply double-click the copy) to open.

The Create (or Modify) Admin Command window appears (Figure 9-1 on
page 236). For new administrator commands, the Command String field is
blank. For existing administrator commands or copies of existing
administrator commands, the current value is shown.

3. Specify or change the administrator command according to the steps
described in the following section, “Defining Administrator Commands.”

Defining Administrator Commands
Follow the steps below to define an administrator command.

To define an administrator command:
1. Open the administrator command. The Admin Command window

appears, as shown in Figure 9-1 on page 236.

2. Type or edit the name for the command in the Command Name field.
This is the name that users will see in the Select Admin Command window
accessed through the Query Window of the User Tool.

3. For each group listed in the Permissions list, select Yes to allow members
of the group to see and execute the administrator command or select No to
deny members of the group access to the command. Select Yes for the
Public group to make the command available to everyone. Use the scroll
bars, if needed, to see the complete list of groups.

4. Type or edit the command string that will invoke the operation in the
Command String field. You can enter up to 255 characters.
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5. You may also want to select the Set Help button and enter help text and
the Change History button to update the change diary for the command.
Help text is useful to remind users of what the command does. This text will
be displayed when selecting a command to run.

6. Select the Apply button to add the command.
The name will appear in the list of administrator commands available from
the Select Admin Command window that opens when users select Run
Admin Command from the Actions menu of the User Tool. (Users who are
currently running the User Tool will need to restart the tool or log in again
to see the new command.)

Deleting Admin Commands
Deleting a command removes its name from the list of administrator
commands in the Select Admin Command window of the User Tool.

To delete an administrator command:
1. Select Admin Commands from the Category menu (or type Ctrl+E ).

2. The currently available administrator commands appear in the list box.

3. Select the administrator command to be deleted, and select Delete from
the Edit menu.

4. A confirmation message appears.

5. Select the Proceed with Delete button to delete the admin command.

Defining Group Access For Admin Commands
Group access for admin commands lets you do bulk assignments of group
permissions for all admin commands within a server. Rather than going
through each admin command individually to assign permissions for a group,
the Group Access window lets you assign them all at once.

Group access is particularly useful when you have added a new access control
group since the admin commands were created and you want to set its access
rights across a number of admin commands. You can use one window to
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assign the new group access for each admin command instead of having to
open each admin command and modify the conditions for each admin
command.

Note – The Administrator Tool offers several different ways to set permissions.
For example, when creating an admin command, you might give access to the
Public group. However, if you decide that you want to deny the Public group
access to a particular admin command, you then can use the Group Access
window to set the group permissions for all admin commands at the same
time.

To define group access for admin commands:
1. Select Admin Command under the Category menu of the Admin Tool

main window. This enables the Group Access item under the Edit menu.

2. Select Group Access (or type Ctrl+G ). This causes the Group Access —
Admin Commands window to appear, as shown in Figure 9-2. You use
this window to set admin command permissions globally for each group
defined for a server.

Figure 9-2 Group Access — Admin Commands Window

3. Click the Group list icon. The Groups dialog box appears.
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4. Select a group from the dialog box, then click Apply (or double-click the
entry). The Group Access window then lists all current permission
settings for that group for all items in the current category.

5. For each item, set the permissions for the specified group. Selecting Yes
gives the group permissions to access the admin command.

6. Click the Apply button to save the option settings.

Setting Help for Administrator Commands
Selecting the Set Help button in the Create Admin Commands window brings
up an Admin Commands Help Text editing window. You can supply help text
for the selected command here. In most cases, this help text is simply a
description of the command and what it is used for. Users will see this help
text when they select an administrator command from the Select Admin
Command window. For more information on setting help, see “Setting Help”
on page 38.

Building and Using Admin Commands Change History
The AR System automatically records information about the owner of a
command, the user who last modified the command, and the date of the
modification. You can display this information at any time by selecting the
Change History button at the bottom of the Admin Commands window to
open the Change History dialog box. For more information on viewing and
modifying change history information, see “Building and Using Change
History” on page 36.



241

Importing and Exporting
Definitions 10

This chapter describes how to use the Import and Export commands to transfer
schema, menu, filter, escalation, active link, and admin command definitions.
A definition is the structure in which the data in the AR System is organized
and manipulated (for example, for fields or active links).

This chapter covers the following topics:

• Importing definitions.

• Exporting definitions.

• Exporting mail templates.

Importing and Exporting Definitions
The Import and Export commands are located under the File menu in the
Admin Tool window.

• The Export command lets you export schema, filter, active link, escalation,
menu, and admin command definitions and schema mail templates to a file.

• The Import command lets you import schema, menu, filter, escalation, active
link, and admin command definitions to a server. If you want to move a
definition from one server to another, first export it from the current server
(which saves the structure definition as an ASCII file), and then import the
definition into the AR System on the destination server.
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To import data into your server, use the AR Import Tool. The Import Tool
imports data in the AR Export, CSV, and ASCII file formats. To use the AR
Import Tool, refer to Chapter 11.

Importing Definitions

Follow these steps to import definitions to a server. For information on
importing data records into the database, refer to Chapter 11.

To import definitions:
1. Copy the exported ASCII file to the destination server.

2. Select Import from the File menu (or type Ctrl+I ).

3. Specify the filename containing the definitions you wish to import.

4. Select Apply. The Import Definitions window appears, as shown in
Figure 10-1. The names of the definitions in the file you specified are
listed in the Import Definitions window.

Figure 10-1 Import Window

Use these
fields to
rename the
definitions
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5. Select as many definitions as desired, or select them all using the Import
All checkbox.

Note – Import operations involving large amounts of data can take a great deal
of time and require a great deal of space. You should make sure you have
adequate resources before you begin the operation. You may want to perform
such operations during hours when users do not require access to the system.

You may wish to rename a definition from the file prior to completing the
import (as shown in Figure 10-1 on page 242), since you may not import a
definition whose name already exists in the target server. Change the definition
name by selecting the name and editing it. (You must make sure the Import All
checkbox is deselected to allow editing of definition names.)

6. Select the Apply button to import the definitions to the current server.

The new definition names will automatically appear as selections in the
respective categories the next time the tools are invoked.

7. If desired, select the Select File button to choose a different set of
definitions for import. The Import Definitions window will reappear.

8. When you have finished importing definitions, select the Dismiss button
to dismiss the Import Definitions window.

Note – If you import an active link which sets a field to a specific value that
uses the $MENU$ pattern and the menu is not already present on the server, the
import operation will fail. You must import the menu first and then import the
active link.

Exporting Definitions

This section describes how to export definitions to a file. For information about
exporting mail templates, see the following section, “Exporting Mail
Templates.” For information on exporting data, refer to Chapter 5, Reports in
the Action Request System User’s Guide.

To export definitions:
1. Choose Export Definitions from the File menu (or type Ctrl+D ).
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The Export Definitions window appears, as shown in Figure 10-2. The Export
Definitions window lists all available schemas, menus, filters, escalations,
active links, and admin commands in a scrolling list. This is where you select
the definitions you want to export.

Figure 10-2 Export Definitions Window

2. Select as many individual definitions as desired by selecting the checkbox
next to the definition in the scroll list. Use the scroll bars to see all items
in the list.

You can select all of a specific type of definition for export by selecting the
appropriate Export checkbox. For example, to export all filters defined on the
server, select the Filters checkbox.

You can select all definitions on the server by using the All checkbox.

Note – When exporting object definitions that reference other objects (for
example, menus that reference schemas), always make sure that you export the
schemas first. Otherwise, the import operation will fail.
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3. In the Server Independent field, select the Yes or No radio button to
specify whether or not the export operation should remove references to
the current server when the definitions are exported. Selecting this option
allows connection to items on the new server when the definitions are
imported.

Note – When active links are exported with the server independent option, any
server names in embedded macros are changed only if the server name is the
current server; otherwise the server names remain intact.

4. In the Related Items field, select the Yes or No radio button to specify
whether or not to export any other definitions that are related to the
item(s) selected for export, as follows:

• If you select a schema, the export operation will include all related filters,
active links, escalations, and menus.

• If you select a filter, the export operation will include all related schemas.

• If you select an escalation, the export operation will include all related
schemas.

• If you select an active link, the export operation will include all related
schemas and menus.

If you choose No for the Related Items option, the export operation will
include only the selected item itself.

5. Select the Append button to append the definitions to an existing file.
Select the Overwrite button to overwrite the contents of an existing file.

A file selection window appears.

6. In the file selection window, specify where you want the definitions
stored.

All the definitions you selected will be stored in a single file.

The actual export will not occur until you complete your actions in the file
selection window.
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Exporting a Range of Definitions to a File

Because of limits imposed by the X window system, all the structures on a
server cannot always be included in a single export window. For that reason,
the AR System only allows a maximum of 700 items per export.

To export a range of definitions:
1. Choose Export Definitions from the File menu (or type Ctrl+D ).

The Export Range window appears, as shown in Figure 10-3.

Figure 10-3 Export Range Window

2. Select the range of definitions you want to export to a file. Note that in the
example the total number of definitions in the server (224) is divided into
groups of 30.

3. Select the Apply button.

The Export Definitions window appears (Figure 10-2 on page 244). The bottom
of the window lists the range of definitions that you selected.

4. Follow the rest of the export definitions procedure that is described in
“Importing Definitions” on page 242.

Exporting Mail Templates

A mail template is a form for submitting ARs to the User Tool through email.
You use the Export utility to generate mail template files for schemas. You can
then distribute these files to users. For more information about mail templates
and how the AR System supports email, see Chapter 12.

(narnia)
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To export a mail template:
1. Choose Export Schema Mail Templates from the Admin Tool File menu

(or type Ctrl+T ).

The Export Mail Templates window appears, as shown in Figure 10-4.

Figure 10-4 Export Mail Templates Window

2. From the Schemas list, select the schema for which you want to generate a
mail template by clicking the box next to the title.

Note – If you want to export more than one schema, create a separate email
template for each schema.

3. Select the Append button to append the mail template to an existing file.
Select the Overwrite button to overwrite the contents of an existing file.

A file selection window will appear.
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4. In the file selection window, specify where you want the templates stored.

5. Click the OK button. The dialog box disappears.

The templates are saved in an ASCII file that you can distribute to users for use
with their mail programs.
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Using the Import Tool 11

The Action Request System Import Tool allows you to bring data into a schema
from another AR System schema or from a different data source. The Import
Tool’s mapping capability allows you to specify the information to be imported
from the originating source and the fields that will contain that information on
the destination schema. You can import data directly from AR Export files,
comma separated value (CSV) files, or ASCII files.

This chapter includes information on the following topics:

• Starting and exiting the Import Tool.

• Importing information into a schema.

• Mapping information from the source to the destination schema.

• Setting Import Tool preferences.

Import Tool Functions
You use the Import Tool to import data and records from other AR servers or
from other applications into your AR server.

To import data into a schema, you must have modify permissions for the fields
that you wish to import to. For system fields like Create-date, you must be the
Administrator or Subadministrator of the schema.

The Import Tool includes the following functionality:
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• Lets you import data from a wide variety of sources (databases or
spreadsheets) and formats (.csv , .asc , and .arx ).

• Lets you “map” data sources to specific fields in your schemas, even if the
data sources have different names than your fields.

• Lets you interactively handle bad records on a record-by-record basis with
its sophisticated Action Request System Administrator’s Guide error-
handling capability.

Note – You do not use the Import Tool to import definitions into the server. For
information on importing definitions, see Chapter 10.

Starting the Import Tool
You can start the Import Tool from any UNIX workstation on the network that
is running the 2.1 version of the client tools. Before you start the Import Tool,
make sure you have the following information from your AR System
administrator:

• The directory that contains the executables for the Import Tool (by default,
this directory is /usr/ar/bin ).

• Your registered AR System user name and password.

Note – The Import Tool uses the same configuration directory as the AR
System User Tool.

Your user name and password identify you to the AR System and give you the
appropriate access permissions.

In the following steps, <ar_install_dir>/bin refers to the directory containing the
executables for the AR System client tools.

See Appendix E for information on the command line options that are available
when you start the Import Tool.

To start the Import Tool:
1. Type the following at the UNIX prompt:
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2. If you are starting the Import Tool for the first time, the Login window
appears. Enter your registered user name and password, then select the
Apply button.

Once you have logged into the Import Tool, your login name is included in the
title of the Import Tool window.

Logging In as a Different User
If the Import Tool was previously started by another user, you can change the
user information and log in as yourself. This means that you can log in at any
machine on the network that has access to the AR System server.

Note – If you log into the Import Tool on a system where someone else is
logged into the UNIX operating system, before you change the user
information and log in as yourself in the Import Tool, you might want to
change the other user’s ARHOME environment variable to point to the directory
defined by your ARHOME environment variable. If you do not, and you save
mappings during your Import Tool session, they will be saved to the AR
System configuration directory of the user who is logged in at the UNIX
operating system level. For information on changing the ARHOME environment
variable, see Chapter 2, Getting Started with the User Tool in the Action Request
System User’s Guide for OSF/Motif.

Displaying Version Information

To display version information about the Import Tool:
• From the Help menu, choose On Version to display information about the

product. You should be prepared to provide this information whenever you
call for Customer Support.

% <ar_install_dir> /bin/arimport &
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Exiting the Import Tool

To exit the Import Tool:
• To exit the Import Tool, select Exit from the File menu (or type Alt+F4 ). You

can also exit the tool by selecting Quit from the Window menu.

Importing Information Using the Import Tool
You use the Import Tool to load data from another source into an AR System
schema. The Import Tool expects the data to be in one of three formats:

Importing from an AR System Source

Data from an AR System source can be in any of the accepted formats. All
formats must have all fields of each record on a single line. (You can specify
each of these formats when you generate a file using the Report query
operation in the User Tool. See Chapter 5, Reports, in the Action Request System
User’s Guides for information.)

The recommended format choice is the AR Export format. This is the most
straightforward method of transferring AR System data.

If you cannot use the AR Export format, the second choice should be the CSV
format.

If you must use the ASCII format, then generate the data file from the User
Tool in the Compressed Text format, and set the Title, Header, Footer, and
Column Title separator strings to empty in the Report Preferences dialog box.
You should also set the Page break per to None and the Column titles per to
Page. Finally, make sure the column separator string does not appear
anywhere in the data records.

Table 11-1 AR Import Data Formats

Data Format Filename Extension

AR Export. .arx

Comma Separated Value (CSV). .csv

ASCII. .asc



Using the Import Tool 253

11

Note – In CSV format, the Import Tool interprets \n  in the data as a new line
character. However, in ASCII format, \n  is interpreted as a literal string "\n ".

Importing from a Non-AR System Source

Data from a source outside the AR System must be in comma separated value
(CSV) format or, if it is not possible to generate CSV output, ASCII format.

If you generate a file for import and must use the ASCII format, save the data
with a specified separator string. You can then use the same separator
specification for the data import operation.

The Import Tool can read data files in either the UNIX or DOS formats.

To import data using the Import Tool:
1. Start the Import Tool according to the instructions in “Import Tool

Functions” on page 249. The Import Tool window appears as shown in
Figure 11-1.
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Figure 11-1 Import Tool Window

2. Open the schema that you want to import information into by selecting
Open Schema from the File menu, selecting the schema name from the list
in the Open Schema window, then selecting Apply. The destination
schema name will appear in the Schema area at the top of the Import Tool
window.

Note – If your schema contains duplicate or empty field labels, those fields will
appear in the Schema Fields list as their field IDs.

3. Open the file that contains the information you want to import by
selecting Open Import File from the File menu. The Open Import File
window appears as shown in Figure 11-2 on page 255.
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Figure 11-2 Open Import File Window

a. Use the Directories list and the Filter button to navigate through the
directory structure in order to locate the import file. Then, click on the
file name in the Files list to add it to the directory path in the Selection
field. (If you choose, you can type the directory path and file name
directly into the Selection field.)

b. Select the file format of the file you want to import by choosing AR
Export, CSV, or ASCII in the File Format selection field.

c. If the file is CSV or ASCII format, specify whether or not the file
includes titles by selecting or deselecting the File Contains Field Titles
field checkbox. If the file contains titles and you do not select the File
Contains Field Titles button, the Import Tool will treat the titles the
same as the rest of the data in the file and generate default titles (for
example, Field-01 ).

d. If the file is ASCII format, enter a character string to be used as the
field separator within the import file in the Field Separator field. For
example, “,”. Use \t  for tab and \b  for backspace. The separator can be a
maximum of 32 characters.
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e. Click on the Apply button to load the fields from the import file in the
Import Tool’s main window.

Note – If your import file contains duplicate field titles, a warning dialog box
appears. If your file is .arx  format, the fields will appear as their field IDs. If
your file is .csv or .asc  format, the fields will have a count appended, as in
the following example:
<field_title> [1], <field_title> [2], and so on.
If the Import Tool warns that there is only one field in the import file, you may
have specified the wrong file format. For example, if the file is in record format
but you specified .csv or .asc , this warning will appear.

4. Specify how the data you are importing should be mapped to the fields of
the destination schema according to the instructions in the following
section, “Mapping Import Fields.”

5. If desired, specify default mappings for the import operation according to
the instructions in “Defining Fallback Mappings” on page 261.

6. Select the Import button to load the source information into the schema.
Each record in the source file will generate a single AR. A dialog allows
you to stop the import process before it completes. If you cancel the
operation, you will be prompted to decide whether to copy the remaining
records to the log file. (See “Using the Import Tool Log File” on page 263
for how to use the information copied to the log file.)

Mapping Import Fields
When you import information, you specify which pieces of information from
the source file should be “mapped” (loaded) into which fields in the
destination schema. You can map fields one at a time or all at once. Fields that
you map to each other do not need the same name. In fact, you can even
mismatch data if you are not careful, for example, mapping character data to
selection field data or phone numbers into first names.

You can map multiple fields to more than one schema field. You can also map
multiple import values to a single schema field or map fields to a keyword, as
in the following:

CS Call ID $Product$   $Version$

Modified-date $TIMESTAMP$
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To map import file fields to schema fields:
1. Select the destination schema and the import file in the Import Tool

window and set the import parameters according to the instructions in
“Importing Information Using the Import Tool” on page 252.

2. From the Schema Fields list, click on a field name. The name appears in
the Schema Field entry field.

3. Choose either Import Fields or Keywords from the selection menu above
the Import Fields/Keywords list. The list will contain either a list of the
fields in the import file or a list of keywords, according to your choice.

4. Select the field or keyword you want mapped to the schema field you
selected in Step 2

• If the field names from the import file appear in the
Import Fields/Keywords list, you can click on a field name to display it in
the Mapping field. The result will be a direct transfer of data from the
import file to the schema.

• If keywords appear in the Import Fields/Keywords list, you can click on a
keyword from the list. For example, if you enter the Create-date field in the
Schema Field entry field and you want each date in the import file to reflect
the current day’s date, you can click on DATE in the keywords list to insert
it in the Mapping field. When you import the file, the resulting value will be
the current date.

If you prefer, you can type field names or keywords directly into the list or
select the icon to the right of the Mapping field to open a Text Edit - Mapping
dialog box.

You can map more than one keyword or value to a single schema field by
entering a space or other separator character after the first value then selecting
(or typing) a second value.

5. Select the Add button to create the mapping for the field.

Note that the field is removed from the list of fields on the Schema Fields list.

6. Continue selecting schema fields and import field mappings until you
have mapped all the fields you want to import.
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7. To map all the import fields directly to the schema fields with the same
name, select the Add All button. The Import Tool will try to match data to
schema fields as follows:

8. Make sure you double check the mappings to make sure all fields
matched. You can resolve unmatched fields by mapping the fields
individually.

Note – If Add All is successful, no entries will be left in the Schema Fields list.
If the matching was partially successful, it will add all the matches that it
found. If it did not find any matches, an informational dialog will be posted
saying it was not able to find any matching fields.

9. To modify a field mapping, select the mapping in the Mapping list. The
Add button will become a Modify button. Change the values in the
Schema Field and Mappings fields as required, then select the Modify
button.

10. To delete a field mapping, select the mapping in the Mapping list and
select the Delete button. Select Delete All to delete all the mappings from
the list.

11. When you have completed mapping, your Import Tool window will look
similar to that shown in Figure 11-3 on page 259.

Import File Format Matching (for Add All button only)
AR Export 1. Field IDs (attempted first)

2. Field names, case insensitive (attempted second for fields not
yet matched)

CSV Field names, case insensitive
ASCII Field names, case insensitive
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Figure 11-3 Import Tool Window with Mappings

12. Once all settings in the Import Tool main window are as you want them,
select the Import button to load the source information into the schema.
Each record in the source file will generate a single AR. A dialog allows
you to stop the import process before it completes. If you cancel the
operation, you will be prompted to decide whether to copy the remaining
records to the log file. (See “Using the Import Tool Log File” on page 263
for using information copied to the log file.)

Note – You do not need to map all the schema fields before starting the import.
You only need to map the fields that you want to import.

Saving Field Mappings

You may want to save a mapping you create for future use. This can save you
a great deal of time if you regularly perform a similar import operation.
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When you save mappings, the entire set of information is saved. This includes
the schema name, the server, the import file name, all mappings, all fallback
mappings, all error handling data information, and preferences.

To save mapping information:
1. Specify map settings in the Import Tool main window.

2. Select Save Mapping from the File menu. The Save Mapping dialog box
appears.

3. Enter a name in the Mapping Name field. This name will become the file
name for the mapping file.

4. Specify the directory that will contain the mapping file by typing the
directory name in the Directory field or by selecting the menu button
beside the field to choose from the list of available directories.

5. Optionally, you can enter text in the Help Text field to describe the
mapping file you are saving.

6. Select Save to create the mapping file. If a file by the same name already
exists, you will be asked if you want to overwrite the file. Select Continue
to overwrite the file. Select Cancel to cancel the save operation.

Using Saved Field Mappings

You can load mappings you previously saved by following the steps below.

To use an existing mapping file:
1. Select Load Mapping from the File menu. The Load Mapping dialog box

appears.

2. Specify the directory that contains the mapping file by typing the
directory name in the Directory field or by selecting the menu icon beside
the field to choose from the list of available directories.

3. Select the mapping file from the Available Mappings list.

4. Select the Load button.
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Note – Loading a mapping file will change your saved preferences to be the
same as those in the mapping file.

Considerations for Importing Data

Because sizeable performance impacts can occur if you are importing a lot of
data into a schema with Full Text Search (FTS) fields, you should consider
shutting down FTS from the AR System Administrator Tool before importing
the data. For instructions, “Configuring FTS in the AR System” on page 317.

Your should factor in the following when deciding whether to shut down FTS:

• Size of the database.

• When will you re-index the database.

• How soon you need the data.

One more consideration: do not edit the import file between the time you start
the Import Tool and the time you start the actual import of data. (For more
information, “Using the Import Tool Log File” on page 263.)

Defining Fallback Mappings
You can define fallback mappings to tell the Import Tool what to do should a
problem with data mapping occur during an import operation.

Fallback mappings are used when the import value is invalid for the schema
field type. For example, if the schema field is of type integer and the import
value is a character string (such as “name”), the fallback mapping for the field
will be used, if one is defined.

In cases where an error can only be detected by the server, the Fallback
mappings will not be used. For example, the import data may be valid for the
field type but not an acceptable value (for example, if the schema field has a
range of 1 to 10 and the import value is 11).
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To set fallback mappings:
1. In the Import Tool main window, select Fallback Mapping from the

Options menu (or type Ctrl+F ). The Fallback Mappings window appears,
as shown in Figure 11-4. The Schema Fields list contains a list of the fields
for the currently selected destination schema.

Figure 11-4 Fallback Mappings Window

2. Select the field you want to specify a fallback mapping for from the
Schema Fields list. The field name appears in the Schema Field field.

3. Specify the fallback mapping by selecting a keyword from the Keywords
list or by typing a value into the Mapping field.

If you prefer, you can type keywords directly into the field or select the icon to
the right of the Mapping field to open a Text Edit dialog box.

You can map more than one keyword to a single schema field by entering a
space or other separator character after the first value then selecting (or typing)
a second value.

4. Select the Add button to add the mapping to the Mapping list.

5. To modify a mapping, select the mapping in the Mapping list. The Add
button will become a Modify button. Change the values in the Schema
Field and Mappings fields as required, then select the Modify button.



Using the Import Tool 263

11

6. To delete a mapping, select the mapping then select the Delete button. To
delete all current mappings from the list, select the Delete All button.

7. Once you have specified all the mappings you want to specify, select the
Apply button.

Using the Import Tool Log File
During each import operation, a dialog appears to let you know the status of
the operation. If you have set Import Tool preferences to alert you of bad
records or to use fallback options, the dialog informs you that an error has
occurred each time a record cannot be successfully imported. You can then
select one of three options:

• You can skip the record and import the rest of the data. The record in error
will be written to the error log and the Import Tool will continue importing
the remaining data.

• You can skip all records with the same type of error and import the rest of
the data. The records in error will be written to the error log and the Import
Tool will continue importing records that are not in error.

• You can stop the import operation at that point with the option to copy all
remaining data to the error log.

You may also have set error handling preferences so that records that cannot be
imported are skipped automatically and recorded in the error log.

You may also set error handling preferences so that records that cannot be
imported are skipped automatically and recorded in the import log, or to use
the fallback mapping, then only alert you if the fallback mapping also had an
error.

No matter how you set preferences, the error log file contains detailed
information on every error that occurred, including information that was not in
the error dialog. It also contains a copy of every record that caused an error.

Once the import operation is ended, you can open the import log to examine
the records in error. You can then edit the import log to correct the problem
that caused the error and, if you copied all remaining records to the log file,
you can choose to complete the data import operation by using the corrected
import log itself as the import source file, after removing all non-data
information from the file.
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Alternatively, you can examine the error log to identify the cause of the
problem then correct the problem in the original source file and re-import from
that file. If you choose this alternative, be sure to delete any data from the
source file that was imported successfully during the original import operation
to avoid creating duplicate ARs.

Setting Import Tool Preferences
You can set preferences that control the behavior of the Import Tool, including
how you want the tool to perform error handling and data transformations and
other options you want set.

To set preferences for the Import Tool:
1. Select Preferences from the Options menu. The Preferences window

appears as shown in Figure 11-5.

Figure 11-5 Import Tool Preferences Dialog Box
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2. Set options by selecting from the selection menus, typing information in
the fields, or selecting choices. You can set the following Import Tool
preferences:

a. You can set the following Error Handling preferences:

b. You can set the following Data Transformation preferences:

c. You can set the following Options preferences:

Bad Records Alert User The import process is interrupted and you receive an
error dialog.

Skip The record is not imported in the schema and the Import
Tool will not alert the user before recording the error to
the log file.

Use
Fallback

The Import Tool uses the fallback mapping that you
specify for the field in the Fallback Mappings window. If
the fallback mapping also produces an error, it will alert
the user.

Duplicate Entry-
IDs

New New Entry IDs are assigned to all of the ARs in the
import file.

Old The existing ID will be used for all entries imported. If an
ID is already in use, an error will be returned.

Fixup Entries will be imported using their existing IDs. If an ID
is already used, a new ID will be generated for the new
record.

Log File Enter a directory and path name for a file that logs error
messages encountered during the import process.

Remove leading and trailing
white space

If set, all leading and trailing white space (blanks and tabs)
is removed from values before they are imported. If not set,
values are imported as they are in the import file.

Truncate data to character
field limit

If set, any character values that are too long for the target
field are truncated. If not set, an error is reported if a value
will not fit within the field limits.

Prompt for Login Select if you want to be prompted for your login every
time you open the Import Tool. This setting is useful
when more than one user works on one workstation.

Confirm upon Exit Select if you want a confirmation message every time
you exit the Import Tool.
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3. Once you have chosen your preference settings, select the Apply button to
accept the settings or select Dismiss to dismiss the Preferences dialog box
without changing the old preference settings.

Confirm upon Delete All Select if you want a confirmation message every time
you click on the Delete All button in the Import Tool
window.

Reset Log File when starting
Import Tool

Select if you want to purge the error log each time you
start the Import Tool. If you do not reset the log file,
you have to monitor the size of the file more closely.
The log file can grow quite large depending on what is
added to it during error handling.
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This chapter describes how the AR System makes use of electronic mail (email)
to allow users without direct access to the AR System server to submit ARs,
query ARs, or receive notifications. It describes how to set up and use the
electronic mail handler (armaild ) so that users can submit ARs. It also
describes how users can receive notifications by email. The following topics are
included:

• Overview of the electronic mail interface.

• Submitting ARs through email.

• Querying via email.

• Receiving notifications through email.

The AR System Electronic Mail Interface
Electronic mail (email) may be the interface of choice for submitting action
requests and receiving notifications in environments where there is no
high-speed network link between the user and the AR System server.

This chapter describes the setup and configuration for both the UNIX and
Windows NT-based armaild  services. While the capabilities of armaild  are the
same regardless of the platform it is running on, their operation and
configuration are a little different. The differences for each of the platforms are
clearly indicated throughout the chapter.
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The main differences between the two platforms are described in Table 12-1:

The AR System mail handler (armaild ) allows users to submit and query ARs
using their email facility. The armaild  daemon watches the mailbox designated
for use by the AR System for new messages. When messages are received and
processed, the mail handler creates the new AR and enters it into the AR
System. If there is an error, the original message and error messages are
returned to the submitter. If the AR server is not responding, the message is
held and periodically resubmitted until the server responds.

The AR System also allows users to receive notifications via email. You may
design filters and escalations to send specified text or the contents of selected
fields to users via email notification. The AR System sends the notifications via
the sendmail  command on UNIX servers and via armaild  on Windows NT
servers.

Using Electronic Mail to Submit ARs
Before users can submit ARs using electronic mail, you need to perform the
following administrative tasks.

Table 12-1 Differences Between armaild  in UNIX and Windows NT

Function UNIX Windows NT

email Uses SMTP for email. Uses Microsoft Mail (MS
Mail) for email.

Sending email
Notifications

* Server sends email
notifications.
* In some circumstances, you
can override who the email is
sent from.

* armaild  sends email
notifications.
* Notifications always come
from the armaild  Microsoft
Mail logon account, which
you cannot override.

Location of
Configuration File

 /etc/armaild.conf
You can specify another
filename and location
through the command line.
For more information, see
“Starting the Mail Handler”
on page 275.

<ar_install_dir>\conf\
armaild.cfg
In addition, the Windows NT
armaild  service has extra
configuration values that
reside in the ar.cfg
configuration file.
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1. Establish a mailbox address for the mail handler. If you are in the
Windows NT environment, create a user in Microsoft Mail for the
armaild  mail handler to use.

2. Install the mail handler and, optionally, specify a configuration file
containing values that define the operational settings for the mail handler.

3. Generate one or more email templates for each schema you want to make
available for users to submit via email.

Details on how to perform each of these administrative tasks are included in
this chapter.

Establishing a Mail Address

For UNIX Servers

The AR System mail handler must have a mail address somewhere in your
system. By default, the AR System will look for the address ARSystem.
However, you can use any address you want, if you specify the address in the
armaild  configuration file.

The mail address you specify should be used strictly for the AR System.

The most likely machine on which to establish the mail address is the machine
running the AR server. However, this is not a requirement. You can establish a
mail address on any machine in your network that has the ability to access the
AR server by using the procedure that follows:

• Update the /etc/aliases file to add an entry for the mail address. For
example, if you use the default name ARSystem for your mail address, you
could add an entry of the form:

For all other nodes in the network, you need to make any changes that are
required for them to forward mail targeted at the mail handler to the
appropriate location. This may or may not require updates to the other nodes.

If you are using NIS services, you would make the changes noted above
following the rules and guidelines for updating files under NIS.

ARSystem:/usr/spool/mail/ARSystem
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For Windows NT Servers

The only machine on which to establish the armaild  service is the system
running the AR server. All mail sent by the armaild daemon will be from the
Microsoft Mail ID configured at installation. Mail destined for the AR server
should be sent to this Microsoft Mail address.

Setting Up the Mail Handler

The armaild  daemon must have access to several types of information in order
to process action requests through email. It must know the address of the AR
System mailbox. It must also know other information, including what server to
use, what schema to process a submittal for, and what to do if the transaction
succeeds or fails.

There are several ways to supply needed information to the mail handler:

• You can accept AR System defaults, where defaults exist.

• You can specify a configuration file when you start the mail handler. This
file should contain values for various options affecting how the mail handler
operates. These settings will then become “defaults” for that run of the mail
handler. Values set through a configuration file will override AR System
defaults. See the section “Creating an Email Configuration File” that follows
for information on defining the configuration file values.

• You can make sure that the mail templates available to users submitting ARs
include all necessary specifications. Settings included in a template will
override both system defaults and values set through a configuration file.
See “Using Mail Templates” on page 276 for information on mail templates.

Creating an Email Configuration File

You can set a number of options for the AR System mail handler by including
their specifications in an ASCII file. You then designate the file as the
configuration file when you start the armaild  daemon. The values set through
the configuration file will be associated with that run of the mail handler
process and the values for options specified in the configuration file will
override the system defaults.
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Table 12-2 shows the options that you can specify in the configuration file:

Table 12-2 armaild  Configuration File Options (1 of 3)

Option Function System Default

Address: The mail address the mail
handler should watch for AR
System messages. (UNIX only.)

ARSystem

Default-
Password:

The AR System password to use
if no password is specified in the
submitted message.

No password

Default-Schema: The schema to submit to if no
schema is specified in the
submitted message.

None. The schema must
be specified here or in
the message

Default-Server: The AR System server to submit
to if no server is specified in the
submitted message.

The machine running
the armaild  process

Default-User: The AR System login user to use
if there is no login specified in the
submitted message.

Mailer daemon

Include-
Original-
On-Failure:

A flag indicating whether to
include the full text of the
original message in a reply to a
failed submission. Legal values
are T and F.

T (include full text)

Include-
Original-
On-Success:

A flag indicating whether to
include the full text of the
original message in a reply to a
successful submission. Legal
values are T and F.

T (include full text)

Poll-Interval: The number of seconds to wait
between polls to the mailbox to
check for new messages. The
minimum interval is 5 seconds.

300 (5 minutes)
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Query-Match-
Full:

Defines the maximum number of
matches that can be returned to a
successful Full Format query
request.
For example, if a user submits a
query request with Full format
indicated, and the query matches
120 items, only the first 25 will be
returned.

25

Query-Match-
Short:

Defines the maximum number of
matches that can be returned to a
successful Short Format query
request.
For example, if a user submits a
query request with Short format
indicated, and the query matches
120 items, only the first 50 will be
returned.

50

Reply-Failure: The email address to use for
replies to failed submissions. Use
to redirect replies for failed
submissions to a third party
rather than the message sender.
This field only applies to submits,
not queries.
To suppress sending a message
on reply failure, for UNIX, set the
address to /dev/null  (or to an
address directed to /dev/null
in the mail aliases file with a line
like nobody: /dev/null ). For
Windows NT, set the address to
Discard .

Reply to message
sender. Use Reply-to:
field, then From:  field,
and finally the From
header to find user.

Table 12-2 armaild  Configuration File Options (2 of 3)

Option Function System Default



Electronic Mail Support 273

12

Reply-Success: The email address to use for
replies to successful submissions.
Use to redirect replies for
successful submissions to a third
party rather than the message
sender. This field only applies to
submits, not queries.
To suppress sending a message
on reply success, for UNIX, set
the address to /dev/null  (or to
an address directed to
/dev/null  in the mail aliases
file with a line like
nobody: /dev/null ). For
Windows NT, set the address to
Discard .

Reply to message
sender. Use Reply-to:
field, then From:  field,
and finally the From
header to find user.

Required-Schema: The only schema for which
submissions will be accepted. If
there is a Schema:  line in the
submitted message, it must
contain this schema name or the
submission will be rejected. If
there is no Schema:  line, the
Default-Schema:  setting in the
configuration file must match this
schema name or the submission
will be rejected.

No required schema
setting.

Required-Server: The only server for which
submissions will be accepted. If
there is a Server:  line in the
submitted message, it must
contain this server name or the
submission will be rejected. If
there is no Server:  line, the
Default-Server:  setting in the
configuration file must match this
server name or the submission
will be rejected.

No required server
setting.

Table 12-2 armaild  Configuration File Options (3 of 3)

Option Function System Default
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For Windows NT Servers
Table 12-3 shows additional configuration parameters that are used for the
Windows NT server. These parameters are located in the
<ar_install_dir>\conf\ar.cfg configuration file.

Sample Email Configuration File

The following is an example of a configuration file that specifies a mailbox
address of NewTickets  and sets the default server to narnia and the default
schema to TroubleTickets :

Table 12-3 Windows NT Server armaild  Configuration File Options

Option Function System Default

MailNotifyDir: Indicates the full pathname for the
mailntfy  directory that holds all
of the email notifications the server
passes to the armaild service. The
armaild  service deletes them after
they are processed.

<ar_install_dir>\
arserver\mailntfy

MailLogin: Indicates the Microsoft Mail and
NT account login name.

No default.

MailPassword: Indicates the Microsoft Mail and
NT account login password.

No default. Stored
encrypted.

PO-Location: Indicates the NT full pathname for
the system and share file that hold
the Microsoft Mail post office.

UNC (universal
naming convention)
name for the Microsoft
Mail postoffice.
No default.

Address: NewTickets
Default-Server: narnia
Default-Schema: TroubleTickets
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Starting the Mail Handler

For UNIX Servers

Once you have established a mail address for messages to be mailed to the AR
System and set up a configuration file, if one is desired, you can run the AR
System mail handler, armaild . The syntax for armaild  is as follows:

Command Options
The following command options may appear in any order on the command
line:

To start the mail handler:
The following example will start the mail handler using a configuration file
called mailopt . (You will need read/write access to the file.)

You will probably want to add the command line you will use most often to
start the mail handler to your system start-up script.

-d Set the system into debugging mode. This mode prints messages to
stdout  that detail the progress of the operations being performed.
You should use debugging mode only to find problems with how the
mail handler is running.

-f <filename> Process the indicated configuration file for command options to the
armaild  process. The various options are described in “Creating an
Email Configuration File” on page 270.

-n <number-of
intervals>

The number of polling intervals this daemon will run. This setting
allows you to limit the amount of time the mail handler will run. If
this option is not specified, the daemon will run until terminated.

armaild [-d][-f filename ][-n number-of-intervals ]

% armaild -f mailopt &
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For Windows NT Servers

The mail handler is installed to run as a Windows NT service. The startup
settings for the armaild  service must start the service as the Windows NT
account designated for use during installation, not as the System Account , as
described in “Establishing a Mail Address” on page 269.

You also can use the following debug options with armaild :

• If you run armaild  as a Windows NT service and use the -d debug option,
debug messages are logged in the
<ar_install_dir>\arserver\db\armaild.log  file and do not appear on
the screen.

• If you do not want to run armaild  as a Windows NT service, you can run
armaild  in manual mode by adding the -m option to the command line, as
in the following example.

Debug messages appear on screen and not in the armaild.log  file.

For more information on the armaild  command options, see “Command
Options” on page 275.

Using Mail Templates

Users who wish to submit ARs using email will use the mail templates that are
available to them according to the instructions provided in the Action Request
System User’s Guide. As the AR administrator, it is your responsibility to
generate the mail templates and modify them so that they meet the needs of
your users.

Generating Mail Templates

To generate a mail template for any schema, you use the Export operation of
the Administrator Tool. Instead of exporting the schema definition to a file, you
choose the Export Schema Mail Definition menu choice to create an ASCII file
that can then be used to submit ARs via mail. See “Importing Definitions” on
page 242 for complete instructions on exporting mail templates.

%  armaild -d -f c:\remedy\armaild.cfg -m
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The Export operation generates a template that looks like Figure 12-1. Only the
fields shown below are available to all users during submission:

Figure 12-1 Email Template

Email templates have four pieces:

• The initial comment block stating when the template was generated.

• A header containing fields identifying the schema and user.

• A block of fields.

• Begin and end message comment lines.

The comment block is optional and can be retained or deleted as desired. Any
line beginning with a # in column 1 will be treated as a comment. Comments
can occur anywhere in the message.

#
# File exported Sun Nov 17 14:30:02 1995
#
# AR-Message-Begin Do Not Delete This Line

Schema: Schema01
Server: narnia
Login:
Password:
Action: Submit
#Values: Submit, Query
Format: Short
#Values: Short, Full

 Submitter! 2!:
 Short-Description ! 8!:
 Long-Description ! 9!:
 Notify-method !12!: None
# Values: None, Notifier, E-mail
 Submitter-Severity !13!: Low
# Values: Low, Medium, High

# AR-Message-End Do Not Delete This Line
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The header block may contain a Schema: line with a valid schema named, a
Server:  line to identify the server on which the schema is located, a user login
and password, and optional Action and Format lines to define the operation to
perform.

If no schema is specified or the specified schema does not exist, the mail
handler will check to see if a schema was defined in a configuration file that
was specified when the mail handler was started. If not, the item will be
rejected since a schema must be specified.

If no server is specified or the specified server does not exist, the mail handler
will first check to see if a server was defined in a configuration file that was
specified when the mail handler was started. If not, then the machine running
the armaild  process will be used as the server.

If no user name or password is specified, the mail handler will check to see if
they were defined in a configuration file that was specified when the mail
handler was started. If not, the user performing the operation is set to “Mailer
daemon.”

If no action line is specified, the mail handler defaults to Submit. If you make a
query and do not specify a format, the mail handler uses the Short format.

The header block is considered ended when any field other than a comment or
one of the header labels is encountered. The blank line shown in the example
above is useful but not required.

The field block section of the email template contains the fields that can be set.
The Export operation includes all fields open to all users at submit time. Field
order is not significant. The Export operation generates fields in the same order
as on the default administrator view of the schema.

A field consists of:

• An optional field name (the field name is just to provide a useful name, the
ID is what the AR System uses).

• The field ID within exclamation points (!) (for example, field ID 9 would be
!9!), with any single delimiter character after the second !. The character :
(colon) is often used as a delimiter. Blanks are acceptable. If any characters
other than digits and spaces are between the exclamation points, the
reference is not recognized as a field ID.
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• Values can be entered any place after the single delimiting character.
Leading blanks are ignored when reading a value. When generated from the
Export operation, fields with default values have the values loaded in the
template.

You can place several field references on a single line as long as the second (or
third) item starts far enough after the end of the previous item to leave enough
room for a full-length value. For example, if the first field is a 10-byte
maximum character string, the second field name or ID must start at least 10
bytes after the start of the value of the first item. Any diary type or character
type with an unlimited length or length limit over 50 characters cannot have a
following field on the same line. The export operation generates a single field
on each line.

There is no significance to the positioning of the field IDs on a line. They can be
placed to align for readability or not, as desired.

The AR-Message-Begin and AR-Message-End comment lines are
recommended but not required. The begin and end message delimiters avoid
armaild  parsing problems that can be encountered when mail passes through
mail gateways on its way to armaild .

Modifying Mail Templates

If necessary, you can modify mail templates before distribution, as long as the
resulting template matches the rules discussed in this section.

When you export a mail template, the template contains only those fields that
are available to all users during the submit operation; that is, all fields that
have a create mode of Open. It is possible for you to add any of the fields that
are not exported under this rule to the template; however, since they did not
meet the requirements to be included in the template automatically, these fields
have additional security protection. A user submitting an entry with a value
for one of these additional fields must specify their Login and Password in
order to gain access to these protected fields. If the Login and Password fields
are not supplied in either the template or the configuration file specified when
armaild  was started, the submission defaults to Mailer daemon.
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Submitting ARs Using Templates

Once you have established an email address for the AR System, set up and
installed the mail handler, and generated email templates, AR System users
will be able to use the templates to submit ARs. To do so, the user opens the
appropriate email template in their email tool (or in any text editor), fills in the
fields as required, and directs the resulting message to the AR System mailbox.
Users will receive confirmation if their submission is successful, or receive a
message identifying any errors if the submission is rejected. See the Action
Request System User’s Guide for more information on using email templates to
submit action requests.

Querying via Electronic Mail
The armaild  process also supports querying via email. AR System users can
send the armaild  process query requests encapsulated in specially formatted
email messages and receive the query results by email.

Overview

Users now have the ability to query the AR System, in addition to the already
established ability to submit to the AR System. The AR System administrator
needs merely to modify the email template.

The query requests are supported in three formats:

Formatting

All matching requests are listed in the body of the message one after another.
In full format, each entry is separated by a line of dashes. If a request fails, an
error envelope is returned with an indication of the cause of the failure.

Query by Entry
ID

The simplest method is the query by entry-id, which requires that the
user email a specific entry-id value.

Query by Field The query by fields method allows the user to specify a selection on a
field or fields for the schema they wish to query, much like the
functionality of the user tool. This method can return multiple entries.

Query Bar
Command

The query via a query bar request is the most powerful version of the
query via email functionality. It provides an email based query-bar
facility, anything you can enter in the query bar can also be done via
email.



Electronic Mail Support 281

12

If a query request returns more than one match, the beginning of the message
indicates the total number of matches that were made. If a request exceeds the
configured query match limit, an additional message is provided indicating
this, as well as what the limit was. The maximum number of allowable
matches are returned in the message.

The Action and Format keywords can appear anywhere in the header portion
of the message. The user specifies whether the action to be performed is a
query or a submission by typing Query  or Submit  after the Action keyword. If
the Action keyword does not appear, the armaild  daemon will treat the email
message as a submit request.

The user can chose that requested information be formatted in full or short
form using the Format keyword, as described below.

• The default format is short, and returns the information via the query list
definition for the schema being queried.

• The full format lists the information for all accessible fields. The user
controls the format through the Format keyword in the header portion of
the email request.

The AR-Message-Begin and AR-Message-End comment lines are
recommended for use in the email templates, but are not required. Gateways
may add extra text or graphics before and after the body of a message. The
beginning and end message delimiters prevent armaild  from having trouble
parsing these additions.

Additional Configuration File Options

To prevent large email responses, you can define limits on the total number of
entries that can be returned in the armaild configuration file. The
modifications needed for the /etc/armaild.conf  file (for UNIX) or
<ar_install_dir>\conf\armaild.cfg file  (for Windows NT) are described
in “Creating an Email Configuration File” on page 270.

These settings allow the administrator to limit the number of matches returned
to the requester. All matching requests are listed in the body of the message
one after another. In Full format, each entry is separated by a line of dashes. If
a request fails, an error envelope is returned with an indication of the cause of
the failure.
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If a query request returns more than one match, the beginning of the message
indicates the total number of matches that were made. If a request exceeds the
configured query match limit, an additional message is provided indicating
this happened and what the limit was. The maximum number of allowable
matches are returned in the message.

The Format keyword is followed by the requested format, either Full or Short.
This setting allows the requestor to control the information used in the
summary. The Format keyword is only useful with query requests; it has no
affect on submit requests.

Preparing the Electronic Mail Template

To create the format required to use the query capability, modify the email
submit format you create using the Administrator Tool. For more information,
see “Using Mail Templates” on page 276.

Follow the steps below to modify the email template.
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To create the query by entry ID format:
1. Export the schema mail template via the Administrator Tool for the

schema that you want to query. Figure 12-2 shows an example of an
exported schema mail template.

Figure 12-2 Original Template for Query by Entry-ID

2. Edit the exported file by doing the following:

a. Make sure the Action keyword value is set to Query .

b. In the body portion of the message, you can only define the entry-ID
field. It must have a field-id value of 1.

c. Fill in the data portion of the message with the entry ID of the ticket to
be retrieved.

d. Remove all other fields from the body of the template. The only field in
the body should be !1! TT00000000119 .

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values: Submit, Query
Format: Short
# Values: Short, Full

# Values: Phone, AR System, email,
Method !536870914! Phone

 # Priority !536870915! Low
Phone Number !536870916!

# AR-Message-End                Do Not Delete This Line
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Figure 12-3 shows an exported file and how it was modified to become a query
by entry ID message.

Figure 12-3 Modified Template For Query by Entry-ID

The Action keyword and format can appear anywhere in the Header portion of
the message. If the Action keyword and format does not appear, or the action
keyword is present but specifies Submit , then the armaild  daemon will treat
the email message as a submit request.

To create the query by field format:
The query by field format requires the same Action keyword as the query by
entry ID, but can have more that one field defined.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Short

 !1! TT00000000119

# AR-Message-End Do Not Delete This Line
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1. Export the schema mail template via the Administrator Tool for the
schema that you want to query. Figure 12-4 shows an example of an
exported schema mail template.

Figure 12-4 Original Template for Query by Fields

2. Edit the exported file by doing the following:

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values Submit, Query
Format: Short
# Values Short, Full

Source !5368737933! Phone
# Values: Phone, AR System, email,
#      NMP, ACD
Caller Impact !5368783455! Low
# Values: High, Medium, Low
Last Name !5386753452!
Phone Number !5386748345!

# AR-Message-End Do Not Delete This Line
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a. Make sure the Action keyword value is set to Query .

b. Set the Format option as desired if you want other than the default (Short).

c. Edit the body portion of the message to include the fields you are querying, but
remove all other extra information. Only fields that have values are used in the
request. Field that do not have values are ignored.

Figure 12-5 shows an exported file and how it was modified to become a query
for multiple fields message.

Figure 12-5 Modified Template For Query for Fields

Note – Compare Figure 12-5 with Figure 12-4 on page 285. The Action keyword
value has been changed to Query , and the unneeded fields
(Last Name and Phone Number ) have been removed

To create the query bar format:
The Query bar format requires the same Action keyword as the query via entry
ID, but the field format is a little different.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Full

Source !5368737933! Phone
Caller Impact !5368783455! Low

# AR-Message-End Do Not Delete This Line
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1. Export the schema mail template via the Administrator Tool for the
schema that you want to query. Figure 12-6 shows an example of an
exported schema mail template.

Figure 12-6 Original Template for Query Bar Format

2. Edit the exported file by doing the following:

a. Make sure the Action keyword value is set to Query .

b. Remove all fields in the body portion of the message to include a
Query Bar line. The query bar formatted request must have the
keyword QueryBar  in the field label portion of the line. The field ID
can be any non-negative value, though zero is recommended. The
value portion of the field can be any valid query bar formatted query.
All of the restrictions that apply to the query bar in the user tool apply
to its usage when performed via email.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin              Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values: Submit, Query
Format: Short
# Values: Short, Full

Source !5368739331! Phone
# Values: Phone, AR System, email,
#      NMP, ACD
Caller Impact !5368783455! Low
# Values: High, Medium, Low
Last Name !5386753452!
Phone Number !5386748345!

# AR-Message-End                    Do Not Delete This Line
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Figure 12-7 shows an exported file and how it was modified to become a query
bar format message.

Figure 12-7 Modified Template For Query Bar Format

Note – Make sure that the value after the Query Bar keyword and its field ID is
in valid AR System query-by-example format.

Using Electronic Mail for Notifications
You can define filters and escalations that direct AR System notifications to
users via electronic mail by specifying E-mail  as the delivery mechanism when
you define the Notify filter or escalation action. You can send a text message or
you can send the contents of selected fields, as long as the user being notified
has the appropriate permissions for those fields.

See Chapter 6 and Chapter 7 for details on setting up a filter or an escalation to
send notifications to users via email.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin             Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Short

QueryBar !0! 'Source' = "Phone" OR 'Source' = "email"

# AR-Message-End Do Not Delete This Line
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For UNIX Servers

The AR System will automatically generate a sendmail  command to send the
notification text (and field contents) to the designated user when the filter or
escalation is triggered.

For Windows NT Servers

The AR System server automatically passes notifications to the armaild

service, which then sends the notifications. This is different than the UNIX
armaild  daemon which only receives email tickets for submission to the AR
System. To send email notifications, the armaild  service on NT must be
running.

The notification information is passed to armaild  via the
<ar_install_dir>\arserver\mailntfy  directory. The armaild  service
periodically checks the directory for notifications and sends all that it finds.
You define the frequency of the polling interval by setting the Poll-Interval:

configuration parameter.
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The Multi-Process Server Option 13

This chapter discusses the administration and performance of the multi-
process (MP) server option in the AR System. The topics covered include the
following:

• Multi-processing and the AR System.

• Configuring an MP server.

• Administering an MP server.

• Using the MP server with different AR clients.

• Using the MP server with private servers.

Note – The MP server option is a feature that you can purchase along with the
AR System 2.0 (or later) UNIX server and may not be available on the server
you are administering.

Multi-Processing and the AR System
To improve AR System performance, you can be licensed to run the MP server
option. Running multiple arserverd  processes involves performance questions
that only you, the administrator, can answer. Sometimes it makes sense to off-
load certain operations to a different server, sometimes not.
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Using multiple arserverd  processes improves system performance by
distributing the process load. For example, using several servers allows the AR
System to do multiple database searches in parallel. If users feel that queries
are taking too long, increasing the number of servers should create a noticeable
improvement in performance.

The MP server is scalable from a single Admin server doing all server
functions to multiple servers doing specific functions. The arserverd  processes
adapt to the configuration parameters defined and spread the load. You
determine what amount of server resources to dedicate to the AR System.

Note – The 2.0 (or later) AR server is compatible with earlier versions of AR
clients. However, the only way you can take advantage of the MP ability of the
AR System is if you are using 2.0 (or later) clients.

The MP server option provides the following features for AR users:

• All operations are hidden within the API.

• Scalability. You can add additional servers as needed.

• Compatibility with clients using older versions of our API.

• Allows users to run private servers (if needed).

• Provides a distinct and measurable gain in performance.

Figure 13-1 shows how the MP server design works and shows the server
processes and their RPC socket numbers.

Figure 13-1 MP Server Design

You can configure the number of arserverd  servers you need. Note that there
are five types of arserverd  processes:

• Admin arserverd  process.

arservtcd

Admin Fast1 [Fast2 ...] List1 [List2] [List3 ...] Escalation

(RPC 390604)

(RPC 390600) (RPC 390620 to 390634) (RPC 390635 to 390669) (RPC 390603)
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• Fast arserverd  processes.

• List arserverd  processes.

• Escalation arserverd  process.

• Private arserverd  processes.

The following sections describe the admin, fast, list, and escalation arserverd

processes. For private arserverd  processes, “Using the MP Server with Private
Servers” on page 299.

Admin Server

The arserverd  admin process is an AR System server that can perform any
operation within the system. It performs all admin restructuring operations,
guaranteeing the serialization and integrity of all restructuring operations.
There can be only one admin server process at any time.

In addition to its role as the restructure server, the admin server is also the
catch-all server for older clients that do not handle MP server capabilities. In a
worst case scenario (all older clients with an MP server running), all operations
from all clients would be handled through the admin server.

If you do not have an MP server license or choose not to run any fast, list, or
escalation servers, you will be running the arservtcd  server and the admin
server. For information on the arservtcd  controller process, “Configuring
Multiple Process Servers” on page 295.

Fast Servers

Fast servers handle all the fast operations of the AR System, that is, the
operations that generally run to completion quickly without blocking access to
the server. The arserverd  fast servers handle all server operations except for
admin operations that restructure the database (which use the Admin process),
and the ARExport, ARGetListEntry, and ARGetEntryStatistics calls (which use
the List processes).

User Tool operations that use a fast server include the following:

• Previous and Next buttons in the Display and Modify windows.

• Generating reports.
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• Modify Individual and Modify All functions.

• Submit functions.

• Generating lists of schemas and fields.

For most sites, you probably only need a couple of fast servers. However, for
larger sites, you might benefit from the use of additional fast servers. To
configure the number of fast servers, see “Configuring Multiple Process
Servers” on page 295.

List Servers

List servers handle operations of the AR System that may take some time:
ARExport, ARGetListEntry (high-performance database searches), and
ARGetEntryStatistics.

User Tool operations that use list servers include the following:

• Queries.

• Initial connection to a schema.

Most sites can benefit from using multiple list servers. For example, to
eliminate queuing for access to the database, list server processes allow
multiple searches to occur in parallel. To configure the number of list servers,
see “Configuring Multiple Process Servers” on page 295.

Escalation Server

Typically, the admin server handles escalation processes. However, if you
create and use many escalations with short intervals for checking conditions,
putting the load on an arserverd  server that handles only escalations makes a
lot of sense.

As with all MP servers, sharing the processing load insulates the admin server
from escalation overhead. However, you must juggle whether creating an
escalation server is worth the performance cost to your system or whether you
have enough escalation processes that merit creating an escalation server in the
first place.

You can have only one escalation server. To enable the escalation server, see
“Configuring Multiple Process Servers” on page 295.
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Multi-Process Server Lock and Log Files

Normally, to prevent multiple instances of the arserverd  process from
running, a lock file is created (ar.lck ). When using the MP server feature, to
prevent multiple instances of the server running on the same address, lock files
related to the specific RPC socket address are created. The admin server creates
a lock file named ar.lck  while the servers using other RPC sockets create files
named ar.lck. <rpcnum> where <rpcnum> is the RPC socket address. For
example, if using the RPC socket address of 390680, the associated lock file
would be ar.lck.390680 . But, in general, you do not need to worry about
these files.

If you specify an SQL, Filter, Escalation, User, or API log file using the
Administrator Tool, a similar file naming strategy is followed. The system adds
.<rpcnum> to the end of the log filename that you supply. This logs the
operations related to each server into separate files.

Configuring Multiple Process Servers
To configure the multiple-process server environment, select the Multiple
Processes category (Figure 13-2 on page 296) in the Server Information window
to specify a multiple process server configuration. If you do not have a Multi-
Process Server Option license, you cannot access the Server Information —
Multiple Processes category.

To set the multiple-process server environment:
1. Select Server Information from the File menu. The Server Information

window appears.

2. In the Server Information window, select Multiple Processes from the
Category list, as shown in Figure 13-2 on page 296.
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Figure 13-2 Server Information — Multiple Servers

3. Select from the following options or enter settings as required:

4. Select the Apply button to save the option settings.

• If you increase the number of fast or list servers, the arservtcd  server
immediately starts the additional fast and list servers you configure.

• If you activate the escalation server, the arservtcd  server does not start the
escalation server until you stop and restart the arservtcd  server.

• If you reduce the number of fast, list, or escalation servers, those processes
are not killed until you stop and restart the arservtcd  process.

Fast Servers Number of processes to run as fast servers. For more
information on fast servers, “Fast Servers” on page 293.

List Servers Number of processes to run as list servers. For more
information on list servers, “List Servers” on page 294.

Activate
Escalation Server

If your site uses many escalations which the server checks
frequently, select Yes to activate a separate escalation server.
If you select No, escalations are handled by the main Admin
server.
For more information on escalation servers, “Escalation
Server” on page 294.
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Administering Processes
The AR System includes a controller process, arservtcd , that handles requests
from clients for information on which socket to use for communicating with
the various arserverd  processes. The arservtcd  server responds to requests
for which RPC socket to use for the Fast and List processes. In addition, the
arservtcd  server starts and manages arserverd , arservdsd , and arservftd

processes. While arservtcd  is available to all AR System users, it includes
extra capabilities if you are running multiple-processes.

All querying of the arservtcd  server is done automatically within the API and
is invisible to the user. Regardless of the client platform being used, the various
fast and list server processes being used are invisible to the user.

Note – If the arservtcd  process is not running, all clients default to using the
Admin server (on RPC socket 390600).

The arservtcd  process administers the MP servers for you, including the
following:

• Launching configured admin, fast, list, and escalation processes at startup,
including the optional arservftd  and arservdsd  processes.

• Relaunching any child processes that shut down.

• Inheriting any running server (the arservtcd  process checks every 15
minutes on inherited processes).

• Automatically launching new fast and list servers if the Administrator
increases the number of processes in the Server Info window in the
Administrator Tool.

• Sending kill -15  (SIGTERM) to arservtcd  will cause it to shut down all
MP servers.

• Sending kill -1  (SIGHUP) to arservtcd  will cause it to synchronize all
MP servers.

Figure 13-3 illustrates how the arservtcd  controller process handles requests
from 2.0 clients and administers the escalation, fast, and list servers.
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Figure 13-3 MP Server Environment
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Using the MP Server with AR Clients
You can use the MP server with clients using older versions of the AR System
API (1.2 and earlier). The AR System always runs a server process on RPC
socket 390600 that responds to any and all client requests. Figure 13-3 on
page 298 illustrates how older versions of the AR System fit in the 2.0 (or later)
MP server environment.

1.2 AR System clients are compatible with the 2.0 (or later) release and can
continue to be used without change. In fact, you can use 1.2 and 2.0 clients in
any combination with 1.2 and 2.0 servers.

1.1 clients are also compatible with the 2.0 (or later) release but cannot take
advantage of many of the features of the 2.0 release.

Note – You cannot use 2.0 (or later) clients against 1.1 servers.

Note – Wherever possible, it is a good idea to allow customize privileges for
users who will access a 2.0 (or later) server from a 1.1 client tool. This will
allow the 1.1 users to deal with many of the cases where they cannot take
advantage of 2.0 (or later) features. But in cases where this is not possible, the
schema designer will need to account for differences when designing a schema.

Using the MP Server with Private Servers
In addition to fast, list, and escalation servers, AR administrators also can
create private servers for specific users who need more dedicated access to
system operations. For example, you might create a private server for a user
who is performing critical operations that you do not want blocked by other
users of the AR System. The RPC socket numbers used for the multiple-process
server do not overlap the socket numbers used for private servers.

Private servers support all operations except restructuring operations. These
are supported only on the Admin server (“Admin Server” on page 293).
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Note – Figure 13-3 on page 298 illustrates how private servers fit in an MP
server environment. Notice that the private servers are not managed by the
arservtcd  process. As a a result, stopping or starting the arservtcd  process
does not stop or start these private servers. You must stop or start them
separately.

Server RPC Socket Addresses

When using a private server, you must specify the RPC socket address that the
server will use. You can specify an RPC address in one of two ways:

• Using the -r  command line argument.

• Defining the ARRPC environment variable.

Starting a Private Server

To start a private server, enter the following UNIX command in a shell tool at
the command line (first log in as root):

# arserverd -r <socketnumber> &

The -r option allows you to specify which server to run. In the AR System,
socket numbers 390680 to 390694 are reserved for private servers.

Note – If you use the -r  command line argument and also define the ARRPC

environment variable, the value supplied with the -r  command line argument
takes precedence.

You can run one, two, or more private servers as is appropriate for your
environment. For example, to run two private servers in your environment,
you could start the server processes as follows:

# arserverd -r 390680 &
# arserverd -r 390681 &
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Note – You do not need to use the socket addresses in sequence. You can
choose from among any of the available sockets. These servers are in addition
to the servers managed by arservtcd .

Killing a Private Server

Killing the arservtcd  process does not kill private servers. You must kill them
separately.

To kill a private server:
1. Log in as root and get the process ID number of the private arserverd

process:

For SunOS systems, type the following:

For other systems, type the following:

2. Kill the arserverd  process by typing the following UNIX command at the
UNIX prompt:

Warning – Do not use the kill -9  command to stop a private server. Doing so
may leave your database in an inconsistent and unrecoverable state.

Defining the ARRPC Environment Variable

For users, the difference between the arservtcd  server and the private server
is transparent.

# ps -ax

# ps -ef

# kill < process_number_arserverd>
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Note – The Administrator Tool always uses the admin server, no matter what
the ARRPC environment variable is set to.

Using Motif Clients with a Private Server
When using a Motif client, you can connect clients to the private server
processes by using the ARRPC environment variable to specify the RPC address
of the private server.

• For the C shell, use the following commands:

• For the Bourne shell, use the following commands:

Using Windows Clients with a Private Server
To connect a Windows client to a private server, the user needs to add the
following line in the [User] section of their ar.ini  file before starting the tool:

Note – Each user of the Windows client on the same PC needs to add the
RPCSocketNumber to their own ar.ini  file.

% setenv ARRPC 390680
% aruser &

% ARRPC=390680; export ARRPC
% aruser &

[User]
RPCSocketNumber= <RPC_#_of_private_server>
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Full Text Search 14

This chapter discusses some of the capability, performance, and administration
issues of full text search (FTS) in the AR System. The topics covered include the
following:

• Introduction to FTS, including an overview of FTS features.

• Who can perform an FTS search.

• How to use FTS to retrieve records, especially using the accrue operator (the
LIKE  operator with comma separators).

• Administering FTS.

• Licensing users for FTS.

• Configuring FTS in the AR System, including:
• Setting search options.
• Modifying the ignore words list.
• Rebuilding the index for FTS.
• Defining a field for FTS.
• Estimating the size of the FTS index.
• Weighting the results of an FTS.

Note – Full text search is an optional feature that you can purchase for the AR
System 2.0 (or later) UNIX server. It may not be available on the server you are
administering.
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What is Full Text Search?
Full text search (FTS) is an important and extremely useful feature of the AR
System. For starters, FTS is typically much faster than searching in relational
databases for long text fields.

FTS benefits also include making use of your knowledge base. For example,
FTS lets you access your company’s history of solving problems that are
sometimes stored in long text fields. With the FTS option, you can easily search
through long text fields to find solutions to related problems. You may even
want to re-design schemas to require entering data into diary or long-text
fields in order to build up a knowledge base that helps you learn from
previous experience.

The FTS option provides quick and consistent access to the records (or ARs)
that you are searching for. Unlike OR searches that retrieve records in random
order, the FTS accrue operator presents the best solutions first to your query
with a “weighted” order. The accrue operator lets you use multiple search
terms in a query, for example, computer , PC, and an error number 3794 .
Records that contain the most search terms receive a higher weight and appear
higher on the list (if ordered in descending order of weight) and are more
likely to contain the information you are looking for. In contrast, if an OR search
yielded 20 records, you would have to look through all 20 records because you
would have no way of knowing which records contain what information. For
more information, “Accruing and Weighting Results in an FTS” on page 305.

FTS solves many problems that users confront when searching their databases,
including the following:

• Searching long text fields. The FTS option lets you index character and diary
fields for searching and matches entries from FTS-indexed fields against the
search criteria you specify. Like database indexes, an FTS index can greatly
decrease the time required for a database search.

• Searching for key words regardless of the underlying database, whether flat-
file or relational.

Note – If you have questions about searching against text fields or the search
capabilities in particular database products, refer to your database reference
documentation.
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• Improving search performance by searching large volumes of data. FTS
organizes long text in a way that is typically quicker to access than when in
relational databases.

• Defining how the server interprets wildcards used in queries on FTS-
indexed fields in order to tailor search performance to your specific needs.
For more information, “Configuring FTS Search Options” on page 320.

• Performing case-insensitive searches. Administrators can enable or disable
case sensitivity. For more information, “Case” on page 319.

• Using the [ ] wildcards in an FTS field even if the underlying database does
not support them. For example, you could enter do[a-z ] to find ARs that
include doe , don , and dot .

Accruing and Weighting Results in an FTS

As mentioned earlier, weighing results of an accrue search is a powerful FTS
feature. FTS does not limit you to searches for key words in FTS-indexed fields.
You also can use a special accrue operator (the LIKE  operator with comma
separated words) to cause the AR System to “accrue” and retrieve from the
database all the ARs that contain any or all of the comma separated words. For
more information, “Using the Accrue Operator” on page 307.

Records that are retrieved in an accrue operation are assigned a “weight” by
the FTS engine. WEIGHT is a number that varies from 0 to 100. With WEIGHT,
the AR System can sort the ARs in a query list using a “the more, the better”
approach: if you set the Field Sort Order in the User Tool to include WEIGHT in
descending order, the more search terms found in an AR, the earlier in the list
it appears in the set of retrieved ARs. The closer the weight number is to 100,
the better it matches the search criteria.

For more information about modifying Query List attributes to include FTS
weights, “Placing FTS Weight in a Query List” on page 329.

Sorting Records by Weight

In the User Tool, users can sort records retrieved in an FTS by weight in
descending or ascending order, by selecting WEIGHT and the sort order in the
Field Sort Order window. For more information on setting the sort order, see
Sorting Query Operation Results in the Action Request System User’s Guide.
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Using the Ignore Words List

You can tell the FTS engine to ignore frequently-used words (such as and , the ,
because , and so on) or words that you do not want indexed. Adding entries to
the Ignore Words List saves space in the FTS index and speeds up text
searches. The FTS option comes with a default set of ignore words that you can
modify as needed. For more information, “Modifying the Ignore Words List”
on page 323.

Be aware that accrue searches that contain words from the Ignore Words List
will not find any matching ARs for those words. However, the accrue search
will retrieve ARs with the other search terms of the query. For restrictions on
FTS, “Limitations of FTS” on page 311.

Who Can Perform A Full Text Search?
Users must have a fixed or floating FTS license to use the FTS capability. Full
text licenses are separate from AR System read/write licenses.

• If users are assigned a fixed FTS license, they can always perform a search in
an FTS-indexed field.

• If users are assigned a floating FTS license but one is not currently available,
they will get a warning the first time they perform a database operation in
the User Tool. The system will use the search capabilities of the underlying
database (to the degree available). When a floating license becomes
available, each affected user will be alerted with a note and will then be able
to perform a search using the FTS capability.

Note – Users can tell if a field is indexed for FTS by looking at the context-
sensitive help for that field.

For more information, “Licensing Users for FTS” on page 316.

How Do I Use FTS?
FTS is transparent to end-users in queries:

• If an FTS license is available and the field is indexed for FTS, then FTS is
used. If users are getting unexpected results in their searches, make sure
that they have either a fixed or floating FTS license.
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• If an FTS license is unavailable or the field is not indexed for FTS, the AR
System uses the search capability of the underlying database.

To use FTS to retrieve ARs, you can either enter a query-by-example (QBE)
value in any field indexed for FTS or you can enter a value into the query bar,
just like an ordinary database query.

Performing a Query in an Field Indexed for FTS

Entering a string into a field indexed for FTS returns results consistent with the
ordinary database searches most users expect. Users can still use the query
strings and search patterns they are already familiar with. But FTS offers
additional benefits. Unlike some databases, the FTS engine lets you index and
search long-text fields for any text string in the entire field. Users might also
notice enhanced performance in retrieving ARs.

Depending on factors like wildcards entered in the query or the QBE match
settings of the field, the FTS engine uses that query to search the entire
contents of all ARs indexed for that field. (This is also known as a “document
search” or a “pattern search.”)

For example, in a field indexed for FTS (with a QBE match setting of
Anywhere and an FTS query option of Query Unchanged), searching for turn
retrieves all ARs with these variations of turn :

turn
return
upturn
turns
turned
turnoff
turnabout

For more information on how QBE settings affect FTS, “How QBE Settings
Affect FTS” on page 311.

Using the Accrue Operator

You can use a special accrue operator (the LIKE  operator with comma
separators) to search for ARs with multiple terms, as in the following entry in
a field indexed for FTS:

ntclientd, notifier, turn



308 Action Request System Administrator’s Guide for OSF/Motif—January 1996

14

This search would retrieve all ARs with any of the search terms and their
stems. (This is also known as a “word search.”)

You also can perform an accrue search for a single word, as in the following:

turn ,

When the FTS engine encounters a comma in the search string, it then begins
using the accrue operator, even if there is only one search term. This search
retrieves ARs with turn  and its stems. For information on stemming,
“Searching for Word Stems” on page 309.

Note – You can use the accrue operator only with fields indexed for FTS. Using
the same operator for a field which is not FTS indexed will cause the AR server
to search for the literal string.

Using the QBE Method
• If the QBE match property for the field is not set to Equal, you do not need

to add any wildcards to the search string, as in the following:

ntclientd, ntclientd, turn

• If the QBE match property for the field is set to Equal, you must add a
leading wildcard to the string to use the accrue operator, as in the following
QBE example that you would enter into the field on the schema:

%ntclientd, notifier, ntserverd

For more information on how QBE settings affect FTS, “How QBE Settings
Affect FTS” on page 311.

Using the Query Bar Method

Use the accrue operator in the Query bar, according to the following syntax:

<field> LIKE  "ntclientd, notifier, ntserverd"

The accrue operator causes the AR System to retrieve ARs that contain one or
more of the search terms, ntclientd or notifier or ntserverd. Remember that an
FTS also returns weight information that is a function of the number of
occurrences found.
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Searching for Word Stems

For case-insensitive searches with no wildcards added, you can use the accrue
operator to search for common variations of word stems. For example, the
query ntclientd, notifier, turn  in an field indexed for FTS would also
retrieve ARs with the following variations of turn:

turns
turning
turned

However, the capability of searching for words stems will not return ARs with
turnabout , return , or upturn  in them.

Using Wildcards

You can also use the % wildcard for a search with the accrue operator,
according to the following syntax:

<field> LIKE "nt%, notifier"

This query would retrieve all ARs that contain the search term notifier  and
words that start with nt , including ntclientd , ntserverd , and so on.

Combining FTS and Non-FTS Fields

You can include FTS and non-FTS fields in a query, as in the following:

<field> LIKE "ntclientd, notifier, ntserverd" AND 'Create-
date' > "01/01/95"

This query bar search using the FTS accrue operator would retrieve all ARs
that contained any of the search terms ntclientd or notifier or ntserverd and that
were created after January 1, 1995. For efficient searches with better
performance, group all FTS fields at the front of complex query expressions.

Search Strategies and Issues

When querying fields within the AR System for which FTS indexing has been
enabled, be aware of the following tips and strategies:
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• Make your queries as specific as possible. As a rule of thumb, remember
that the more defined and qualified that your queries are, the fewer hits to
the database. In addition, it is more likely you will actually find the
information that you really want (as opposed to having to search through
hundreds of ARs). A more efficient query will also yield a quicker response
time.

• Group FTS fields at the front of complex query expressions.

• Remove common words in FTS searches. Try using more specific, more
particular search terms. For example, if you use the accrue operator against
5 words and the search yields hundreds of hits to the database, you may
want to consider dropping more generic terms from the list to focus your
query on a smaller set.

In conclusion, remember that some queries work better than others. If you
receive unexpected results or a time-out, try reformulating your query.

FTS Issues When Performing Queries

Be aware of these issues when performing FTS queries:

• FTS queries that involve a field and an arithmetic operation result in the
underlying database executing the query. For example, a search like
'Short Description' LIKE 'Assigned To' + "ing"  will defer the query to the
underlying database.

• FTS does not treat the following as literal characters in a search string,
unless they are preceded by a backwards slash in the query. Instead, the
special characters listed in Table 14-1 have unique functions in an FTS
search.

For example, a search for "Hello, world " will be translated by the FTS engine into an
accrue search for the terms Hello  and world . To perform a literal search for the string,

Table 14-1 Special Punctuation in FTS Searches

, comma ! exclamation mark

{ } curly brackets ? question mark

[ ] straight brackets _ underscore

* asterisk \ backslash

% percent sign
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"Hello, world ", enter a backwards slash before the comma, as in the following: "Hello\,

world ".

How QBE Settings Affect FTS

Enter a query-by-example (QBE) in any field indexed for FTS, according to the
following syntax:

ntclientd, notifier, ntserverd

However, be aware the QBE property settings influence how an accrue works,
as shown in Table 14-2:

Warning – When you index a field for FTS, we advise that do not set the QBE
match property to Equal. For more information on QBE, see “QBE Match” on
page 107.

Limitations of FTS

There are certain limits in doing an FTS, including the following:

Table 14-2 How QBE Property Settings Affect FTS

 If the QBE Match
property setting is... The server receives the following query:

 Anywhere %ntclientd, notifier, ntserverd%
The User Tool adds wild cards to the start and end of the
query.

 Leading ntclientd, notifier, ntserverd%
The User Tool adds a wild card to the end of the query.

 Equal ntclientd, notifier, ntserverd
The User Tool does not add any wildcards to the search
string, but it will use the Equal operator instead of the LIKE
operator if the first character in the search string is not a %.
Therefore, to use the accrue operator with a QBE property
setting of Equal, users must either:
Add a leading wild card to the string, as in the following:

 %ntclientd, notifier, ntserverd

Use the Query bar to enter the accrue operator.



312 Action Request System Administrator’s Guide for OSF/Motif—January 1996

14

• In accrue searches, you cannot search for most punctuation because they are
treated as word separators. For more detail, see Table 14-1 on page 310.

If you are searching for special punctuation like commas or dashes, use the
backwards slash to include them in the search string. For example, if you are
searching for the phrase database, remedy from the Short-Description field,
you would enter the following in the Query bar:

'Short-Description' LIKE "%database\, remedy%"

Using QBE, you would enter the following:

database\, remedy

• In accrue searches, do not use words from the Ignore Words List. For
example, if the word the  is in the Ignore Words List, searching on the
phrase the, database, remedy in the Short-Description field may return
records with the word in them but it was not used in the search itself. For
additional information, “Modifying the Ignore Words List” on page 323.

• In queries that use FTS, be aware that newly submitted or modified ARs
might not appear immediately in the query list, if you are searching on an
FTS-enabled field. There is sometimes a short delay from the time the AR is
submitted or modified in the database to the time that the AR is available
for searching in the FTS index.

Administering FTS
This section describes how to administer FTS in the AR System.

Selecting Fields for FTS Indexing

You can only index character or diary fields for FTS. You should only index
fields that are frequently searched. Work diaries and descriptions of problems
are good candidates for FTS, especially if the underlying database does not
support searches of these fields.

For example, you could search for one or more key words in a diary field that
would retrieve and weight all the ARs that describe how to solve a problem
suggested by those keywords. Here you would perform a search on key words
or phrases, like the following:

• Schemas, tools, screens, hardware and software products, and so on.
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• Descriptions of problems or solutions.

• Topics, subjects, or other areas of interest.

When you define a field as indexed for FTS, it may take some time before that
field is available for full text searches. Indexing a field can take a long time (up
to several hours), depending on the amount of data in that field, system load,
and other factors. While a field is being indexed for FTS, you can still do non-
FTS searches on that field if the underlying relational database permits it.

To index a field for FTS, “Defining a Field for FTS in the Field Properties
Window” on page 326.

Remember that for each field that you index for FTS, the amount of disk space
required for the FTS index can grow significantly. To estimate approximately
how much space you will need for your FTS index, see “Estimating the Size of
the FTS Index” on page 327.

Warning – Do not define fields for FTS during normal production hours,
especially if you have a lot of ARs in your database. The indexer accesses the
database at the same time as the AR servers, which can significantly impact the
performance of your system.

Re-Indexing

Most of the time, you should not have to rebuild your FTS index because the
arservftd  process automatically optimizes space after ARs are added or
deleted. However, you might need to rebuild the FTS index (re-indexing) in the
following circumstances:

• If you make changes to your Ignore Words List.

• If you delete ARs to reclaim disk space (normally they are simply marked as
deleted in the FTS index, not removed). So if disk space is getting low on the
partition that the FTS index resides on and a lot of ARs have been deleted,
then administrators should schedule some time to do a full reindex.

For additional information, “Rebuilding the Full Text Search Index” on
page 326.
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Time Required to Rebuild an Index

Because re-indexing rebuilds your entire FTS index from scratch, it can take a
long time, depending on the following factors:

• Amount of data in each FTS-indexed field in each AR.

• System load.

• Whether your indexes are on NFS-mounted or local directories. For more
information on where to locate your FTS indexes, especially for performance
reasons, “Estimating the Size of the FTS Index” on page 327.

Warning – Do not rebuild an index during normal production hours.

After Modifying the Ignore Words List

When you modify the Ignore Words List and do not re-index, your changes
affect only tickets that are inserted, deleted, or modified after that point in
time. For example, if you added network to the Ignore Words List, the FTS
would ignore the word network only for ARs added or modified from this
time on. However, the FTS index with the word network would still exist for
all ARs created before the Ignore Words List was modified, if there were ARs
with the word network in them.

When you re-index all the fields in all your schemas that are currently flagged
as indexed for FTS, you create a new FTS index that then ignores the word
network in all ARs. To change the Ignore Words List, “Modifying the Ignore
Words List” on page 323.

The FTS Server (arservftd) Process

The AR System uses the arservftd  process to insert or delete all data in the
FTS index. All changes to the FTS index are made through the arservftd

process. In addition, the arservftd  process optimizes the FTS index every 2000
index field commands (from the time that arservftd  is started).

The AR System runs only one arservftd  process at a time.
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The arservftd process is started or stopped by the arservtcd process that
administers all the other types of AR servers, if you have valid FTS user
licenses.

When you are performing an FTS, it is the arserverd  process that searches the
FTS index for ARs. If the server’s FTS operations are disabled when an AR is
submitted, modified, or deleted, changes are still made to the FTS index. But if
FTS operations are disabled when a query is made, the underlying database
executes the query instead of the FTS engine.

Debugging FTS

You can activate the debug trace mode on the server to create a log file of FTS
activity. All debug tracing for FTS is logged in the
<ar_install_dir>/db/arft.log  file.

To enable FTS debugging:
1. Add the following line to your ar.conf  file:

FTS-Debug-mode: 15

A setting of 15  logs all VDK failure messages. You also can set the following
trace options:

• 2 for incoming index commands.

• 4 for index drop commands

• 8 for VDK commands.

2. Use the UNIX ps  command to get the process ID number of the arservftd

process.

3. Stop the arservftd  process by entering the following:

kill -15 <process_number_arservftd>

The arservtcd  process will automatically restart the arservftd process and
begin logging immediately.
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Moving the FTS Index

The installation script for the AR System places the FTS index into the
<ar_install_dir>/ftindex  directory by default. If you have a large amount
of data in a lot of ARs that are indexed for FTS, you may find that you need
more disk space in which to locate the FTS index. Use the Administrator Tool
first to disable FTS operations, then move the index as needed. For more
information, “FTS Index Directory” on page 319.

If you decide to move the FTS indexes, first make sure that you relocate them
in a directory with enough space. To estimate the size of FTS indexes,
“Estimating the Size of the FTS Index” on page 327.

Licensing Users for FTS
To be able to perform an FTS, users must be assigned a fixed or floating FTS
license. You specify the type of license that users have through their entry in
the User schema (Figure 14-1 on page 317), just like you would with their AR
System write licenses.

To license a user for FTS:
1. Open the User schema in the User Tool (Figure 14-1 on page 317).
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Figure 14-1 The User Schema (with Full Text License Message)

2. Query the database for the user you want to license for FTS. Or open the
Submit window if you are creating a new user.

3. Select the type of FTS license that you want the user to have, whether
fixed or floating.

4. Select the Apply button. If you issued the user a fixed FTS license, a
message appears (Figure 14-1).

5. Select the Dismiss button to dismiss the message.

Configuring FTS in the AR System
Use the Administrator Tool to configure the operation of FTS. To configure the
AR System’s FTS capabilities, the system must have valid fixed or floating FTS
licenses from Remedy Corporation.
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FTS Options in the Server Information Window

Click the Full Text Search tab (Figure 14-2) to set FTS options in the Server
Information window. If you do not have an FTS license, you cannot access the
Full Text Search category on the Server Information window.

To display and update information about full text search:
1. Select Server Information (Ctrl+R ) from the File menu. The Server

Information window appears.

2. In the Server Information window, select Full Text Search from the
Category list, as shown in Figure 14-2 on page 318.

Figure 14-2 Server Information — Full Text Search

3. Select from the following options or enter settings as required:

Enable
Full Text
Search

* Selecting Disable turns off the FTS engine; the system alerts
you with a message that FTS will be stopped.
* Selecting Enable activates the FTS engine; the system alerts
you with a message that FTS will be started. The default is
Enable.
Note that selecting Disable will disable the Case,
Reindex, and Ignore Words List options and enable the FTS
Index Directory field. Selecting Enable does the opposite.
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4. Click the OK or Apply button to save the option settings.

FTS Index Directory Directory where the index files for FTS are located. The
installation script puts this directory in a default location with
the other AR System directories
(<ar_install_dir>/ftindex ), but if needed, you can
relocate the index files in a different directory.
Changing the location of the index directory requires that FTS
capability be temporarily disabled. This prevents the system
from trying to update files while they are being transferred.
This field is disabled when FTS is enabled. You must
temporarily disable FTS (by clearing the Enable check box) to
change the location of the index directory.
When moving your index, you need to be sure that there is
sufficient space in the new location. For information on how
much disk space is needed to store the index files, see
“Importing Data into Schemas with FTS Fields” on page 327.

Case Selecting Sensitive includes case as a criterion for full text
search. The full text search looks for specific upper- and lower-
case letters in words. If you select Sensitive, you cannot use
the stemming capability in accrue searches. (For more
information, “Searching for Word Stems” on page 309.)
By default, case is set to Insensitive.
Selecting Insensitive excludes case as a criterion for full text
search (the search engine will ignore case completely). For
example, if you search for the word project , the search
engine looks through the FTS index for Project , project ,
PROJECT, and so on.

Search Options Use this menu to configure how wild cards are interpreted by
the server in queries on fields indexed for FTS. For
information on setting the FTS match operator and the types
of responses users can expect, “Configuring FTS Search
Options” on page 320.
By default, Search Options is set to Query Unchanged.

Reindex Selecting this button rebuilds the FTS index. The default is off.
For information on re-indexing,
“Rebuilding the Full Text Search Index” on page 326.
Note that re-indexing can take a long time.

Ignore Words List Displays the Ignore Words List used for full text searches in
the database. This window lets you specify which words will
not be indexed. Using the Ignore Words List, the AR System
ignores these words in the database. To use the Ignore Words
List, “Modifying the Ignore Words List” on page 323.
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Configuring FTS Search Options

In both accrue and non-accrue searches, the Search Options menu in the Full
Text Search window (Figure 14-3) allows you to configure how the server
interprets queries on fields indexed for FTS. Whether or not users create FTS
queries using wild cards, you can define how those queries will be interpreted
by the server. This is important because the presence or absence of wild cards
in an FTS query can significantly impact search performance.

Note – If the FTS search option is set to add wildcards to the search string, the
stemming capability on accrue searches is disabled. For additional information,
“Searching for Word Stems” on page 309.

For Searches Using the Accrue Operator
Table 14-3 lists FTS search option actions in the server when users enter an
accrue operator in a query.

Table 14-3 FTS Search Option Actions for Accrue Operations  (1 of 3)

Search
Option

Search
Term
Passed
to
Server

Server
Interprets ARs Retrieved

Search Performance
Results

Force
Leading &
Trailing
Wildcard

turn, %turn%, Any AR with turn
as part of the
word,
including:
* right turn
* turn left
* turned
* return
* turned left
* user
returned
* turnabout is

* Slowest search
performance for users.
* Maximum number of
ARs retrieved.%turn, %turn%,

turn%, %turn%,

%turn%
,

%turn%,
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Ignore
Leading &
Force
Trailing
Wildcard

turn, turn%, Any AR starting
with turn as
the starting
part of the
word,
including:
* right turn
* turn left
* turned
* turned left
* turnabout is

Will not retrieve ARs
with return in them.
Creates performance
results that users will
most likely expect in
an FTS, including:
* Relatively fast
search.
* Retrieves the number
of ARs most users
probably anticipate
from an FTS.

%turn, turn%,

turn%, turn%,

%turn%
,

turn%,

Ignore
Leading
Wildcard

turn, turn, Any AR starting
with word turn
and possibly its
stems,
including:
* right turn
* turn left
* turned
* turned left

Will not retrieve ARs
with return in them.
* Relatively fast
search.
* May not retrieve the
ARs that users expect
because query does
not consistently add a
trailing wild card. For
example, the search
terms turn% and
%turn% will retrieve
ARs with turnabout
is  in them, the other
search terms will not.

%turn, turn,

turn%, turn%,

%turn%
,

turn%,

Table 14-3 FTS Search Option Actions for Accrue Operations  (2 of 3)

Search
Option

Search
Term
Passed
to
Server

Server
Interprets ARs Retrieved

Search Performance
Results
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Note – Be aware that the QBE Match settings defined in the Field Properties
window will affect the search terms that are passed to the server. For example,
a QBE Match set to Anywhere adds additional wild cards to your search term
(perhaps creating unexpected results in QBE searches). We recommend that
you do not set the QBE Match to Equal if a field is indexed for FTS.

For Non-Accrue Searches
The information in Table 14-3 on how the server interprets wildcards also
applies to non-accrue searches, with the following qualification. In non-accrue
searches, the FTS engine searches the entire contents of all ARs indexed for that
field. As a result, if you enter the query string turn  and the server does not
add or remove wildcards, you find exact matches if the only data in the AR is
turn .

Remove
Leading &
Trailing
Wildcards

turn, turn, Any AR with word
turn (and its
stems),
including:
* right turn
* turn left
* turned
* turned left

Will not retrieve ARs
with return or
turnaround in them.
* Fastest search
performance.
* Potentially fewest
ARs retrieved because
query never contains
wild cards.

%turn, turn,

turn%, turn,

%turn%
,

turn,

Query
Unchanged
(default)

turn, turn, Retrieves ARs that
match the
the search string.

Depends on the wild
cards specified by the
user.

%turn, %turn,

turn%, turn%,

%turn%
,

%turn%,

Table 14-3 FTS Search Option Actions for Accrue Operations  (3 of 3)

Search
Option

Search
Term
Passed
to
Server

Server
Interprets ARs Retrieved

Search Performance
Results
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However, if you entered turn% , you would retrieve ARs with the following:

turn left
turned
turned left
turning
turnabout

To configure the FTS search option:
1. With the Full Text Search category selected in the Server Information

window (Figure 14-3), select an item from the Search Options menu.

Figure 14-3 Search Options Menu

2. Select the Apply button to save the search option settings.

Modifying the Ignore Words List

The Ignore Words List (Figure 14-4 on page 324) causes the full text search
engine to ignore frequently-used words or words you do not want indexed
(such as and , the , because , and so on).
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Note – If you extensively modify the ignore words list, you should consider
rebuilding the FTS index. Because the indexes are already created, the modified
ignore words list affects only changes to the FTS index that are made after you
click the OK button. To rebuild the index, “Rebuilding the Full Text Search
Index” on page 326.

To modify the Ignore Words List:
1. In the Server Information — Full Text Search window, select the Ignore

Words List button. The Full Text Search Ignore Words window appears, as
shown in Figure 14-4. The Choices list contains the words currently
defined for the Ignore Words List.

This window lets you define which words will not appear in the index. You
can either modify the existing list entry by entry or append a series of ignore
words to the Choices list by loading a file.

Figure 14-4 Full Text Search Ignore Words Window

2. To modify the Choices list, do one of the following:

• To add a word to the Choices list, type a word in the Choice field, then
select Add.

• Each entry in the Choices list must be unique.

• To delete a word from the Choices list, choose an entry, then select Delete.
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• To modify the Choices list, choose an entry from the list. The entry appears
in the Choice field. Edit the entry, then select Modify. The edited entry re-
appears in the Choices list.

• To delete all words from the Choices list, choose Delete All.

• To append a list of words to the Choices list, select Load From File, then
select a file from the Directory — File Selection window.

3. Select the Apply button in the Ignore Words window to save the settings.

4. Select the Apply button in the Server Information window to apply all
the changes you made from the Full Text Search category. Remember that
the modified ignore words list affects only changes to the FTS index that
are made after you select the Apply button.

Appending a List of Words to the Ignore Words List

You can append an entire list of words to the Ignore Words list rather than
having to add words one at a time.

To append a list of words to the Ignore Words List:
1. Select Load From File. A file selection window will appear.

2. Specify a file name containing the list of words you want appended to the
Ignore Words List. This file can contain only one word per line.

3. Select the Apply button. The file entries appear in the Full Text Search
Ignore Words window and the words append to the previous list.

4. Select the Apply button in the Ignore Words List.

5. If needed, select Reindex to rebuild the FTS index after making any
changes in the Ignore Words List.

6. Select the Apply button to save the option settings.

Note – To replace the current Ignore Words List with a list from the file, first
select Delete All, then load the list from the file.
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Rebuilding the Full Text Search Index

If you need to rebuild the FTS index, be aware that rebuilding it can take
several hours.

To re-build the FTS index:
• In the Server Information — Full Text Search window (Figure 14-2 on

page 318), select Reindex, then select the Apply button.

Warning – Remember that rebuilding your entire index could take several
hours. Do not rebuild an index or define fields for FTS during normal
production hours, especially if you have a lot of ARs in your database.

Defining a Field for FTS in the Field Properties Window

Use the Field Properties window (Figure 14-5 on page 327) to create an FTS
index of the text in character and diary fields.

Warning – Do not define fields for FTS during normal production hours,
especially if you have a lot of ARs in your database.

To define a field for FTS:
• In the Field Properties window (Figure 14-5 on page 327), select Yes in the

Index For FTS category.

The full text search index for a field is automatically updated and does not
require manual run-time administration when you create, delete, or modify
entries.
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Figure 14-5 Index For FTS Setting in Field Properties Window

Importing Data into Schemas with FTS Fields

Be aware that sizeable performance impacts can occur if you are importing a
lot of data into a schema with FTS fields.

Warning – Do not import data in schemas with FTS fields during normal
production hours. To import data, set the Index for FTS  settings for each
field to No for each FTS-indexed field, import the data, then turn the FTS
indexing back on.

Estimating the Size of the FTS Index

Locate the FTS index in a directory that has sufficient disk space. Remedy
recommends that the directory be large enough to accommodate
approximately 1 to 1.5 times the amount of data that is indexed for FTS. For
example, if the total amount of data in all fields you want to be indexed for
FTS in all schemas is 100 MB, then you will need between 100 and 150 MB of
disk space for the full text indexes.

Remember that this example of determining the size of an FTS index is an
approximation only.

Setting a field to
be indexed for
FTS
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Warning – For performance reasons, you should create indexes on local
partitions in your system, not NFS-mounted partitions. Indexing and searching
NFS-mounted directories takes significantly longer than when using local
directories.

To estimate size of the FTS index:
Use the following steps to determine approximately how much disk space is
occupied by the FTS index:

1. Estimate the size of text in your database. For example, take a small
sample of entries and calculate the average size of data in the field. Then
multiply this average by the number of ARs to derive the size of text in
your database.

2. Use a number between 1.0 and 1.5 as a percentage multiplier. The ratio of
the size of the FTS index to source text can differ widely, based on, for
example, the size of your Ignore Words List.

If the estimated size of text is 100 MB, the FTS index occupies between 100 and
150 MB of disk space: 100 MB * 1.0 = 100 MB as the lower boundary of the FTS
index and 100 MB * 1.5 = 150 MB as the upper.

Moving the FTS Index

There may be situations when you need to move the FTS index, especially if it
becomes quite large.

To move the FTS index:
1. Estimate how much space you need in the new directory location to

relocate the FTS index.

2. Before disabling FTS on the server, wait until the number of pending ARs
in the <ar_install_dir>/db/arftp.lst file reaches 0 (zero).

3. Open the Server Information dialog box and disable FTS by clearing the
Enable Full Text Search check box (Figure 14-6 on page 329).
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Figure 14-6 Server Information Dialog Box

4. Copy the contents of the FTS index directory to its new location.

5. Enter the new location of the directory in the FTS Index Directory field.

6. Enable FTS.

You then can remove or delete the old FTS index, as needed. However, you do
not have to copy the contents of the old directory if you re-index after
changing the directory location and enabling FTS.

Placing FTS Weight in a Query List

In the Query List Fields Dialog Box (Figure 14-7 on page 330), you can display
the FTS weight for all records retrieved in the query list.

To define fields returned in a query list:
• For fields indexed for full text search, see “Defining Query List Fields” on

page 126 to define query lists but include WEIGHT as well.

Including the WEIGHT value displays the weighted value of retrieved ARs when
you do a query list in the User Tool, as shown in Figure 14-7 on page 330.
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Figure 14-7 Query List Fields Dialog Box

For further information on weights in an FTS, “Re-Indexing” on page 313.

Including the WEIGHT value displays the weighted value of retrieved ARs when
you do a query list in the User Tool. In the query results shown in Figure 14-8
on page 331, the FTS engine assigned different “weights” to the records
retrieved and the User Tool listed them in descending order, based on how
many times the search terms were found.

Selecting WEIGHT
for a full text search
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Figure 14-8 Query List Results with FTS Weighting

Note – If your query does not use the accrue operator, all entries returned in
the list are given the default weight value of 100.

For further information on weights in an FTS, “Sorting Records by Weight” on
page 305.

FTS weights assigned
to the records
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AR System Server Utilities 15

This chapter describes how to use the arcache  and arreload  utilities to
administer your Windows NT AR System server.

This chapter covers the following topics:

• Using arcache .

• Using arreload .

• Modifying the Windows NT registry to include additional servers.

Using the arcache Utility
You use arcache  to update an entry in one or more user/group caches in the
AR System. Use the following command and options from the command line:

arcache  {-U | -G} {a | d} [-d ] -e entryId  [ -n name ] [ -s server ]
[ -g groupList ] [ -ld dashboardLicense ] [ -lf fulltextLicense]
[ -lw writeLicense ] [ -m mailAddress ] [ -p password ]
[ -x notifyMech ] [ -i groupId ] [ -t groupType ]

Note – Items between square brackets ( [ ] ) are optional. You must choose one
of the items between braces ( { } ). Vertical bars ( | ) separate the available
choices. You can list more than one server.
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The arcache  utility allows you to update a single user/group entry in the
access control cache for one or more AR System servers. You specify the
operation you want to perform and the information about the item to update.
The program will send that update to all the appropriate target servers to
update their caches with the new information.

This program is only used in a multi-server environment where there is a
desire to have a centralized access control scheme. All updates from a
user/group schema to the local access control cache are performed
automatically.

This program is generally run using a filter in the AR System.

arcache Options

There is a set of common options that can be used with either users or groups
and a set of options specific to one or the other. Each option is identified below
according to which type of option it is.

The following settings and options to arcache  may appear in any order on the
command line:

Table 15-1 Settings and Options for the arcache  utility  (1 of 3)

Option Action

-d Set the system into debugging mode. This mode prints messages to
stdout that detail the progress of the operations it is performing.
Debugging mode should be used only to find problems with how the
arcache process is running.

-e Identifies the entry ID of the corresponding entry in the User or Group
schema. This is the key for the entry and must be supplied for both
users and groups.

-g A list of groups defining the user’s permissions in the system. This list
consists of a set of one or more group IDs separated by semicolons. This
field is used only when adding/updating users.
For example, for a new user who was an administrator, the group list
value would be 1; . If the user had Customize capability and was a
member of the Staff group (which had an ID of 43), the value would be
2; 43;.
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-G Identifies this operation as an operation on the group cache. This tag
must be followed by the type of operation to be performed:
a — Add a new or update an existing group
d — Delete an existing group
This option is mutually exclusive with the -U option.

-i The ID for the group. This field is used only when adding/updating
groups.

-ld The Flashboards license type (0 — none, 1 — fixed, or 2 — floating) to
be issued to this user. This field is used only when adding/updating
users.
If no Flashboards license type is specified, it will default to none.

-lf The full text license type (0 - none, 1 - fixed, or 2 - floating) to be issued
to this user. This field is used only when adding/updating users.
If no full text license type is specified, it will default to none.

-lw The write license type (0 - read, 1 - fixed, or 2 - floating) to be issued to
this user. This field is used only when adding/updating users.
If no write license type is specified, it will default to read.

-m The email address for the user. The address is used by default when a
message is to be sent to the user. This field is used only when
adding/updating users.

-n The name of the user/group. This field is required for add operations
and is recommended (but not required) for delete operations. This field
is used with both users and groups.

-p The password for the user. This field is used only when
adding/updating users.

-s The name of a single server. Ordinarily, the program will update the
entry in all servers in the system. It finds all servers by reading the
<ar_config_dir>\ar file and contacting all AR System servers it
identifies. With this option, you can identify a single specific server to
be updated with the information. This field can be used with both users
and groups.
Note: If you do not specify a -s option, arcache will look for a list of
servers from the Windows NT Registry. For more information, see
“Creating and Modifying the Server List in the Windows NT Registry”
on page 338.

Table 15-1 Settings and Options for the arcache  utility  (2 of 3)

Option Action
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Using arcache from the Command Line

The following example adds a new user to all server caches. The new user is
Fred Johnson with no password, an email address of fredj@remedy.com, and a
default notify mechanism of 1. The entry ID of the entry in the User schema is
000000000000104. Fred will be added to the cache as a user who is a member of
no access group.

arcache -Ua -e000000000000104 -n "Fred Johnson" -m
"fredj@remedy.com" -x 1

Using the arreload Utility
You use arreload  to reload all the user/group cache entries from a given
schema. Use the following command and options from the command line:

arreload  { -u | -g } schema -a adminUser [ -d ] [ -f ] [ -p adminPassword ]
[ -s server ]

The arreload utility allows you to reload the user/group caches from a given
user/group schema to one or more AR System servers. The process will delete
all the existing cached entries for the selected schema and load all the
information from the schema into the cache. This is useful for bringing all the
servers into sync.

-t The type of the group (1 — view only or 2 — view/change). This field
is used only when adding/updating groups.

-U Identifies this operation as an operation on the user cache. This tag
must be followed by the type of operation to be performed:
a — Add a new or update an existing user
d — Delete an existing user
This option is mutually exclusive with the -G option.

-x The default notify mechanism for the user. The notify mechanism is
used when a notification is delivered to the user via the default notify
method for that user. This field is used only when adding/updating
users.
If no notify mechanism is specified, it will default to 1 (notifier).

Table 15-1 Settings and Options for the arcache  utility  (3 of 3)

Option Action
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Note – This process must be run on the same machine as the AR System server
that contains the schema to be reloaded. You can only run arreload  on a
machine that is an AR server and it will only load users from that machine’s
schemas.

In a multi-server environment, this program is generally run as part of a
periodic maintenance operation for the AR System. Setting up a job to run on a
weekly or monthly basis that does a reload of the user/group caches helps
insure that all the caches remain in sync with all the latest information. In a
single-server environment, this program is generally unused (except to recover
from disk crashes).

arreload Options

The following options to arreload  may appear in any order on the command
line:

Table 15-2 Settings and Options for the arreload utility  (1 of 2)

Option  Action

-a The user name of a user with Administrator access to the schema to be
reloaded.

-f Flush the user or group cache definition of entries from all servers before
reloading the cache with the specified definitions. This option is
especially useful when you are changing or renaming the machine that
is running the AR System.

-d Set the system into debugging mode. This mode prints messages to
stdout that detail the progress of the operations it is performing.

-g Identifies this operation as a group reload and supplies the name of the
schema that is to be reloaded.
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Using arreload from the Command Line

The following example reloads the user cache of all servers to remove any
existing definitions from the user schema on this server and add entries for all
the current users defined in the User schema. The administrator user is Admin
with a password of password to allow access to the schema to get the
information to be reloaded.

arreload -a Admin -p password -u User

Creating and Modifying the Server List in the Windows NT Registry
In the Windows NT environment, if you want to use arcache  or arreload  to
update multiple servers (or to make the ARGetListServer API call), use the
Registry Editor to modify the server list for your machine.

To create or modify the Windows NT Registry:
1. Open the Register Editor by entering the following at a DOS command

prompt:

regedt32

The Registry Editor appears.

-p The password for the Administrator user identified with the -a option.
If there is a password for the Administrator identified (which is
recommended), you must specify this option with the appropriate
password.

-s The name of a single server. Ordinarily, the program will update the
entry in all servers in the system. It finds all servers by reading the
<ar_config_dir>\ar  file and contacting all AR System servers it
identifies. With this option, you can identify a single specific server to be
updated with the information.
Note: If you do not specify a -s option, arreload  will look for a list of
servers from the Windows NT Registry. For more information, see
“Creating and Modifying the Server List in the Windows NT Registry”
on page 338.

-u Identifies this operation as a user reload and supplies the name of the
schema that is to be reloaded.

Table 15-2 Settings and Options for the arreload utility  (2 of 2)

Option  Action
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2. Select the HKEY_LOCAL_MACHINE on Local Machine window, as
shown in Figure 15-1.

Figure 15-1 Register Editor

3. Select the SOFTWARE\Remedy\ARServer\CurrentVersion directory.

4. If the ServerList entry already exists, double-click it to open the Multi-
String Editor. Otherwise, perform steps a - c.

a. From the Edit menu, choose Add Value. The Add Value dialog box
appears (Figure 15-2).

Figure 15-2 Add Value Dialog Box

b. In the Value Name field, enter the following:

ServerList
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c. From the Data Type drop-down list, choose REG_MULTI_SZ and click
the OK button. The Multi-String Editor appears, as shown in
Figure 15-3.

Figure 15-3 Multi-String Editor

5. Add any servers to the list that you want updated whenever you use
arcache , arreload , or the ARGetListServer API call.

6. Click the OK button. The ServerList appears in the
HKEY_LOCAL_MACHINE on Local Machine window, as shown in
Figure 15-4 on page 341.
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Figure 15-4 Server List Added to Registry
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Changing Colors and Fonts A

You can change colors and fonts used by the Administrator Tool, although
usually the defaults supplied will be sufficient. For your reference, the default
fonts and colors are provided in a sample file, called ARSystem, located in the
<ar_install_dir>/bin  directory. To change colors or fonts, you simply update the
.Xdefaults  file in your home directory, or you can copy the sample file
(ARSystem) to your home directory and change the default settings to the
settings you want.

In order to have changes to the file recognized, you will need to do one of the
following:

• Run the program xrdb  as follows:

From then on, all instances of the Administrator Tool will use the new colors
and fonts.

Customizing Color
You can change the colors used in a number of areas within the Administrator
Tool windows. To see a listing of available colors, at the command line type
showrgb.

cd ( to change to your home directory)
xrdb -merge .Xdefaults
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Administrator Tool color resources:

ARSystem*admin*background:

The default background color of all Administrator Tool windows, unless
you override it for a specific pop-up window (see resources below).

ARSystem*admin*XmText*background:

The background color of the text fields in all windows.

ARSystem*admin*menubar*background:

The background color of the menu bar in all windows.

ARSystem*admin*footer*baceekground:

The background color of the footer in all windows.

ARSystem*MessagePopup*background:

The background color of the warning pop-up messages.

ARSystem*MessagePopup*foreground:

The foreground color of the warning pop-up messages.

ARSystem*PopupWindow*XmText*background:

The background color of the text fields in pop-up windows.

ARSystem*PopupWindow.Schema*background:

The background of the scrollable portion of the Schema window.

ARSystem*PopupWindow.SetFields*background:

The background of the area within the Set Fields window that contains
the schema fields when defining a set fields operation.

ARSystem*PopupWindow.GetListFields*background:

The background color of the Query List Fields window.

ARSystem*PopupWindow.SchemaIndex*background:

The background color of the Index Fields window.

ARSystem*PopupWindow.License*background:

The background color of the License Info window.
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ARSystem*PopupWindow.History*background:

The background color of all Change History windows.

ARSystem*PopupWindow.DefProp*background:

The background color of the Field Properties window.

ARSystem*PopupWindow.HelpText*background:

The background color of all Help Text windows.

ARSystem*PopupWindow.ServerInfo*background:

The background color of the Server Info window.

ARSystem*PopupWindow.AdminCommands*background:

The background color of the Admin Command window.

ARSystem*PopupWindow.Schema*XmText.background:

The background color of the text fields in the Schema window.

ARSystem*PopupWindow.SetFields*XmText.background:

The background color of the text fields in the Set Fields window.

ARSystem*PopupWindow.ServerInfo*XmText.background:

The background color of the text fields in the Server Info window.

ARSystem*PopupWindow.AdminCommands*XmText.background:

The background color of the text fields in the Admin Command window.

ARSystem*PopupWindow.ActiveLink*background:

The background color of the Active Link window.

ARSystem*PopupWindow.ActiveLink*ActiveLinkConditions*background:

The background of the top area of the Active Link window, where the
active link conditions are defined.

ARSystem*PopupWindow.ActiveLink*ActiveLinkActions*background:

The background of the bottom area of the Active Link window, where
the active link actions are defined.

ARSystem*PopupWindow.Filter*background:
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The background color of the Filter window.

ARSystem*PopupWindow.Filter*FilterConditions*background:

The background of the top area of the Filter window, where the filter
conditions are defined.

ARSystem*PopupWindow.Filter*FilterActions*background:

The background of the bottom area of the Filter window, where the filter
actions are defined.

Customizing Fonts
You can change the font used for labels on the schema windows. If you decide
to change the font, you can specify any combination of fonts for the optional,
required, and system fields. Since the AR System uses normal, bold, and italic
fonts respectively to represent visually the style for each field, it is important
that you specify a font with the appropriate weight when configuring fonts.
You can use any font that is listed by the xlsfonts X-window utility. Reports
require a fixed-width font.

Configurable fonts:

For example, to use Helvetica font add the following lines to your .Xdefaults :

ARSystem*menubar*fontList: Font used for menus.
ARSystem*fontList: Default font used by AR System.
font Font used for optional fields.
font=Italic Font used for system supported fields.
font=Bold Font used for required fields.

ARSystem*fontList: -adobe-helvetica-medium-r-*--12-*, \

-adobe-helvetica-medium-o-*--12-*=Italic, \

-adobe-helvetica-bold-r-*--12-*=Bold
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AR System Files B

This appendix describes the various files needed by and created by the AR
System. The directory where the AR System is installed is referred to as
<ar_install_dir> (usually, this directory is /usr/ar  on UNIX workstations, and
\remedy  on Windows and Windows NT machines). The directory specified to
hold the user’s configuration information is referred to as <ar_config_dir>
(usually, this directory is /home/ <user_name>/arHome  for UNIX workstations,
and \home  on Windows and Windows NT machines).

To access the UNIX manual pages, you must add the <ar_install_dir>/man  and
the <ar_install_dir>/api/man  directories to your MANPATH environment variable.
For more information about the UNIX manual pages, see Chapter 5 in the
Action Request System Programmer’s Guide.

Note – For some of the files listed in this appendix, “NT” refers to the AR
System Notification Tool, for example, NTSystem . When this appendix refers to
the Windows NT operating system, it is described either as the “Windows NT
operating system” or simply as “Windows NT”.
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UNIX Server File Locations

Table B-1 UNIX Server File Locations

Category Location

Executables <ar_install_dir>/bin

Catalog /usr/lib/locale/C/LC_MESSAGES
(for Sun, AT&T, SGI, and Motorola
workstations)

/usr/lib/nls/msg/En_USAction Request
System Administrator’s Guide
(for IBM workstations)

/usr/lib/nls/C
(for HP 9000 workstations)

Man Pages <ar_install_dir>/man/man1/*.1
<ar_install_dir>/man/man5/*.5

Sample Databases <ar_install_dir>/sample_db

AR Server Directory /etc/ar

Full Text Search Index <ar_install_dir>/ftindex

Server Configuration /etc/ar.conf

Server Error File <ar_install_dir>/db/arerror.log

Default Log Files <ar_install_dir>/ar/db/*.log

License /etc/remedy.lic

AR Server Lock <ar_install_dir>/db/ar.lck
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UNIX Client File Locations

Table B-2 UNIX Client File Locations  (1 of 2)

Category Location

Executables <ar_install_dir>/bin

Catalog /usr/lib/locale/C/LC_MESSAGES
(for Sun, AT&T, SGI, and Motorola
workstations)

/usr/lib/nls/msg/En_US
(for IBM workstations)

/usr/lib/nls/C
(for HP 9000 workstations)

X Application Defaults /usr/lib/X11/app-defaults/ARSystem
/usr/lib/X11/app-defaults/HyperHelp
/usr/lib/X11/app-defaults/License

/usr/openwin/lib/app-defaults/ARSystem
/usr/openwin/lib/app-defaults/HyperHelp
/usr/openwin/lib/app-defaults/License
(for Sun workstations running OpenWindows)

Man Pages <ar_install_dir>/man/man1/*.1
<ar_install_dir>/man/man5/*.5

Sample Databases <ar_install_dir>/sample_db

API
Libraries
Include Files
Man Pages
Sample Source

<ar_install_dir>/api/lib/lib*.a
<ar_install_dir>/api/include/*.h
<ar_install_dir>/api/man/man3/*.3
<ar_install_dir>/api/src

AR Server Directory /etc/ar

User Configuration <ar_config_dir>/config

Macros <ar_config_dir>/arcmds/ <macro_name>.arq

User Defaults <ar_config_dir>/ <schema_name>.ard

User Views <ar_config_dir>/ <schema_name>.arv

Report Design <ar_config_dir>/arcmds/ <report_name>.arr
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Import Mappings <ar_config_dir>/arcmds/ <mapping_name>.arm

Schema Definition Cache <ar_config_dir>/ <schema_name>.arf

HyperHelp <ar_install_dir>/help

Table B-3 UNIX Notification System File Locations

Category Location

Executables <ar_install_dir>/bin

Catalog /usr/lib/locale/C/LC_MESSAGES
(for Sun, AT&T, SGI, and Motorola
workstations)

/usr/lib/nls/msg/En_US
(for IBM workstations)

/usr/lib/nls/C
(for HP 9000 workstations)

X Application Defaults /usr/lib/X11/app-defaults/NTSystem

/usr/openwin/lib/app-defaults/NTSystem
(for Sun workstations running OpenWindows)

Man Pages <ar_install_dir>/man/man1/*.1

API
Libraries
Include Files
Man Pages

<ar_install_dir>/api/lib/lib*.a
<ar_install_dir>/api/include/*.h
<ar_install_dir>/api/man/man3/*.3

NT Server Directory /etc/ar

Table B-2 UNIX Client File Locations  (2 of 2)

Category Location
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UNIX Flat-File Database File Locations

Windows NT Server File Locations

Table B-4 UNIX Flat-File Database File Locations

Category Location

Schema Definitions <ar_install_dir>/db/*.def

Schema Data <ar_install_dir>/db/*.db

Structure Definitions <ar_install_dir>/db/*.ar

Table B-5 Windows NT Server File Locations

Category Location

Executables and DLLs <ar_install_dir>\bin

Sample Schemas and
Applications

<ar_install_dir>\arserver\samples

Server Configuration <ar_install_dir>\conf\ar.cfg

Server Error File <ar_install_dir>\arserver\db\arerror.log

Default Log Files <ar_install_dir>\arserver\db\*.log

License <ar_install_dir>\conf\remedy.lic

AR Server Lock <ar_install_dir>\arserver\db\ar.lck

API
Libraries
Include Files
Sample Source

<ar_install_dir>\arserver\api\lib\*.lib
<ar_install_dir>\arserver\api\include\*.h
<ar_install_dir>\arserver\api\driver

Mail Notification and
Submission Configuration

<ar_install_dir>\conf\armaild.cfg

Outgoing Mail Notifications <ar_install_dir>\arserver\mailntfy
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Windows Client File Locations

Windows NT Notification System File Locations

Table B-6 Windows Client File Locations

Category Location

Executables <ar_install_dir>\*.exe

Control DLLs <ar_install_dir>\miscdll.dll
<ar_install_dir>\sh20w16.dll
<ar_install_dir>\sh21w16.dll

RPC DLL <ar_install_dir>\tirpc.dll

AR System Servers <ar_config_dir>\ar

User Configuration <ar_config_dir>\ar.ini

Help Information <ar_install_dir>\*.hlp

Macros <ar_config_dir>\arcmds\ <macro_name>.arq

User Defaults <ar_config_dir>\ <schema_name>.ard

User Views <ar_config_dir>\ <schema_name>.arv

Report Design <ar_config_dir>\arcmds\ <report_name>.arr

Report Printer Setup <ar_config_dir>\arcmds\ <report_name>.arp

Schema Definition Cache <ar_config_dir>\ <schema_name>.arf

Import Tool Message Log <ar_config_dir>\config.lst

Table B-7 Windows NT Notification System File Locations

Category Location

Executables and DLLs <ar_install_dir>\bin

API
Libraries
Include Files

<ar_install_dir>\arserver\api\lib\*.lib
<ar_install_dir>\arserver\api\include\*.h

Saved Notifications <ar_install_dir>\arserver\db\ntserver.log

Users Logged in to Notification
Server

<ar_install_dir>\arserver\db\ntusers
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Windows NT Flat-File Database File Locations

Table B-8

Category Location

Schema Definitions <ar_install_dir>\db\*.def

Schema Data <ar_install_dir>\db\*.db

Structure Definitions <ar_install_dir>\db\*.ar



354 Action Request System Administrator’s Guide for OSF/Motif—January 1996

B



355

Core and Reserved Schema Fields C

The AR System allows flexibility in creating schemas to address the varied
needs of its users. While it is recognized that customization is vital, it is also
recognized that the schemas created for resolving action requests have a set of
concepts and information needs in common.

The AR System core schema fields are a set of fields that every schema must
have. The commonality gained by such a convention is useful for conceptual
consistency, sharing macros, sharing filters, and exchanging and merging
databases.

The AR System reserved fields are special purpose data fields that exist on
either the User schema or the Group schema, for row level access control, or
that you can add to schemas if you are licensed with the Distributed Server
Option. You can use the reserved fields in any schema, if desired. See
Chapter 3 for more information on access control.

There are additional limits placed on the core fields, including the fact that
some fields are required, others are maintained by the system, and others have
fixed or maximum sizes. Core field limits cannot be changed. All the other core
field limits are noted in this appendix.

In addition to the core and reserved fields, a number of other fields are defined
within the AR System. These are fields that were core fields in prior releases of
the AR System. You can still use these fields on the schemas you design, as
long as you follow the rules that pertain to them. These fields and their rules
are also noted in this appendix.
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Core Schema Fields

Note – Users can change these field labels.

The following list of fields are common to all schemas:

Table C-1 Core Schema Fields  (1 of 2)

Field Label Description

Entry-Id A unique identification value for each request entering the
system. It is created and maintained by the system; however it is
possible to prepend a string to the value for descriptive
purposes. Groups that have neither Change nor View access to a
schema’s Entry ID field will not be able to access information
from any of the schema’s fields, regardless of the permissions
settings of the other fields.
Data Type         Character
Max Length        15
Min Length          5
Field ID                1

Submitter The name of the user who submitted the entry. It is usually the
name of the AR System user who performed the submit
operation, though it may not be (as in the case of someone
submitting for someone else).
Data Type     Character
Length            30
Field ID            2

Create-date The time at which the entry was created in the system. This field
is set by the AR System and cannot be modified. It serves as a
reliable time-stamp for database entries.
Data Type        DateTime
Field ID             3

Assigned-to The name of the user who has been assigned responsibility for
the AR.
Data Type        Character
Length               30
Field ID               4
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Last-
modified-by

The name of the user who last altered the AR. This field is set by
the AR System to the login name of the user who last changed
the entry. It cannot be modified.
Data Type        Character
Length              30
Field ID              5

Modified-date The date the field was last modified. This field is set by the AR
System to the time the last change to this entry was made. It
cannot be modified.
Data Type        DateTime
Field ID              6

Status Indicates the current state of the entry. Users have control over
this field. It must have a value at all times; there must be a
default value in case there is no value specified by the user at
create time. The actual names and values of the status field can
be customized.
Data Type        Selection
Field ID              7

Short-
Description

A brief description of the reason for the request. A size limit
forces the submitter to be concise, including only the key
problem. This allows for quick delegation to appropriate support
staff who can then investigate more descriptive fields.
Data Type        Character
Max Length        128
Field ID                  8

Status-
History

The user who last changed and the time the change was made to
each of the states identified by the Status field. This field is set
and maintained by the AR System and cannot be modified.
Data Type        Character
Field ID              15

Table C-1 Core Schema Fields  (2 of 2)

Field Label Description
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Reserved Schema Fields
The AR System User schema contains eight reserved fields, as listed below.

Table C-2 Reserved Schema Fields  (1 of 2)

Field Label Description

Login name The name of a user who is allowed to access the AR System.
This is the name the user will enter in the User Name field on
the Login dialog box when logging into the system.
Data Type        Character
Length                 30
Field ID            101

Password The password of the user whose login name is in the Login
name field. This is the password the user will enter when
logging into the system.
Data Type        Character
Length                 30
Field ID            102

Email Address The email address of the user whose login name is in the Login
name field.
Data Type        Character
Max Length        255
Field ID              103

Group list The list of access control groups to which the user whose name
is in the Login name field belongs. Group names are separated
by spaces. Note that though you make entries to the Group list
using the alias name (Group name for a group), the Group ID is
actually stored as an integer value.
Data Type        Character
Max Length        255
Field ID              104

License Type The type of write license the user has. The choices are Read
(includes Submit permission), Fixed, and Floating.
Data Type        Selection
Selection           Read/Fixed/Floating
Field ID            108
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The AR System Group schema contains three reserved fields, as listed below:

Default Notify
Mechanism

The notification method that is used if the user specifies
that the default mechanism should be used. There are as many
choices as there are notify mechanisms.
Data Type        Selection
Field ID            109

Full Text License
Type

The type of full text license the user has. The choices are None,
Fixed, and Floating.
Data Type        Selection
Selection           None/Fixed/Floating
Field ID            110

Flashboards
License

The type of Flashboards license the user has. The choices are
None and Fixed.
Data Type        Selection
Selection           None/Fixed
Field ID            111

Table C-3 Reserved Fields in Group Schema

Field Label Description

Group name The alias by which the access control group is known. This is
the name used in the Group list field of the User schema and in
the Group Permissions list of each schema field.
Data Type        Character
Length                 30
Field ID            105

Group id The integer ID that is the identifier by which the AR System
recognizes the group named in the Group name field. (For
groups that you create, the ID must be greater than 10.)
Data Type        Integer
Range                 0-100 (can be expanded if desired)
Field ID            106

Group type The maximum permission type intended for the group named
in the Group Name field. The choices are None, View, and
Change.
Data Type        Selection
Selection           None/View/Change
Field ID            107

Table C-2 Reserved Schema Fields  (2 of 2)

Field Label Description
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You also can add a field to support row level access, as listed below:

The AR System Distributed Server Option contains the following reserved
fields that you can add to schemas, as listed below:

Table C-4 Row Level Access Control Reserved Field

Field Label Description

Assignee The group assigned ownership of the entry.
Data Type        Character
Field ID            112

Table C-5 Distributed Mapping Reserved Fields

Field Label Description

Transfer
Status

The status of a distributed server transfer operation. The
choices are Success, Retry, Failure, Timeout, and Cancelled.
Data Type        Selection
Selection           Success/Retry/Failure/Timeout/Cancelled
Field ID            301

Update
Status

The status of a distributed server update operation. The choices
are Success, Waiting, Retry, Failure, Timeout, and Cancelled.
Data Type        Selection
Selection           Success/Waiting/Retry/Failure/Timeout/
                            Cancelled
Field ID            302

Master Flag Flag indicating whether or not the entry is the master. The
choices are No and Yes.
Data Type        Selection
Selection           No/Yes
Field ID             303

From
Entry ID

The ID of the original entry from which this copy was
transferred.
Data Type        Character
Length                 15
Field ID            307

From Schema The schema from which this entry was transferred.
Data Type        Character
Length                  30
Field ID             310
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From Server The server from which this entry was transferred.
Data Type        Character
Length                 64
Field ID             311

To
Mapping

The field which tells the Distributed Server Option the
mapping to be used when transferring the entry.
Data Type        Character
Length                 30
Field ID            300

From
Mapping

The mapping that was used during a transfer to create this
entry.
Data Type        Character
Length                  30
Field ID             306

To Entry ID The ID of the entry that the data was transferred to.
Data Type        Character
Length                 15
Field ID            308

To Schema The schema to which to transfer the entry.
Data Type        Character
Length                  30
Field ID            312

To Server The server to which to transfer the entry.
Data Type        Character
Length                  64
Field ID              313

Mapping
History

A history tracking record created at transfer time, which
includes the date/time of transfer, source entry ID, source
schema, source server and the name of the specific mapping
used.
Data Type        Character
Field ID            309

Current Schema The schema in which the master copy of the entry resides.
Data Type        Character
Length                 30
Field ID            304

Table C-5 Distributed Mapping Reserved Fields

Field Label Description
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Additional AR System Defined Fields
The following fields were defined as core fields in AR System versions prior to
the 1.2 release. You may use these fields in schemas you design; however, you

Current Server The server on which the schema with the master copy of the
entry resides.
Data Type        Character
Length                  30
Field ID             305

When to Update The frequency with which to update the original entry if a
transferred copy is updated. The choices are Immediately,
Hourly, Daily, On Return, and No Update.
Data Type        Selection
Selection            Immediately/Hourly/Daily/On Return/
                              No Update
Field ID              314

Transfer Mode The type of transfer to perform. The choices are Data Only,
Data + Ownership, Independent Copy, and Copy + Delete.
Data Type        Selection
Selection           Data Only/Data + Ownership/
                            Independent Copy/Copy + Delete
Field ID            315

Duplicate Entry
ID Action

The action that will occur if you transfer an entry and there is
already an entry with the same entry ID in the To schema. The
choices are Error, Overwrite, and Create New.
Data Type        Selection
Selection           Error/Overwrite/Create New
Field ID            316

Max Time to
Retry

The maximum time (in hours and minutes) to keep re-trying a
distributed operation on an entry before the system cancels the
operation.
Data Type        Integer
Field ID            317

Table C-5 Distributed Mapping Reserved Fields

Field Label Description
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must follow the rules specified below.

Table C-6 Additional AR System Defined Field

Field Label Description

Long-
Description

An open-ended description of the problem. The long description
is used to expand upon the short description.
Date Type        Character
Field ID            9

Disposition A running log of the progress on the request, time and user
stamped each time it is accessed. Once information in this field
has been applied, it becomes read-only. This field will always
accept new information.
Data Type        Diary
Field ID            10

Related-to Information about items this entry is related to, such as Entry IDs
of other tickets with similar problems.
Data Type        Character
Max Length       128
Field ID               11

Notify-method How the submitter wishes to be notified of significant progress
on the request.
Data Type        Selection
Field ID            12

Submitter-
severity

How critical the AR is to the submitter. It is a subjective
assessment of the severity of the problem.
Data Type        Selection
Field ID           13

Assigned-
priority

The priority assigned to the request by the delegator or support
staff. The value in this field can be used for generating statistics
and reports, as well as setting priorities for support staff.
Data Type        Selection
Field ID           14
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Operators, Wildcards, and
Keywords D

The following information is provided in this appendix:

• Operators used in defining qualifications.

• Operator precedence.

• Wildcards.

• Keywords.
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Table of Operators

Table D-1 Operators Used in Qualifications  (1 of 2)

Operator Action

AND

&&

Logical AND of the result of two conditions (the result is true only if
both conditions are true). For example, 'Status'=''New'' AND
'Assigned-to'=''Andy''  would find all new ARs assigned to
Andy.
You can use the symbol && instead of the word AND.

OR

||

Logical OR of the result of two conditions (the result is true if either
condition is true). For example, 'Status'=''New'' OR
'Assigned-to'=''Andy''  would find all new ARs and all ARs
assigned to Andy (no matter what their status).
You can use the symbol ||  (two vertical lines) instead of the word
OR.

NOT

!

Negates the condition that follows (if the condition is false, the result
is true). For example, NOT 'Status'=''New''  would find all ARs
that are not new.
You can use the symbol ! instead of the word NOT.

LIKE Performs a pattern search. For example, 'Submitter' LIKE
''Bob%ton''  would find all ARs with a submitter name that begins
with the letters “Bob” and ends with the letters “ton” — such as Bob
Compton and Bobby Fenton. The LIKE  operator is useful only with
character and diary type fields. For more information on wildcards,
see Table D-2 on page 368.
You also use LIKE  along with comma separators as the accrue
operator in full text searches. For further information, see “How Do I
Use FTS?” on page 306.

+ * Adds two integer or real values.
* Adds an integer or real interval to a time value.
* Concatenates two character strings.
For example, 'Create-date' > $DATE$ + 28800  would find all
ARs that were created after 8:00 am today. (28800 is the number of
seconds in 8 hours.)

- * Subtracts two integer or real values.
* Subtracts two time values (resulting in an integer).
* Subtracts an integer or real interval from a time value.
For example, 'Create-date' > $DATE$ - 604800 would find
all ARs that were created within the past week. (604800 is the
number of seconds in one week.)
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Operator Precedence

When you use multiple operators in constructing qualification criteria, they are
evaluated in the following order.

* Multiplies two integer or real values. For example,
'Quantity' * 'Price' > 50  finds all ARs where the contents of
the Quantity field times the contents of the Price field is over 50.

/ Divides two integer or real values. For example,
'Total Expenses' / 'Total Income' = 1  would find all ARs
where the total amount spent for expenses equaled the total amount
brought in as income.

% Supplies the modulo of two integer values (the remainder of a divide
of the values). Since a percent sign is also a valid wildcard symbol,
the context when using a percent sign determines how it is
interpreted. For example,
'ID' % 2 = 1  finds all ARs with an odd number in the ID field.

< Matches contents that are less than the value. For example,
'Create-date' < ($DATE$ - 86400)  would find all ARs
created more than 24 hours ago. (86400 is the number of seconds in
24 hours.)

> Matches contents that are greater than the value. For example,
'Create-date' > "06/10/93 00:00:00"  would find all ARs
with Create-dates that are more recent than June 10, 1993 at
midnight.

!= Matches contents that are not equal to the value. For example,
'Status' != "Closed"  finds all ARs that aren’t closed.

<= Matches contents that are less than or equal to the value. For
example,
'Salary'<= 10000 would find all ARs where the contents of the
Salary field is less than or equal to 10000.

>= Matches contents that are greater than or equal to the value.
For example, 'Create-date' >= "10/31/93"  would find all ARs
with Create-dates equal to or more recent than October 31, 1993.

= Matches contents that are exactly equal to the value. For
example,
'Status' = 0  would find all ARs with a status value equal to the
first selection value.

Table D-1 Operators Used in Qualifications  (2 of 2)

Operator Action
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1. ( )

2. !, NOT, - (unary minus)

3. *, /, %

4. +, -

5. <, <=, >, >=, =, !=

6. && (AND)

7. || (OR)

Operators of the same precedence are performed left to right.

Table of Wildcards
The table below lists the wildcards that you can use with the LIKE  operator in
qualifications.

Wildcard symbols are only interpreted as wildcards when used with the LIKE

operator; otherwise they are interpreted verbatim. To use the percent symbol
(%), underbar ( _ ), or open bracket ( [ ) as an explicit text character within a
LIKE  operation, you must enclose the symbol in brackets. For example, [%] will
match the % character — not find 0 or more characters. The close bracket ( ] )
functions as a wildcard only when it is accompanied by an open bracket ( [ ).
The hyphen functions as a wildcard character only when preceded by an open
bracket ( [ or [^ ).

Table D-2 Wildcard Symbols

Wildcard Action

% Matches any string of 0 or more characters.
Example: J%son matches Jackson, Johnson, Jason, and Json.

- (Underbar) Matches any single character.
Example: B_b matches Bab, Bob, and Bub.

[ ] Matches any single character within a specified range or set.
Example: [a-f ] matches the range of characters a through f . [abcf ]
matches the set of characters abc and f .

[- ] (Hyphen) Indicates a character range. Used only within brackets ([ ]).
Example: [a-f ] matches the range of characters a through f .

[^ ] Matches any single character not within the specified range or set.
Example: [^a-f ] matches all characters except the range a through f .
[^abcdf ] matches all characters except the set of abcdf .
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You must use the % symbol when you want to include leading and trailing
characters. For example, if you want to match Jill Bobbington, Bobby Fenton,
and Bob Compton in the Submitter field, you could enter
'Submitter' LIKE ''%Bob%ton%'' .

Table of Keywords
You can use any of the keywords from Table D-3 in qualifications or to set a
field value.

• In a qualification, the data type of the keyword value must match the field
data type.

• In a set field, the system will attempt to correct the data type if it is not
compatible.

Table D-3 Keywords  (1 of 2)

Keyword Value

$DATE$ The current date (time defaults to midnight).

$DEFAULT$ The default value for the field, if any.

$HARDWARE$ The hardware on which the process is running. This is the name
that the hardware vendor has given to their hardware, as in the
following:
* On UNIX platforms, the name returned by the uname -m
command (for example, sun4c ).
* On PC platforms, the processor type (for example, PC i486 ).
You can use this keyword to build filters, escalations, and active
links that execute only if the process is running on an appropriate
platform. This is especially useful in an active link, if the action is
to run a UNIX process and the current platform may be a PC.

$GROUPS$ The groups of which the current user is a member. (This keyword
is an empty string for escalations.)

$NULL$ A null value (no value).
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$OPERATION$ The current operation (CREATE, DELETE, GET, MERGE, SET, or
QUERY). You can use this keyword in filter and active link
qualifications to determine whether the current operation is one
that should activate the filter or active link.
For example, in the Modify Active Link window, you could use
the $OPERATION$ keyword to set an “Audit Log” field to:
"Filter X executed on operation" + $OPERATION$
This entry would inform you if the filter fired during a submit
operation (CREATE returned) or a modify operation (SET
returned).
You could also create a qualification that fires only for the Modify
Individual window and not for the Display window, as in the
following example:
 $OPERATION$ = "SET"
Operation values indicate the following AR System actions:
* CREATE — In active links, used on Submit window. In filters,
during an operation to create a new entry.
* DELETE — In filters, during a delete operation. (Unused in
active links.)
* GET — In filters, when an entry is retrieved. (Unused in active
links.)
* MERGE — Merge an existing entry. Used when loading an AR
Export format file with the Import Tool. (Unused in active links.)
* SET — In active links, used on Modify Individual and Modify
All Selected windows. In filters, used on Modify operations.
* QUERY — In active links, used on the Query window. (Unused
in filters.)

$OS$ The operating system of the platform on which the process is
running. You can use this keyword to build filters, escalations, and
active links that execute only if the actions are supported under
the operating system that is running.

$SCHEMA$ The name of the current schema.

$SERVER$ The name of the current server.

$TIME$ The current time as a character string (date defaults to current
day).

$TIMESTAMP$ The current date/time as a character string.

$USER$ The current login user. (This keyword is AR_ESCALATOR for
escalations.)

$WEEKDAY$ The current day of the week as a string.

Table D-3 Keywords  (2 of 2)

Keyword Value
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You start the Administrator and Import Tools from the command line. For the
Administrator Tool, you can include any of the various command line options.
For example, you can include the -i  or -e  command line option to execute a
macro when the Administrator Tool starts. You can also use most of the X11
Toolkit Intrinsics command line options. For more information about X11
Toolkit Intrinsics command line options, see the X11 man page or your system
administrator.

Note – If you run the Administrator or Import Tools from within a shell or
script, be sure to set any necessary environment variables before executing the
tool, for example.

Administrator Tool (aradmin)
The command to run aradmin is:

Note – Items between square brackets ( [ ] ) are optional. You must choose one
of the items between braces ( { } ). Vertical bars ( | ) separate the available
choices. You can list more than one server.

aradmin [-a | -e | -f | -m | -s | -t ] [-x server]
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Names containing spaces or special characters must be entered within quotes.

Syntax Options

The following options to aradmin may appear in any order on the command
line:

Example Using Syntax Options

Open the Administrator Tool with filters appearing in the main window and
connecting to two servers:

Import Tool (arimport)
The command to run arimport is:

Option Function
-a Start the Administrator Tool with the Active Links category displayed in

the list.
-e Start the Administrator Tool with the Admin Commands (admin

extensions) category displayed in the list.
-f Start the Administrator Tool with the Filters category displayed in the list.
-m Start the Administrator Tool with the Menus category displayed in the list.
-s Start the Administrator Tool with the Schemas category displayed in the

list.
-t Start the Administrator Tool with the Escalations category displayed in the

list.
-x Start the Administrator Tool and connect only to the specified server or

servers. This option overrides the list of servers specified in the /etc/ar
file. You can specify this option multiple times to connect with multiple
servers.
For example, to start the Administrator Tool and connect only to the
servers named metaphysix and narnia, you would enter:
<ar_install_dir>/bin/aradmin -x metaphysix -x narnia&

% <ar_install_dir>/bin/aradmin -f -x narnia -x metaphysix &
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The following options to arimport  may appear in any order on the command
line:

Examples Using Syntax Options

Start arimport  and load the mapping named “DB Mapping”. The program will
remain running after the mapping is loaded.

Options Function
-b Load the indicated mapping at tool startup and exit the tool when the

mapping has been completed. The tool does not display any windows
when this option is used.

-d The directory that the mapping indicated by the -m parameter is located
in. This parameter is optional. If it is not specified, the mapping is
assumed to be in the default location for the user running the command
($ARHOME/arcmds).

-m Load the indicated mapping at system startup. This option is good for
loading an initial mapping.

-x Specify the name of a server to connect to. This option may be included
more than once to connect to multiple servers.
By default, the list of servers the tool will connect to is defined in the
directory file /etc/ar . If this option is not specified, this file will be used
to determine where to connect. If this option is specified one or more
times, the servers specified in these options will be used.

arimport [[ -x server ] ...] [ -d directory ] [ -m mappingName ] [ -b ]

% <ar_install_dir>/bin/arimport -m "DB Mapping" &

% <ar_install_dir>/bin/arimport -m "DB Mapping" -d /usr/mappings -b
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Start arimport  and load the mapping named “DB Mapping” from the
directory /usr/mappings, then import the data from the import file specified
in the mapping. The program will exit after the file is imported.

Start arimport  specifying the machine fred  as the machine running the AR
System server process. The directory file /etc/ar  is not accessed.

% <ar_install_dir>/bin/arimport -x fred &
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This appendix contains worksheets that you can reproduce as needed to create
workflow diagrams and design the various AR System objects (for example,
schemas, active links, and so on).
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Workflow Worksheet
State Diagram Objects You Need to Create

Schemas

Data Fields

Filters

Escalation Criteria

Groups

Macros

Active Links

Users
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Schema Worksheet

Schema Name: ____________________________________
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Fields Worksheet

Schema Name: __________________________________
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Active Links Worksheet
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Filters Worksheet
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Escalations Worksheet

New Fields Needed for Escalation?

Escalation Actions & Description
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Here is a ist of procedures with their locations.

To stop and start the AR System server manually  5
To start the Administrator Tool  6
To select a server  12
To display platform information about the currently selected server 14
To set timeouts  15
To display license information and set the Submitter Mode  16
To set the configuration  18
To set log files  22
To display and update information about the database  23
To display information about licenses  25
To force the release of a floating license  28
To set warnings  29
To set default schema permissions  30
To set default active link permissions  31
To set default field permissions  33
To display version information about the Administrator Tool  35
To exit the Administrator Tool  36
To update the change history  37
To establish row level access to a schema and fields  75
To create a group  77
To modify a group  79
To delete a group  79
To add users to the system  82
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To allow users to change their passwords  84
To delete a user  84
To create a user having subadministrator capabilities  86
To open a schema  91
To delete a schema  92
To create a new field  93
To modify a field  94
To delete a field  95
To make a field non-operational  95
To create a new field that is a copy of an existing field  96
To create selection values  115
To move a field  117
To define a schema view  119
To select and modify a schema view  120
To delete a schema view  121
To define group access for schemas  122
To define indexes for a schema  125
To define fields returned in a query list  126
To define schema permissions  129
To allow all users to see a schema  129
To define sub admin permissions  130
To define group access for schema fields  131
To create a menu  137
To define a character menu  139
To define a menu that uses a query  141
To define a menu that uses a file  142
To open a filter  147
To specify or change filter conditions  148
To create a filter action  157
To modify a filter action  158
To delete a filter action  158
To change the order of filter actions  159
To define the Notify filter action  160
To define the Message filter action  165
To define the Log to File filter action  167
To define the Set Fields filter action  168
To assign a value from another field in the current transaction  171
To assign a value from a different AR  172
To assign a value using a function in the set field operation  175
To define the Run Process filter action  181
To open an escalation  189
To specify or change escalation conditions  190
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To set an execution interval  191
To set an execution time  192
To create an escalation action  195
To modify an escalation action  196
To delete an escalation action  196
To change the order of escalation actions  196
To open an active link  201
To open an active link from the Modify Schema window  201
To specify or change active link conditions  202
To create an active link action  206
To modify an active link action  207
To delete an active link action  207
To change the order of active link actions  208
To define the Run Macro active link action  209
To define the Set Fields active link action  212
To assign a value from another field on the current screen  215
To assign a value from a different AR  215
To use a function in the set field operation  219
To define the Run Process active link action  220
To define the Message active link action  222
To define the Change Field active link action  224
To define the DDE active link action  226
To define group access for active links  231
To open an administrator command  236
To define an administrator command  237
To delete an administrator command  238
To define group access for admin commands  239
To import definitions  242
To export definitions  243
To export a range of definitions  246
To export a mail template  247
To start the Import Tool  250
To display version information about the Import Tool  251
To exit the Import Tool  252
To import data using the Import Tool  253
To map import file fields to schema fields  257
To save mapping information  260
To use an existing mapping file  260
To set fallback mappings  262
To set preferences for the Import Tool  264
For Windows NT Servers  274
Command Options  275
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To start the mail handler  275
To create the query by entry ID format  283
To create the query by field format  284
To create the query bar format  286
To set the multiple-process server environment  295
To kill a private server  301
Using Motif Clients with a Private Server  302
Using Windows Clients with a Private Server  302
To enable FTS debugging  315
To license a user for FTS  316
To display and update information about full text search  318
For Searches Using the Accrue Operator  320
For Non-Accrue Searches  322
To configure the FTS search option  323
To modify the Ignore Words List  324
To append a list of words to the Ignore Words List  325
To re-build the FTS index  326
To define a field for FTS  326
To estimate size of the FTS index  328
To move the FTS index  328
To define fields returned in a query list  329
To create or modify the Windows NT Registry  338
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access control
Security feature that lets you limit the access users have to specific fields
within a schema and to specific functions within the system.
See also access control group, permissions.

access control group
Facility of the Action Request System used primarily to define user access to
the contents of a schema field. Each group can have its own member list
defining users who belong to that group. The AR System defines a number of
special groups: Public, Administrator, Subadministrator, Customize, Submitter,
Assignee, and Flashboards Administrator. You can define additional groups
through the Group schema. Once you have defined a group, you can specify
the type of access that the group will have to specific fields within a schema.
See also access control, permissions.

access permissions
See permissions.

action request
AR. A collection of information that describes an event (transaction), such as a
problem or a service request.

active link
A cause and effect relationship that you define on a per schema basis. Active
links cause the Action Request System to perform specific operations in
response to specific user actions. The AR System administrator can define
active links that run macros, set fields to specified values, run independent
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system processes, send an interactive message to the user, change field
characteristics, or execute a DDE operation on a Windows User Tool. Active
links run on the client machine.

administrator
Individual responsible for the management of the AR System, including setting
up schemas, setting access rights for users, and designing the workflow
process. To manage the AR System, you must be a member of the
Administrator or Subadministrator group.

administrator default
Value that the administrator assigns to a field while designing the schema.
When the user sets defaults, this value is used unless the user has assigned
their own default. When a user submits an AR, the AR System automatically
enters this value in the field unless the user has assigned their own default or
has entered a different value.

Administrator group
One of several special access control groups provided by the AR System.
Members of this group have full and unlimited access to the AR System,
including unlimited ability to create schemas, filters, escalations, active links,
menus, and administrator commands. See also Subadministrator group.

Administrator Tool
The part of the AR System used exclusively by administrators (and to a lesser
extent, by subadministrators) to set up the system for use by support staff and
end users. This includes setting up schemas, setting access permissions (users
and groups), and creating filters, escalations, active links, menus, and
administrator commands.

administrator view
The layout of a schema that was designed by the AR System administrator.
This is the view that users will see unless they customize their view.

admin server
The arserverd process that can handle any AR System operation. The admin
server performs all admin restructuring operations, guaranteeing the
serialization and integrity of data. There can be only one admin server process
at any time.
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API
Application program interface. A set of functions that provide application
programmers with access to the full functionality of a product. The AR System
API provides a complete interface to the AR System server.

AR
See action request.

arservtcd server
The controller server process that handles requests from clients for information
on which socket to use for communicating with other server processes. Also
restarts servers if they terminate.

AR System client
1. Subset of AR System software necessary to allow a user to access an AR
System server on the network and run the AR System tools on a local
workstation.
2.Hardware (workstation, terminal, Macintosh, or PC) running the AR System
client software.

AR System server
1.Full set of AR System software, including the arservtcd and the fast, list, and
escalation arserverd processes. When installed on a workstation on the
network, the server software provides access to the full feature set of the AR
System and can be accessed by workstations, Macintoshes, terminals and PCs
on the network that are running the AR System client software.
2.Hardware (workstation) running the AR System server software.

ARWeb license
Fixed or floating license that allows a user access to the ARWeb product.

assignee
The person who is assigned responsibility for resolving an action request.

Assignee group
One of several special access control groups provided by the AR System. This
is an implicit group; users automatically belong to this group and, if they have
a valid AR System license, are granted change access for ARs for which they
have been assigned responsibility (their name is in the Assigned-to field).

broadcast operation
A distributed operation in which one source server simultaneously transfers
data-only copies of entries to two or more target servers.
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chained operation
A distributed operation in which one source server transfers an entry to a
target server, and the target server in turn transfers the entry to another server.
This operation is used in environments containing three or more servers.

character data type
Data type used for fields where you will be entering text. The AR System
administrator can specify a maximum length for the field or leave the length
unlimited. The administrator can also specify a pattern to restrict the data that
users can enter or attach a character menu to the field.

character menu
A type of menu that the AR system administrator can create and attach to any
character-type data field. Character menus can be displayed as list boxes or
pull-right menus. (Also called list menu.)

client
See AR System client.

command line options
Parameters that you can combine with the commands to start the User,
Administrator, Notification, and Import Tools that allow you to specify how
the tools will run. For the User Tool, you can execute a macro or open to the
Query or Submit window. For the Administrator Tool, you can attach to a
specific server or open the tool with a specific category displayed.

configuration
1.The process of setting up hardware and/or software so that it operates in a
manner consistent with the needs of a location.
2.The physical setup of a device or devices.
3.The operating characteristics of software.

core field
One of a set of basic fields that are common to all AR System schemas.
Additional limits, such as fixed or maximum sizes, are placed on some core
fields.

Customize group
One of several special access control groups provided by the AR System. This
group grants users the right to customize their schema layout and create
custom commands in the User Tool.
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database
A collection of information maintained in the form of individual entries.

data type
Property of a field that determines what type of information the field contains.
The choices are character, date/time, diary, integer, real, and selection.

date/time data type
Fields with this data type are limited to calendar dates and time.

DDE
Dynamic Data Exchange. This is a standard inter-application communication
feature used in Windows applications. For more information, see your
Windows documentation.

default
Administrator or user defined setting or value that automatically applies to a
field if users do not supply a different setting or value when submitting a new
action request.

default mapping
The mapping selected by the Distributed Server Option if the AR System finds
multiple mappings which apply to the specified transfer criteria.

diary data type
Fields with this data type allow you to capture a history of the actions taken
for an AR. Each multiple character entry is stamped with the time, date, and
name of the user who entered the item.

distributed delete
To remove an entry from the AR System. In a distributed environment, a copy
of an entry may be deleted on one server if the master copy is deleted on
another server.

distributed fields
Fields you can add to an AR System schema which allow you to manipulate
certain mapping controls. The amount and type of fields added to a schema is
determined by the mapping type selected.

distributed processes
These processes control the action that is taken when filter or escalation criteria
is met within a given schema. There are three distributed processes you can
select as the Run Process action in a filter or escalation: Distributed-Transfer,
Distributed-Return, and Distributed-Delete.
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distributed return
A distributed operation that returns the latest copy of an entry, with
ownership, to the requesting server.

distributed server
An AR System server that exists within a multi-server, distributed
environment.

distributed transfer
A distributed operation that sends a copy of an entry, with or without
ownership, from one server to another.

distributed update
A distributed operation that refreshes a copy of an entry on one server when
the master copy, on another server, is modified.

duplicate entry IDs
A condition that may occur in a distributed operation when an entry
transferred from the source server has the same entry ID as an entry on the
target server. The Distributed Server Option provides several options to handle
this issue.

dynamic menu
Menu that performs a query at the time a user selects the menu icon and uses
the results of the query to build the list of menu items from which the user
chooses.

email
Electronic mail. The AR System allows you to set up an electronic mail handler
so that users can submit ARs through email if they do not have access to a User
Tool or if the AR server is inaccessible. (If you are running the client tools on a
PC, your PC must be equipped with an SMTP gateway to allow email
submissions.)

end user
In the AR System, an end user is the person who notifies support staff of
problems and service requests by submitting ARs.
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escalations
Facility that tests server transactions at specified times or regular intervals to
see if certain conditions are met and responds to the conditions by taking a
specific action or actions. The AR System administrator can define escalations
to perform actions such as notify an individual, run a process, set specified
fields, or make an entry to a log file.

This facility is useful if, for example, you want to notify support staff when
ARs are in the Assigned state too long.

escalation server
The arserverd process that, if enabled, handles all escalation operations.

export
Facility that lets you move schemas, filters, active links, menus, administrator
commands, and mail templates to a file. Exporting is useful if you want to
share schemas, filters, active links, menus, and administrator commands with
another server or generate mail templates.

fast server
The arserverd process that, if enabled, handles the operations that generally
run to completion quickly without blocking access to the server.

extension
See user command, administrator command.

filter
Facility that tests every server transaction to see if certain conditions are met
and responds to the conditions by taking a specific action or actions. The AR
System administrator can define filters that set fields to specified values, run
independent system processes, send an interactive message to the user, notify
the user when the state of an AR changes, or make an entry in an audit trail log
file. Filters run on the server.

fixed license
Write license that is permanently assigned to a user so that the user always has
access to the AR System.
See also floating license, write license.

Flashboards license
Fixed or floating license that allows a user access to the AR System
Flashboards product.
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floating license
Write license that exists on a server and is allocated to any user who requests a
license and who is defined in the User database as having a floating license
type. If no floating license is available at the time of the user request, the user
must wait until a license becomes available.
See also fixed license, write license.

FTS
See full text search.

FTS license
Fixed or floating license that allows a user to perform a full text search in any
large text or diary field indexed for FTS.

Full Text Search (FTS)
Facility that allows a user to quickly search for information in large text or
diary fields. The fields must be indexed and FTS-enabled by the AR System
administrator, and the user must have an FTS license.

group access
See group type.

Group schema
Schema that lets you add new groups, delete groups, and modify group
permissions.

group type
The maximum permission type allowed for a group. May be None, View, or
Change. (Note that permission may be set below the group’s maximum at the
field level.)

guest user
An unregistered user with a limited set of capabilities (submit ARs and
possibly review those ARs). Unregistered users may not be allowed at your
site.

hidden field
A field that exists but is not visible in a user’s view of the schema.

import
Facility that lets you share schemas, filters, escalations, active links, menus,
and administrator commands that were created on another server. First, you
must export the definitions from the server on which they were created to an
ASCII file, then you can import the file to your own server.
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Import Tool
The part of the AR System that lets you transfer data from one server to
another.

integer data type
Fields with this data type contain numeric values between
-2147483648 and 2147483647. (The range for a particular field may be limited
by the administrator.)

license
See Flashboards license, fixed license, floating license, FTS license, read license,
write license.

list server
The arserverd process that, if enabled, handles the operations of the AR System
that may take some time to complete: AR Export, ARGetListEntry (high-
performance database searches), and ARGetEntryStatistics.

login window or dialog box
Window that allows you to login to the AR System when you first start an AR
System tool.

macro
A set of operations recorded for later execution. Macros are useful for
automating frequently used or complex query operations.

mail template
Template that contains the fields that you need to fill in to submit an action
request using electronic mail. Templates are generated by the administrator
from existing schema using the export facility. (If you are running the client
tools on a PC, your PC must be equipped with an SMTP gateway to allow
email submissions.)

mapping
The parameters for a particular distributed operation, such as To and From
servers and schemas, data control issues, and field-to-field mapping
definitions.

mapping history
A history tracking record created when a distributed operation occurs. This
record includes the date and time of transfer, source entry ID, source schema,
source server, and the name of the specific mapping used.
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master copy
The copy of a distributed entry which currently has ownership.

multiple schema views
Ability of an administrator to create different views of what users see when
they bring up a schema, including hiding or re-arranging fields by changing a
field’s display properties.

multi-process server
A product that allows the AR System administrator to distribute operations
among different servers and, consequently, improve the performance of the AR
System.

For example, the arservtcd process routes the load among the Admin server,
Fast server, List server, Escalation server and Private servers as appropriate,
automatically starts the specified arserverd processes and restarts the arserverd
processes if they terminate.

notification
An alert that tells you that an AR System event has occurred. The alert may be
a system beep, flash, the display of a notice window, or the opening of the
Notification Tool.

Notification Tool
The part of the AR System that alerts you when specific changes are made to
ARs. Also referred to as the Notifier.

operator
One of a number of functions that let you define complex queries or build
qualifications. The AR System operators are available through use of the query
bar palette or the qualification palette or you can type them in directly.

pending operation
A distributed operation that is waiting to occur. Pending operations are
typically due to a specified transfer interval that has not yet been met, or
because there are network or server-related problems within the distributed
environment.

permissions
Property setting that allows you to control who can view and change
individual fields of a schema. You also set permissions for schemas and active
links. Permissions are defined for each access control group. View permission
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limits group members to reading the contents of a field. Change permission
allows group members to read and write the contents of a field. See also access
control group.

pick list
See selection list.

private server
An arserverd process that, if enabled, provides dedicated access to system
operations for specific users.

property
An attribute that is defined. For example, the properties of a field include its
data type, physical characteristics such as length, and whether it is required or
optional.

Public group
One of several special access control groups provided by the AR System. Every
user is automatically a member of this view only group.

pull-right menu
See character menu.

query
Process that lets you select a subset of ARs according to search criteria that you
define and then perform one of several operations on the selected ARs. See also
query operation.

query bar
Part of the Query window, Active Link Qualification window, and the Filter
Qualification window that lets you define complex query criteria. Includes a
palette of operators that you can use in the query you build.

query list
A list that includes a one-line summary of each AR matching a query.

query operation
Action that you can perform on the entries that match the criteria defined in a
query. The possible operations are: Query List, Display, Modify, Report, and
Delete.

query statement
A complete definition of query criteria constructed in the query bar.
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Query window
The User Tool window that lets you search the database for ARs that match
specific criteria and display the results of the search. You also use the Query
window to view or modify an existing AR. See also Submit window.

range
Defines the upper and lower limits of acceptable values. For example, if a
field’s range is -10 to 100, you will be able to enter any number from negative
10 to positive 100 inclusive.

read license
License that allows a user to query the AR System schemas and submit new
ARs but does not allow the user to modify existing ARs. See also write license.

real data type
Fields with this data type contain a floating-point number. The range is set by
the administrator.

report format
The layout that you specify when you generate a report from an AR System
query. You can format a report in columns or as a list of records. You can also
choose selected fields to print or print them all. To create a more sophisticated
layout, you can export the report to a file and import the file into a desktop
publishing application.

reserved field
One of a set of fields defined with specific interpretations. You can use these
fields in any schema, if desired.

return mapping
The specific field-to-field mappings used when an entry is returned.

row level access control
The ability to control a user’s access to particular rows, or parts of rows, within
AR System database tables.

schema
The definition of the data fields in a database. Each schema represents a
database on an AR System server. The AR System comes with several sample
schemas and you can build as many additional schemas as needed.
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scroll bar
Window element that appears when there is more information to view than
will fit in the window. You use the mouse to slide the scroll bar and shift the
view area. A scroll bar at the bottom of the window lets you move the viewing
area left and right. A scroll bar on the right side of the window lets you move
the viewing area up and down.

selection data type
Fields with this data type present a set of mutually exclusive choices from
which the user is to choose. The selections are displayed as radio buttons or as
items on a menu.

selection list
List that appears as a result of an active link that performs a query that returns
more than one AR. The selection list lets the user pick the appropriate AR so
the active link can continue processing.

server
See AR System server.

status field
Core field that lets you keep a record as an AR moves through the various
stages of the process you are using to resolve ARs. The defined states should
reflect the workflow process.

status history
Information that shows the progress that has been made on an AR. You can
view status history from the Display or Modify Individual window.

subadministrator
Individuals who have limited administrative access to the AR System. To be a
subadministrator, you must be a member of the Subadministrator group and
belong to a group with subadministrator access to a schema.

Subadministrator Group
One of several special access control groups provided by the AR System.
Members of this group have limited access to the AR System. You must be a
member of this group to be able to administer any schemas that your group
has subadministrator access to and to create and administer filters, active links,
and escalations connected to schemas that your group has administrative
access to.
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Submit window
The User Tool window that lets you enter the appropriate information to create
and submit a new AR. See also Query window.

submitter
The person who submits an action request. The submitter’s name is entered in
the Submitter field.

Submitter group
One of several special access control groups provided by the AR System. This
is an implicit group; users submitting ARs automatically belong to this group
and, if they have a valid AR System license or if the Submitter Mode is set to
Locked, are granted change access for ARs that are submitted with their name
in the Submitter field.

support staff
Person or group responsible for resolving action requests. They assign and are
assigned ARs, log their progress in appropriate fields, and use information
stored in previous ARs to help resolve problems.

toolbar
Part of the Main window that allows easy access to some of the more
commonly performed functions in the Windows Administrator Tool: New
Server Window, New Object, Save, Align Left, Align Right, Align Value Left,
Align Value Right, Align Top, Align Bottom, and Show Grid.

transfer
A distributed operation that sends a copy of an entry, with or without
ownership, from one server to another.

transfer mapping
The specific field-to-field mappings used when an entry is sent from one server
to another.

user default
Value that a user who has customize permission can assign to a field. When the
user sets defaults, the AR System loads this value into the field. When the user
submits an AR, the AR System automatically loads this value into the field
unless the user has entered a different value.

User schema
Schema that lets you add users to the AR System and specify the type of access
each user will have.
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User Tool
The part of the AR System that lets users enter new ARs and track them
through the troubleshooting process. Users can also query the database for
ARs that match specified criteria, generate reports, and modify existing ARs
with the User Tool.

user view
What the user sees when they bring up a schema. If users have permission to
customize their views, they are able to change the physical layout and other
properties of the schema and schema fields as they appear.

variable
Data element that changes according to user input. In macros, you can include
variable definitions that will cause the AR System to prompt the user for
certain information when the macro executes.

version
The system release number. To display the version of the AR System that you
are running, select About under the Help menu  in the User, Administrator,
Notification, or Import Tools.

view layout
The location of fields in a user’s view of a schema.

wild card
Character that you can enter to represent other characters in a query. In query
statements in character and diary fields, for example, you can use wild card
characters to match single characters, strings, or characters within a range or
set.

write license
License that allows a user to modify and save data on existing ARs as field and
schema permission settings allow. Write licenses may be either fixed
(permanently attached to a single user) or floating (allocated to users as
required).
See also fixed license, floating license, read license.
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Symbols
$, 161, 163, 182
$PROCESS$

active links, setting fields in, 216
filters, setting fields in, 173

%, 367
*, 367
+, 366
.Xdefaults, 343
/, 367

A
About Admin Tool dialog box, 35
About Import Tool dialog box, 251
access control

active links, 203
admin commands, 238
change permission, 70
create mode, 109
creating groups, 78
defining, 70
fields, 114
group list, 81, 83, 87
group permissions, 81, 109
groups, 69, 72
overview, 69
row level, 74

schema permissions, 124
schemas, 128
submitter mode, 18
view permission, 70

access permission
change, 70
submitter mode, 18
view, 70

accrue operator in full text searches,
using, 305, 307

Action Request System
designing schemas for, 44
general design questions, 42
setting up, 41

actions
active links, 63, 206
escalations, 55, 195
filters, 3, 52, 157

activating
active links, 204
escalations, 191
filters, 148

active link
$PROCESS$ in set fields, using, 216
access control, 203
action types, 208
actions, 63, 206
activating, 203
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assigning field values
from a DDE request, 218
from arithmetic operations, 219
from other ARs, 215
from other fields, 214
from process results, 216

assigning keyword values, 214
basic conditions, 3, 202
buttons to appear to users,

placing, 204
change history, 198, 233
changing order of actions, 208
comparing with filters, 63
conditions, 61, 202
constructing qualification

statements, 215
creating, 3
creating from the Modify Schema

window, 121
creating macros for, 211
definition of, 3
designing, 60
difference from filters, 63
enabling, 203
execution option

button, 204
display, 205
modify, 205
return, 205
set default, 205
submit, 205

execution options, 61, 204
execution order, 203
help text, 232
importing, 242
list available, 10
modifying, 3
name, 203
order of, 208
qualifications, 206
selecting a schema, 203
Set Fields Edit menu, 214
specifying permissions, 203

active link action
Change Field, 63, 224

creating, 206
DDE, 63, 225
deleting, 207
Message, 63, 222
modifying, 207
Run Macro, 63, 209
Run Process, 63, 220
Set Fields, 63, 211

Active Link window, 200
Active Links Category menu option, 10
adapting a schema for new needs, 48
adding

fields to schemas, 49
groups, 75
users, 79, 82

Address email option, 271
address for email, 269
Admin Command window, 236
Admin Commands Category menu

option, 11
Admin Permissions, 124
Admin Preferences window, 29
admin server, 293
Admin Tool Exit Confirmation, 29
Admin Tool window, 7

Category menu, 10
Edit menu, 11
File menu, 8
Help menu, 11
using, 8

Administrator access, 72
administrator commands, 11, 67, 235

access control, 238
copying, 237
creating, 4, 237
definition of, 4
group access, defining, 238
listing available extensions, 11
modifying, 4
opening, 237

administrator default, 101
Administrator group, 72, 83
Administrator Tool, 4
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functions, 2
limit on who can run, 6

administrator view, 48
Admin-Only-Permissions Warnings, 29
aliases, 76
allow guest users, 19
allow unqualified queries, 20
Always Prompt For Login, 34
AND operator, 366
API log file, 23
appending menu choices, 106
appending menu selections, 106
applying filters to schemas, 148
AR Export format, 252
AR System file locations, 347
ar.ini file

DDE timeout settings, 228
runmacro, using with, 183

ar.log file, 166
aradmin, syntax options, 7, 374
arcache, using, 333
arft.log file, 315
arimport, 250, 252

syntax options, 374
arithmetic operators, 366
armaild, 270

command options, 275
NT servers, 267
querying via email, 280
starting, 275
UNIX servers, 267

arreload, using, 336
arservdsd process, 297
arserverd processes, 292
arservftd process, 297, 314
arservtcd process, 297, 315
ASCII format (for importing), 252
ASCII text fields, 109
Assigned-priority defined field, 363
Assigned-to core field, 356
assignee, 70

Assignee (row level access control)
reserved field, 360

assignee access, 74
Assignee group, 74

assigning
field default, 101
field IDs, 100
field values

from a DDE request, 218
from arithmetic operations, 174,

219
from other ARs, 172, 215
from other fields, 171, 214
from process results, 173, 216

keyword values in active links, 214
keyword values in filters, 171

attributes of schemas, 123
audit trail, 53, 58, 166
automation aids, 65

B
backward compatibility of 2.0 (or later)

with 1.2, 299
basic conditions

active links, 3, 202
escalations, 3, 189
filters, 3, 147

before importing data, 261
bold field labels, 46
building

active link qualifications, 206
change history, 36
escalation qualifications, 191
filter qualifications, 150, 153
qualifications

for active link Set Fields
action, 214

for filter Set Fields action, 171
buttons, active link placing to appear to

users, 204

C
calendar for escalation time, setting, 192
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capturing history data, 51, 111
Category menu options, 10

Active Links, 10
Admin Commands, 11
Distributed Mappings, 11
Escalations, 10
Filters, 10
Menus, 10
Schemas, 10
selecting, 10

change access, 70
Change Field active link action, 63, 208,

224
change field permission, 70, 114
change group permission, 77, 114
change history, 36

active link, 233
admin command, 240
escalation, 198
field, 116
filter, 185
menu, 144
schema, 133
updating, 37

Change History dialog box, 37
changeable submitter mode, 71
changing field characteristics in an active

link, 224
character data type, 109
character fields, 109

length, 104
pull-right menus, 105, 109
specifying a pattern, 105

character menus, 2, 109, 135
checking database values, 151, 152
checking transaction values, 151, 152
choice fields, 111
clear field values, 170, 214
clients

2.0 (or later) with 1.2 or 2.0 servers,
using, 299

multi-process servers with AR,
using, 299

colors, customizing, 343
comma separated format, 252
command line

options, 7
starting tools from, 373

command options for email, 275
commands, see administrator commands
comment block, 277
comparing filters and active links, 63
compatibility, backward of 2.0 (or later)

with 1.2, 299
conditions

active links, 3, 202
escalations, 3, 55, 189
filters, 3, 52, 147

configurable fonts, 346
configuration file

email, 270
table of options, 271

Configurations window, using, 18
connecting to a specific server at

startup, 8, 374
Copy Edit menu option, 11
copying

active links, 201
administrator commands, 237
escalations, 237
existing fields, 96
filters, 147
items, 11

core fields, 2, 45, 50, 95, 100, 355
Assigned-to, 356
Create-date, 356
Entry ID, 356
Last-modified-by, 357
Modified-date, 357
on new schema, 46
Short-description, 357
special characteristics, 50
Status, 357
Status-history, 357
Submitter, 356

Create a New Edit menu option, 11
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Create Menu - Query dialog box, 141
Create Menu window, 138
create mode, 102, 279

Protected requires write license, 102
Create-date core field, 356
creating

access control group, 78
active link actions, 206
active links, 3, 201
administrator commands, 4, 237
email templates, 4, 247, 276
escalation actions, 195
escalations, 189
export mail templates, 4, 247, 277
fields, 92
filter actions, 157
filters, 147
groups, 77
macros for active links, 211
mail templates, 246, 276
new items, 11
pull-right menus, 135
schemas, 2, 91
selection field values, 114

cross reference blank password, 20
cross reference for notifications, 162
CSV format, 252
current licenses, 27
Current Schema reserved field, 361
Current Server reserved field, 362
custom commands, 4, 65, 66

See also administrator commands
Customize access, 73
Customize group, 73, 83
customizing

colors, 343
fonts, 346
query list fields, 126
schema layout, 73

D
daemon, armaild, 268
data fields, 49

data type, 103
character, 109
date/time, 110
diary, 111
integer, 110
real, 110
selection, 111
specifying, 103

database
home, 24
information, 24
name, 24
password, 24
table, see schemas
type, 24
values, checking, 151, 152
version, 24

DATE function, 176
DATE keyword, 369
date/time data type, 110
DAY function, 176
DDE, 225

$DDE$ keyword, 218
active link action, 63, 209, 225
assigning value from DDE request in

active link, 218
examples of use in an active link, 229,

230
item name, 226
service name, 226
topic name, 226

debug mode, 21, 185, 198, 315
default field property, 101
Default Import/Export Directory, 35
DEFAULT keyword, 369
Default Notify Mechanism field, 81
Default Notify reserved field, 359
default schema view, 48
default view field type, 113
Default-Password email option, 271
Default-Schema email option, 271
Default-Server email option, 271
Default-User email option, 271
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defined field, 362
Assigned-priority, 363
Disposition, 363
Long-description, 363
Notify-method, 363
Related-to, 363
Submitter-severity, 363

defining
administrator commands, 235
Change Field active link action, 224
data fields, 49
DDE active link action, 226
get list fields, 126
Log to File filter action, 167
menu that queries, 141
menu using a file, 142
Message active link action, 222
Message filter action, 165
Notify filter action, 160
Run Macro active link action, 209
Run Process active link action, 220
Run Process filter action, 181
schema indexing, 124
schema permissions, 128
Set Fields active link action, 212
Set Fields filter action, 168
states, 51
workflow process, 52, 60, 63

definition properties for a field, 49, 98
definitions

exporting, 4, 241
importing, 4, 242

Delete Edit menu option, 11
Delete-Confirmation Warnings, 29
deleting

active link actions, 207
escalation actions, 196
fields, 95
filter actions, 158
groups, 79
items, 11
schema view, 121
schemas, 92
users, 84

Demo user, 6

description field, 50, 77
design considerations for schemas, 50
design questions, 42
designing

active links, 60
escalations, 55
existing schemas, from, 47
filters, 52
menus, 51
schemas, 44

dialog box
About Admin Tool, 35
About Import Tool, 251

diary data type, 111
directory of server, 14
disabling

active link, 203
escalations, 191
filter, 149
full text search, 318

disallowing unqualified queries, 20
display length, 112
display properties for a field, 49, 99
displaying

license information, 25
server information, 14
version information for Admin

Tool, 35
version information for Import

Tool, 251
Disposition defined field, 363
distributed mappings

listed on server, 11
menu option, 9

Distributed Server Option (DSO), 9
distributed server option reserved

fields, 360
double-click, xxxi
drag, xxxi
Duplicate Entry ID Action reserved

field, 362
Duplicate-Field-Name Warnings, 29
dynamic data exchange, 225
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E
Edit menu, 11

for Set Fields active link action, 214
for Set Fields filter action, 170

Edit menu option
Copy, 11
Create a New, 11
Delete, 11
Group Access, 11
Open, 11

editing definitions, 11
email

armaild, 267
command options, 275
comment block, 277
configuration file, 270
creating templates, 4, 247
establishing an address, 269
exporting templates, 278
fields, 278
header block, 278
mail handler, 270
mail templates, 246
option

Address, 271
Default-Password, 271
Default-Schema, 271
Default-Server, 271
Default-User, 271
Include-Original-On-

Failure, 271
Include-Original-On-

Success, 271
Poll-Interval, 271
Reply-Failure, 272
Reply-Success, 273
Required-Schema, 273
Required-Server, 273

overview, 267
querying via, 280
receiving notifications, 288
sending notifications, 162, 288
setting options, 270
Subject line, 163
submitting ARs, 277

support, 269
table of options, 271
templates

creating, 246, 276
generating, 246, 276
modifying, 279
using, 276

user notifies from, 21
Email Address reserved field, 81, 358
enabling

active link, 203
escalations, 191
filter, 149
full text search, 318

entering text, 109
entering values in fields, 53, 59, 63, 211
Entry ID core field, 356
entry in audit log, 53, 58, 166
environment variable

MANPATH, 347
equal-to query bar operator, 367
error message, 53, 63, 164, 222
escalation action

creating, 195
deleting, 196
Log to File, 58
modifying, 196
Notify, 58
Run Process, 59
Set Fields, 59

Escalation Time Specification
window, 193

escalations
action types, 197
actions, 55, 195
activating, 191
basic conditions, 3, 189
changing order of actions, 196
conditions, 55, 189
definition of, 3
enabling, 191
execution order, 60, 196
help text, 197
how executed in AR System, 58
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importing, 242
interval, setting, 191
intervals described, 56
intervals, setting, 191
list available, 10
log file, 23, 295
logging activity, 198
name, 190
order of, 196
process timeout, 15
qualifications, 191
server, 294

checking, 56
setting, 296

strategy, 55
time, setting, 191, 192
trace, 198
window, 193

Escalations Category menu option, 10
Escalations window, 188
exactly equal operator, 367
example

email template, 277
filter qualifications, 153
workflow process, 44

executing a macro, 63, 209
execution options for active links, 61, 204
execution order, 54, 60

active links, 203
escalations, 196
filters, 149

exit menu option, 10
exiting

Administrator Tool, 10, 36
Import Tool, 252

Expand Menus On Schema Screens, 34
explicit groups, 72
Export Definitions window, 244
export mail templates, 4, 278
Export Mail Templates window, 247
Export Range window, 246
exporting, 4

definitions, 241

mail templates, 246, 278
menu option, 9

expressions, see qualifications
extensions, see administrator commands

F
fallback mappings, defining for Import

Tool, 261
fast servers

administering, 293
setting, 296

field ID, 100
field label property, 112
field mappings

saving for Import Tool, 259
using, 260

Field Properties window, 98, 120
field property

default, 101
field ID, 100
index for full text search, 326
setting, 97

field type
for default view, 113
for integer fields, 113
for selection fields, 113

fields, 126
access control, 70, 131
bolded, see required
changing characteristics in an active

link, 224
character, 109
copying, 96
core, 356
creating, 92
date/time, 110
Default Notify Mechanism, 81
default permissions, setting, 32
defining, 49
definition properties, 49, 98
deleting, 95
descriptive, 77
diary, 111
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display length, 112
display properties, 49, 99
email, 278
Email Address, 81
Field ID, 100
Full Name, 81
getting help information, 38
group access, defining, 131
Group ID, 76
Group List, 81, 83, 87
Group name, 76
Group type, 77
hidden, 113
integer, 110
label position, 112
labeling, 112
labels, meaning of type style, 45
laying out, 117
length, 104
License Type, 80
location on schema, 113
Login name, 81
Long Group Name, 77
making non-operational, 95
modifying, 92
number of rows, 113
optional, 46, 101
Password, 81
permissions, 77
real numbers, 110
rearranging, 117
required, 46, 101
reserved, 358
restricting contents, 105
row level access control (field ID

112), 75
selection, 111
setting precision, 108
setting properties, 97
specifying permissions, 109
status, 50
status history, 51
system maintained, 46
view or change, 114
visible/hidden on schema, 113

write license required to set values for
fields in Protected
mode, 102

file locations
AR System, 347
UNIX client, 349
UNIX flat-file database, 351
UNIX notification system, 350
UNIX server, 348
Windows client, 352
Windows NT flat-file database, 353
Windows NT notification system, 352

File menu option
Distributed Mappings, 9
Exit, 10
Export, 9
Import, 9
License Info, 9
Login, 9
Preferences, 10
Server, 9
Server Info, 9

files
ar.log, 166
formats for importing data, 252

fill-in aid, 109, 135
filter

$PROCESS$ in set fields, using, 173
action types, 159
actions, 52, 157
activating, 149
applying to schemas, 148
assigning field values

from arithmetic operations, 174
from other ARs, 172
from other fields, 171
from process results, 173

assigning keyword values, 171
basic conditions, 3, 147
change history, 185
changing order of actions, 159
comparing with active links, 63
conditions, 52, 147
constructing qualification

statements, 172
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copying, 147
creating, 147
definition of, 3
difference from active links, 63
enabling, 149
examples, 54
execution order, 54, 149
help text, 184
importing, 242
list available, 10
log file, 23, 295
logging activity, 185
name, 148
opening, 147
order of, 159
process timeout, 15
qualification examples, 153
qualifications, 150
security alert running a process, 181
Set Fields Edit menu, 170
subject line, 163
trace, 185
wild cards in qualifications, 368

filter action, 3
creating, 157
deleting, 158
Log to File, 53, 166
Message, 53, 164
modifying, 158
Notify, 53, 160
Run Process, 53, 181

security alert, 181
Set Fields, 53, 168

filter execution option
delete, 149
merge, 149
modify, 148
query, 148
submit, 149

filter qualifications
checking database values, 151, 152
checking transaction values, 151, 152
non-numeric values, 152

Filter window, 146
Filters Category menu option, 10

fixed licenses, 17
Flashboards License reserved field, 359
floating license timeout, 16, 28
floating licenses, 17
fonts, customizing, 346
force release of floating license, 28
format

AR Export, 252
ASCII, 252
comma separated, 252
CSV, 252
importing, 252
menu file, 143

formatting qualifications, 150
free idle floating license, 28
From Entry ID reserved field, 360
From Mapping reserved field, 361
From Schema reserved field, 360
From Server reserved field, 361
FTS Index Directory field, using, 319
Full Name field, 81
full text search

accrue operator, using, 305
arft.log, using to debug, 315
arservftd process, 314
capabilities, 304
case, 319
configuring, 317
debugging, 315
disabling, 318
efficient searches, 309
enabling, 318
fields, indexing, 312, 326
FTS Index Directory, using, 319
FTS-indexed fields in queries,

using, 305
ignore words list, 319
importing data (when to

rebuild), 261, 327
indexes, managing FTS, 316
indexing, 312
licenses, 17
licenses, fixed and floating, 306
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limits, 311
number of licenses, 81
QBE settings affecting, 311
rebuilding index, 319, 326
relocating index, 319
search options, 319
size of FTS indexes, estimating, 327
sorting records by WEIGHT, 305
timeout, 16
users, licensing, 316
using, 306
WEIGHT, using, 127, 329

Full Text Search Ignore Words
window, 324

Full Text Search License Type reserved
field, 359

functions in filter set field operation, 176

G
generating mail templates, 246, 276
get list fields, setting, 126
getting information

licenses, 25
servers, 13

greater than operator, 367
greater than or equal to operator, 367
greater-than query bar operator, 367
greater-than-or-equal-to query bar

operator, 367
group

Administrator, 72, 83
Assignee, 74
Customize, 73, 83
group access for field, setting, 124
Public, 73
subadmin access to schema,

defining, 130
Subadministrator, 73, 83
Submitter, 74

Group Access
Active Link window, 232
Admin Commands window, 239
Edit menu option, 11

Schema Fields window, 132
Schemas window, 123

Group ID field, 76
Group id reserved field, 359
GROUP keyword, 369
Group List field, 81, 83, 87
Group list reserved field, 358
Group name field, 76
Group Name reserved field, 359
group permissions, 109

none, 77
view or change, 77, 114

Group schema, 75
key fields, 76

Group type field, 77
Group type reserved field, 359
groups, 72

access for admin commands,
defining, 238

access for schema fields,
defining, 131

access for schemas, defining, 122
adding, 75
creating, 77
deleting, 79
explicit, 72
implicit, 72
special, 72
Subadministration permissions, 124

guest users, 19

H
HARDWARE keyword, 217, 220, 226, 369
hardware platform, 14
header block, 278
help

active link help text, 232
admin command help text, 240
escalations help text, 197
filter help text, 184
for a field, 116
for a schema, 133
for administrators, 39
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for end-users, 38
menu help text, 142, 238
on context, 38
Windows clients, 39

hidden fields, 113, 114
history, 51, 111
HOUR function, 176

I
identifying fields, 100
ignore words list

appending words, 325
index criteria, 319
modifying, 324
rebuilding index, 314

implicit groups, 72
import file, opening, 254
Import Tool

data, loading, 252
exiting, 252
fallback mappings, defining, 261
field mappings, saving, 259
field mappings, using, 260
functions, 249
information, importing, 252
keywords, 257
log file, using, 263
mapping fields, 256
preferences, 264
starting, 250
using, 249

Import window, 242
importing, 4

active links, 242
data with the Import Tool, 252
data, before, 261
definitions, 241, 242
escalations, 242
filters, 242
menu option, 9
rebuilding FTS index after importing

data, 261, 327
sample schemas, 48

schemas, 242
Include-Original-On-Failure email

option, 271
Include-Original-On-success email

option, 271
Index Fields dialog box, 125
indexes

FTS, managing, 316
schema attributes, 123
schemas, 124
size of FTS indexes, estimating, 327

indexing for a schema, 124
information

importing into AR System, 252
licenses, 25
server, 13

integer data type, 110
interactive message, 53, 165, 222
invoking UNIX commands from the User

Tool, 4, 235
issues when designing the AR System, 42
italic field labels, 46
item name, 226

K
keeping data in two places, 49
key fields

Group schema, 76
User schema, 80

keywords, 171, 214, 369
$PROCESS$, 173, 216
Import Tool, 257
used to restrict data entry, 105
values in qualifications, 152

killing server processes, 5, 301

L
label for a field, 112
Last-modified-by core field, 357
laying out a schema, 46
layout, 117



Index 417

LEFT function, 176
length

character fields, 104
field display, 112

LENGTH function, 176
less than operator, 367
less than or equal to operator, 367
license

current users, 27
Fixed, 26
Floating, 27
full text search, 17, 81, 306
information, 25
Read, 28
registered users, 26
revoke idle license, 16, 28
server ID, 17
submitter mode, 18
type, 17
users, licensing for FTS, 316

License Info option, 9
License Info window, 26, 27
License Type field, 80
License Type reserved field, 358
LIKE operator, 366
limits

Administrator Tool, running, 6
character fields, 109
permissions, 77

list of servers, 9
list servers

administering, 294
setting, 296

location property, 113
lock files, 295
locked submitter mode, 71
log file

API, 23
ar.log, 166
arft.log, 315
escalation, 23
filter, 23
Import Tool, using, 263

lock files, 295
SQL, 23
user, 23

Log to File
ar.log (when logging fails), 166
escalations, 58, 197
filters, 53, 159, 166

logging
escalation activity, 198
filter activity, 185

logging in
Admin Tool, 9
Import Tool, 251

logical operators, 366
login name, 81
Login name reserved field, 81, 358
Login option, 9
Long Group Name field, 77
Long-description defined field, 363
LOWER function, 176
LPAD function, 177
LTRIM function, 177

M
macro, 65

executing through active link, 63, 209
mail

address, 269
configuration file, 270
setting options, 270
See also email

mail handler, 270
command options, 275
information needed, 270
setting options, 270
starting, 275

mail templates, 4, 246
creating, 246, 276
exporting, 246, 278
generating, 246, 276
modifying, 279
querying via email, 282
using, 276
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making a field non-operational, 95
making menu selections, xxxi
MANPATH environment variable, 347
manual pages (UNIX), accessing, 347
mapping fields, Import Tool, 256
Mapping History reserved field, 361
Master Flag reserved field, 360
match values

anywhere in field, 107
beginning of field, 107
exactly, 107
queries, 107

MAX function, 178
Max Time to Retry reserved field, 362
maximum

entries returned by GetList, 21
length of character fields, 104
number of items in menus, 136
schemas allowed on server, 17

Menu Category menu option, 10, 11
menus, 2, 51, 105

change history, 144
character, creating, 135
defining character, 139
design considerations, 51
file, 142
file format, 143
frequency of retrieval, 138
help text, 142, 238
list available, 10, 11
maximum number of items

displayed, 136
menu drop, 106
menu that uses a file, defining, 142
menu that uses a query, defining, 141
refresh code, 138
styles, 51

Menu-To-List Conversion Threshold, 35
message

interactive, 53, 63, 164, 222
numbers, 166, 223

Message active link action, 63, 208, 222
Message filter action, 53, 159, 164

MIN function, 178
MINUTE function, 178
Modified-date core field, 357
Modify Schema window, 90
modifying

active link actions, 207
active links, 3, 201
administrator commands, 4
escalation actions, 196
escalations, 189
fields, 92
filter actions, 158
filters, 147
mail templates, 279
order of active link actions, 208
order of escalation actions, 196
order of filter actions, 159
schemas, 2, 90

MONTH function, 178
MP servers, see servers
multiple group names, 76
multiple schema views, 48

copying, 119
defining, 118
deleting, 121
display properties, setting field, 98
modifying, 120

multi-process servers, see servers

N
naming a schema, 91
new schema, 45
NIS services, 269
non-numeric values in filter

qualifications, 152
non-operational fields, 95
not equal to operator, 367
NOT operator, 366
note to user, 53, 63, 164, 222
not-equal-to query bar operator, 367
Notification Tool, 54, 162

See alsoAR System User’s Guide
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notifications, 54, 60, 81
cross reference, 162
other (for paging beeper

daemon), 163
send using email, 162, 288
text, 160
through email, 162
user default, 162

Notify
escalation action, 58
escalations, 197
filter action, 53, 159, 160
mechanism, 81

Notify-method defined field, 363
NT servers (Windows), see servers
NULL keyword, 369
NULL value, 369

qualifications, 152
number of rows, 113
numeric text fields, 113

O
On Version, 35
open create mode, 102
Open Edit menu option, 11
opening

active links, 201
administrator commands, 237
escalations, 189
filters, 147
import files, 254
items, 11
schemas, 91

operating system, 14
OPERATION keyword, 370
operator

AND, 366
available operators, 366
LIKE, 366
NOT, 366
OR, 366
precedence, 367

optional fields, 46, 101

options
Category menu, 10
Edit menu, 11
File menu, 8
Help menu, 11

OR operator, 366
order

active link actions, 208
escalation actions, 196
filter actions, 159

OS keyword, 217, 220, 370
overwriting menu choices and

selections, 106

P
password, 81

allowing users to change their
own, 83

database, 24
Password field, 81
Password reserved field, 358
pattern, 105
performance

AR System, 291, 294
expanding menus, 34
most efficient FTS searches, 309

permissions, 109
active link, setting default, 31
Administrator, 72
Assignee, 74
change, 70
Customize, 73
determining, 70
field, setting default, 32
fields, 77
filters, 53
for a schema, 128
for active links, 203
group, 109
group access for admin commands,

defining, 238
group access for schema fields,

defining, 131
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maximum, 70
Public, 73
schema, setting default, 30
subadmin access for schema,

defining, 130
Subadministrator, 73
Submitter, 18, 74
view, 70

physical layout of schema, 117
pick list, 126
plain text field labels, 46
Poll-Interval email option, 271
pop-up text editing window, 104, 109, 111
positioning

field labels, 112
fields, 117

precedence of operators in filter
qualifications, 367

precision of fields, 108
preferences

field permissions, setting default, 32
Import Tool, 264
menu option, 10
miscellaneous options, setting, 33
schema permissions, setting

default, 30
warning settings, 28

private servers, administering, 299
privileges for users, 78
PROCESS keyword, 173, 216
process timeout, 15
processes, administering multiple

server, 297
properties

create mode, 102
data type, 103
default, 101
display length, 112
entry, 101
field ID, 100
field type, 113
group permissions, 109
index for full text search, 326

label position, 112
length, 104
location, 113
menu, 105
menu drop, 106
number of rows, 113
pattern, 105
QBE match, 107
schema, 123
visibility, 114
visible/hidden, 113

protected create mode, 102
requires write license to set values for

field, 102
public access, 73
Public group, 73
pull-right, xxxi
pull-right menus, 2

creating, 135

Q
QBE match, 107
Qualification line, 149, 191, 206
qualification statements

in active links, 215
in filters, 172

qualifications
formatting conventions, 150
in active links, 61, 206
in escalations, 191
in filters, 150
keyword values, 152, 369
NULL values, 152
operators, list of, 366
precedence of operators, 367
wild cards, 368

Qualifications bar, conventions used
in, 151

query bar operator, 367
greater-than, 367
greater-than-or-equal-to, 367
not-equal-to, 367

query list display definition, 126
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Query List Fields, 123
Query List Fields dialog box, 329, 330, 331
query-by-example match, 107
querying

email, 280
using FTS-indexed fields in, 305

quitting
Administrator Tool, 36
Import Tool, 252

R
real data type, 110

precision, 108
rebuilding full text search index, 319
recording an audit trail, 53, 58, 166
reference /etc/passwd file, 20
refresh code for menu, 138
registered licenses, 26
registry, modifying server list in Windows

NT, 338
re-indexing full text search, 313, 319
Related-to defined field, 363
releasing a floating license, 28
relocating FTS index, 319
REPLACE function, 179
Reply-Failure email option, 272
Reply-Success email option, 273
required fields, 45, 46, 101
Required-Schema email option, 273
Required-Server email option, 273
reserved fields, 355

Assignee, 360
Current Schema, 361
Current Server, 362
Default Notify, 359
distributed server option, 360
Duplicate Entry ID Action, 362
Email Address, 358
Flashboards License, 359
From Entry ID, 360
From Mapping, 361
From Schema, 360

From Server, 361
Full Text Search License Type, 359
Group id, 359
Group list, 358
Group Name, 359
Group type, 359
License Type, 358
Login name, 358
Mapping History, 361
Master Flag, 360
Max Time to Retry, 362
Password, 358
row level access control, 360
To Entry ID, 361
To Mapping, 361
To Schema, 361
To Server, 361
Transfer Mode, 362
Transfer Status, 360
Update Status, 360
When to Update, 362

reset field values, 170, 214
restricting contents of fields, 105
restrictions on field IDs, 100
retrieving a menu, 138
returned in query list, 126
revoke idle license, 16
RIGHT function, 179
roles of users, 47
ROUND function, 179
row level access control, 74

reserved field, 360
rows, 113
RPAD function, 179
RPC socket numbers (servers), 292
RTRIM function, 179
Run Macro active link action, 63, 208, 209
Run Process active link action, 63, 208, 220
Run Process escalation action, 59, 197
Run Process filter action, 53, 160, 181

NT server, 173, 183
runmacro.exe, 183
security alert, 181
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runmacro.exe, using with run process
filter action, 183

running
Administrator Tool, 6
Import Tool, 250, 252
process, 53, 59, 63, 181, 220

S
sample

schemas, 48
workflow process, 44

SCHEMA keyword, 370
Schema window, 90
schemas

access control, 122
applying filters, 148
attributes, defining, 123
change history, 133
core fields, 45
creating, 2, 91
default permissions, setting, 30
default view, 48
definition of, 2
deleting, 92
design considerations, 50
designing, 44
Group, 75
help, 133
importing, 242
indexing, 124
layout, 46
list available, 10
maximum number on server, 17
modifying, 2
multiple schema views, 48, 118
naming, 91
opening, 91
permissions

access control groups, 124
defining, 128

sample, 48
selecting for active link, 203
setting attributes, 123
subadmin access, defining, 130

User, 80
Schemas Category menu option, 10
search options for FTS, 319
SECOND function, 180
security, 69, 82, 86

Demo password, 6
See also access control, 82, 86

security alert
run process filter action, 181

select, xxxi
selecting

category, 10
schema for active link, 203
servers, 9

selection data type, 111
selection fields

creating, 114
set number of rows, 113

Selection List window, 126
Selection Values window, 115
send

interactive message, 53, 164, 222
message, 63
message to user, 53, 58, 160

separator for query list fields, 127
Server Info option, 9
Server Info window, 14
SERVER keyword, 370
servers, 9

2.0 (or later) with 1.2 or 2.0 clients,
using, 299

admin, 293
administering processes, 297
armaild process, 267
arservdsd process, 297
arserverd processes, 291, 315
arservftd process, 297, 314
arservtcd process, 297, 315
configuring, 295
escalation, 294
escalation, setting, 296
escalations, checking, 56
fast, 293
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fast, setting, 296
information, 13, 14, 296
list, 294
list in Windows NT registry,

modifying, 338
list, setting, 296
lock and log files, 295
maximum

schemas allowed, 17
multiple processes, 291
multi-process server design, 291
options, 9, 14
performance, 291
private, running with multi-process

servers, 299
processes, administering, 297
registry, modifying Windows

NT, 338
Remedy ID, 17
RPC socket numbers, 292
running processes with NT

servers, 173, 183
search options, configuring FTS, 320
setting multi-process, 295
sockets, 292
starting servers manually, 4
stopping, 4
using multi-process with AR

clients, 299
using private with Motif clients, 302
using private with Windows

clients, 302
service name, 226
Set Fields

active link action, 63, 208, 211
edit menu for active links, 214
edit menu for filters, 170
escalation action, 59, 197
filter action, 53, 160, 168
Filter window, 169

setting
default email options, 270
field property, 97
fields, 168
multi-process servers, 295

setting up
AR System, 41
email, 270

Shift arrow button, 159
short description, 50
Short Description field, 50
Short-description core field, 357
showrgb command (to show colors), 343
size limits, 109
socket numbers (servers), 292
sorting records by WEIGHT, 305
special characteristics of core fields, 50
special characters, 127
special groups, 72
specifying

active link actions, 206
active link conditions, 202
active link execution order, 203
active link name, 203
Change Field active link action, 224
data type, 103
DDE active link action, 226
escalation actions, 195
escalation conditions, 189
escalation name, 190
escalations actions, 195
field precision, 108
filter actions, 157
filter conditions, 147, 148
filter execution order, 149
filter name, 148
filter qualifications, 150
Log to File filter action, 167
menus, 105
Message active link action, 222
Message filter action, 165
message numbers, 166, 223
Notify filter action, 160
number of rows, 113
optional fields, 101
patterns, 105
permissions for a field, 109
permissions for active links, 203
required fields, 101
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Run Macro active link action, 209
Run Process active link action, 220
Run Process filter action, 181
server name at startup, 8, 374
Set Fields active link action, 212
Set Fields filter action, 168
text for character menus, 140
values for fields, 53, 59, 63, 168, 211

SQL database, 24
SQL log file, 23, 295
starting, 4

Administrator Tool, 4
connected to a specific list of

servers, 8, 374
Import Tool, 250
mail handler (armaild), 275
tools from command line, 373
using command line options, 7

states, 51
statistical information, processing, 110
Status core field, 357
status field, 50
status history, 51
Status-history core field, 357
strategy for escalations, 55
STRSTR function, 180
styles of menus, 51
Subadmin Permissions dialog box, 130
Subadministrator group, 73, 83

access, 73
access for schema, defining, 130
admin permissions, 124
permissions described, 84
Subadministrator, creating a, 86

Subject line for email in filters, 163
submitter, 70

access, 74
mode, 18, 71

Submitter core field, 356
Submitter group, 74
Submitter-severity defined field, 363
submitting ARs through email, 277
SUBSTR function, 180

Sun SPARCstation, running SunOS, 5
supplying information to the mail

handler, 270
syntax options

aradmin, 374
arimport, 374
command line, 374

system
defined fields, 362
maintained fields, 46

T
table, database see schemas
text editing window, 104, 109, 111
text entry, 104, 109, 111
text fields, 113

in schemas, 109
size limits, 109
specifying a pattern, 105

TIME function, 180
TIME keyword, 370
time/date data type, 110
TIMESTAMP keyword, 154, 370
To Entry ID reserved field, 361
To Mapping reserved field, 361
To Schema reserved field, 361
To Server reserved field, 361
toggle field display, 171, 214
topic name, 226
tracing

escalation activity, 198
filter activity, 185

transaction values, checking, 151, 152
Transfer Mode reserved field, 362
Transfer Status reserved field, 360
TRUNC function, 180
type style in field labels, 45
types

of active link actions, 208
of escalation actions, 197
of filter actions, 159
of licenses, 80
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U
UNIX client file locations, 349
UNIX flat-file database file locations, 351
UNIX man pages, accessing, 347
UNIX notification system file

locations, 350
UNIX server file locations, 348
UNIX servers, see servers
unqualified queries, 20
Update Status reserved field, 360
updating change history, 37
UPPER function, 180, 219
use password file, 20
USER keyword, 370
User schema, 80

key fields in, 80
User Tool, see also AR System User’s Guide
users

adding, 80, 82
commands, 67
default for notifications, 162
deleting, 84
email notifies from, 21
log file, 23, 295
name, 81
password, allowing users to

change, 83
passwords, 20
permissions, 78
privileges, 78
roles, 47
user name, 81
validating, 20

using
active link change history, 233
Admin Tool window, 8
Administrator Tool, 2
change history, 36
email to send notifications, 162, 288
escalations change history, 198
filter change history, 185
filters versus active links, 63
keywords, 369

mail templates, 276
menu change history, 144
sample schemas, 48
schema change history, 133

V
validating users, 20
version

database, 24
information for Admin Tool, 35
information for Import Tool, 251
server, 14

view
access, 70
field permission, 70, 114
group permission, 77, 114
schema views, multiple, 118

visibility, 114
visible or hidden property, 113

W
warning, 53, 63, 164, 222

settings, 28
WEEKDAY function, 181
WEEKDAY keyword, 370
WEIGHT value of records in full text

search, setting, 127, 329
WEIGHT, sorting records by, 305
When to Update reserved field, 362
width of query list fields, 127
wild cards, 368

QBE settings affecting FTS, 311
search options, configuring FTS, 320

window
Active Link, 200
Admin Command, 236
Admin Preferences, 29
Admin Tool main, 7
Change History dialog box, 37
Create Menu, 138
Create Menu - Query dialog box, 141
Escalation Time Specification, 193
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Escalations, 188
Export Definitions, 244
Export Mail Templates, 247
Export Range, 246
Field Properties, 98, 120
Filter, 146
Full Text Search Ignore Words, 324
Group Access - Active Link, 232
Group Access - Admin

Commands, 239
Group Access - Schema Fields, 132
Group Access - Schemas, 123
Import, 242
Index Field dialog box, 125
License Info, 26, 27
Modify Schema, 90
Query List Fields dialog box, 329,

330, 331
Schema, 90
Selection Values, 115
Server Info, 14
Set Filter Fields, 169
Subadmin Permissions dialog

box, 130
Windows

clients help, 39
NT servers, see servers

Windows client file locations, 352
Windows NT flat-file database file

locations, 353
Windows NT notification system file

locations, 352
workflow process

chart, 44
defining, 52, 60, 63

write license required to set values for
fields in Protected mode, 102

Y
YEAR function, 181


